should not be relied upon in making purchasing decisions. The development, release, and timing of any features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has been executed by you and Oracle and with which you agree to comply. This document and information contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle without prior written consent of Oracle. This document is not part of your license agreement nor can it be incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Sample Code

Oracle may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere through help links. All such sample code is provided “as is” and “as available”, for use only with an authorized NetSuite Service account, and is made available as a SuiteCloud Technology subject to the SuiteCloud Terms of Service at www.netsuite.com/tos.

Oracle may modify or remove sample code at any time without notice.

No Excessive Use of the Service

As the Service is a multi-tenant service offering on shared databases, Customer may not use the Service in excess of limits or thresholds that Oracle considers commercially reasonable for the Service. If Oracle reasonably concludes that a Customer's use is excessive and/or will cause immediate or ongoing performance issues for one or more of Oracle's other customers, Oracle may slow down or throttle Customer's excess use until such time that Customer's use stays within reasonable limits. If Customer's particular usage pattern requires a higher limit or threshold, then the Customer should procure a subscription to the Service that accommodates a higher limit and/or threshold that more effectively aligns with the Customer's actual usage pattern.

Beta Features

Oracle may make available to Customer certain features that are labeled “beta” that are not yet generally available. To use such features, Customer acknowledges and agrees that such beta features are subject to the terms and conditions accepted by Customer upon activation of the feature, or in the absence of such terms, subject to the limitations for the feature described in the User Guide and as follows: The beta feature is a prototype or beta version only and is not error or bug free and Customer agrees that it will use the beta feature carefully and will not use it in any way which might result in any loss, corruption or unauthorized access of or to its or any third party's property or information. Customer must promptly report to Oracle any defects, errors or other problems in beta features to support@netsuite.com or other designated contact for the specific beta feature. Oracle cannot guarantee the continued availability of such beta features and may substantially modify or cease providing such beta features without entitling Customer to any refund, credit, or other compensation. Oracle makes no representations or warranties regarding functionality or use of beta features and Oracle shall have no liability for any lost data, incomplete data, re-run time, inaccurate input, work delay, lost profits or adverse effect on the performance of the Service resulting from the use of beta features. Oracle's standard service levels, warranties and related commitments regarding the Service shall not apply to beta features and they may not be fully supported by Oracle's customer support. These limitations and exclusions shall apply until the date that Oracle at its sole option makes a beta feature generally available to its customers and partners as part of the Service without a “beta” label.
Send Us Your Feedback

We'd like to hear your feedback on this document.

Answering the following questions will help us improve our help content:

- Did you find the information you needed? If not, what was missing?
- Did you find any errors?
- Is the information clear?
- Are the examples correct?
- Do you need more examples?
- What did you like most about this document?

Click here to send us your comments. If possible, please provide a page number or section title to identify the content you're describing.

To report software issues, contact NetSuite Customer Support.
# Table of Contents

Themes and Extensions ................................................................. 9
  Overview .................................................................................. 9
  Install Theme and Extension SuiteApps .................................... 10
Manage Themes and Extensions .................................................. 11
  Set Up Script Deployments for Themes and Extensions .......... 12
  Extension Manager Overview .................................................. 13
Create a New Activation ............................................................. 14
Activate Themes and Extensions ............................................... 14
  Activate a Theme ..................................................................... 16
  Activate Extensions ............................................................... 16
  Update Themes and Extensions .............................................. 17
Commerce Extensions ............................................................... 19
Web Store Items .......................................................................... 21
  Overview ................................................................................ 21
Item Availability ......................................................................... 23
  Item Record Settings ............................................................. 23
  Search Index Settings ........................................................... 24
  Item Inventory ........................................................................ 26
Personalized Catalog Views ....................................................... 28
  Setting Up Personalized Catalog Views ................................. 28
  Verifying Personalized Catalog Views .................................... 34
  Personalized Catalog View Examples .................................... 38
Troubleshooting Item Availability ............................................. 45

Item Images ................................................................................ 51
  Renaming Image Files with an Item Identifier ....................... 52
  Setting a Default Image ........................................................ 53
  Setting the Commerce Image Domain and the Image Folder .... 54
  Uploading Images to the File Cabinet for Websites ............... 54
  Setting Up Image Resizing ...................................................... 54
  Setting up Image Compression for Websites ......................... 56
  Viewing Images on Item Records for Websites ..................... 58
  Making Images Available Without Login ............................... 60

Item Grouping Methods ............................................................ 62
  Item Collections ..................................................................... 62
    Item Collections Roles and Permissions ............................... 63
    Creating Item Collections .................................................. 63
  Commerce Categories ........................................................... 64
    Set Up NetSuite .................................................................... 66
    Configure Commerce Categories Properties ....................... 77

Item Page Options ...................................................................... 78
  Grid Order .............................................................................. 78
    Add Field Sets ..................................................................... 79
    Configure Grid Order ........................................................ 79
    Set Up Matrix Items for Grid Order ..................................... 81
  Size Charts ............................................................................ 82
  Item Badges .......................................................................... 84
  Inventory Display ................................................................... 88
  Stock Notifications .................................................................. 91
  Product Lead Time .................................................................. 96
  Infinite Scroll ........................................................................ 99
Transactions .............................................................................. 101
  Overview ............................................................................... 101
  Checkout ................................................................................ 102
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Featured Category</td>
<td>220</td>
</tr>
<tr>
<td>Featured Product</td>
<td>223</td>
</tr>
<tr>
<td>Gifts</td>
<td>225</td>
</tr>
<tr>
<td>Gift Certificates</td>
<td>225</td>
</tr>
<tr>
<td>Gift Wrap &amp; Message</td>
<td>233</td>
</tr>
<tr>
<td>Look Book</td>
<td>239</td>
</tr>
<tr>
<td>Configure the Look Book extension</td>
<td>240</td>
</tr>
<tr>
<td>Create a Look Book</td>
<td>240</td>
</tr>
<tr>
<td>Add Looks to a Look Book</td>
<td>241</td>
</tr>
<tr>
<td>Add Look Items to a Look</td>
<td>242</td>
</tr>
<tr>
<td>Advertising</td>
<td>244</td>
</tr>
<tr>
<td>Product Feeds</td>
<td>244</td>
</tr>
<tr>
<td>Set Up Product Feeds</td>
<td>248</td>
</tr>
<tr>
<td>Create a Product Feed</td>
<td>252</td>
</tr>
<tr>
<td>Create a Promotion Feed</td>
<td>256</td>
</tr>
<tr>
<td>View the Feed Status</td>
<td>259</td>
</tr>
<tr>
<td>Testimonials</td>
<td>260</td>
</tr>
<tr>
<td>Logo List</td>
<td>262</td>
</tr>
<tr>
<td>SuiteCommerce Customer Management</td>
<td>265</td>
</tr>
<tr>
<td>Customer Registration Flow</td>
<td>265</td>
</tr>
<tr>
<td>Configure Customer Website Settings</td>
<td>271</td>
</tr>
<tr>
<td>Configure Site Registration</td>
<td>272</td>
</tr>
<tr>
<td>Create the Website Customer Center Role</td>
<td>272</td>
</tr>
<tr>
<td>Detect Duplicate Customer Email</td>
<td>274</td>
</tr>
<tr>
<td>Customize Customer Registration Communications</td>
<td>275</td>
</tr>
<tr>
<td>Communications</td>
<td>276</td>
</tr>
<tr>
<td>Email Management</td>
<td>276</td>
</tr>
<tr>
<td>Website Email Settings</td>
<td>276</td>
</tr>
<tr>
<td>Templates for Website Email Messages</td>
<td>280</td>
</tr>
<tr>
<td>Change Email Address</td>
<td>285</td>
</tr>
<tr>
<td>Newsletter</td>
<td>285</td>
</tr>
<tr>
<td>Set Up Newsletter</td>
<td>287</td>
</tr>
<tr>
<td>Newsletter Sign Up</td>
<td>288</td>
</tr>
<tr>
<td>Newsletter Sign Up Using Core SCA Source Code</td>
<td>293</td>
</tr>
<tr>
<td>Social Media</td>
<td>295</td>
</tr>
<tr>
<td>Pinterest</td>
<td>296</td>
</tr>
<tr>
<td>Twitter Product Cards</td>
<td>298</td>
</tr>
<tr>
<td>Facebook Share</td>
<td>299</td>
</tr>
<tr>
<td>Website Content</td>
<td>304</td>
</tr>
<tr>
<td>Website Content</td>
<td>304</td>
</tr>
<tr>
<td>Text Content</td>
<td>305</td>
</tr>
<tr>
<td>SMT Text Content</td>
<td>305</td>
</tr>
<tr>
<td>Columns</td>
<td>310</td>
</tr>
<tr>
<td>Blog</td>
<td>312</td>
</tr>
<tr>
<td>Image Content</td>
<td>319</td>
</tr>
<tr>
<td>Image Manager</td>
<td>319</td>
</tr>
<tr>
<td>SMT Image Content Type</td>
<td>321</td>
</tr>
<tr>
<td>Image Template</td>
<td>323</td>
</tr>
<tr>
<td>Image Text Overlay</td>
<td>324</td>
</tr>
<tr>
<td>Photo Gallery</td>
<td>326</td>
</tr>
<tr>
<td>Slideshow</td>
<td>330</td>
</tr>
<tr>
<td>HTML Content</td>
<td>333</td>
</tr>
<tr>
<td>SMT HTML Content Type</td>
<td>333</td>
</tr>
<tr>
<td>Map &amp; Contact</td>
<td>335</td>
</tr>
<tr>
<td>Map &amp; Contact Content Type</td>
<td>336</td>
</tr>
</tbody>
</table>
Themes and extensions are self-contained packages of files that extend your site in some way. You can install themes and extensions as bundled SuiteApps or as custom-built code deployed to your account by in-house site designers and developers. Once installed, you use the Extension Manager in NetSuite to activate them for a domain associated with your NetSuite account.

- **Themes** – A Theme is a special type of extension that only affects a domain’s design. Each theme presents a different style (colors, fonts, spacing, etc.) and layout for any domain linked to your SuiteCommerce web store. When you activate a theme, you change what visitors see when they browse to your site.

- **Extensions** – An extension introduces added functionality to your website. Extensions offer a wide variety of different features or functions that you can enable on a domain associated with your web store. This might be a blog, an shipping bar, or a set of social media icons to name a few examples. When you activate an extension, NetSuite applies the new capabilities to your web store without requiring any programming or site development knowledge.

Read the following topics to set up themes and extensions:

**Install Theme and Extension SuiteApps**

Before you can activate a published theme or extension, you must install the theme or extension into your NetSuite account as a bundled SuiteApp. This section shows you how.

**Manage Themes and Extensions**

This topic explains how to select themes and extensions and activate them on your Commerce web store.

**Commerce Extensions**

This topic provides information on SuiteCommerce Extensions developed by NetSuite.

**Note:** You must implement SuiteCommerce or the Aconcagua release of SuiteCommerce Advanced and later to use themes and extensions. To customize earlier versions of SCA, see the help topic Core SCA Source Code.
Install Theme and Extension SuiteApps

Applies to: Commerce Web Stores | SuiteCommerce InStore

Before you can activate any published themes or extensions, you must install them as bundled SuiteApps into your NetSuite account.

**Note:** Installing a theme or extension does not activate it for any domain. Installation simply adds the theme or extension source files into your NetSuite File Cabinet. You must activate the theme or extension for a domain using the Extension Manager in NetSuite for it to apply.

**To install a theme or extension SuiteApp:**

1. In NetSuite, go to Customization > SuiteBundler > Search & Install Bundles.
2. In the **Keywords** field, enter the Bundle ID or name of the theme or extension you want to install and click **Search**.
3. Verify that the correct theme or extension SuiteApp is returned in the search and select it.
4. Review the SuiteApp details and then click **Install**.
5. In the confirmation popup, click **OK**.
6. Review the SuiteApp details on the **Preview Bundle Install** page and then click **Install Bundle**.
7. In the confirmation popup, click **OK**.

When the SuiteApp installation is complete, you are ready to activate the associated extension or theme. See Manage Themes and Extensions.

**To uninstall a theme or extension SuiteApp:**

1. Use the Manage Extensions wizard to deactivate the theme or extension related to the SuiteApp you want to uninstall. To deactivate a theme, you must activate a different theme in its place. Repeat this step for all domains currently activating the theme or extension.

   **Important:** Attempting to delete a SuiteApp associated with an active theme or extension will result in an error.

2. Uninstall the SuiteApp. See the help topic Uninstalling a Bundle for details.
Manage Themes and Extensions

**Appplies to:** Commerce Web Stores | SuiteCommerce InStore

**View a Related Video**

The **Extension Manager** lets you activate any theme or extension for a domain linked to your Commerce web store. With it, you can create new or edit existing activations.

An **activation** is the association in NetSuite between a domain and any theme or extensions currently activated for that domain. You can activate any number of extensions for a domain, but you must choose a theme at a minimum.

**Note:** Themes and extensions must either be installed as published SuiteApps or deployed to your NetSuite account by a site developer to be available for activation.

The Extension Manager lets you:

- Activate themes and extensions on a domain
- Activate updates to themes and extensions
- View all current activations for your Commerce web store by domain
- View the status of any activations currently being processed

**Important:** All sites implementing SuiteCommerce or the Aconcagua release of SuiteCommerce Advanced and later require activating a theme using the Extension Manager. Sass development files are not included with SCA source code in any releases later than Aconcagua.

**Before You Begin**

Be aware of the following information before using the Extension Manager:

- If you are using the 2019.1 release of the SuiteCommerce Extension Management bundle or later, you must be logged into NetSuite as an Administrator role. If not, admins can set up Script Deployments to permit other roles to activate themes and extensions. See [Set Up Script Deployments for Themes and Extensions](#) for details.
- Themes and extensions must either be installed from published SuiteApps or deployed to your NetSuite account by a site developer to be available for activation.
- You must activate at least a theme for a domain. You can activate only one theme per activation/domain at a time, but you can activate the same theme across multiple domains.
- You can activate any number of extensions or none at all.
- The Extension Manager is required for all sites implementing SuiteCommerce or the Aconcagua release of SuiteCommerce Advanced and later.
- If activating an extension on a SuiteCommerce InStore (SCIS) domain, you must choose a site, domain, location, and subsidiary. Location and subsidiary are not required for SuiteCommerce sites. In these cases, the system defaults locations and subsidiaries to **All**.
- The Extension Manager lets you set up multiple activations simultaneously. NetSuite only processes one activation at a time, but the Extension Manager creates a Pending queue and provides a status of activation progress.
To use the Extension Manager:

1. Confirm that your script deployments are set up properly. See Set Up Script Deployments for Themes and Extensions for details.
2. In NetSuite, go to Setup > SuiteCommerce Advanced > Extension Manager.
   If you do not see this option, make sure you have installed the SuiteCommerce Extensions Management bundle. See the help topic Install Your Commerce Web Store Applications for information and the Bundle ID.
3. Perform one of the following:
   a. Click **Create Activation** to start a new activation.
   b. Click **Edit** next to any preexisting activation to add, remove, or update themes and extensions for the associated domain.
4. Choose from the following topics, as applicable:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Up Script Deployments for Themes and Extensions</td>
<td>This topic explains how to set up script deployments. If you are using the 2019.1 release of the SuiteCommerce Extension Management bundle or later, you must read this section.</td>
</tr>
<tr>
<td>Extension Manager Overview</td>
<td>This topic describes the Extension Manager interface.</td>
</tr>
<tr>
<td>Create a New Activation</td>
<td>This topic explains how to create a new activation for a specific site and domain. Do this if you have never activated a theme or extension for the intended domain.</td>
</tr>
<tr>
<td>Activate Themes and Extensions</td>
<td>This topic explains how to add, remove, or update themes and extensions for a newly created or preexisting activations.</td>
</tr>
</tbody>
</table>

Set Up Script Deployments for Themes and Extensions

If you are using the 2019.1 release of the SuiteCommerce Extension Management bundle or later and you want to activate a theme or extension, you must log in as an Administrator role. If you want to activate themes and extensions using a different role, admins can set up the `customdeploy_ext_mech_installer_event` deployment script to give other roles this capability.

To set up a role to activate themes and extensions:

1. In NetSuite, go to Customization > Scripting > Script Deployments.
2. Set the following filters:
   - **Type**: User Event
   - **API Version**: 2.0
3. Click **Edit** next to the `customdeploy_ext_mech_installer_event` ID.
4. Set the **Execute as Role** field to **Administrator**.

5. In the **Audience** tab, add the role you want to use to the **Roles** list.
   To select multiple roles, hold down the CTRL key while clicking each role.

6. Click **Save**.

Your account is now prepared to use the specified roles to activate themes and extensions.

---

**Extension Manager Overview**

1. **New Activation** – Creates a new activation for a site and domain. Click this button if you need to activate a theme and extensions for a domain for the first time. To create a new activation, see [Create a New Activation](#).

2. **Edit** – Click **Edit** next to any preexisting activation to add, remove, or update themes and extensions for the associated domain.

3. **Website** – Lists the web site associated with the activation.

4. **Domain** – Lists the domain associated with the activation. NetSuite allows one domain per activation.

5. **Subsidiary** – Lists the subsidiary associated with the activation. This applies to SCIS domains only.

6. **Location** – Lists the location associated with the activation. This applies to SCIS domains only.

7. **Theme** – Lists the currently active theme for the activation. If NetSuite is currently processing the activation, this column lists the theme currently being processed. You can only have one theme per domain/activation.

8. **Active Extensions** – Lists all currently active extensions for the activation. If NetSuite is currently processing the activation, this column lists the extensions currently being processed. You can activate any number of extensions or none at all.

   If an update is available for an active theme or extension this column displays an alert icon ![Alert](https://example.com). You must edit the activation to apply the update. See [Update Themes and Extensions](#) for details.

9. **Status** – Lists one of the following statuses:
   - **Complete** – Indicates that the theme and any extensions listed for the activation are complete and active for the associated domain.
   - **In Process** – Indicates that the activation is currently processing.
   - **Pending** – Indicates that the activation has not started processing. If you create or edit more than one activation simultaneously, the Extension Manager builds a processing queue. Any activations awaiting processing display this status.
   - **Error** – Indicates that the activation process has failed. This status includes a link to open a log popup to aid in troubleshooting.
Note: If an activation experiences an error, at least one theme or extension has failed and requires troubleshooting. Troubleshooting is an advanced effort that requires knowledge of JavaScript, SuiteScript, JSON, and Sass. See the help topic Troubleshoot Activation Errors for assistance.

10. Last Activation Date – Lists the date of the last successful activation.

Create a New Activation

If you are activating themes and extensions on a domain for the first time, you must create a new activation record. If you or anyone else has previously activated a theme or extension for a domain, that activation should already be listed in the Extension Manager.

To create a new activation:

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Extension Manager.
2. Click New Activation.
3. Select a site from the Select a Web Site list. This field is required.
4. Select the domain you want from the Select a Domain list. This field is required.
5. If you are activating themes and extensions on an SCIS domain:
   a. Select the subsidiary from the Select Subsidiary list.
   b. Select the location from the Select Location list.

   Note: If you leave either of these fields blank, your activation applies to All by default.

6. Click Next to select themes and extensions for the domain, or click Cancel to abort the activation.

   Note: If you choose a domain that is already activated, the Extension Manager launches the activation as if you clicked Edit on the preceding page.

7. Follow the instructions in Activate Themes and Extensions.

Activate Themes and Extensions

Creating or editing an activation launches the Activate Themes and Extensions page. See Extension Manager Overview for details on how to create or edit an activation.

The Active Themes & Extensions tab displays all activations for the currently selected web site and domain, as shown below. Note that a theme or extension must also be compatible with your current version of SuiteCommerce or SuiteCommerce Advanced to be listed in the Active Themes & Extensions tab.
To activate themes or extensions:

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Extension Manager.
2. Create a new activation or click **Edit** next to a preexisting activation on the Extension Manager page.
   
   See Extension Manager Overview for details.
3. On the Activate Themes and Extensions page, perform one or more of the following tasks, as applicable:
   - **Activate a Theme**
   - **Activate Extensions**
   - **Update Themes and Extensions**

Selecting **Activate** on this page activates any selected themes and extensions, returns you to the Extension Manager page, and triggers one of the following events:

- If this is the only activation currently being processed, the Extension Manager processes all selected themes and extensions, removes any you deselected, and compiles your domain's run-time files.
- If the Extension Manager is currently processing a different activation, NetSuite adds your activation to the processing queue and sets the status to **Pending**.
Important: As a best practice, test all activations and updates on a development domain before activating on a live site.

Note: For themes and extensions to be available for activation, they must either be installed as a published SuiteApp or be deployed to your account by in-house site developers. For more information on installing themes as SuiteApps, see Install Theme and Extension SuiteApps. For more information on developing your own themes, see the help topic Customization.

Activate a Theme

 Applies to: Commerce Web Stores

The Themes tab lists all themes currently available for activation. You use this tab to select a theme to activate.

To activate a theme:

1. On the Activate Themes and Extensions page, select the Themes tab.
2. Check the Active box next to the theme you want to activate.

You can only activate one theme for a domain at a time. You can deactivate any theme by clearing the Active box. However, you must activate at least one theme to proceed with the activation.

3. Do one of the following:
   - If you want to select one or more extensions to activate with your theme, click the Extensions tab. See Activate Extensions to proceed.
   - If you are ready to process your activations, click Activate.
   - To abort the activation, click Cancel.
4. If this is the initial activation for a domain, clear the domain’s cache by triggering a cache invalidation request. See the help topic Cache Invalidation for details.

Activate Extensions

 Applies to: Commerce Web Stores | SuiteCommerce InStore

The Extensions tab lists extensions that are available for activation. You use this tab to select any extensions to activate.

To activate extensions:

1. On the Activate Themes and Extensions page, select the Extensions tab.
2. Check the Active box next to any extensions you want to activate.
You can activate any number of extensions for a domain or none at all.

3. To deactivate an extension, clear the associated **Active** box.

4. Do one of the following:
   - If you want to select a theme to activate, select the **Themes** tab and see **Activate a Theme**. You must choose a theme to proceed with the activation.
   - If you are ready to process your activations, click **Activate**.
   - To abort the activation, click **Cancel**.

5. If this is the initial activation for a domain, clear the domain's cache by triggering a cache invalidation request. See the help topic **Cache Invalidation** for details.

Update Themes and Extensions

The Extension Manager alerts you if an update is available for an active theme or extension. The Extension Manager displays the latest version available with an update alert icon 🔄. In both the **Themes** and **Extensions** tabs, the box in the **Update** column is now enabled for the applicable item, as shown in the example below.

Be aware of the following important information regarding updates:

- When an update becomes available, it does not automatically update the theme or extension on your domain. You must manually activate the latest version using the steps described in this section.
- The update alert icon only appears for themes and extensions that are currently active. If an update is available for a theme or extension that is not currently active on a domain, you will not see the alert icon. Instead, the latest version is now available as an option.
Updates that are part of managed bundles become available for update automatically.

You are not required to update a theme or extension for a domain.

As a best practice, activate updates to a development domain and test thoroughly before activating to a production domain.

To keep the current version, leave the **Update** box clear (unchecked). The update remains available until you either activate the latest version or deactivate the current version.

### To update a theme or extension:

1. On the Activate Themes and Extensions page, select the **Themes** or **Extensions** tab, whichever applies to the update available.
2. Check the **Update** box next to the theme or extension you want to update.
   - This box is only enabled for themes and extensions with an update available.
3. Click **Activate** to activate the update, or click **Cancel** to abort.

**Important:** If you deactivate the current version without updating, the Extension Manager processes your activation and removes the theme or extension from your domain. The latest update version becomes your only option to activate the next time you launch the Extension Manager.
Commerce Extensions

Applies to: Commerce Web Stores

Commerce Extensions offer a wide variety of features and functions that you can use to enhance your Commerce web store. This topic describes extensions distributed by NetSuite.

These features include:

- Product feeds
- New predefined content layouts
- Integrations with third-party tools

To benefit from and use these extensions, a number of conditions must be met:

- Your account must be provisioned with the corresponding Commerce extension bundle.
- Your account administrator must have installed the bundle. For more information on installing Commerce Extension SuiteApps, see Install Theme and Extension SuiteApps.
- Some Commerce extensions may be dependent on the latest release of NetSuite. Check that your account has been upgraded to the latest version.
- For those extensions requiring activation, your account administrator must have activated the extension for your website domain. For more information on how to activate a Commerce extension, see Manage Themes and Extensions

Furthermore, you need to have installed the following SuiteApps in your account:

- SuiteCommerce or SuiteCommerce Advanced (Aconcagua release or later)
- SuiteCommerce Extension Management
- SuiteCommerce Base Theme
- SuiteCommerce Configuration
- Reference Product Lists Records

Available Extensions

Applies to: Commerce Web Stores

The following table lists Commerce extensions developed and supported by NetSuite.

You can check whether you have the latest version of the extension in the Extension Manager. For more information, see Manage Themes and Extensions.

<table>
<thead>
<tr>
<th>SuiteApp</th>
<th>Bundle ID</th>
<th>Related Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SC Best Sellers</td>
<td>244097</td>
<td>Best Sellers</td>
</tr>
<tr>
<td>SC Blog</td>
<td>250929</td>
<td>Blog</td>
</tr>
<tr>
<td>SC Columns</td>
<td>249263</td>
<td>Columns</td>
</tr>
<tr>
<td>SC Custom Fields</td>
<td>247488</td>
<td>Create Custom Fields Using an Extension</td>
</tr>
<tr>
<td>SC Featured Category</td>
<td>250732</td>
<td>Featured Category</td>
</tr>
<tr>
<td>Extension Name</td>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>SC Featured Product</td>
<td>250724</td>
<td>Featured Product</td>
</tr>
<tr>
<td>SC Gift Certificate Management</td>
<td>243341</td>
<td>Gift Certificate Management</td>
</tr>
<tr>
<td>SC Gift Wrap &amp; Message</td>
<td>248547</td>
<td>Gift Wrap &amp; Message</td>
</tr>
<tr>
<td>SC Google Tag Manager Editor</td>
<td>250341</td>
<td>Google Tag Manager</td>
</tr>
<tr>
<td>SC Grid Order</td>
<td>251806</td>
<td>Grid Order</td>
</tr>
<tr>
<td>SC Image Text Overlay</td>
<td>249292</td>
<td>Image Text Overlay</td>
</tr>
<tr>
<td>SC Infinite Scroll</td>
<td>251769</td>
<td>Infinite Scroll</td>
</tr>
<tr>
<td>SC Inventory Display</td>
<td>251783</td>
<td>Inventory Display</td>
</tr>
<tr>
<td>SC Item Badges</td>
<td>251246</td>
<td>Item Badges</td>
</tr>
<tr>
<td>SC Logo List</td>
<td>248750</td>
<td>Logo List</td>
</tr>
<tr>
<td>SC Map &amp; Contact</td>
<td>249788</td>
<td>Map &amp; Contact</td>
</tr>
<tr>
<td>SC McAfee Secure</td>
<td>249425</td>
<td>McAfee Secure</td>
</tr>
<tr>
<td>SC Newsletter Sign Up</td>
<td>249935</td>
<td>Newsletter Sign Up</td>
</tr>
<tr>
<td>SC Order Status</td>
<td>251720</td>
<td>Order Status</td>
</tr>
<tr>
<td>SC Photo Gallery</td>
<td>249422</td>
<td>Photo Gallery</td>
</tr>
<tr>
<td>SC Product Comparison</td>
<td>251558</td>
<td>Product Comparison</td>
</tr>
<tr>
<td>SC Product Feeds</td>
<td>250407</td>
<td>Product Feeds</td>
</tr>
<tr>
<td>SC Product Lead Time</td>
<td>251993</td>
<td>Product Lead Time</td>
</tr>
<tr>
<td>SC Shipping Bar</td>
<td>249983</td>
<td>Shipping Bar</td>
</tr>
<tr>
<td>SC Size Chart</td>
<td>249416</td>
<td>Size Charts</td>
</tr>
<tr>
<td>SC Slideshow</td>
<td>250352</td>
<td>Slideshow</td>
</tr>
<tr>
<td>SC Stock Notifications</td>
<td>250891</td>
<td>Stock Notifications</td>
</tr>
<tr>
<td>SC Testimonials</td>
<td>248760</td>
<td>Testimonials</td>
</tr>
</tbody>
</table>
Overview

**Applies to:** Commerce Web Stores

Commerce web stores and SuiteCommerce InStore provide a comprehensive set of tools you can use to manage items on your site. Clear item descriptions, high-quality item images, and commerce categories (for sites with a large number of items) all contribute to the success of your site.

You can:
- Configure items
- Group items in different ways
- Add product images
- Set up commerce categories
- Create item collections
- Set up personalized catalog views for different customer segments
- Add features to product pages
- Display item badges
- Set up side-by-side product comparison
- Enable infinite scroll

See the following topics for more information:

**Item Availability**
Set up item records and inventory for your website and prepare items for search engine optimization (SEO). Set up personalized catalog views that provide different customers with access to different items.

**Item Grouping Methods**
Group items using the method most suited to your purpose, for example, sales, web store navigation etc. Group items into general purpose collections that can be used to create personalized catalog views for different customer segments. Create a hierarchical structure of product categories, subcategories, and products to make it easy for your users to locate products in your web store.

**Item Images**
Add product image files to your site. Product images significantly enhance the effectiveness of your product details and other site pages.
Item Page Options

Add elements to the Product Details and Product Listings Pages of your web store. You can set up Inventory Display, Product Lead Time, Stock Notifications, Item Badges, Infinite Scroll, and Grid Order for your products.
Item Availability

Applies to: Commerce Web Stores

There are many settings in your Commerce account that determine what items are available on your site. These options control many factors such as:

- what items are displayed on your site
- how to handle out-of-stock items
- which items display in a multi—website implementation
- effective dates for Commerce Categories

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Set Up Item Records for website</td>
<td>This section provides instructions for displaying an item on your website. Item Record Settings</td>
</tr>
<tr>
<td>Step 2</td>
<td>Set Up Item Records for the Search Index</td>
<td>This section details how to set up the search index for item records on the web store. Search Index Settings</td>
</tr>
<tr>
<td>Step 3</td>
<td>Set Up Item Inventory for web store</td>
<td>This section details how to set up the item inventory for the web store. Item Inventory</td>
</tr>
<tr>
<td>Step 4 (If necessary)</td>
<td>Define minimum/maximum order quantities</td>
<td>This section details how to set up order quantities for the web store. Order Quantity</td>
</tr>
<tr>
<td>Step 5 (If necessary)</td>
<td>Improve SEO Ranking for web store</td>
<td>This section provides tips on optimizing search engine results for the web store. Search Engine Optimization (SEO)</td>
</tr>
<tr>
<td>Step 6 (If necessary)</td>
<td>Create Commerce Categories</td>
<td>This section details how to use commerce categories. Commerce Categories</td>
</tr>
</tbody>
</table>

Item Record Settings

This section details how to make items which are already created available to site visitors for viewing and purchase on your web store. If your item is not yet created, see the help topic Creating Item Records. To make your item available for display on your web store, you must complete the following tasks in the item record:

To make your item available for display on your web store:

1. Go to Lists > Accounting > Items.
2. Use the Sales/Pricing subtab to enter a price for the item.
3. On the Web Store subtab under Web Store Display, check the Display in Web Store box.
4. In the Page Title field, enter the text you want to appear as the page's title for that item. This text appears in the browser tab. Use a descriptive title for the item page, this can help achieve better results with search engine ranking.
5. In the **Web Store Display Name** field, enter the name to show in the Website for this item.

6. In the **Web Store Description** field, enter a brief description of this item.

7. In the **Detailed Description** field, enter the details about the item to display when a site visitor views the item.

   The description fields can have letters, numbers, and basic punctuation. You can also enter basic HTML codes like lists, bold characters, and underlines. You can enter 999 characters in the **Store Description** field and 1,300 in the **Detailed Description** field.

8. In the **Featured Description** field, if this is displayed on the home page of your Website, enter a featured description for this item.

   This description appears below the item's store display name on the Home page of your store or site. You can enter up to 999 characters including basic HTML code. Enter and format text using the formatting options, or click the HTML Source Code link to enter HTML.

9. Attach and display images with the items in the web store. See **Item Images**.

10. Enable Commerce Categories as required. See **Commerce Categories**.

11. Click Save.

---

**Search Index Settings**

The Search Index plays a key role in displaying items in Commerce web stores and in SCIS. Items published to your web store are first indexed, and once the search index process is complete, data on the item records can be queried using the Item Search API.

While setting up your item records for the Search Index, you may have to create additional custom fields in addition to the standard fields. For example, two facets that are commonly used on e-commerce sites are price and brand. In NetSuite, price is a standard field on item records. Brand would be a custom field that you create. You can then include both fields in the field sets so that price and brand information can be displayed in your Commerce web stores and in SCIS. For more information, see the help topic **Custom Fields**.

**To set up item records for the search index:**

1. Go to Lists > Web Site > Items.

2. Determine which standard fields you want to use as search fields, facet fields, and sort fields.

   **Note:** Search fields, facet fields, sort fields, and field sets exposed to your website can be any combination of standard item record fields and custom item record fields. But only certain field types are supported as search fields, facet fields, sort fields, and field sets. For more information, see **Field Set Reference**.

3. Determine the fields on the item record that you require to create field sets.

   For example, for SEO purposes, you can use descriptive URL components in an item template. To do this, you must enter a value in the URL Component field on item records, and then include the URL Component field in a field set.

4. Ensure that there is data in each of the fields you plan to access with the Item Search API.

   For information on supported API parameters, see the help topic **Item Search API Input Parameters**.

   **Note:** Ensure that data is also populated for Matrix Child items.

5. Create custom fields for use as search fields, facet fields, sort fields, and field sets.
For example, you can create a custom item field named Brand.

6. Enter data in the custom fields you created. For example, if you created the custom field Brand, enter the value for brand on each item record for display on your site.

7. Check the **Display in Web Site** box on the item record.

8. Clear the **Inactive** box. Items marked Inactive are not included in the search index.

9. You can index all item records in NetSuite by using the Show Uncategorized Items option, or you can individually select the item records you want indexed. For more information, see Including Item Records in the Search Index.

### Including Item Records in the Search Index

The following conditions must be met for an item to be included in the Search Index:

- The **Display in Web Site** box must be checked on the item record.
- The item must be active. Therefore, the Inactive box must not be checked on the item record.
- The **Show Uncategorized Items** box must be checked on the Web Site Setup page, or the item should be assigned to a Site Builder Category or a Commerce Category.

When you check the **Show Uncategorized Items** box, all items that are active and have the Display in Web Site box checked are indexed. This option enables items to display in search results, even if the items are not published to a category. But the Show Uncategorized Items option might not be appropriate for all scenarios. For example, you may want to display only selected items when you have multiple sites with distinct item sets.

Alternately, you can clear the Show Uncategorized Items option, and configure the item records individually. In this case, only item records that are assigned to a Site Builder Category or a Commerce Category are indexed. If you use the Multiple Web Sites feature, you must add each item to a category on the site where you want it to appear. You can do this on the item record, or use the content manager.

**Note:** When you change the Show Uncategorized Items setting and save the Web Site Setup record, the Search Index Rebuild process is triggered. You are then redirected to the Job Status page, which shows the running Search Index process.

#### To index all the item records:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click **Edit** next to your SuiteCommerce Advanced site.
3. On the **Setup** subtab, check the **Show Uncategorized Items** box.
4. Click **Save**.

#### To index individual item records:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click **Edit** next to your SuiteCommerce Advanced site.
3. On the **Setup** subtab, clear the **Show Uncategorized Items** box.
4. Click **Save**.
5. Go to Lists > Web Site > Items.
6. Click **Edit** next to an item record.
7. On the **Web Store** subtab, select a **Site** and **Site Category** for this item.
8. Click **Save**.
9. Repeat Steps 6 through 8 for item record you wish to index.

Item Inventory

Commerce web stores, Site Builder web stores, and SCIS rely on multiple fields to determine on-hand inventory visibility in your web store. How you set up the following fields determines what and how items display. Some fields take precedence over others.

Setting Precedence

<table>
<thead>
<tr>
<th>Precedence</th>
<th>Field</th>
<th>Location in NetSuite</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Make Inventory Available in Web Store</td>
<td>Store Record</td>
</tr>
<tr>
<td>2</td>
<td>Drop Ship Item</td>
<td>Inventory Item Record</td>
</tr>
<tr>
<td></td>
<td>Special Order Item</td>
<td>Inventory Item Record</td>
</tr>
<tr>
<td></td>
<td>Drop Ship/Special Order Items are Always in Stock</td>
<td>Web Site Setup Record</td>
</tr>
<tr>
<td>3</td>
<td>Out of Stock Behavior</td>
<td>Inventory Item Record</td>
</tr>
<tr>
<td>4</td>
<td>Include Out of Stock Items in Web Store</td>
<td>Web Site Setup Record</td>
</tr>
</tbody>
</table>

The following diagram details the logic behind NetSuite's inventory visibility based on these field settings:
Make Inventory Available in Web Store

This setting takes precedence over all other inventory visibility settings. If any location is not set up to display inventory in the web store, that store's inventory does not appear, regardless of any other settings.

Drop Ship Item, Special Order Item, and Drop Ship/Special Order Items are Always in Stock

Assuming a location's inventory is available in the web store, these settings take the next level of precedence. If an inventory item is marked as a Drop Ship or Special Order item and the Drop Ship/Special Order Items are Always in Stock field is checked, the item is considered in stock and appears in the web store.

Out of Stock Behavior

If an inventory item is out of stock, this setting determines the next level of precedence. Keep the following in mind when setting this field:

- If you set this field to Default, the Site Setup Record’s Include Out of Stock Items in Web Store field takes precedence.
- If you set this field to Remove Item When Out of Stock, NetSuite does not index the item for availability on your web site and ignores the Site Setup Record’s Include Out of Stock Items in Web Store field.
- If you set this field to any other option, NetSuite indexes the item for availability on your site and ignores the Site Setup Record’s Include Out of Stock Items in Web Store field.
- This setting is not available for Sub Items.

Include Out of Stock Items in Web Store

This field takes precedence only if the Inventory Item’s Out of Stock Behavior field is set to Default.

Example:

You have two store locations with on-hand inventory, and you want your web store to function in the following ways:

- You want Store Location A’s inventory to be available in your web store.
- You do not want Store Location B’s inventory to be available in your web store.
- You want drop-ship items to always be listed as in stock.

Your NetSuite set up will look like this:

<table>
<thead>
<tr>
<th>Location in NetSuite</th>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store Record for Location A</td>
<td>Make Inventory Available in Web Store</td>
<td>Checked</td>
</tr>
<tr>
<td>Store Record for Location B</td>
<td>Make Inventory Available in Web Store</td>
<td>Unchecked</td>
</tr>
<tr>
<td>Inventory Item Record (for any items to be listed as drop ship items)</td>
<td>Drop Ship Item</td>
<td>Checked</td>
</tr>
</tbody>
</table>
## Item Inventory

<table>
<thead>
<tr>
<th>Location in NetSuite</th>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Site Setup Record</td>
<td>Drop Ship/Special Order Items are Always in Stock</td>
<td>Checked</td>
</tr>
<tr>
<td>Inventory Item Record</td>
<td>Out of Stock Behavior</td>
<td>Remove item when out-of-stock</td>
</tr>
</tbody>
</table>

Based on these settings, the Site Setup Record’s **Include Out of Stock Items in Web Store** field does not apply.

## Personalized Catalog Views

### Applies to: Commerce Web Stores

### Note: This information refers to SuiteCommerce or the 2019.2 release of SuiteCommerce Advanced or later. Do not enable Personalized Catalog Views if your site is using a SuiteCommerce Advanced release prior to 19.2.

The Personalized Catalog Views (PCV) feature enables you to provide different customers with access to different items. You can divide your customers into groups and provide each group with access to a tailored selection of catalog items. This is useful in many scenarios, particularly for B2B websites. For example:

- Businesses can grant VIP customers exclusive access to specific catalog items
- Retailers that are licensed to sell certain products in limited geographies can prevent customers in other geographic locations from seeing those items
- Manufacturers that require customers to be certified to purchase certain items can ensure only certified customers have access to those items

PCV uses NetSuite records, such as Customer Groups, Commerce Categories, and Item Collections as well as the Customer Segment Manager tool to help you personalize your catalogs for your customers.

See the following topics for more information about PCV:

- **Setting Up Personalized Catalog Views** - provides guidance on how to set up PCV including how to create customer and item segments, how to make item segments visible to customer segments, and how to check that the correct items are visible to the correct customers. The [Personalized Catalog Views Setup Checklist](#) lists the main steps you need to take to set up PCV.
- **Personalized Catalog View Examples** – demonstrates how PCV is set up for the three use cases listed previously, namely, VIP customers, different catalogs based on customer location, and items restricted to certified customers.
- **Troubleshooting Item Availability** – lists the settings that can prevent items from being displayed to the correct customers in the web store.

View the [Introduction to Personalized Catalog Views video](#)

## Setting Up Personalized Catalog Views

The first step in setting up personalized catalog views is to determine how you want to divide your customers and items and which items you want to make accessible to which customers. Some questions you should ask at this stage are:
Personalized Catalog Views

- What are the customer groups I need? On what basis will I assign a customer to one group or the other?
- Do I want anonymous visitors to my web store to see any items? If so, which ones?
- Do all my customers fall into one or more customer groups or do I have some “leftover” customers? What items, if any, do I want the leftover customers to see? Do they have to be logged in or recognized by the web store to see them?
- Do I want any of my customers to be in more than one customer group?
- What item segments do I need? On what basis do I want to assign an item to one segment or another? Do the item segments correspond to the sections in my website navigation or are they different?
- Who should be able to view any items that are not in item segments mapped to a customer segment?

Setting up PCV after you have answers to these questions makes the process much easier.

View the Setting Up Personalized Catalog Views video

Personalized Catalog Views Setup Checklist

To use PCV in your web store:

1. Determine the customer segments and item segments you require for your web store.
2. Create customer segments — see Defining Customer Segments.
3. Create item segments — see Defining Item Segments.
4. Enable the Personalized Catalog Views feature — see Enabling Personalized Catalog Views.
5. Ensure that the people working with PCV have the correct permissions — see Personalized Catalog Views Roles and Permissions.
6. Define which item segments are visible to which customer segments — see Managing Item Segment Visibility.
7. Define visibility of items not included in any item segments that are mapped to customer segments — see Defining Visibility of Unmapped Items.
8. Check that the correct items are displayed to the correct customers — see Verifying Personalized Catalog Views.

Defining Customer Segments

A customer segment is a group of customers for whom you can configure a personalized catalog view. PCV supports the following customer segments:

- **Customer Groups** - you can create these segments using the NetSuite entity groups feature. They can be:
  - Static - use static groups if you want to create a personalized catalog view for a single customer or a group of unrelated customers. You can choose each customer to be included in the group.
  - Dynamic - use dynamic groups if you want to create a personalized catalog view for a group of customers who have something in common, for example, West Coast customers or customers who have placed $10,000 worth of orders. You can use saved searches to define these groups.

- **Anonymous Users** - this segment comprises those website visitors who are not logged in and whom the website cannot recognize in any way, for example, through session data or browser cookies.

- **Recognized and Logged In Users** - this segment comprises those website visitors who are either logged in or visitors whom the website can recognize, for example, by using session data or browser cookies.
All Users – this segment comprises all visitors to the website, regardless of whether the visitors belong to another customer segment or not. By default, all items are visible to all users.

To create new customer groups, follow the instructions in the Working with Groups help topic.

**Note:** You can make item segments visible to the All Users, Anonymous Users, and Registered and Logged In Users customer segments but you cannot control or view which customers are in these groups at any given point of time.

### Defining Item Segments

An item segment is a group of items that can be made visible to one or more customer segments. PCV supports the following item segments:

- **Item Collections** - you can add specific items to an item collection record either manually or by using a mass update. For more information, see Item Collections.
- **Commerce Categories** - these enable you to create a hierarchical structure of product categories, subcategories, and products for display on your website. If you use commerce categories to organize and display products on your website, you can also use them in PCV to display specific commerce categories to selected customer segments. For more information, see Commerce Categories.

Commerce categories are not always a good fit for PCV because they are not necessarily tailored to individual customers or customer segments. For example, if you have a clothing website, you may want your website visitors to see products organized into Men's, Women's, and Accessories categories. But you may want VIP customers to view a “VIP Items” item segment, which contains products from all three categories. In this scenario, where the hierarchical item groupings are distinct from the customer-focused item groupings, it would be much better to create “VIP Items” as an item collection.

Whether you use item collections, commerce categories, or a combination of the two while setting up a personalized catalog view, depends on the result you want to achieve.

### Personalized Catalog Views Roles and Permissions

Any user who sets up personalized catalog views must have a valid NetSuite user account and also be assigned a role that provides sufficient permissions for PCV. The roles that provide these permissions by default are:

- Administrator - this role also has access to Site Management tools
- Store Manager - this role also has access to Site Management tools
- Marketing Manager
- Sales Manager
- Marketing Administrator
- Sales Administrator
- System Administrator

For more information on NetSuite users and roles, see NetSuite Users & Roles.

### Customer Segments Manager Permission for an Existing Role

You can add permissions to a NetSuite custom role to enable users to set up personalized catalog views. The following permissions are needed:

- **Customer Segments Manager** - Required for setting up personalized catalog views.
Without this permission, users cannot access the Customer Segments Manager or set up any personalized catalog views. However, they can view which item segments are mapped to different customer segments on Customer Groups and Item Collections records.

- **Commerce Categories** - Required only if Commerce Categories are used with PCV.
- **Site Management Tools (SMT) permissions** - Required if users want to preview PCV in the website. Necessary permissions for SMT are:
  - Documents and Files
  - Website (External) Publisher
  - Website Management
- **SuiteAnalytics Workbook and Analytics Administrator** - Required to view the standard SuiteAnalytics Workbooks that display which items are visible to which customer and which customer can see which item. The access level for these permissions should be Edit.

You cannot edit a NetSuite standard role, but you can use it as the basis for a new custom role. For detailed instructions and best practices for customizing a NetSuite role, see [NetSuite Roles Overview](#).

### Enabling Personalized Catalog Views

The first step for implementing Personalized Catalog Views, is to enable the feature. PCV is an account-specific feature, which means that the personalized catalog settings are used for all Commerce web stores associated with the account. If PCV is enabled, SCIS websites show only those items that are visible to All Users.

**To enable personalized catalog views:**

1. Go to Setup > Company > Enable Features.
2. Click the Items & Inventory subtab.
3. Check the Personalized Catalog Views box.
4. On the Web Presence subtab, check:
   - **Commerce Categories** - Do this only if you want to use Commerce Categories as item segments.
   - **Site Management Tools** - Do this to use SMT to verify PCV.
5. On the Analytics subtab, check the SuiteAnalytics Workbook box. Do this to use SuiteAnalytics Workbooks to verify PCV.
6. Click Save.

The Customer Segments Manager is now available to users who have the appropriate permission.

**Note:** When you enable Personalized Catalog Views, by default, all items are visible to all users. This means that there is no change to the website when you enable the feature. Changes to the website occur only when you make specific item segments visible to customer segments. For more information, see [Managing Item Segment Visibility](#).

### Managing Item Segment Visibility

When you have defined the item segments and customer segments you want to use, you need to define which item segments are visible to which customer segments. For some item segments, you may not want to restrict access to specific customer segments. In that case, you can make them visible to all users. Finally, if there are items on your web store that are not mapped to a customer segment, you need to specify who should be able to see them.
Making Item Segments Visible to Customer Segments

When you have defined the item segments and customer segments you want to use, you need to define which item segments are visible to which customer segments. There are three ways you can do this:

- **Using the Customer Segments Manager (CSM)** - You can use this feature to define mappings between item segments and customer segments. It also provides an overview of all the mappings that have been defined.

- **From the Customer Group record** - You can define which item segments a customer group can view on the customer group record.

- **From the Item Collection record** - You can define which customer segments can view an item collection on the item collections record.

All item collection to customer segment mappings are visible and editable in the Customer Segments Manager regardless of where the mapping was created.

If you are using Commerce Categories in PCV, you can define which customer segments can view a commerce category from either the CSM or the Customer Groups record.

If you make a dynamic item collection visible to a customer segment, PCV uses a snapshot of the dynamic group members. The snapshot is updated once every hour.

Using Customer Segment Manager to Make Item Segments Visible to Customer Segments

The Customer Segment Manager provides an overview of all the item and customer segment mappings that have been defined. Regardless of where a mapping is defined, it is visible and editable in the Customer Segments Manager.

When you open the Customer Segments Manager for the first time, the **Visibility of Unmapped Items** toggle is set to "Items not mapped to a Customer Segment are VISIBLE to all users". This means that at this point, no items are mapped to a customer segment, so all items are visible to all users.

**To make item segments visible to customer segments using the CSM:**

1. Go to Setup > Marketing > Customer Segments Manager.
2. Click **Add Item Segments**.
3. In the Available pane, depending on the type of item segment you want to map, select either **Item Collection** or **Commerce Category** from the list.

   **Note:** When using a Commerce Category as an item segment, remember that only items included directly in the category are included in the item segment. Any subcategories must be selected as separate item segments.

4. Select the item segments you want to define visibility for and click > to move them to the Selected pane. You can use the Shift and Ctrl keys on your keyboard to select more than one value or to clear a value.
   
   To search the list of item segments, use the filter at the top of the list of item segments.
5. Click **Add** to add the selected item segments to the Customer Segments Manager matrix.
   
   If you want to remove an item segment from the matrix, click the icon in the Remove column.
6. Click in the Customer Segments selection area next to an item segment, and select one or more customer segments from the list.
   
   To remove an customer segment from the selection area, click the cross icon next to it.
If you want to make any of the item segments available to all users, check the All Users checkbox next to it. Doing so disables the Customer Segments selection area as All Users includes all other customer segments.

**Note:** If you have already defined customer segments for the item segment, they remain visible but inactive in the Customer Segments selection area. If you clear the All Users checkbox, the customer segments become active again.

7. When you have completed mapping item segments to customer segments, click Save.

If you want to verify if the personalized catalog views are set up correctly, click Save & View Site or Save & View Report. For more information, see Verifying Personalized Catalog Views.

**Note:** When you click any of the Save buttons, the search index for the website is rebuilt. As soon as the rebuild is complete, the personalized catalog views become active and customers visiting the website are shown the personalized catalog view applicable to them. For information on how to check the status of the search index rebuild, see Check the Search Index Job Status.

Making Item Segments Visible to Customer Segments from a Customer Group

You can define the item segments visible to a customer group from the customer group record.

**To make item segments visible to a customer group:**

1. Go to Lists > Relationships > Groups.
2. Click Edit next to the customer group.
3. On the Personalization Rules tab, select an item segment from the list in the Item Segment column and click Add. Do this for all the item segments you want to add.
4. When you are done, click Save.

Making Item Segments Visible to Customer Segments from an Item Collection

You can define the customer segments to which an item collection is visible from the item collection record.

**To make an item collection visible to customer segments:**

1. Go to Lists > Accounting > Item Collections.
2. Click View next to the item collection.
3. On the Customer Segments tab, select a customer segment from the list in the Customer Segment column.
   - To add another customer segment, click Add Row and select another customer segment.
4. When you have finished adding customer segments, click Save.

**Defining Visibility of Unmapped Items**

If an item is included in one or more item segments and at least one of the item segments is mapped to a customer segment, the item is visible to the customer segment. Such an item is called a mapped item.

An unmapped item, however, is one that is:

- Not included in any item segment
Included in one or more item segments but none of the item segments are mapped to a customer segment

For example, if you want to display a subset of your inventory to your VIP customers but not to anyone else, you would put those items in an item collection "VIP Items" and make it visible to the customer segment, "VIP customers". But in this scenario, what happens to the rest of your items, which are unmapped?

Suppose you have just added a large number of new items to your inventory but have not yet assigned them to item segments? By default, these unmapped items are visible to all users, which may not be what you want.

In both these scenarios you need to define the visibility of the unmapped items in the Customer Segments Manager.

To display unmapped items to all users:
1. Go to Setup > Marketing > Customer Segments Manager.
2. Click the Visibility of Unmapped Items toggle to display “Items not mapped to a Customer Segment are VISIBLE to all users”.

To hide unmapped items from all users:
1. Go to Setup > Marketing > Customer Segments Manager.
2. Click the Visibility of Unmapped Items toggle to display “Items not mapped to a Customer Segment are HIDDEN from all users”.

Note: An item can be included in multiple item segments. If any of these segments is mapped to a customer segment, the item is not unmapped and its visibility is not controlled by the Visibility of Unmapped Items toggle.

Verifying Personalized Catalog Views

In complex scenarios, particularly when there are multiple customer segments and items are included in more than one item segment, it can be difficult to understand which customers can see which items. To make it easier to check that the correct items can be seen by the correct customers, the following verification options are available:

- Reports - Two standard SuiteAnalytics Workbooks are provided with PCV. You can use these workbooks to display which customers can see a particular item and which items can be seen by a particular customer. For more information, see Using Workbooks to Verify Personalized Catalog Views.

- Website preview - You can use Site Management Tools to preview what items will be displayed to different customer segments.

For more information, see Using SMT Advanced Preview to Verify Personalized Catalog Views.

View the Verifying Personalized Catalog Views video

Using Workbooks to Verify Personalized Catalog Views

SuiteAnalytics Workbook is a powerful analytical tool that allows you to create and view highly customizable workbooks using NetSuite data. For Personalized Catalog Views, the following standard workbooks are available:

- Items by Customer - you can select specific customers and see which items are visible to them. The workbook shows you which customer segments the selected customers are in, which item segments
are visible to those customer segments, and which items are included in the item segments. For more information on the components of this workbook, see Items by Customer Workbook.

- **Customers by Item** - you can select specific items and see which customers can see them. The workbook shows you which item segments the selected items are in, which customer segments can view those item segments, and which customers are included in the customer segments. For more information on the components of this workbook, see Customers by Item Workbook.

Both workbooks reflect the latest changes to PCV as soon as you click any of the Save buttons on the Customer Segment Manager page.

You can add other fields and filters to the standard SuiteAnalytics Workbooks or create your own. For more information about SuiteAnalytics Workbooks, see the help topic SuiteAnalytics Workbook Overview.

**Items by Customer Workbook**

The Items by Customer workbook enables you to select specific customers and see which items are visible to them. The workbook shows you which customer segments the selected customers are in, which item segments are visible to those customer segments, and which items are included in the item segments.

**To view which items are visible to specific customers:**

1. Go to Setup > Marketing > Customer Segments Manager.
2. Click Save & View Report and select the Items by Customer workbook.
   
   You can also access the workbook, by going to the Workbook Listing Page and clicking the Items by Customer link in the Standard Workbooks list. For more information, see the help topic Accessing and Sharing Workbooks and Datasets.

   **Note:** If you cannot see the Save & View Report button, you do not have the correct permissions to access workbooks. See Personalized Catalog Views Roles and Permissions for more information.

3. In the Items by Customer pivot table, click on Entity ID in the Value Filter(s).
4. In the left pane of the filter window, select the customers you are interested in and click > to move them to the right pane.
5. Click OK.
6. Click the Refresh icon above the Pivot Table Viewer.

   The Workbook refreshes to show you the items each selected customer can view.

**Workbook Configuration**

The source data used in the Items by Customer workbook combines fields from four record types. For more information, see the help topic Defining a Dataset.

<table>
<thead>
<tr>
<th>Root Record</th>
<th>Joined Record(s)</th>
<th>Data Grid</th>
<th>Pivot Table(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer</td>
<td>Customer Segment</td>
<td>The following record fields are included in the workbook source data:</td>
<td>Items by Customer</td>
</tr>
<tr>
<td></td>
<td>Item Segment</td>
<td>Customer record:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item</td>
<td>▪ Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Customer Segment record:</td>
<td></td>
</tr>
</tbody>
</table>
Customers by Item Workbook

The Customers by Item workbook enables you to select specific items and see which customers can see them. The workbook shows you which item segments the selected items are in, which customer segments can view those item segments, and which customers are included in the customer segments.

To view which customers can see specific items:

1. Go to Setup > Marketing > Customer Segments Manager.
2. Click Save & View Report and select the Customers by Item workbook.
   You can also access the workbook directly, by going to the Workbook Listing Page and clicking the Customers by Item link in the Standard Workbooks list. For more information, see the help topic Accessing and Sharing Workbooks and Datasets.
   
   **Note:** If you cannot see the Save & View Report button, you do not have the correct permissions to access workbooks. See Personalized Catalog Views Roles and Permissions for more information.

3. On the DataSet tab of the Customers by Item SuiteAnalytics Workbook, click on Item Name/Number in the Criteria Summary.
4. In the left pane of the filter window, select the items you are interested in and click > to move them to the right pane.
5. Click OK.
6. Click the Refresh icon above the Pivot Table Viewer.
   The workbook refreshes to show you the items each selected customer can view.

Workbook Configuration

The source data used in the Customers by Item workbook combines fields from four record types. For more information, see the help topic Defining a Dataset.

<table>
<thead>
<tr>
<th>Root Record</th>
<th>Joined Record(s)</th>
<th>Data Grid</th>
<th>Pivot Table(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Item Segment</td>
<td>The following record fields are included in the workbook source data:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Customer Segment</td>
<td>Customer record:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item</td>
<td></td>
<td>Customers by Item</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item Segment</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Customer Segment</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Using SMT Advanced Preview to Verify Personalized Catalog Views

This refers to SuiteCommerce or the 19.2 release of SuiteCommerce Advanced or later.

Site Management Tools Advanced Preview lets you see how your site appears to customers when Personalized Catalog Views (PCV) is enabled. You can select and apply customer segments to the preview to confirm that customers assigned to the segments can access the items they have permission to purchase. Likewise, you can confirm that customers in the segments cannot access items that are not available to them.

You can access SMT Advanced Preview in two ways:

- From the Customer Segments Manager in NetSuite, click Save & View Site and choose a domain from the dropdown list. This opens a new browser tab and logs you in to SMT on the site. By default, you are logged into the domain specified as the primary URL. If no primary URL is specified, you are logged into the first domain specified on the Domains tab of the website setup record.

  Note: When you Save & View Site in the Customer Segment Manager, the site index is rebuilt. The changes will not be visible in SMT until the reindexing is complete.

- From within Site Management Tools, select Advanced Preview on the Site Management toolbar.

Preview Customer Segments in SMT

When you select Advanced Preview in SMT, the Advanced Preview Settings are displayed in the side panel. By default, no customer segments are selected and all items and categories are displayed in the preview.

When you select one or more customer segments in the side panel and click Apply, the items in the preview are filtered to only those items that are available for purchase by the selected customer segments. Additionally, the site category navigation is updated to reflect the conditional category display structure. The Commerce Category Hide Empty Categories feature hides category branches that contain no items. See Exclude Empty Commerce Categories.

After you apply one or more customer segments to the preview, you can use the site shopping navigation to preview the items that are available to the selected customer segments.

To close Advanced Preview, click Advanced Preview in the Site Management toolbar.

You can copy the following Related Topics sidebar and paste it into this topic.

Tips on Testing Personalized Catalog Views

When you click Save, Save & Preview or Save & View on the Customer Segments Manager page, the search index for the website is reindexed. When the reindexing is complete, the personalized catalog views become active and customers visiting your website are shown the personalized catalog view applicable to them. Making an item segment visible to a customer segment from a customer group record or an item collection record has the same effect.

Though you can use SuiteAnalytics Workbooks and SMT Preview to verify that PCV has been set up correctly, this is possible only after saving the personalized catalog views. Therefore, it is advisable to test the personalized catalog views in a way that does not affect the production website. There are two ways to do this:

- Use test customer segments - if you want to make certain items available only to selected customers, you can add test customers to your customer groups and set up PCV as you would do for real customers. Make sure that Visibility of Unmapped Items is set to "Items not mapped to a Customer Segment are VISIBLE to all users". This ensures that all real customers can see all items.
other than those you have mapped to the test customers. After you have logged in as a test customer and checked that the correct items are visible, you can add real customers to the customer group.

- **Publish to a test website** - if you have a more complex PCV plan, it is better to test the setup in a sandbox account and publish to a test website to make sure the correct customers have access to the correct items.

### Personalized Catalog View Examples

Personalized Catalog Views can be complicated to design, particularly if you have items in multiple item segments and customers in multiple customer segments. It is important to spend some time thinking about what each customer segment can and cannot view before setting it up in NetSuite. The following examples show you how to work through the design and implementation process:

- **Exclusive Items for VIP Customers** - this example looks at a scenario where a subset of the inventory items should be available only to a certain group of customers. All other items should be available to all users.
- **Different Catalogs based on Customer Location** - this example restricts the items visible depending on the customer location. Some items are visible to customers from more than one location.
- **Items Available only to Certified Customers** - this example restricts different product lines to customers who have achieved the required certification. Some customers may be certified for more than one product line.

### Exclusive Items for VIP Customers

Company A is a wholesale company selling home decor items such as wall art, cushions, and glassware. The Company A website uses commerce categories to structure its navigation menu and users can browse through the items in the Wall Art, Cushions, and Glassware categories.

Company A wants to start a VIP program that will provide certain customers with exclusive access to premium items. Customers who wish to participate in the VIP program must first sign a contract with Company A.

### Design

First, Company A needs to decide how to segment their items and customers. Let's look at how their answers to some important questions helps to design PCV:

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
<th>Design Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>What are the customer groups I need?</td>
<td>VIP customers and All Users</td>
<td>Customer groups to be created - VIP Customers</td>
</tr>
<tr>
<td>On what basis will I assign a customer to one group or the other?</td>
<td>The Sales Operation Manager will add customers to the VIP group after they sign a contract.</td>
<td>VIP Customers customer group is a static customer group</td>
</tr>
<tr>
<td>Do I want any of my customers to be in more than one customer group?</td>
<td>All Users includes VIP customers.</td>
<td>None</td>
</tr>
<tr>
<td>What item segments do I need?</td>
<td>VIP Items is a group of items that spans all the commerce categories. Also, we are launching a new line of items called Designer Carpets, which should be available only to VIP Customers to start with, though we may later make it available to all customers.</td>
<td>Item segments needed - VIP Items and Designer Carpets.</td>
</tr>
</tbody>
</table>
On what basis do I want to assign an item to one segment or another?
The Marketing Manager will add all VIP items to the VIP Items segment and the Designer Carpets segment. None

Do the item segments correspond to the sections in my website navigation or are they different?
VIP Items is different and contains items from all the sections of my navigation menu. Designer Carpets is intended to be a top-level section in the navigation menu. VIP Items is not a Commerce Category. It should be an item collection. Designer Carpets should be a Commerce Category since it will appear in the navigation menu.

Which item segments should be visible to my customer segments?
VIP customers can see all items. All users (including anonymous users) can see all items except for VIP Items and Designer Carpets (at least for now). VIP Items and Designer Carpets item segments should be visible to only the VIP customers customer group.

Who should be able to view any items that are not in item segments mapped to a customer segment?
All users should be able to see items not mapped to VIP Customers. The unmapped items visibility should be set to “Visible to All Users”.

Implementation

From the design inputs, Company A creates the following in NetSuite:
- Customer Group (static): VIP Customers
- Item Collection: VIP Items
- Commerce Category: Designer Carpets
- Personalized Catalog View Setup:
  - Makes VIP Items and Designer Carpets visible to VIP Customers
  - Sets Visibility of Unmapped Items toggle to display “Items not mapped to a Customer Segment are VISIBLE to all users”.

![Customer Segments Manager](image)
Note: In this example, Designer Carpets does not have any subcategories. If it did, the subcategories would be selected separately. Only items included directly in the category are included in the item segment.

The Designer Carpets Commerce Category is, at present, exclusive to VIP users so other users will not see this category in the navigation menu at all. For more information, see Exclude Empty Commerce Categories. Later, if Company A decides to make Designer Carpets visible to all users, they can remove the mapping from the Customer Segments Manager. This makes all items within it “unmapped” and therefore visible to all users. The Designer Carpets category will then appear in the navigation menu for all users.

Different Catalogs based on Customer Location

Company B sells washing machines and dishwashers made by different manufacturers to retailers across the world. They are licensed to sell the following:

- Washing machines and dishwashers made by manufacturer M in the USA, Canada and the United Kingdom
- Washing machines and dishwashers made by manufacturer S in the USA
- Washing machines made by manufacturer D in Canada
- Dishwashers made by manufacturer D in Canada and the United Kingdom
- Dishwashers made by manufacturer Y in the USA and Canada

The Company B website navigation menu contains sections for washing machines and dishwashers with further filtering by manufacturer, capacity, energy rating etc. They do not use Commerce Categories.

Design

First, Company B needs to decide how to segment their items and customers. Let’s look at how their answers to some important questions helps to design PCV:

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
<th>Design Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>What are the customer groups I need?</td>
<td>US Customers, Canada Customers, UK Customers</td>
<td>Customer groups to be created - US Customers, Canada Customers, UK Customers</td>
</tr>
<tr>
<td>On what basis will I assign a customer to one group or the other?</td>
<td>Customers will be automatically placed in the group corresponding to their registered address.</td>
<td>US Customers, Canada Customers, and UK Customers are dynamic customer groups that use saved searches based on customer registered address</td>
</tr>
<tr>
<td>Do I want any of my customers to be in more than one customer group?</td>
<td>No</td>
<td>No need to consider what a customer should see if they are in more than one group.</td>
</tr>
<tr>
<td>What item segments do I need?</td>
<td>Manufacturer M Products, Manufacturer S Products, Manufacturer D washing machines, Manufacturer D dishwashers, Manufacturer Y dishwashers</td>
<td>Item segment to be created - Manufacturer M Products, Manufacturer S Products, Manufacturer D washing machines, Manufacturer D dishwashers, Manufacturer Y dishwashers</td>
</tr>
<tr>
<td>On what basis do I want to assign an item to one segment or another?</td>
<td>Based first on manufacturer and then on type of item.</td>
<td>Use mass updates to assign items to item collections.</td>
</tr>
<tr>
<td>Do the item segments correspond to the sections in my website navigation or are they different?</td>
<td>They are similar but not exactly the same.</td>
<td>Since Company B does not already use Commerce Categories and because the navigation structure is not identical to the item segments needed, it is best to use item collections for the item segments.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Which item segments should be visible to my customer segments?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
- US Customers - Washing machines and dishwashers made by manufacturer M and manufacturer S, dishwashers made by manufacturer Y  
- Canada Customers - Washing machines and dishwashers made by manufacturer M and manufacturer D, dishwashers made by manufacturer Y  
- UK Customers - should see washing machines and dishwashers made by manufacturer M and dishwashers made by manufacturer D  |  
- US Customers customer group mapped to Manufacturer M Products, Manufacturer S Products, Manufacturer Y dishwashers  
- Canada Customers group mapped to Manufacturer M Products, Manufacturer D washing machines, Manufacturer D dishwashers, Manufacturer Y dishwashers  
- UK Customers group mapped to Manufacturer M Products, Manufacturer D dishwashers |
| Who should be able to view any items that are not in item segments mapped to a customer segment? | All item segments should be mapped to customer segments. If there are any items that are not in item segments, it is because they have not yet been classified. They should not be visible to any customer. | The unmapped items visibility should be set to “Hidden from All Users”. |
| Do all my customers fall into one or more customer groups or do I have some ‘leftover’ customers? What items, if any, do I want the leftover customers to see? | We are not licensed to sell to customers outside USA, UK and Canada. Any visitors to the website from anywhere else in the world should not see any products. | No item segments should be mapped to any customer segments other than US Customers, Canada Customers, and UK Customers, |

### Implementation

From the design inputs, Company B creates the following in NetSuite:

- Three saved searches that return US Customers, Canada Customers, and UK Customers respectively
- Customer Groups (dynamic based on the saved searches): US Customers, Canada Customers, UK Customers
- Item Collections: Manufacturer M Products, Manufacturer S Products, Manufacturer D washing machines, Manufacturer D dishwashers, Manufacturer Y dishwashers
- Personalized Catalog View Setup:
  - Manufacturer M Products item collection mapped to US Customers, Canada Customers, and UK Customers customer groups
  - Manufacturer S Products item collection mapped to US Customers customer group
  - Manufacturer D washing machines mapped to Canada Customers customer group
  - Manufacturer D dishwashers mapped to Canada Customers and UK Customer customer groups
  - Manufacturer Y dishwashers mapped to US Customers and Canada Customers customer groups,
  - Sets Visibility of Unmapped Items toggle to display “Items not mapped to a Customer Segment are HIDDEN from all users”.

SuiteCommerce Store Front
Company C supplies equipment and chemicals to laboratories. It sells only to customers who have received training and are certified to use the equipment and chemicals. It also sells online training courses to people interested in becoming certified.

Another factor is that the training is manufacturer-specific. The certification for manufacturer A covers all its equipment and chemicals. However, Manufacturer B requires separate certification for its equipment and its chemicals.

**Design**

First, Company C needs to decide how to segment their items and customers. Let's look at how their answers to some important questions helps to design PCV:

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
<th>Design Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>What are the customer groups I need?</td>
<td>Certified Customers (Manufacturer A), Certified Customers (Manufacturer B equipment), Certified Customers (Manufacturer B chemicals), and non-Certified Customers</td>
<td>Certified Customers (Manufacturer A), Certified Customers (Manufacturer B equipment) and Certified Customers (Manufacture B chemicals). Non-Certified Customers could possibly be 'All Users' but it will depend on other answers.</td>
</tr>
<tr>
<td>On what basis will I assign a customer to one group or the other?</td>
<td>We are the exclusive suppliers of training for Manufacturer B. If the customer has bought and successfully completed the classroom-based equipment training course, the instructor fills in a form, which automatically updates the customer record to show that they are now certified. If the customer has bought the online chemicals training course from us, when the customer completes the course, their customer record is automatically updated to</td>
<td>Certified Customers (Manufacturer B equipment) and Certified Customers (Manufacturer B chemicals) should be dynamic customer groups that use saved searches based on the custom Certification fields on the customer record. Certified Customers (Manufacturer A) should be a static customer group so that Customer Support can manually add</td>
</tr>
</tbody>
</table>
show that the customer is now certified. The customer should be automatically included in the correct certified group based on the information in the customer record.

Manufacturer A has different suppliers for its certifications so a customer who wants to buy Manufacturer A products from us has to email Customer Support and provide proof of certification. If the customer has bought the training course from us, their customer record is automatically updated upon completion of the training.

customers to it when they receive proof of certification. However, it would make more sense to have a dynamic group for the customers who buy the training from Company C. It would be a better customer experience if such customers did not have to send in evidence of completing a course. Therefore, we can have two groups for such customers - a static one for external certification and a dynamic one for internal certification.

<table>
<thead>
<tr>
<th>Do I want any of my customers to be in more than one customer group?</th>
<th>Yes. We support three certifications - Manufacturer A, Manufacturer B (equipment) and Manufacturer B (chemicals). Customers can have one or more of these certifications so should be in the customer group for whichever certification they have.</th>
<th>We need to give consideration to what items customers in more than one group can see.</th>
</tr>
</thead>
<tbody>
<tr>
<td>What item segments do I need?</td>
<td>Manufacturer A Products, Manufacturer B Equipment, Manufacturer B Chemicals, Certification Courses</td>
<td>Item segment to be created - Manufacturer A Products, Manufacturer B Equipment, Manufacturer B Chemicals, and Certification Courses</td>
</tr>
<tr>
<td>On what basis do I want to assign an item to one segment or another?</td>
<td>For equipment and chemicals, based first on manufacturer and then on type of item. For certification courses, based on type of item.</td>
<td>Use mass updates to assign items to item collections. For certification courses, there are only three courses so they can be added manually.</td>
</tr>
<tr>
<td>Do the item segments correspond to the sections in my website navigation or are they different?</td>
<td>They are different. The website is categorized by type of product, for example, microscopes, electronic burettes etc.</td>
<td>Since company C does not already use Commerce Categories and because the navigation structure is not identical to the item segments needed, it is best to use item collections for the item segments.</td>
</tr>
<tr>
<td>Which item segments should be visible to my customer segments?</td>
<td>■ Certified Customers (Manufacturer A external) - Manufacturer A Products, Certification Courses ■ Certified Customers (Manufacturer A internal) - Manufacturer A Products, Certification Courses ■ Certified Customers (Manufacturer B equipment) - Manufacturer B Equipment, Certification Courses ■ Certified Customers (Manufacturer B chemicals) - Manufacturer B Chemicals, Certification Courses</td>
<td>■ Certified Customers (Manufacturer A external) and Certified Customers (Manufacturer A internal) customer groups mapped to Manufacturer A Products and Certification Courses ■ Certified Customers (Manufacturer B equipment) group mapped to Manufacturer B Equipment and Certification Courses ■ Certified Customers (Manufacturer B chemicals) mapped to Manufacturer B Chemicals and Certification Courses ■ Recognized and Logged In Customers mapped to Certification Courses</td>
</tr>
</tbody>
</table>
Non-Certified Customers - Certification Courses

It is time to expand our understanding of the requirements for this group. Some further questions:

- Can customers with one certification see the other certification courses? - Yes, they can
- Can customers with a certification see the certification course they have already completed? - Yes, they can
- Can any visitor to the website see the certification courses? - No, we do not sell to the general public at all. Our customers are schools, universities etc. Only their members can buy from us.

Who should be able to view any items that are not in item segments mapped to a customer segment?

- All item segments should be mapped to customer segments. If there are any items that are not in item segments, it is because they have not yet been classified. They should not be visible to any customer.
- The unmapped items visibility should be set to ‘Hidden from All Users’.

Do all my customers fall into one or more customer groups or do I have some ‘leftover’ customers? What items, if any, do I want the leftover customers to see?

- We do not sell to the general public. If a person who is not a registered customer visits our website, they should not see any products for sale.
- All certified customers will be in one or more customer groups. Non-certified customers who are recognized and logged in can see only the certification courses. Any customer who is not logged in or recognized should not see any products at all.

Implementation

From the design inputs, Company C creates the following in NetSuite:

- Three saved searches that return customers certified by Company C on Manufacturer A products, customers certified on Manufacturer B equipment, and customers certified on Manufacturer B chemicals respectively
- Customer Groups (dynamic based on the saved searches): Certified Customers (Manufacturer A internal), Certified Customers (Manufacturer B equipment), Certified Customers (Manufacturer B chemicals)
- Customer Group (static, to be updated by Customer Support): Certified Customers (Manufacturer A external)
- Item Collections: Manufacturer A Products, Manufacturer B Equipment, Manufacturer B Chemicals, Certification Courses
- Personalized Catalog View Setup:
  - Manufacturer A Products item collection mapped to Certified Customers (Manufacturer A internal) and Certified Customers (Manufacturer A external) customer groups
  - Manufacturer B Equipment item collection mapped to Certified Customers (Manufacturer B equipment) customer group
  - Manufacturer B Chemicals item collection mapped to Certified Customers (Manufacturer B chemicals) customer group
- Certified Course item collection mapped to Recognized and Logged In Customers
- Sets **Visibility of Unmapped Items** toggle to display “Items not mapped to a Customer Segment are HIDDEN from all users”.

Troubleshooting Item Availability

There can be multiple reasons why an item is not available on a website to a particular customer. The following flowcharts cover the settings you should check if a customer is unable to see an item that they should be able to:

- Item Settings
- Commerce and Site Category Settings
- Out of Stock Behavior Settings
- Multi-Subsidiary Settings
- Personalized Catalog View Settings

*Note:* Some of the settings mentioned are role-specific. Contact your administrator if you cannot access any of them.

<table>
<thead>
<tr>
<th>Flowchart Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUSTOMER</td>
</tr>
<tr>
<td>ITEM</td>
</tr>
<tr>
<td>WEBSITE</td>
</tr>
<tr>
<td>DATE</td>
</tr>
</tbody>
</table>
Item Settings

List A: Item Types

- Assembly Items
- Download Items
- Gift Certificates
- Inventory Items
- Kit
- Non Inventory Items
- Service Items
Commerce and Site Category Settings

**List B: Category Visibility**

If you answer YES to all the following questions, the Commerce or Site Category is visible on the WEBSITE:

For Commerce Categories only:
- Is the WEBSITE selected for the Commerce Catalog?
- Is the *Inactive* box clear for the Commerce Catalog?
- Is the Commerce Category included in the Commerce Catalog?
- Is the *Inactive* box clear for the Commerce Category?
- Is *Display in Web Site* checked for the Commerce Category?
- Is DATE within the period defined by the Start and End date of the Commerce Category?

For Site Categories only:
- Is the WEBSITE selected for a Presentation tab?
- Is the Site Category included on the Presentation tab?
- Is the *Inactive* box clear for the Presentation tab AND the Site Category?
- Is *Display in Web Site* checked for the Presentation tab AND the Site Category?
- Is the CUSTOMER included on the Audience subtab of the Presentation tab AND the Site Category?
Out of Stock Behavior Settings

List C: Out of Stock Behavior

- Disallow back orders but display out-of-stock message
- Allow back orders but display out-of-stock message
- Allow back orders with no out-of-stock message
Multi-Subsidiary Settings

**Diagram 4**

1. Are multiple subsidiaries defined in NetSuite? **YES**
   - Is the ITEM included in at least one subsidiary? **YES**
     - Is the ITEM included in the subsidiary (specific or default) requested by the CUSTOMER? **YES**
     - ITEM DOES NOT DISPLAY
   - Is the ITEM included in the subsidiary (specific or default) excepted for the CUSTOMER? **NO**
     - Is cross-subsidiary fulfillment enabled and set up for the CLIENT? **NO**
       - In an option in the list set Out of Stock Behavior for the WEBPAGE? **NO**
         - Defects are included in Out of Stock Behavior for the WEBPAGE? **YES**
           - Include Out of Stock Items in Web Store checked for the WEBPAGE? **YES**
           - Go to Diagram 5
         - Defects are included in Out of Stock Behavior for the WEBPAGE? **NO**
           - In the ITEM in issue in the subsidiary (specific or default) requested by CUSTOMER? **YES**
             - Go to Diagram 5
           - In the ITEM in issue in the subsidiary (specific or default) excepted for the CUSTOMER? **NO**
             - Go to Diagram 5
2. **NO**

**Diagram 5**
Personalized Catalog View Settings

* This refers to the Item Segment containing the ITEM

** This refers to the Customer Segment which is mapped to one of the Item Segments in which the ITEM is included.
Item Images

Applies to: Commerce Web Stores

There are two ways to add product images to your web stores:

- Use Site Management Tools (SMT) - a quick method to add marketing images, banner images, or non-item related images
- Upload images to the File Cabinet - the method to add item images

For information on how to use SMT to add images to your website, see SMT Image Content Type.

To set up images by uploading them to the File Cabinet, complete the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Before you begin</th>
<th>Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Renaming Image Files with an Item Identifier</td>
<td>Decide on a naming convention for image files that includes an item identifier.</td>
<td>To link image files to item records. NetSuite uses the item identifier to match image files to item records.</td>
</tr>
<tr>
<td>2. (Optional) Setting a Default Image</td>
<td>Decide on a default image to display.</td>
<td>Designate one of these images to display by default on the product list page and first on the product detail page.</td>
</tr>
<tr>
<td>3. Setting the Commerce Image Domain and the Image Folder</td>
<td>Rename all of the image files you want to associate with item records.</td>
<td>To set the root folder for all product image files associated with a particular Commerce website.</td>
</tr>
<tr>
<td>4. Uploading Images to the File Cabinet for Websites</td>
<td>Create a .zip file on your computer that contains all the image files.</td>
<td>To populate the images folder for your Commerce website with product images.</td>
</tr>
<tr>
<td>5. (Optional) Setting Up Image Resizing</td>
<td>To specify the maximum height and width for images, and IDs for different image sizes. You can use the Image Size ID to resize images in site templates.</td>
<td></td>
</tr>
<tr>
<td>6. (Optional) Setting up Image Compression for Websites</td>
<td>To reduce the file size of images, enabling faster loading and better website performance. You can apply image compression settings at the website level and at the File Cabinet folder level.</td>
<td></td>
</tr>
<tr>
<td>7. Viewing Images on Item Records for Websites</td>
<td>Complete tasks 1 — 4.</td>
<td>To view images associated with a particular item record. You can also edit Alt Image text.</td>
</tr>
</tbody>
</table>
Renaming Image Files with an Item Identifier

The first step in setting up images for a Commerce web store, SCIS, or Site Builder website is to rename each image file with an item identifier.

Decide on a naming convention that includes an item identifier for image files intended for your website and rename image files accordingly. Use the Item Identifier field to choose a field on item records that NetSuite can use to link image files together with item records.

Note: For custom fields, only stored custom fields are available for use as Item identifiers. If a custom field has the Store Value set to False in the custom field record, it is not available.

Image File Naming Guidelines

- Append the item identifier to the beginning of the image file name you want associated with each item record. You can add to the filename of each image using the Item ID Delimiter and the Structure Delimiter.
  
  The example below shows the image file name format when the item identifier is set to UPC code: `SKU123_modelshot-longcoat.jpg`
  
  The Item ID Delimiter is required. The default value is an underscore (_). It is used to parse the item identifier from the image filename.
  
  The default value of the Structure Delimiter field is a single dash (-). The Structure delimiter can be used to add information to the image filename. You are not required to use the Structure Delimiter in your image file names, but the Structure Delimiter field requires a value to prevent the Item Search API from returning internal errors.
  
  The image file naming convention you choose should make sense for your website.
  
  Image file names should ideally be descriptive and reflect the content of the image. It is easier for a search engine to index images on your site when you use descriptive file names. For more information, see the help topic SEO and Images.
  
  The image file name should be unique, and the file name can have a maximum of two delimiters and three words.
Renaming Image Files with an Item Identifier

Note: If you do not follow the image file naming guidelines, item images may not be returned in the search results even though the images have been associated with the item on the item record.

- For images associated with items that have item options, you should use a non-numeric value after the last delimiter in the image file name.

Note: If you use a numeric value after the last delimiter, you might not be able to change item images in the web store when you change the item options. For example, `sku12345_toySlide-9-blue.png` and `sku12345_toySlide-blue-size9.png` are as per the image file naming guidelines but `sku12345_toySlide-blue-9.png` is not.

Examples:

- You can upload image files intended for different types of site templates. For example, if you create one site template for a list of search results, and another for the product detail view, then name image files accordingly:

```plaintext
camera_sideview-searchresults.jpg
camera_sideview-detail.jpg
sku123_main-red.png
sku123_detail-red.png
```

- You can upload different images optimized for various devices:

```plaintext
camera_sideview-mobile.jpg
camera_sideview-browser.jpg
```

- While adding multiple images of the same item, you should maintain uniqueness of the image file name. For example, you can maintain uniqueness while not exceeding the permitted delimiter and word limit as shown below:

```plaintext
sku12345_toySlide-blue.png
sku12345_toySlide-blueAltA.png
sku12345_toySlide-blueAltB.png
```

To designate one of these images to display by default on the product list page and first on the product detail page, see Setting a Default Image.

Notes on delimiters:

- Delimiters parse the file name from the item identifier.
- You can change the value for either of the Item ID or Structure delimiter. Both delimiters can be the same.
- You can change the delimiters to any combination of up to five supported characters ($ - _ + ! * ' () ,). The maximum limit is five characters.

Setting a Default Image

When using two or more images for one product, you can designate one of the images as the default image. The default image displays on the product list page and first on the product details page. To designate an image as the default, add `.default` to the end of the file name.
In the following example, sku12345_toyslide-blueAltB.png is renamed to become the default image: sku12345_toySlide-blueAltB.default.png.

<table>
<thead>
<tr>
<th>Image Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sku12345_toyslide-blue.png</td>
</tr>
<tr>
<td>sku12345_toyslide-blueAltA.png</td>
</tr>
<tr>
<td>sku12345_toyslide-blueAltB.default.png</td>
</tr>
</tbody>
</table>

### Setting the Commerce Image Domain and the Image Folder

After you rename all of the image files you want to associate with item records, select a domain and create a new folder for storing the image files.

1. Go to Setup > SuiteCommerce Advanced/Site Builder > Set Up Web Site.
2. Click Edit next to the site.
3. Click the **Images** tab.
4. Select the domain you want to use in the **Image Domain** field.
5. Click (+) next to the **Image Folder** field to create a new folder for image files. Remember the folder name.
6. Click Save.

You can upload image files to this folder at any time. Images files are mapped to item records based on the item identifier and the image file name.

### Uploading Images to the File Cabinet for Websites

On your computer, you can create a .zip file that contains all the image files for your site, and then expand the zipped file after it has been uploaded.

1. Go to Setup > SuiteCommerce Advanced > Web Site Hosting Files.
2. Find the folder you selected as **Image Folder**.
3. Click Advanced Add.
4. Select the .zip file on your computer.
5. Check the Unzip Files box.
6. Click Add.

### Setting Up Image Resizing

If you want to resize images files for your website, you can use the Image Resizing section on the Web Site Setup page. Here, you can specify the maximum height and width of the image and an ID for the image size. You use the Image Size ID to include a specified image size in a template.
To set up Image Resizing

1. Go to Setup > SuiteCommerce Advanced/Site Builder > Set Up Web Site.
2. Click Edit next to the web site you want to modify.
3. Click the Images subtab.
4. Go to the Image Resizing section and modify the following fields:
   - **Image Size ID** – Assign an ID for the image resize definition. Use a name that denotes a particular image size.
     For example, you may want to configure two different sizes for image on your site. In the Image Size ID field, enter thumbnail, and then in the next row, enter rectangle.

     ![Note: To allow resizing of an image slider, you must add a homeslider Image Size ID (at 200 pixels wide by 220 pixels high) and a homecell Image Size ID (at 125 wide by 125 pixels high).](image)

     - **Description** – (Optional)
     - **Enabled** – Check this box so that you can use the Image Size ID with the Item Search API. If an Image Size ID is not enabled, then the Item Search API ignores the image size you set up, and returns the image in its original size.
     For example, if the enabled check box is cleared here, and the Image Size ID is included in a website template, the Image Size ID you set up is ignored, and the original image size is rendered.
     - **Maximum Width and Maximum Height** – Enter the values you want to use for the maximum height and width of the image. You can specify one or neither. For example, if you enter a value for Maximum Width, the Maximum Height is automatically calculated.
     Note that the image aspect ratio is stored with the image file in the file cabinet. Automatic resizing is based on the image aspect ratio. Width and height are computed.

5. Click **Save** after you have set your specifications for image resizing.

   ![Important: Resized images are generated when they are first requested. They are not generated when they are uploaded to File Cabinet.](image)

After you have set up resizing images for your website, you can use the Commerce API to include image resize settings for a site. For more information, see Using the Commerce API to Resize Images.

Resized images are automatically compressed using the ‘Optimum’ image compression setting regardless of the setting chosen at the site or folder level. For more information about image compression, see Setting up Image Compression for Websites.

To confirm images are associated with the correct item records, see Viewing Images on Item Records for Websites.

Using the Commerce API to Resize Images

Calls to the Item Search API return image URLs without resize information. However, you can call the Commerce API from an SSP application to return the image resize settings for a site. Use the sitesettings.imagesizes field to get the image sizing parameters. The JSON response contains an array of objects that includes the urlsuffix for each Image Resize ID that has been defined for the
Setting Up Image Resizing

The urlsuffix can then be used to construct the correct image URL. For more information on the sitesettings.imagesizes field, see the help topic sitesettings.

Note the following examples:

- An image URL without parameters, such as http://mysite.com/images/OU9613.media.orange.01.jpg? displays on the site as follows:

  ![Image URL without parameters](http://mysite.com/images/OU9613.media.orange.01.jpg?resizeid=10&resizeh=230&resizew=201)

- An image URL that includes a parameter, such as http://mysite.com/images/OU9613.media.orange.01.jpg?variant=3, displays the following URL on the site:

  ![Image URL with parameter](http://mysite.com/images/OU9613.media.orange.01.jpg?variant=3&resizeid=10&resizeh=230&resizew=201)

The following image resize data is included in the JSON response for the sitesettings.imagesizes field.

- **maxwidth**–maximum resized image width in pixels
- **maxheight**–maximum resized image height in pixels
- **urlsuffix**–suffix that should be added to the image URL to return a resized image
- **name**–value from the Image Resize ID field (image resize definition) as entered on the Web Site Setup page
- **internalid**–internal system ID of resize definition

Note the following example of image resize data in the JSON response for the sitesettings.imagesizes field:

```json
"imagesizes": [
  {
    "maxwidth": 100,
    "internalid": 104,
    "urlsuffix": "resizeid=104&resizeh=100&resizew=100",
    "maxheight": 100,
    "name": "large"
  },
  {
    "maxwidth": 800,
    "internalid": 103,
    "urlsuffix": "resizeid=103&resizeh=600&resizew=800",
    "maxheight": 600,
    "name": "medium"
  },
  {
    "maxwidth": 100,
    "internalid": 102,
    "urlsuffix": "resizeid=102&resizeh=100&resizew=100",
    "maxheight": 100,
    "name": "small"
  }
]
```

Setting up Image Compression for Websites

Image compression enables you to reduce the file size of images used in Commerce websites, Site Builder websites and SCIS. Compressed images load faster resulting in better website performance. The
higher the compression level, the smaller the file size and the quicker it is to load. Higher compression levels also lower the quality of the image. However, the reduction in quality typically isn’t noticeable. The available levels of compressed image quality are:

- Very High (minimum compression)
- Optimum (recommended)
- Standard
- Low (maximum compression)

You can define image compression settings at the website level which apply to all images displayed on website domains. You can also define image compression settings in the File Cabinet for any subfolder of the Web Site Hosting Files folder. Defining compression settings at the folder level, means that images in the folder are compressed regardless of where they are accessed from. If you set different image compression settings for a website and folder, the compression settings used for an image depends on where the image is accessed from. If it is accessed from a website, the website compression settings are used. If it is accessed directly from the folder (for example, by SCIS), then the folder settings are applied.

If image compression settings apply to an image, a compressed copy of the image is created the first time it is accessed. The original image is not affected. The compressed copy of the image is cached, either internally, or on the CDN, if CDN is enabled for the website. See the help topic CDN Caching for more information.

Which Images are Compressed?

Image compression is applied to all images in the website or folder that are:

- JPEG or PNG format. Other file formats are not compressed.
- Between 500KB and 5 MB. Images that fall outside of this range are not compressed.
- Stored in the NetSuite file cabinet. Images stored outside of NetSuite and linked to from the website are not compressed.
- Not already resized. Resized images are automatically compressed using the ‘Optimum’ image compression setting regardless of the setting chosen at the site or folder level. See Setting Up Image Resizing for SuiteCommerce for information about resizing images.

To set up image compression for a website

1. Go to Setup > SuiteCommerce Advanced/Site Builder > Set Up Web Site.
2. Click Edit next to the website you want to modify.
3. Click the Images subtab.
4. Select **Compress All Website Images**. This turns on image compression for all images in the website that meet the criteria defined in Which Images are Compressed?.
5. Select the image quality setting to use from the **Compressed Image Quality** dropdown. The options are:
   - **Low (maximum compression)** - minor reduction in quality
   - **Standard** - minor reduction in quality when images are zoomed
   - **Optimum (recommended)** - occasional minor reduction in quality when images are zoomed
   - **Very High (minimum compression)** - no noticeable reduction in quality at any time
6. Select **Strip Metadata** to remove all metadata, such as camera details, caption, or copyright information, from the images. Doing this reduces the file size further.
7. Select **Chroma Subsampling** to modify the image file in a way that reduces the color information in favor of luminance data. The human eye can detect differences in luminosity better than it can.
To set up image compression for a File Cabinet folder

1. Go to Setup > SuiteCommerce Advanced > Web Site Hosting Files.
2. Click Edit next to the image folder to which you want to apply image compression.
3. Click the Hosted Images Compression subtab.
4. Select **Compress All Website Images**. This turns on image compression for all images in the folder that meet the criteria defined in *Which Images are Compressed?*.
5. Select the image quality setting to use from the **Compressed Image Quality** dropdown. The options are:
   - **Low (maximum compression)** - minor reduction in quality
   - **Standard** - minor reduction in quality when images are zoomed
   - **Optimum (recommended)** – occasional minor reduction in quality when images are zoomed
   - **Very High (minimum compression)** - no noticeable reduction in quality at any time
6. Select **Strip Metadata** to remove all metadata, such as camera details, caption, or copyright information, from the images. Doing this reduces the file size further.
7. Select **Chroma Subsampling** to modify the image file in a way that reduces the color information in favor of luminance data. The human eye can detect differences in luminosity better than it can detect differences in color, so using chroma subsampling results in image files that look the same but are smaller in size. This is suitable only for digital images.
8. Click **Save**.

When any image in this folder or any subfolders is accessed, the image compression parameters are applied. Image compression will be applied to any images added to the folder in the future as well.

Unlike image compression settings defined on a website record, image compression defined for a folder applies to:

- Images on the system domain. System domains are those that have the format `system.netsuite.com`.
- Images that are not associated with website domains, such as those used by SCIS.

If a folder has image compression applied, any subfolders inherit the parent folder’s settings. You cannot define different compression settings for the subfolders. Similarly, if you try to apply image compression settings to a folder whose subfolders already have image compression settings defined, the subfolder settings are removed and the parent folder settings apply to the subfolders. A warning message is displayed before the subfolder settings are removed.

**Viewing Images on Item Records for Websites**

Item records include the Images sublist, where you can see the list of images associated with each item record.

<table>
<thead>
<tr>
<th>SKU</th>
<th>Description</th>
<th>Related Items</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>SKU123_model-longcoat.jpg</td>
<td>Longcoat</td>
<td>My Site</td>
<td></td>
</tr>
</tbody>
</table>
When the item record is in Edit mode, you can change the Image Alt Text, and you can click on the file name to open the image file record in a new tab. Note that the image can be associated with multiple websites.

Notes on product-image mapping with Commerce websites, SiteBuilder websites and SCIS:

- You can have different image size configurations on different sites. For example, you can use a medium sized rectangle for images on site A, and a large rectangle on site B.
- You define the Image Size ID in website templates. This sublist shows the images associated with the item. The Image Size ID is not applicable to the information shown on this list.
- Multiple sites can share one image folder, or you can create different image folders for each site.
- One image can match multiple items or multiple images can match one item, based on how you name the image file.

Setting Up Multiple Images for an Item

You can configure your website to display multiple images for an item in the Product Details Page of your site.

The Item Option ID determines what images display in your web store when a user makes an option selection in the PDP. For example, you configure an item option with the ID: `customColor` to be the selection that triggers an image change. In your web store, a user selects a shirt from your store that offers multiple color options. In the PDP, the user selects blue for the item’s color option. This triggers the image change to display the correct image of a blue shirt.

In the Elbrus release of SCA and later, the image change capability extends to configuring two or more item option IDs. This lets you configure your images to accurately depict items based on multiple item option selections. For example, you configure two item options with the following IDs: `customColor` and `customSize`. When a user selects a shirt in your web store and then selects color: blue (ID: `customColor`), the image for the shirt changes to display the correct image of a blue shirt. The user then selects size: medium (ID: `customSize`). The image in the PDP changes again to depict the correct blue, medium shirt.

To configure the multiple-image option for your site:

1. Determine the Item Option ID you want to use to trigger an image change in the PDP.
2. Configure the `multiImageOption` property using the SuiteCommerce Configuration record. See the help topic Multi-Image Option Subtab for more information.
   a. In the SuiteCommerce Configuration record, navigate to the Shopping Catalog tab and Multi-Image Option subtab.
   b. Add the ID of the triggering Item Option to the table.
   c. Click Add. Repeat this for every Item Option ID you want to add, as required. Vinson release of SCA and earlier allow only one level of Item Options.
   d. Save the record.
3. Format your images following the same configuration pattern in your image file name format.

**Important:** For the multiple image option feature to work, you must format your image file names to include options that match those of the triggering item option or options. See Renaming Image Files with an Item Identifier for more information.

For example, if you configured an item option ID for the item color, followed by the ID for the item size, include the item color and size in the file name. Your file name format should look something like this:

```
sku_media_blue_small.jpg
sku_media_blue_medium.jpg
sku_media_blue_large.jpg
sku_media_red_small.jpg
...
```

### Making Images Available Without Login

In the file cabinet, you can have some files restricted to only those who have login access to your account. However, files that are published in your website or available for download in your site should always be available without login to ensure they are displayed properly.

Make sure all of the image files used on your website are available without login by using a mass update.

**To mass update files as available without login:**

2. Click Files to expand the options for files.
3. Click Make Files Available Online.
4. On the Criteria subtab, select a filter to search for files that should be updated. For example, select folder to update files based on the folder they are stored in the file cabinet.
5. In the Mass Update popup window, select the type of file that should be updated. For example, if you selected Folder as the filter, select Images to update the files in the Images folder.
6. Repeat steps 5 and 6 to set additional criteria.
   Unless you are using expressions for your search with the **And** and **Or** functions, all criteria must
   be met to have the mass update apply.

7. On the **Results** subtab, you can decide what information should show when you preview the
   results of the search before performing the update.

8. To preview your results before performing the update, click **Preview**.

9. To perform the update, click **Perform Update**.
   Alternatively, to save the update for future use, click **Save**. If you save the update, you still need to
   reopen the update to perform the update. Saved mass updates can be accessed at Lists > Mass
   Update > Mass Updates.

All files meeting your criteria are now updated with the Available Without Login box checked.

To attach an image to an information item, go to Web Site > Publishing > Information Items.
# Item Grouping Methods

There are multiple ways of grouping items in Commerce web stores — some grouping methods have specific purposes while others are more general purpose. The following table describes all available item grouping methods and highlights the differences between them.

<table>
<thead>
<tr>
<th>Grouping Methods</th>
<th>Item Collections</th>
<th>Commerce Categories</th>
<th>Merchandise Hierarchy Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main Purpose</strong></td>
<td>General purpose</td>
<td>Web store navigation</td>
<td>Reporting</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Item collections are a general purpose way of grouping items. Used by Personalized Catalog Views. For more information, see Personalized Catalog Views.</td>
<td>Commerce Categories are used to create a hierarchical structure of product categories, subcategories, and products that are used in the navigation structure of web stores.</td>
<td>Merchandise Hierarchy Nodes are used to organize your company's merchandise in a way that enables the production of reports, which identify market trends and analyze shopper buying and demand.</td>
</tr>
</tbody>
</table>
| **Web Store Availability?** | Available for use with:  
- NetSuite  
- NetSuite web stores | Available only for NetSuite web stores. | Available for use with:  
- NetSuite  
- NetSuite web stores |
| **Cardinality**   | Many to many      | Many to many        | One to many                  |
| **Member Definition** |  
- Static (manual selection)  
- Dynamic (based on saved searches) | Static (manual selection) | Static (manual selection) |
| **Date Effectivity** | Does not support date effectivity. | Supports date effectivity, that is, Start Date and End Date. | Supports date effectivity, that is, Start Date and End Date. |
| **More Information** | Item Collections | Commerce Categories | Merchandise Hierarchy |

**Note:** There are other ways of grouping items within NetSuite, including item types such as item groups, kits and assemblies, and grouping methods specific to Site Builder, such as Site Categories. For more information about these, please see the help topics [Groups, Assemblies, and Kit/Packages](#) and [Site Builder Tabs & Categories](#).

## Item Collections

Item collections are a way of grouping catalog items. The items you add to item collections might have no connection with each other or they could be based on one or more criteria, for example, vendor or location. Your business needs drive what items you add to each item collection.

You can:

- Add an item to multiple item collections
- Add a set of items to an item collection by choosing members individually
- Automatically add items to an item collection by using a saved search

Item collections can contain all item types supported by NetSuite. For matrix items, only the parent item can be added to the item collection but the parent item represents all child items. For more information about item types, see the help topic Item Types.

An important use for item collections is in personalized catalog views. You can create an item collection and make it visible to one or more specific groups of customers. For more information, see Personalized Catalog Views.

Item Collections Roles and Permissions

Any user who creates item collections must have a valid NetSuite user account and also be assigned a role that provides sufficient permissions. The roles that provide these permissions by default are:
- Administrator
- Store Manager
- Marketing Manager
- Sales Manager
- Marketing Administrator

You can also add the Item Collection permission to a NetSuite custom role to enable users to manage item collections.

For more information on NetSuite users and roles, see NetSuite Users & Roles. You cannot edit a NetSuite standard role, but you can use it as the basis of a new custom role. For detailed instructions and best practice for customizing a NetSuite role, see NetSuite Roles Overview.

Creating Item Collections

You can create two types of item collections:
- Static item collections - add and remove items to these collections manually. Ideal for item collections whose items cannot be grouped based on one or more properties
- Dynamic item collections - add and remove items automatically based on a saved search. Every time an item is added that matches the saved search criteria, that item is automatically added to the item collection

To create a dynamic item collection:

1. Go to Lists > Accounting > Item Collections > New.
2. In the Name field, enter up to 200 characters for the name of this item collection.
3. (Optional) Enter a description of the item collection.
4. Select the Dynamic option on the toggle.
5. Select the existing item saved search you want to use from the Saved Search list.
For information on how to create a saved search, see the help topic Defining a Saved Search.

6. Click Save.

**To create a static item collection:**

1. Go to Lists > Accounting > Item Collections > New.
2. In the Name field, enter up to 200 characters for the name of this item collection.
3. (Optional) Enter a description of the item collection.
4. Select the Static option on the toggle.

![Static Dynamic Item Collection Type]

**Note:** You cannot change the item collection from Static to Dynamic or vice versa after you have saved it.

5. On the Items subtab of the item collection, do one of the following:
6. ■ To add multiple items at once:
   1. Click Add Multiple.
   2. Check the boxes for the items you want to include in the item collection and click > to move them to the Current Selections pane. You can use the Shift and Ctrl keys on your keyboard to select more than one value or to clear a value.
   3. To search for specific items, use the search box at the top of the Add Items window. You can also filter the list using the filter at the top of the list of items.
      ■ To add items one by one, select them from the list in the Name field. You can search for specific items by typing in at least three characters from the item name.
7. Click Save.

You can also use CSV Import to create static item collections. The Item Collection and Item Collection Item Map record need to be imported separately in this process. For more information, see the help topics Item Collection Import and Item Collection Item Map Import.

**Commerce Categories**

** Applies to: Commerce Web Stores**

This information refers to SuiteCommerce or the Vinson release of SuiteCommerce Advanced or later.

Commerce Categories enable you to create a hierarchical structure of product categories, subcategories, and products. At the top level of this hierarchy is the catalog. Each site can have one catalog, and all categories are assigned to that catalog. A well-planned and organized catalog lets you present items on your website to your shoppers in a structured fashion. The catalog’s category hierarchy can be general purpose in nature to present all items that you sell. Alternatively, the catalog might be based on occasion such as season. For example, you may have a spring theme that highlights spring related apparel and accessories, or a back to school organization that emphasizes back to school specials.

Since you can assign the same item to multiple categories, your category structure can even be a combination of both types. An example of this would be a larger multi-purpose category organization...
with subcategories that highlight spring fashions and accessories in addition to the more common categories of Men’s, Women’s, or Children’s, with each of these containing multiple subcategories.

Category organization can be simple with one level of categories and products assigned to those categories. More likely, the category organization and structure is sophisticated with multiple category levels that result in a well-organized, intuitive grouping of products. Consider the following sample category hierarchy for an apparel site.

**Note:** To manage Commerce Category records pages, you must have the appropriate permission.

This category structure contains 4 levels. The root level category is **Men**. This category is further organized by two levels of subcategories. Items are assigned to the lowest level subcategory. It is important to note that items do not have to be assigned to only the lowest level in the category hierarchy. You may have some levels that have both categories and items assigned to it.

**Note:** SuiteCommerce can support a total of 9,999 categories and subcategories combined. In this image, there are 7 total categories and subcategories. Additionally, SuiteCommerce can support a total of 10,000 items per category.

**Note:** Do not confuse Commerce Categories with Merchandise Hierarchy. Commerce Categories let you define the organization of items in your web store. Merchandise Hierarchy lets you efficiently group and manage products or inventory items across your enterprise. Merchandise Hierarchy can help you with planning, purchasing, and tracking your product inventory. For more information, see the help topic **Merchandise Hierarchy**.

### Category URLs

When you create a category you specify the URL fragment for that category. The URL fragment is used for accessing that category page. URL fragments for categories and subcategories are concatenated
together and prepended with the domain to form the full URL for a category page. For example the URL fragment for the category Camping is camping and the URL fragment for the category Camping Equipment is equipment. The Camping Equipment category is assigned as a subcategory of Camping. So the full URL becomes http://mysite.com/camping/equipment.

For a subcategory you have the option of specifying a URL fragment override which is substituted for that subcategory when it is accessed as a subcategory of that parent category. This enables you to use one URL fragment when the subcategory is accessed through one parent category and a different URL fragment when it is accessed through a different parent category. For more information on subcategories see Create Subcategories for a Commerce Category.

Categories in Site Management Tools

In addition to creating and managing categories in NetSuite, you can also manage categories in Site Management Tools. Any changes you make to categories in SMT are reflected in NetSuite. Any category management you perform in NetSuite is reflected in SMT. Category management in Site Management Tools is always in a published state on your site. See the help topic Commerce Categories in SMT for more information on managing categories in Site Management Tools.

Set Up NetSuite

Perform the following setup tasks to implement Commerce Categories:

Enable Commerce Categories Feature

To enable the Commerce Categories feature:

1. Go to Setup > Company > Enable Features.
2. Click the Web Presence subtab.
3. In the Web Site field group, select the Commerce Categories box.

Note: If you use Commerce Categories to implement Personalized Catalog Views on your website, you must remove all mappings between Commerce Categories and Customer Segments before you can disable the Commerce Categories feature. For more information about using Commerce Categories to implement Personalized Catalog Views, see Defining Item Segments.

Add Commerce Categories to Website Field Sets

The field sets for a website define the data that is exposed to the site templates. When you implement Commerce Categories on an existing SCA site, you must add Commerce Categories to the site's field sets. For more information on field sets, see Define Field Sets.

To add Commerce Categories to website field sets:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click the Edit link for the website to which you are adding the Commerce Categories field.
3. Click the Field Sets subtab.
4. Locate the Details field set and click the Fields Included in Field Set column. This is the last column in the row.

5. Click the Set button to the right of the field.

![Set button](image)

This opens the Field Set window which displays the assigned fields and lets you assign additional fields.

6. Click the Field Name dropdown list at the bottom of the field list and choose Commerce Categories.

![Field Name dropdown list](image)

7. Click the Add.

8. Click the Submit button. This closes the Field Set window.

9. Click the OK button on the search field set row.

10. Click the Save button.

---

**Add Commerce Categories to Website Search Index**

SuiteCommerce provides enhanced item search capabilities for SuiteCommerce sites. As part of implementing Commerce Categories for a site, you must add Commerce Categories to the facet fields search index. See Search Settings Overview for more information on search settings.

**To add Commerce Categories to the website search index:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Website.
2. Click the Edit link for the website to which you are adding the Commerce Categories field.
3. Click the Search Index subtab.
4. Click the Facet Fields subtab.
5. Click the Facet Field Name dropdown list in the last row, and choose Commerce Categories.

![Facet Field Name dropdown list](image)

6. Click the Add button.

7. Click the Sort Fields subtab.
8. Click the Field Name dropdown list in the last row and choose Commerce Categories.

![Field Name dropdown list](image)

9. Click the Add button.
10. Click the **Save** button.

**Set Image Resizing Options For Commerce Category Banners**

SCA lets you specify image resizing options for the images on your site. When implementing Commerce Categories you should set the image resizing option for the commerce category banner images. For more information on image resizing for SCA, see Setting Up Image Resizing.

**To set up image resizing options for Commerce Categories:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Website.
2. Click the **Edit** link for the website for which you need to set up image resizing.
3. Click the **Advanced** subtab.
4. Locate the **Image Resizing** group and make the following entries.

<table>
<thead>
<tr>
<th>Image Size ID</th>
<th>Description</th>
<th>Enabled</th>
<th>Maximum Width</th>
<th>Maximum Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>categorybanner</td>
<td>— Enter <strong>categorybanner</strong>.</td>
<td>— The description is optional.</td>
<td>— Check the box.</td>
<td>— Enter the maximum width and height to use for the category banner image. If you enter only the width or height, the remaining value is automatically calculated.</td>
</tr>
</tbody>
</table>

5. Click the **OK** button.
6. Click the **Save** button.

**Set Up Commerce Catalog**

The catalog is the highest level of grouping for Commerce Categories. Before you can create Commerce Categories you must first have a catalog to which you will assign the categories. Each website can have only one catalog.

**To create a Commerce Catalog:**

1. Go to Lists > Website > Commerce Catalogs > New.
2. From the **Site** dropdown list, select the website for this catalog. Remember, each website can have only one catalog.
3. In the **Name** field, enter a name for this catalog. The name does not appear on the website and is used to identify the catalog in NetSuite.
4. In the **Description** field, enter an expanded description for this catalog. The description is not displayed on the site and used only to provide additional information, such as the purpose, for the catalog in NetSuite.
5. Click the **Save** button.

**Set Up Commerce Categories**

Go to the Commerce Categories page to complete the setup tasks related to Commerce Categories.
Define Commerce Categories Basic Settings

Commerce categories are defined on the Commerce Categories page at Lists > Website > Commerce Categories. The basic settings for a commerce category are defined in the category header.

To add a Commerce Category:

1. Go to Lists > Web Site > Commerce Categories > New.
2. Enter the following information in the header:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Specify the name for the category. The name identifies the category in NetSuite and can be used publicly on the site in category navigation.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description for the category. The description lets you supply additional information about the category.</td>
</tr>
<tr>
<td><strong>Catalog</strong></td>
<td>Select the catalog for this category. Remember the catalog determines the website for which this category is available. Each website can have only one assigned catalog.</td>
</tr>
<tr>
<td><strong>Primary Parent</strong></td>
<td>If you are creating a subcategory, then select the primary parent category to which this subcategory should be assigned. The new category is assigned as a subcategory for the parent category specified here. All subcategory override values are blank, but you can change them on the <strong>Subcategory</strong> subtab for the parent category record. See Create Subcategories for a Commerce Category for more information. Leave this field empty if you do not want to assign a primary parent category. When a subcategory is assigned to multiple parent categories, you create a scenario where duplicate content can be accessed through multiple URLs. For SEO best practice, the primary parent flag is used to build the canonical link tag which tells webcrawlers that this is the preferred URL for accessing the content.</td>
</tr>
<tr>
<td><strong>Page Title</strong></td>
<td>Enter a title for the page. This value will populate the <code>&lt;title&gt;</code> element for an SCA category page. The value can also be used to populate the <code>&lt;title&gt;</code> element in a custom SSP application.</td>
</tr>
<tr>
<td><strong>Heading</strong></td>
<td>This field lets you specify a heading to display at the top of the categories page. The page template must be configured to display the Heading. You can also use this field to display a heading for the category in your custom SSP application.</td>
</tr>
<tr>
<td><strong>Sequence Number</strong></td>
<td>The sequence number you specify here determines the order of categories in the Site Management Tools category list. If you use the Move option in Site Management Tools to reorder the category list, the sequence number on the Commerce Category record is automatically updated to reflect the new order of the categories.</td>
</tr>
<tr>
<td><strong>URL Fragment</strong></td>
<td>The URL Fragment lets you specify the section of the URL that can be used to navigate to the category page. If the category is a subcategory, then it is prepended with the URL fragments from all categories in that branch of the hierarchy. Enter the URL with no slashes, for example. For a category of shoes, enter shoes. In turn, the shoes category may be assigned as a subcategory of the category mens. If the mens category has a URL fragment of mens, the full URL to the shoes category page is /mens/shoes. URLs are case sensitive so be consistent with the way you specify URL fragments. Best practice suggests always entering URLs as lower case. For more detail on category URLs see Category URLs.</td>
</tr>
<tr>
<td><strong>Page Banner</strong></td>
<td>The page banner field lets you specify an image file in the file cabinet that can be displayed as the banner on a category page on an SCA site. The page template file must be configured to display the banner image. You can also use this information to display the banner in your custom SSP application.</td>
</tr>
<tr>
<td><strong>Thumbnail Image</strong></td>
<td>The thumbnail image field lets you specify a file in the file cabinet to display as the thumbnail image for this category.</td>
</tr>
</tbody>
</table>
Addition to <head> The addition to head field lets you specify code such as HTML, CSS, or JavaScript to include between the <head></head> tags on this category page.

Meta Keywords This field lets you specify the meta keywords for the page.

Meta Description The description you enter here is an important SEO consideration. It is normally the description that is included on search results pages. See the help topic SEO and Meta Descriptions for best practice on writing meta descriptions.

Sitemap Priority The value you enter here populates the <priority></priority> element in an XML sitemap. Valid values for the priority are 0.0 to 1.0. If no priority is set in the sitemap then the default priority of 0.5 is used. These priorities let you rank the importance of the pages on your site as they relate to each other. Search results pages may consider this ranking when presenting multiple pages from your site and order the pages based on the priority.

Display in Web Site The Display in Web Site box lets you specify if a category should be available to visitors on your site. If the box is not selected, the category is not displayed on an SCA site.

Inactive Mark a category as inactive when you want to prevent it from displaying on the website and also prevent any other activity from occurring with that category. For example, when a category is inactive, it cannot be assigned as a subcategory of another category. You cannot mark a category as inactive if it has subcategories assigned to it.

Note: When a category as marked as inactive, it is omitted, by default, from the Commerce Categories list. To include inactive categories in the list, select the Show Inactives box on the categories list page.

Note: Required entries are marked with an *.

3. Add any subcategories. See Create Subcategories for a Commerce Category for more information.
4. Assign any items to the category. See Assign Items to a Commerce Category for more information.
5. Click the Save button to save the category.

Create Subcategories for a Commerce Category

Any category can be used as a subcategory, and you can assign the same category as a subcategory for multiple categories. You assign subcategories on the Subcategory subtab of the Commerce Category page at Lists > Website > Commerce Categories.

When you create a category you define basic information about that category such as name, title, and meta description. See Define Commerce Categories Basic Settings for more information.

When you assign a category as a subcategory, you can override the basic settings of the category with different values to use when the category is functioning as a subcategory. The overrides may be for all, some, or none of the category's primary values. For example, you have categories named Outdoors, Camping, and Equipment. You assign the Equipment category as a subcategory for both the Camping and Outdoors categories. For the Outdoors category assignment, you want to use a different banner image than you use for the equipment category assignment so you create an override for the banner image.

Note: When you assign a category as a subcategory, it is no longer accessible as a root level category and can be accessed only through its subcategory assignments.

Canonical Tags for Commerce Categories

When you use URL overrides for subcategories you create a situation where category pages with different URLs provide the exact same content. To promote SEO best practice for pages with duplicate content,
Commerce Categories

SCA adds the HTML canonical link tag to these pages. The page for the primary path URL contains a self canonical tag, and pages that override the URL have a canonical tag that targets the primary parent path as well. To continue with the example listed above, the canonical link tags might be as follows:

<table>
<thead>
<tr>
<th>Primary Parent URL</th>
<th>Subcategory URL With Override</th>
<th>Canonical Tag</th>
</tr>
</thead>
</table>

**Note:** The Vinson release of SuiteCommerce Advanced uses relative paths in canonical URLs. Since search engines do not index canonical URLs with relative paths, you should extend the Facets.Browse.View.js in the [Facets](#) module to use absolute paths instead. See the help topic [Canonical Tags Populated With Relative Paths](#). This is necessary only for the Vinson release of SuiteCommerce Advanced.

**Order of Subcategories**

The order of the subcategories on the [Subcategories](#) subtab, can reflect the order of how the categories will be listed on the site. You can use Site Management Tools to change the order of the categories. Any changes made to the order of the categories in Site Management Tools are also reflected on the [Subcategories](#) subtab. See the help topic [Move a Category or Subcategory](#) for more information. The order in which categories are displayed on the site can be specified in the SCA Categories Configuration, see the help topic [Categories Subtab](#) for more information on configuring Commerce Categories in SCA.

**To assign a subcategory to a category:**

Before you can assign a category as a subcategory, you must first create a category record for the category. See [Set Up Commerce Categories](#).

1. Create a new category record or edit an existing category record.
2. Select the [Subcategories](#) subtab.
3. Select the category to assign as a subcategory from the categories dropdown list. Enter override values for any of the following or leave the override fields empty to use the default from the category record for the subcategory.
   - Name Override
   - Description Override
   - URL Fragment Override
   - Title Override
   - Heading Override
   - Page Banner Override
   - Thumbnail Image Override
   - Addition to `<head>` Override
   - Meta Keywords Override
   - Meta Description Override
   - Sitemap Priority Override
   - Display in Web Site Override
4. Click the [Add](#) button to add the subcategory.
5. Repeat the previous two steps for each subcategory you want to add.
View Category URL's

The URL subtab of the Commerce Categories record provides you with a listing of all URLs that can be used to access a subcategory page. This is especially useful when you have a subcategory assigned to multiple parent categories, because the subcategory page can be accessed through multiple URLs. To see the URLs for a subcategory page:

1. Go to Lists > Website > Commerce Categories.
2. Click the category record for which you want to view URLs.
3. Click the URL subtab.

Assign Items to a Commerce Category

You assign items to a category on the Items subtab of the Commerce Categories page. Assigning items to a category makes those items accessible through that category on the website. An item can be assigned to multiple categories. Additionally you can assign items at various levels within the category hierarchy, For example, you may have a level in your hierarchy that includes both subcategories and items.

**Note:** When you assign items to a category and save the record, it may take up to 5 minutes or more for the items to be displayed in the SMT category preview and also in the category item list on the site. This delay is expected behavior and occurs because the search index is rebuilt when you add or change an item category assignment.

To assign an item to a category

1. Go to Lists > Website > Commerce Categories.
2. Click the category to display the category record.
3. Click the Edit button.
4. Click the Items subtab.
5. Select the item from the item dropdown list. The list only includes those items configured to display in the web store.
6. If this is the item’s primary category, select the Primary Category box. The primary category is used on the item detail page of SCA sites to provide a link for visitors to quickly access the primary category for an item.
7. Click the Add button to add the item to the list.
8. Repeat steps 5 through 7 for each item you want to assign to the category.
9. Click Save.

Commerce Category Customer Segment Assignment

Customer Segment Assignment for commerce categories enables you to assign a category to an existing customer segment. This lets you make a customer segment assignment directly from the commerce category record instead of using the customer segment manager. You can edit existing customer segment assignments, create new ones, or delete existing segment assignments.

To use customer segment assignment, Personalized Catalog Views must be enabled. For more information, see Enabling Personalized Catalog Views.

To assign a commerce category to a customer segment:

1. Go to Lists > Web Site > Commerce Categories.
2. Click **Edit** on the category record you want to update.
3. Click **Customer Segments**.
4. Click the **Customer Segments** dropdown list and choose one or more customer segments to associate with the category. Only previously defined customer segments are available.
5. Enter your translations in the fields on the line of the selected language.
6. Click **Add**.
7. Click **Save** to complete your edits to the commerce category record.

**Commerce Category Multi-Language Support**

Multi-language support for commerce categories enables you to add your own translations for multiple languages directly to the commerce category record. This lets you add, edit, or delete custom translations on the category record.

To use multi-language support,

**To enter translations to a commerce category:**

1. Go to Lists > Web Site > Commerce Categories.
2. Click **Edit** on the category record you want to update.
3. Go to System Information > Translations.
4. Click the **Locale** dropdown list and choose the desired language. Only languages you have previously selected for use are available to choose.
5. Enter your translations in the fields on the line of the selected language.
6. Click **Add**.
7. Click **Save** to complete your edits to the commerce category record.

**View Commerce Category Assignments for Items**

When you use Commerce Categories to organize items on your site, you can assign an item to multiple categories. This is an important feature, but it can make it challenging to remember every category you assigned an item to. Luckily, you don't have to remember all your category item assignments. There are two different methods you can use to see which categories an item is assigned to.

- **View Commerce Category Assignments on the Item Record**
- **View Commerce Category Assignments with a Custom or Saved Search**

**View Commerce Category Assignments on the Item Record**

You can see a list of all the categories an item is assigned to on the Item Record in your NetSuite account. Use this method when you are interested in seeing the category assignment for a single item.

**To view Commerce Category assignments:**

1. View the item record in NetSuite.
   
   ![Tip: You can use the Global Search field to quickly view or edit an item record. Enter i: [item name] in the global search field and click the item in the displayed results.]

2. Click the **Web Store** subtab.
3. Click the **Commerce Categories** subtab.

   The following information is listed for each Commerce Category the item is assigned to:
   - Site
   - Commerce Catalog
   - Commerce Category
   - Primary Category Assignment Yes/No
   - Inactive Category Yes/No
   - Category Start Date and Time
   - Category End Date and Time

**View Commerce Category Assignments with a Custom or Saved Search**

When you need to see a more detailed or extensive report of an item's category assignments you can create a custom view for the item list or create a custom or saved search of the item records commerce category related search criteria and available results to display include the following:

- Commerce Catalog
- Commerce Category
- Commerce Category End Date
- Commerce Category Is Inactive Yes/No
- Commerce Category is Primary Yes/No
- Commerce Category Name
- Commerce Category Start Date

You can use the following procedure to customize the view on the item record list to include the category. After you create a custom list view, you can quickly access it by selecting it from the **View** dropdown list.

**To create a custom item view for Commerce Category assignments:**

1. Go to Lists > Website > Items. This displays the item list.
2. Click **Customize View**.
3. In the **Search Title** field enter a name for this view.
4. Click **Remove All**. This clears all fields from the view.
5. Select **Commerce Category Name** from the **Field** dropdown list.
6. Click **Add**. This adds the first row to the table.
7. Select **Name** from the **Field** dropdown list.
8. Click **Add**.
9. Select **Display Name** from the **Fields** dropdown list.
10. Click the **Add** button.
11. Select the **Available Filters** subtab.
12. Click the **Remove All** button.
13. Select **Commerce Categories** from the **Fields** dropdown list.
14. Click **Add**.
15. Click **Save**.
You can include additional criteria and results fields to this custom view to enhance it for your specific needs.

**To create a saved search for item Commerce Category assignments:**

1. Go to Lists > Website > Items.
2. Click **Search**.
3. Click **Create Saved Search**.
4. Click **Remove All**. This clears all fields from the view.
5. Select **Commerce Category Name** from the **Field** dropdown list.
6. Click **Add**. This adds the first row to the table.
7. Select **Name** from the **Field** dropdown list.
8. Click **Add**.
9. Select **Display Name** from the **Fields** dropdown list.
10. Click the **Add** button.
11. Select the **Available Filters** subtab.
12. Click the **Remove All** button.
13. Select **Commerce Categories** from the **Fields** dropdown list.
14. Click **Add**.
15. Click **Save**.

---

**Exclude Empty Commerce Categories**

This information refers to SuiteCommerce or the 19.2 release of SuiteCommerce Advanced or later.

The Exclude Empty Commerce Categories feature lets you omit empty categories from your site when the category branch contains no visible items. This ensures that empty categories are not displayed on the site. An empty category is a category that has no available items and has no subcategories with available items. Item availability has many determining factors. See **Item Availability** for more information.

The option to exclude empty categories has a couple of important benefits:

- When you have a complex category structure with rotating or inconsistent item availability, category navigation is adjusted automatically based on the availability of items. This saves time by dynamically updating displayed categories and category navigation structure and by eliminating the need for manual category management to reflect item availability.

- If you are using Personalized Catalog Views, then the Commerce Category navigation structure is constructed based on logged-in user and the items available to that customer’s segment assignment. When a customer is not permitted to buy items assigned to categories, the categories are omitted from the site. See **Personalized Catalog Views**.

Here are three different examples of how category navigation is adjusted based on item availability.

---

**Example 1: No Items Assigned to Category**

You have a **Closeouts** category with subcategories of **Men's Apparel**, **Women's Apparel**, **Children's Apparel**, and **Accessories**. You have assigned items to the three apparel categories but you have not assigned items to the **Accessories** category. Consequently, the category navigation on the site appears as follows:
In this example, Accessories is omitted from the category navigation because it is an empty category with no items assigned to it.

Example 2: Out of Stock Behavior

You have a Closeouts category with subcategories of Men's Apparel, Women's Apparel, Children's Apparel, and Accessories. Sales depleted your inventory of all items assigned to the Children's Apparel Category. Because of the nature of your out of stock behavior, items with no stock are not listed on the site. Consequently, no items are available in the Children's Apparel category and the resulting category navigation looks like this:

The Children's Apparel category is omitted from the category navigation because it contains no available items.

Example 3: Category Structure with PCV

You have implemented Personalized Catalog Views, and you have a VIP Items item segment that has items from your Children's Apparel and Accessories categories assigned to it. ABC Wholesaler is assigned to a customer group that can purchase items from VIP Items. Consequently, when the customer logs in to the site, the category navigation for the Closeouts category reflects this structure:

In this example Men's Apparel and Women's Apparel are omitted from the category navigation, because the ABC Wholesaler's customer segment assignment prevents it from purchasing anything from those categories.

To exclude empty categories:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the Website from the dropdown list.
3. Select the Domain from the dropdown list.
4. Click Configure.
5. Click the Integrations subtab.
6. Click the Categories subtab.
7. Check the Exclude Empty Categories box.
8. Click Save.

Configure Commerce Categories Properties

To configure Commerce Categories, use the SuiteCommerce Configuration record. See the help topic Categories Subtab for details.

To configure properties for Commerce Categories:

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the Integrations tab and the Categories subtab.
3. Set feature properties as required.
4. Save the Configuration record.
Item Page Options

Applies to: Commerce Web Stores

This section includes information on elements featured on the Product Details Pages and Product Listings Pages of your web store.

Grid Order

The Grid Order extension lets you set up matrix items to display purchasing options in a table on the Product Details page (PDP).

When you activate this extension, you configure items to use Grid Order. These items display purchasing options in a tabular format in place of the standard experience. This view is ideal for customers who require buying several variations of an item.

For example, a user can add the following items to their cart at one time:

- 10 small red gloves
- 10 medium black gloves
- 15 large white gloves

You can set up Grid Order for any matrix items with one or two item options. If enabled and set up correctly, users can quickly add quantities for multiple buying options in an easy-to-use table.

This topic explains how to do the following:

- Add Field Sets
- Configure Grid Order

<table>
<thead>
<tr>
<th>Gloves</th>
<th>No Reviews yet.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Grid</td>
<td></td>
</tr>
<tr>
<td>Small</td>
<td>10</td>
</tr>
<tr>
<td>Quantity pricing</td>
<td>$14.00</td>
</tr>
<tr>
<td>Stock 6</td>
<td></td>
</tr>
<tr>
<td>Medium</td>
<td>N/A N/A</td>
</tr>
<tr>
<td>Quantity pricing</td>
<td>$14.00</td>
</tr>
<tr>
<td>Stock 56</td>
<td></td>
</tr>
<tr>
<td>Large</td>
<td>15</td>
</tr>
<tr>
<td>Quantity pricing</td>
<td>$14.00</td>
</tr>
<tr>
<td>Summary</td>
<td>10 15 10 0 0</td>
</tr>
</tbody>
</table>

Subtotal $4,900.00
Add 25 items to Cart
Set Up Matrix Items for Grid Order

Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

Limitations

Be aware of the following limitations when using the Grid Order extension:

- If a matrix item includes three or more item options, the grid does not appear on your site. Using the Grid Order feature, limit item options for matrix items to one or two.
- Grid Order does not display items whose parent matrix item includes a mandatory item option.

See the help topic Matrix Items for details on how to create item records using an item matrix.

Add Field Sets

The field sets for a website determine the data that is exposed to site templates. To employ the Grid Order feature, you must add several fields to the site’s details field sets. For more information on field sets, see Define Field Sets.

To add Grid Order fields to the Web Site Setup Record:
1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to the website to which you are adding Grid Order.
3. Navigate to the Field Sets subtab.
4. Add the Grid Order Behavior, Show Stock Quantities, and Activate Stock Notifications fields to the details field set. For each field, perform the following steps:
   a. Locate the Fields Included in Field Set column of the details field set and click the Set button.
   b. Select the fields from the Field Name list and click Add.
   c. In the Field Set window, click Submit.
   d. In the Field Set row, click OK.
5. After adding all of the fields to the field set, click Save.

Configure Grid Order

You enable the Grid Order extension for a domain using the SuiteCommerce Configuration record. This makes the Grid Order feature available for all matrix items. However, you need to individually set up each item for which you want to include Grid Order.

To configure Grid Order:
1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where the Grid Order extension is activated and click Configure.
3. Navigate to the Extensions tab.
4. In the **Grid Order** subtab, fill out the listed fields for each category, using the tables below as references.

5. Click **Save**.

### Grid Order Configuration Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate for All Matrix Items</td>
<td>Turns on Grid Order for all matrix items that have the <strong>Grid Order Behavior</strong> field on the Item Configuration record set to <strong>Default Site Behavior</strong>. For more information, see Set Up Matrix Items for Grid Order.</td>
</tr>
<tr>
<td>Activate for Mobile</td>
<td>Turns on Grid Order for mobile sites.</td>
</tr>
</tbody>
</table>

### Grid Order Options Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Grid Title</td>
<td>Sets the title for the order grid.</td>
</tr>
<tr>
<td>Quantity Pricing Label — Order Grid</td>
<td>Determines the label for the Quantity Pricing link in the order grid. For more information on using Grid Order in conjunction with Quantity Pricing, see Integration with Other SuiteCommerce Features.</td>
</tr>
<tr>
<td>Quantity Summary Level — Order Grid</td>
<td>Sets the label for the Quantity Summary row, which gives the total number of items selected.</td>
</tr>
<tr>
<td>Subtotal Price Label — Order Grid</td>
<td>Sets the label for the Subtotal Price row, which gives the subtotal amount owed.</td>
</tr>
<tr>
<td>Combination Not Available — Order Grid</td>
<td>Determines the text to display when an item is not available.</td>
</tr>
<tr>
<td>Inventory Label — Order Grid</td>
<td>Sets the label for current inventory quantity. The placeholder <code>[[units]]</code> is replaced by the currently available quantity automatically.</td>
</tr>
<tr>
<td>Stock Notifications Label — Order Grid</td>
<td>Determines the label for the Stock Notifications link in the order grid. For more information on using Grid Order in conjunction with Stock Notifications, see Integration with Other SuiteCommerce Features.</td>
</tr>
<tr>
<td>Add to Cart Button Label — Order Grid</td>
<td>Sets the label for the <strong>Add to Cart</strong> button. The placeholder <code>[[items]]</code> is replaced by the number of items to be added to the cart automatically.</td>
</tr>
<tr>
<td>Quantity Warning Message - Order Grid</td>
<td>Determines the message to display when there is an error with the quantity requested.</td>
</tr>
<tr>
<td>Minimum Quantity Hint - Order Grid</td>
<td>Determines the message to display for a highlighted field when the required minimum quantity is not met. The placeholder <code>[[min]]</code> is replaced by the minimum quantity for that item automatically.</td>
</tr>
<tr>
<td>Maximum Quantity Hint - Order Grid</td>
<td>Determines the message to display for a highlighted field when the maximum quantity limit is exceeded. The placeholder <code>[[max]]</code> is replaced by the maximum quantity for that item automatically.</td>
</tr>
</tbody>
</table>
### Grid Order Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirmation Text</td>
<td>Determines the confirmation message that appears after items have been added to the cart. The placeholder ([\text{items}]) is replaced by the number of items added to the cart automatically.</td>
</tr>
<tr>
<td>View Cart Button Label</td>
<td>Sets the label for the View Cart &amp; Checkout button that appears with the confirmation text.</td>
</tr>
<tr>
<td>Continue Shopping Button Label</td>
<td>Sets the label for the Continue Shopping button that appears with the confirmation text.</td>
</tr>
<tr>
<td>Grid Order Table Combinations</td>
<td>Determines how the matrix item options combination appears in the order grid.</td>
</tr>
<tr>
<td></td>
<td>To display two matrix item options, list one option as the Order Grid Row field and the other as the Order Grid Column field.</td>
</tr>
<tr>
<td></td>
<td>If you list a matrix item options pair twice using both row/column alignments, the combination listed first takes precedence.</td>
</tr>
<tr>
<td></td>
<td>To display items with only one matrix item option, list the matrix item option in either the Order Grid Row field or the Order Grid Column field depending on whether you would like this field to display in rows or columns.</td>
</tr>
<tr>
<td>Item Color Palette Mapping</td>
<td>Determines which color palette to use with a custom field involving color swatches. In the Item Field ID column, enter the custom field ID for the field involving item color.</td>
</tr>
<tr>
<td></td>
<td>In the Palette ID column, enter the ID for the color palette you want to use to display item colors. If you have not set up additional color palettes, enter default as the Palette ID.</td>
</tr>
<tr>
<td></td>
<td>To view or create additional color palettes, see the help topic Color Palettes Subtab.</td>
</tr>
</tbody>
</table>

### Set Up Matrix Items for Grid Order

After enabling Grid Order for your domain, you can set up matrix items to display options as a grid. Grid Order is available to matrix items with one or two matrix item options. A shirt with size and color options is a good example of an item that can use Grid Order.

**To set up a matrix item to display item options as a grid:**

1. In NetSuite, access the matrix item to which you want Grid Order to apply. Search NetSuite for the matrix item or go to Lists > Accounting > Items.

   ![](important.png) **Important:** Set Grid Order for the Matrix Item record (parent), not the Matrix Subitem.

2. Click Edit next to the matrix item record you want to edit.
4. In the Grid Order area:
   a. Set the Grid Order Behavior field to determine how the item displays information in the PDP.
      
      Select from the following options:
      - **Default Site Behavior** – Choose this option to turn Grid Order on or off for as many matrix items as you want at one time, using the Activate for All Matrix Items field on
the SC Configuration record. If **Activate for All Matrix Items** is checked, an order grid displays for items with **Default Site Behavior** selected.

For more information, see Configure Grid Order.

- **Always Activate for This Item** – Choose this option to display the matrix dimensions of this item as a grid, ignoring the default website configuration.
- **Deactivate for This Item** – Choose this option to deactivate the purchasing grid for this item, ignoring the default website configuration.

b. Check the **Show Stock Quantities** option to display the in-stock quantity in the grid. Clear this option to hide quantities in stock.

For items that are out of stock, this option follows the Out of Stock Behavior set on the Item record. For more information, see the help topic Setting Web Store Backorder and Out-of-Stock Preferences.

c. Check the **Activate Stock Notifications** option to display a **Notify Me** link in the order grid when an item is out of stock and not available on backorder.

**Note:** SC Stock Notifications extension must be installed and activated on the same domain to be used in conjunction with this extension.

5. Click **Save**.

Integration with Other SuiteCommerce Features

This extension integrates with the following SuiteCommerce features:

- **Quantity Pricing** – If Quantity Pricing is enabled, any option in the grid that includes quantity pricing options displays an expandable price chart. See Quantity Pricing for details.
- **Stock Notifications** – If your domain employs the Stock Notifications extension, each tabulated item includes an option to sign up for a stock notification email. See Stock Notifications for details.
- **Require Login for Pricing** - If you have enabled **Require Login for Pricing** and the user is not logged in when viewing the PDP, the Grid Order extension does not appear. Instead, a message displays asking users to log in to see the price. Clearing the **Require Login for Pricing** box on the Web Site Configuration record allows users to use the Grid Order extension without being logged in. For more information, see the help topic Shopping Basics.

Size Charts

The Size Chart extension lets you add size charts to your web store, allowing shoppers to view sizing options without having to leave the Product Details page (PDP). In addition to a pop-up feature on the PDP, Size Chart also creates a specific landing page where shoppers can view several size charts.

Using this extension, you can provide information on sizes in the shopper’s preferred unit of measurement and offer tips on measurements and fit.

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

This topic explains how to:

- **Update the Field Sets**
Assign a Size Chart to an Item
Customize the Size Charts

Size Chart Page

The Size Chart extension creates a size chart landing page with all the size charts for your website at domain.com/size-charts.

You can access the individual size charts by using the size chart record internal ID and the size chart name in the URL. Any spaces in the size chart name are replaced by underscores. For example, to display a size chart named Women's Tops, the URL is domain.com/size-charts/1-Womens_Tops.

Update the Field Sets

The field sets for a website determine the data that is exposed to site templates. To employ the Size Chart feature, you must add the Size Chart (Custom) and Size Chart ID (Custom) fields to the site's field sets.

For more information on field sets, see Define Field Sets.

To add Size Chart fields to the Web Site Setup Record:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to the website to which you are adding Size Charts.
3. Navigate to the Field Sets subtab.
4. Add the Size Chart (Custom) and Size Chart ID (Custom) fields to the details and matrixchilditems field sets. To add each field to each field set, perform the following steps:
   a. Locate the Fields Included in Field Set column and click the Set button.
   b. Select the fields from the Field Name list and click Add.
   c. In the Field Set window, click Submit.
   d. In the Field Set row, click OK.
5. After adding all of the fields to the field sets, click Save.

Assign a Size Chart to an Item

You must determine the size chart to display when shoppers click the size chart link on the PDP. The size chart link only appears if you select a size chart on the Item record.

You can update item records individually or use Mass Update to add Size Charts to entire commerce categories. For more information on using the Mass Update functionality, see the help topic Mass Changes or Updates.

To assign a size chart to the item:

1. In NetSuite, go to Lists > Accounting > Items.
2. Click Edit next to the item to which you want to add a size chart.
4. In the Size Chart field, select the size chart you want to assign to the item.

   Note: You can only assign one size chart to an item.

5. Click Save.
If the item is a Matrix Item, click Update Matrix.
If not, click Save.

Customize the Size Charts

The Size Chart extension includes 19 default size charts that you can use in your web store. These size charts include standard measurements in imperial and metric units for women's, men's, kid's, and baby's apparel. You can use the existing size charts or create new size chart records.

To add a new size chart:

1. Go to Lists > Web Site > Size Charts > New.

   **Note:** If you make changes to the default size charts, you overwrite the existing values. If you want to create a new chart using another size chart as a template, view the chart and use the Make Copy action.

2. Set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive</td>
<td>If checked, makes the size chart inactive.</td>
</tr>
<tr>
<td>Name</td>
<td>Sets the name for the size chart. This name appears in the Size Chart field of the Item record.</td>
</tr>
<tr>
<td>Title</td>
<td>Sets the title to display at the top of the size chart on your site.</td>
</tr>
<tr>
<td>Description</td>
<td>Determines additional details to display with the size chart on your site, such as fit of the clothing and tips on taking measurements.</td>
</tr>
<tr>
<td>Chart</td>
<td>Determines the size chart to display. You can use the basic formatting tools in Formatted Text editing mode or enter HTML tags using the Source editing mode.</td>
</tr>
</tbody>
</table>

3. Click Save.

Item Badges

The Item Badges extension lets you display promotional badges on a product. Item Badges appear on the Product Details and Product Listings pages, as well as in image carousels. You can use these to promote certain products to users by choosing the label, shape, and size of the badge.
Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

This topic explains how to:

1. Set Up the Extension
2. Enable Item Badges for an Item
3. Configure Properties
4. Create or Edit an Item Badge
5. Create or Edit a Badge Shape
6. Add Facet Fields

Set Up the Extension

In order to set up the extension, you must add fields to your site's field sets. The field sets for a website determine the data that is exposed to site templates. To employ the Item Badges feature, you must add the Badges (Custom) and Show Item Badges (Custom) fields to the site's field sets. For more information on field sets, see Define Field Sets.

To add Item Badges fields to the Web Site Setup Record:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to the website to which you are adding Item Badges.
3. Navigate to the Field Sets subtab.
4. Add the Badges (Custom) and Show Item Badges (Custom) fields to the details, search, related items, and correlated items field sets. To add each field to each field set, perform the following steps:
   a. Locate the Fields Included in Field Set column and click the Set button.
   b. Select the fields from the Field Name list and click Add.
   c. In the Field Set window, click Submit.
   d. In the Field Set row, click OK.
5. After adding the fields to all of the field sets, click Save.

Enable Item Badges for an Item

For Item Badges to display on your products, you must enable the badges at the item level. You can update item records individually or use Mass Update to update badges for a whole category of items. Mass Updates related to Item Badges can be found in NetSuite in Lists > Mass Update > Mass Updates > General Updates > Custom Records > Item Badges and Shapes. For more information on using the Mass Update functionality, see the help topic Mass Changes or Updates.

To enable Item Badges for an item:

1. In NetSuite, go to Lists > Accounting > Items.
2. Click **Edit** next to the item for which you want to add an item badge.
3. Navigate to the **SuiteCommerce Extensions** tab and the **Item Badges and Shapes** subtab.
4. Check the **Show Item Badges** box.
5. In the **Badges to Display** field, select the badges you want to add to this item.
   You can select a maximum of three badges to display for each item.
6. Click **Save**.

**Configure Properties**

To determine how Item Badges display on your website, configure the properties on the SuiteCommerce Configuration record. You can choose where to display the badge on the product image.

**To configure properties:**

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where the Item Badges extension is activated and click **Configure**.
3. Navigate to the **Extensions** tab and the **Item Badges** subtab.
4. In the **Badge Position** field, select where to position the badge on the product image.
5. Click **Save**.

**Create or Edit an Item Badge**

You can customize the badge text, color and shape by editing an existing item badge or creating a new one. To edit or create an item badge, you will make changes to the Item Badges and Shapes record.

**To create or edit an item badge:**

1. In NetSuite, go to Customization > List, Records, & Fields > Record Types > Item Badges and Shapes.
   The Item Badges and Shapes record can also be found in Lists > Web Site > Item Badges and Shapes.
   The Item Badges and Shapes record is created when you install the extension.
2. Click **List**.
3. Click **Edit** next to the badge you want to edit, or click **New** to create a new record.
4. Set the following general fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge Name</td>
<td>This sets the name for the badge to display at the Item level.</td>
</tr>
<tr>
<td></td>
<td>This name displays in the <strong>Badges to Display</strong> field of the Item record.</td>
</tr>
<tr>
<td>Badge Text</td>
<td>This sets the text to display on the badge.</td>
</tr>
<tr>
<td></td>
<td>Basic HTML formatting tags are supported.</td>
</tr>
<tr>
<td>Alt Text</td>
<td>This sets the description for the badge.</td>
</tr>
</tbody>
</table>
5. In the **Style** subtab, set the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Color</td>
<td>This sets the color of the badge text.</td>
</tr>
<tr>
<td>Background Color</td>
<td>This sets the background color of the badge or fill color of SVG images. This field supports text, HEX, or RGB.</td>
</tr>
<tr>
<td>Shape</td>
<td>This sets the shape of the badge from a list of pre-defined shapes. You can choose a default badge or upload a new image. If the Shape field is set to Bookmark, the Badge Text will display next to the badge instead of on the badge. To customize badge shape options, see Create or Edit a Badge Shape.</td>
</tr>
<tr>
<td>Text Weight</td>
<td>This sets the weight of the badge text. The text display depends on your web store’s theme.</td>
</tr>
<tr>
<td>Inactive</td>
<td>This determines if the item badge is inactive. An inactive badge does not render on your web store but can be made active again at any time.</td>
</tr>
</tbody>
</table>

6. Click **Save**.
   - If the item is a Matrix Item, click **Update Matrix**.
   - If not, click **Save**.

Create or Edit a Badge Shape

To add or change the options available in the Shape field of the Item Badges and Shapes record, you must edit the Item Badge Shape record. You can customize item badge shapes by choosing the name and shape or image to use. You select a shape from the options found in the Item Badge Shapes list.

**To create or edit a badge shape:**

1. In NetSuite, go to Customization > List, Records, & Fields > Record Types > Item Badge Shapes. The Item Badge Shapes record is created when you install the extension.
2. Click **List**.
3. Click **Edit** next to the badge shape you want to edit, or click **New** to create a new record.
4. Set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This sets the name for the shape that appears in the Shape field of the Item Badges and Shapes record.</td>
</tr>
<tr>
<td>Shape</td>
<td>This sets the badge shape from a list of pre-defined options. If the Shape field is set to Bookmark, the Badge Text will display next to the badge instead of on the badge.</td>
</tr>
<tr>
<td>Image</td>
<td>This allows you to select an image from the file cabinet or upload an image to serve as a badge shape. If you select or upload an image, but select a shape in the Shape field, the chosen shape overrides the image selection.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
Add Facet Fields

Item badges can be configured as facets, so users can search the web store for products with badges.

To use faceted navigation with item badges:

- Select facet fields on the Web Site Setup record.
- Configure facet fields on the SuiteCommerce Configuration record.

Follow the instructions for setting up facets in Select and Configure Facet Fields, using these guidelines:

- When selecting facets in the Web Site Setup record, add the Badges (Custom) facet field.
- When configuring facets in the SuiteCommerce Configuration record, add the custitem_ns_ib_badges facet field.
  
  This internal ID corresponds to the Badges (Custom) facet field listed on the Web Site Setup record.

After setting up this extension, you can display item badges on both the Product Listings and Product Details pages. You can customize the badges to highlight different types of products in a way that fits in with your web store, and users can conduct faceted navigation using the badges.

Inventory Display

The Inventory Display extension lets you show stock status and available quantity on an item's Product Details page (PDP). You can customize the behavior for different types of inventory, such as special order or drop ship items. You can also create an additional message to display when an item is low on inventory.

This extension displays different notifications, depending on how you set up your web store. For more information on what determines inventory visibility with different types of items, see Item Inventory.

![Fallon Shirt](image)

Fallon Shirt

**No Rollovers yet**

**SIZE**

- X-Small
- Small
- Medium
- Large
- X-Large

SKU: OM0236

$38.99

- **This Item is In Stock:**
  
  Current Stocks: 100

**QUANTITY**

1:1

**Add to Cart**

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

To enable Inventory Display for a product, perform the following steps:
1. Configure Properties
2. Add Field Sets

Configure Properties

You can determine how Inventory Display appears on your website by configuring properties at the extension level and item level. Configuring properties at the extension level determines the settings for all items, but you can override these settings for specific items by configuring properties at the item level.

You can choose different status messages to display for regular, special order, and drop ship items, and create messages for when an item is low in inventory. You can also turn off Inventory Display messages for some or all items.

You can update item records individually or use Mass Update to configure Inventory Display for entire commerce categories. For more information on using the Mass Update functionality, see the help topic Mass Changes or Updates.

To configure properties at the extension level:

1. After activating the Inventory Display extension in a NetSuite account, go to Setup > SuiteCommerce Advanced > Configuration.
   
   For more information on activating an extension, see Manage Themes and Extensions.
2. Select the website and domain where the Inventory Display extension is activated and click Configure.
3. Navigate to the Extensions tab.
4. In the Inventory Display subtab, fill out the listed fields for each category, using the tables below as references.
5. Click Save.

Regular Items:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Stock Message - Regular Items</td>
<td>Sets the message to display for a regular item that is in stock.</td>
</tr>
</tbody>
</table>
| Back Order Message - Regular Items | Sets the message to display for a regular item that is available on back order.  
   To avoid conflicting inventory display messages, set the Out of Stock Behavior to Allow back orders with no out-of-stock message. For more information on how to do this, see the help topic Setting Web Store Backorder and Out-of-Stock Preferences. |
| Quantity Available - Regular Items | Sets the message to display the quantity available for a regular item.          
   The placeholder [quantity] is automatically replaced by the currently available quantity. |

Special Order Items:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Stock Message - Special Order Items</td>
<td>Sets the message to display for a special order item that is in stock.</td>
</tr>
<tr>
<td>Back Order Message - Special Order Items</td>
<td>Sets the message to display for a special order item that is available on back order.</td>
</tr>
</tbody>
</table>

SuiteCommerce Store Front

ORACLE NETSUITE
### Inventory Display

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always in Stock Message - Special Order Items</td>
<td>Sets the message to display when special order items are set to <strong>Always in Stock</strong>.</td>
</tr>
</tbody>
</table>

### Drop Ship Items:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Stock Message - Drop Ship Items</td>
<td>Sets the message to display for a drop ship item that is in stock.</td>
</tr>
<tr>
<td>Back Order Message - Drop Ship Items</td>
<td>Sets the message to display for a drop ship item that is available on back order.</td>
</tr>
<tr>
<td>Always in Stock Message - Drop Ship Items</td>
<td>Sets the message to display when drop ship items are set to <strong>Always in Stock</strong>.</td>
</tr>
</tbody>
</table>

### Low Stock Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Stock Threshold</td>
<td>Sets the stock amount that determines when to display a low stock message for regular items. If set to 0, low stock messages do not display.</td>
</tr>
<tr>
<td>Low Stock Message</td>
<td>Determines the message to display when a regular item has met the low stock threshold.</td>
</tr>
<tr>
<td>Hide Quantity Available for Low Stock</td>
<td>If checked, hides the quantity available for a regular item that has met the low stock threshold.</td>
</tr>
</tbody>
</table>

### To configure properties at the item level:

**Note:** Configuring fields on the item level overrides the corresponding fields on the SC Configuration record listed above.

1. In NetSuite, go to Lists > Accounting > Items.
2. Click **Edit** next to the item for which you want to configure Inventory Display.
3. Navigate to the **SuiteCommerce Extensions** tab and the **Inventory Display** subtab.
4. Fill out the listed fields for each category, using the table below as a reference.
5. Click **Save**.
   - If the item is a Matrix Item, click **Update Matrix**.
   - If not, click **Save**.

### Inventory Display Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Stock Message</td>
<td>Sets the message to display when the item is in stock.</td>
</tr>
<tr>
<td>Back Order Message</td>
<td>Sets the message to display when the item is not in stock but available on back order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Quantity Available Message</strong></td>
<td>Sets the message to display the quantity available. The placeholder [quantity] is automatically replaced by the currently available quantity. This number updates dynamically for matrix and child items.</td>
</tr>
<tr>
<td><strong>Low Stock Message</strong></td>
<td>Sets the message to display when a regular item has met the low stock threshold.</td>
</tr>
<tr>
<td><strong>Low Stock Threshold</strong></td>
<td>Sets the stock amount that determines when to display a low stock message for regular items. If set to 0, low stock messages do not display.</td>
</tr>
<tr>
<td><strong>Hide Quantity Available</strong></td>
<td>If checked, hides the quantity available for this item.</td>
</tr>
<tr>
<td><strong>Hide Quantity Available for Low Stock</strong></td>
<td>If checked, hides the quantity available for a regular item that has met the low stock threshold.</td>
</tr>
<tr>
<td><strong>Hide Inventory Messages</strong></td>
<td>If checked, hides the quantity and inventory messages for this item.</td>
</tr>
</tbody>
</table>

### Add Field Sets

The field sets for a website determine the data that is exposed to site templates. To employ the Inventory Display feature, you must add the **Drop Ship Item** and **Special Order Item** fields to the site's field sets. For more information on field sets, see **Define Field Sets**.

**To add fields to the Web Site Setup Record:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click **Edit** next to the website to which you are adding Inventory Display.
3. Navigate to the **Field Sets** subtab.
4. Add the **Drop Ship Item** and **Special Order Item** fields to both the **details** and **matrixchilditems** field sets. For each field set, perform the following steps:
   a. Locate the **Fields Included in Field Set** column and click the Set button.
   b. Select **Drop Ship Item** from the **Field Name** list and click **Add**.
   c. Select **Special Order Item** from the **Field Name** list and click **Add**.
   d. In the Field Set window, click **Submit**.
   e. In the Field Set row, click **OK**.
5. After adding the fields to both field sets, click **Save**.

Once setup is complete, you can display stock status and inventory quantity on product detail pages.

### Stock Notifications

The Stock Notifications extension lets users sign up for an email notification alerting them when an out-of-stock item again becomes available. If enabled, users see a stock notification option on the Product Details and Product Listings pages. Logged in users can visit the Stock Notifications tab of their My
Account page to view details of the items to which they are subscribed, the notification statuses, and the option to cancel a notification.

![Peat Beanie](image)

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see [Commerce Extensions](#).

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

This topic explains how to:

- Set Up the Stock Notifications Email Template
- Configure Properties
- View Saved Searches for Stock Notifications

**Before You Begin**

To take advantage of the Stock Notifications extension, you must set the **Out of Stock Behavior** field to a setting that fits your needs for this extension. You can choose this setting for each item, so Stock Notifications does not have to behave the same for each item. You can find the **Out of Stock Behavior** field on the **Web Store** tab of the Item record.

Refer to the table below for the **Out of Stock Behavior** field options and the resulting Stock Notifications behaviors.

<table>
<thead>
<tr>
<th>Out of Stock Behavior</th>
<th>Does Stock Notifications Appear on the PDP?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>No</td>
</tr>
<tr>
<td>Disallow back orders but display out-of-stock message</td>
<td>Yes</td>
</tr>
<tr>
<td>Allow back orders but display out-of-stock message</td>
<td>Yes</td>
</tr>
<tr>
<td>Remove item when out-of-stock</td>
<td>No</td>
</tr>
</tbody>
</table>

The item is removed from the web store.
<table>
<thead>
<tr>
<th>Out of Stock Behavior</th>
<th>Does Stock Notifications Appear on the PDP?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow back orders with no out-of-stock message</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>If you switch to this option after previously using an option in which Stock Notifications appears on the PDP, an email is sent to subscribers notifying them that the item is ready to order.</td>
</tr>
</tbody>
</table>

For more information on out of stock behavior, see Item Inventory.

Set Up the Stock Notifications Email Template

After installing the Stock Notifications bundle, create the email template used to notify users that their item is back in stock. You must create an email template in order for the extension to work. To set up the notification email, create a new email template in NetSuite using a file included in the Stock Notifications bundle. For more information on modifying an email template, see the help topic Customizing Templates for System-Automated Email.

**Note:** For advanced users experienced in HTML and FreeMarker, you can use the variables defined in the header of the included file to further customize the email template as you wish. For more information on modifying a template with FreeMarker, see the help topic Scriptable Templates.

**To set up the email template:**

1. In NetSuite, go to File Cabinet > SuiteBundles > [BUNDLE ID] > com.netsuite.backinstocknotification100 > Email Templates.
   
   In the path above, [BUNDLE ID] equals the Stock Notifications bundle ID. For the bundle ID, see Commerce Extensions.
2. Click Download next to the `stock_notifications_email.template.ftl` file.
3. Use this file to create a new email template:
   a. In NetSuite, go to Documents > Templates > Email Templates > New.
   b. In the Name field, give your new template a name.
      This name displays as an option in the Email Template field of the SC Configuration Record, which you select to configure the extension's email template.
   c. In the Record Type field, select Custom Record.
   d. In the Template tab, perform the following steps:
      i. In the Subject field, enter a message to display as the subject of the stock notification email.
         For example:
         
         ```
         ${customRecord.custrecord_ns_sc_ext_sn_s_item?split(":")?last} is back in stock!
         ```
         If you are experienced with HTML and FreeMarker, you can adjust this subject to meet your needs.
      ii. In the Create Template From: field, select File.
      iii. Click the New icon to add a file.
      iv. In the Select File field, choose the `stock_notifications_email.template.ftl` file downloaded from the File Cabinet.
      v. Click Save.
Configure Properties

To determine how Stock Notifications displays on your website, configure the properties on the SuiteCommerce Configuration record. You can choose section titles, placeholder texts, feedback messages, and more.

To configure properties:

1. After activating the Stock Notifications extension in a NetSuite Account, go to Setup > SuiteCommerce Advanced > Configuration. For more information on activating an extension, see Manage Themes and Extensions.
2. Select the website and domain where the Stock Notifications extension is activated and click Configure.
3. Navigate to the Extensions tab.
4. In the Stock Notifications subtab, fill out the listed fields for each category, using the tables below as references.
5. Click Save.

**General Fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section Title - Items</td>
<td>Sets the title for the Stock Notifications option to display on the Product Details page (PDP).</td>
</tr>
<tr>
<td>Section Text - Items</td>
<td>Determines the description for the Stock Notifications section.</td>
</tr>
<tr>
<td>Subscribe to Matrix Options - Items</td>
<td>If checked, displays the option for users to subscribe to Stock Notifications for each variation of a matrix item.</td>
</tr>
<tr>
<td>Subscribe to Matrix Options Label - Items</td>
<td>Sets the label for the Subscribe To Matrix Options - Items box on the PDP.</td>
</tr>
<tr>
<td>Product List Link - Items</td>
<td>Sets the label for the Stock Notifications option to display on the Product Listings Page (PLP). This link appears with the product on the PLP and leads to the quick view window with a Stock Notification subscription option.</td>
</tr>
</tbody>
</table>

**User Information Fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Address Label</td>
<td>Sets the label for the Email field. Users are asked to enter an email address when signing up for a stock notification.</td>
</tr>
<tr>
<td>Email Address Placeholder</td>
<td>Sets the placeholder text to display in the Email field.</td>
</tr>
<tr>
<td>Mandatory First Name</td>
<td>Determines if the First Name field is mandatory.</td>
</tr>
<tr>
<td>First Name Label</td>
<td>Sets the label for the First Name field. Users are asked to enter a first name when signing up for a stock notification.</td>
</tr>
<tr>
<td>First Name Placeholder</td>
<td>Sets the placeholder text to display in the First Name field.</td>
</tr>
</tbody>
</table>
### Stock Notifications

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Lead First Name</td>
<td>Sets the default text to display in the <strong>First Name</strong> field of the Lead record if a first name is not supplied by the user.</td>
</tr>
<tr>
<td>Mandatory Last Name</td>
<td>Determines if the Last Name field is mandatory.</td>
</tr>
<tr>
<td>Last Name Label</td>
<td>Sets the label for the Last Name field. Users are asked to enter a last name when signing up for a stock notification.</td>
</tr>
<tr>
<td>Last Name Placeholder</td>
<td>Sets the placeholder text to display in the Last Name field.</td>
</tr>
<tr>
<td>Default Lead Last Name</td>
<td>Sets the default text to display in the <strong>Last Name</strong> field of the Lead record if a first name is not supplied by the user.</td>
</tr>
</tbody>
</table>

### Submission Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription Agreement Label</td>
<td>Sets the label for the Subscription Agreement field that asks users to subscribe to marketing emails.</td>
</tr>
<tr>
<td>Submit Button Label</td>
<td>Sets the label for the signup submit button.</td>
</tr>
<tr>
<td>Success Message</td>
<td>Determines the message to display upon successful form submission.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Determines the message to display when there is an error during form submission.</td>
</tr>
</tbody>
</table>

### My Account Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriptions Page Title - My Account</td>
<td>Sets the title for the Subscriptions page and menu item associated with My Account.</td>
</tr>
<tr>
<td>Subscriptions Empty State - My Account</td>
<td>Determines the message to display on a Subscriptions page with no current Stock Notifications subscriptions.</td>
</tr>
<tr>
<td>Item Column Label - Subscriptions Table</td>
<td>Sets the label for the Item column in the Subscriptions table, which gives the name of the item which the user subscribed.</td>
</tr>
<tr>
<td>Show Item SKU</td>
<td>Determines if the item SKU is displayed.</td>
</tr>
<tr>
<td>Price Column Label - Subscriptions Table</td>
<td>Sets the label for the Price column in the Subscriptions table, which gives the price of the item which the user subscribed.</td>
</tr>
<tr>
<td>Status Column Label - Subscriptions Table</td>
<td>Sets the label for the Status column in the Subscriptions table, which gives the notification status of the item which the user subscribed.</td>
</tr>
<tr>
<td>Active Subscription Label - Subscriptions Table</td>
<td>Sets the label to display in the Status column of the Subscriptions table if the stock notification is active for the item.</td>
</tr>
<tr>
<td>Subscription Date Label - Subscriptions Table</td>
<td>Sets the label for the subscription date to display in the Status column of the Subscriptions table if the stock notification is active.</td>
</tr>
<tr>
<td>Cancel Subscription Button Label - Subscriptions Table</td>
<td>Sets the label for the Cancel Subscription button to display for each active item in the Subscriptions table.</td>
</tr>
<tr>
<td>Subscription Canceled Message - Subscriptions Table</td>
<td>Determines the message to display when stock notifications are canceled for an item.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Cancel Subscription Label - Subscriptions Table</td>
<td>Sets the label for the button to undo canceled stock notifications for an item.</td>
</tr>
<tr>
<td>Cancel All Subscriptions Button Label - Subscriptions Table</td>
<td>Sets the label for the Cancel All Subscriptions button to display for each active matrix item in the Subscriptions table.</td>
</tr>
<tr>
<td>Undo Cancel All Subscriptions Button Label - Subscriptions Table</td>
<td>Sets the label for the button to undo all canceled Stock Notifications for a matrix item.</td>
</tr>
<tr>
<td>Date Format - Subscriptions Table</td>
<td>Determines the format in which the date appears.</td>
</tr>
</tbody>
</table>

#### Email Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Template (Required)</td>
<td>Sets the email template used for stock notification emails to users. Select the email template you created in the Set Up the Stock Notifications Email Template section.</td>
</tr>
<tr>
<td>Email Employee Sender</td>
<td>Determines from which employee the stock notification email originates.</td>
</tr>
</tbody>
</table>

### View Saved Searches for Stock Notifications

After setting up the extension, you can view the saved searches associated with Stock Notifications. The following saved searches are created automatically when you install the extension:

- **Stock Notifications Customers Waitlist** — You can check which customers are currently waiting on an item.
- **Stock Notifications TOP 10 Requested items** — You can find out which products have been requested the most.
- **Stock Notifications Sent Mails** — You can see which stock notification emails have been sent.
- **Stock Subscriptions Newsletter** — You can learn which customers elected to subscribe to the newsletter when signing up for a stock notification.

These saved searches can teach you more about your customers while also enabling you to gather information that can be used for marketing and inventory purposes.

**To view a saved search:**

1. In NetSuite, go to Reports > Saved Searches > All Saved Searches.
2. Click **View** next to the saved search you want to see.

For more information on how to view or use a saved search, see the help topic *Accessing a Saved Search*.

### Product Lead Time

** Applies to:** Commerce Web Stores | Site Management Tools

The Product Lead Time extension lets you display the estimated wait time for an out-of-stock item to again become available for purchase. This extension uses NetSuite’s Lead Time feature to calculate the wait time.
Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

To display Product Lead Time for a product, perform the following steps:

1. Configure Properties
2. Add Field Sets
3. Enable Product Lead Time for an Item

Before You Begin

To take advantage of the Product Lead Time extension, you must enable the Advanced Inventory Management feature in NetSuite. To do this, navigate to Setup > Company > Enable Features > Items & Inventory > Inventory and check the Advanced Inventory Management box.

Configure Properties

To determine how Product Lead Time displays on your website, configure the properties on the SuiteCommerce Configuration record. You can choose the message to display on the product page and whether to show lead time as a daily countdown or date.

To configure properties:

1. After activating the Product Lead Time extension for a domain, go to Setup > SuiteCommerce Advanced > Configuration.
   For more information on activating an extension, see Manage Themes and Extensions.
2. Select the website and domain where the Product Lead Time extension is activated and click Configure.
3. Navigate to the Extensions tab.
4. In the Product Lead Time subtab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Text</td>
<td>Sets the message to display on the Product page of your webstore.</td>
</tr>
</tbody>
</table>
Product Lead Time

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Lead Time As</td>
<td>Determines how the wait time displays on your website.</td>
</tr>
<tr>
<td></td>
<td>Selecting <strong>Day Countdown</strong> displays the number of days until the item is back in stock.</td>
</tr>
<tr>
<td></td>
<td>Selecting <strong>Date</strong> displays the date when the product will be back, formatted as specified in the <strong>Date Format</strong> field.</td>
</tr>
<tr>
<td></td>
<td>If the lead time is less than one day, the wait time displays as one day or the current date.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Sets the date format for when the <strong>Show Lead Time As</strong> field is set to <strong>Date</strong>.</td>
</tr>
<tr>
<td>Maximum Number of Days</td>
<td>Determines the maximum number of days to display.</td>
</tr>
<tr>
<td></td>
<td>If the number of days when the product will be back exceeds the maximum, the maximum number displays in the <strong>Message Text</strong>.</td>
</tr>
<tr>
<td></td>
<td>You can set the <strong>Maximum Number of Days</strong> at the extension and item level. You can override this setting for specific items by setting the <strong>Maximum Number of Days</strong> field on the Item record (<strong>SuiteCommerce Extensions</strong> tab &gt; <strong>Product Lead Time</strong> subtab).</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Add Field Sets

The field sets for a website determine the data that is exposed to site templates. To employ the Product Lead Time feature, you must add the **Show Lead Time Message** field to the site's field sets. For more information on field sets, see **Define Field Sets**.

To add a **Product Lead Time** field to the **Web Site Setup Record**:

1. Go to **Setup > SuiteCommerce Advanced > Set Up Web Site**.
2. Click **Edit** next to the website to which you are adding Product Lead Time.
3. Navigate to the **Field Sets** subtab.
4. Add the **Show Lead Time Message (Custom)** field to both the **details** and **matrixchilditems** field sets. For each field set, perform the following steps:
   a. Locate the **Fields Included in Field Set** column and click the Set button.
   b. Select **Show Lead Time Message (Custom)** from the **Field Name** list and click **Add**.
   c. In the Field Set window, click **Submit**.
   d. In the Field Set row, click **OK**.
5. After adding the field to both field sets, click **Save**.

Enable Product Lead Time for an Item

For Product Lead Time to display on your product pages, the extension must be enabled at the item level. You can update item records individually or use Mass Update to add Product Lead Time to entire commerce categories. For more information on using the Mass Update functionality, see the help topic **Mass Changes or Updates**.

To enable **Product Lead Time** for an item:

1. In NetSuite, go to **Lists > Accounting > Items**.
2. Click **Edit** next to the item for which you want to add Product Lead Time.
3. Navigate to the **SuiteCommerce Extensions** tab.
4. In the **Product Lead Time** subtab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Lead Time Message</td>
<td>If checked, enables the Product Lead Time feature for this item.</td>
</tr>
<tr>
<td>Maximum Number of Days</td>
<td>Determines the maximum number of days to display.</td>
</tr>
<tr>
<td></td>
<td>If the number of days when the product will be back exceeds the maximum,</td>
</tr>
<tr>
<td></td>
<td>the maximum number displays in the <strong>Message Text</strong>.</td>
</tr>
<tr>
<td></td>
<td>You can set the <strong>Maximum Number of Days</strong> at the extension and item level.</td>
</tr>
<tr>
<td></td>
<td>This field overrides the <strong>Maximum Number of Days</strong> field on the SuiteCommerce Configuration record (Extensions tab &gt; Product Lead Time subtab).</td>
</tr>
</tbody>
</table>

5. Click **Save**.
   - If the item is a Matrix Item, click **Update Matrix**.
   - If not, click **Save**.

### Infinite Scroll

The Infinite Scroll extension loads content continuously as users scroll down the page, eliminating the need for pagination. This extension allows users to view items on the Product Listings page (PLP) easily and efficiently, ultimately encouraging sales. With the optional auto scroll feature, you can choose whether users need to click a button to show more content or continue to scroll as new products are automatically loaded on to the page.

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see [Commerce Extensions](#).

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

### Configure Infinite Scroll

Use the SuiteCommerce Configuration record to determine how many pages to load at a time, set the labels for the loading buttons, and choose whether to enable the auto scroll feature.

**To configure Infinite Scroll:**

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where the Infinite Scroll extension is activated and click **Configure**.
3. Navigate to the **Extensions** tab.
4. In the **Infinite Scroll** subtab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Loading Increments</td>
<td>Determines the number of pages to load at one time.</td>
</tr>
<tr>
<td>Load More Content Label</td>
<td>Sets the label for the <strong>Load More Content</strong> button.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Previous Content Label</td>
<td>Sets the label for the Load Previous Content button.</td>
</tr>
<tr>
<td>Enable Auto Scroll</td>
<td>If checked, pages automatically load and display when the user reaches the bottom of the page, instead of offering a Load More Content button. This feature prevents users from reaching the site footer until they have scrolled through every page.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

After configuring this extension, users on your site will be able to browse your PLP using Infinite Scroll.
Overview

** Applies to: Commerce Web Stores

The Web Store Transactions chapter ties together the checkout, payment, and shipping options for your site. We will walk you through the many choices for tasks such as configuring your checkout steps, setting up Paypal accounts, web store taxes for different countries, and various shipping options.

Checkout

This section describes the different checkout flows and options available for your web store checkout experience.

Payment Options

These topics take you step-by-step on setting up the available payment options for your web store. These include credit cards, Paypal, and other alternative payment methods.

Shipping Setup

This section lets you set up preferences on how shipping from your site works and what options are available to customers to your site.

Device Fingerprinting

This option enables your site to gather information about the device ordering from your web store to determine if it's trustworthy.

Commerce Web Store Taxes

SuiteCommerce Advanced enables you to display tax amounts for different International editions of NetSuite.
Checkout

Applies to: Commerce Web Stores

SuiteCommerce web stores include a checkout application that can be customized or configured to provide unique checkout experiences for your users.

You can quickly customize your experience by changing:

- **Checkout Flows** — use one of several predefined checkout flows. Each configuration defines a specific checkout flow and includes steps that direct the shopper through checkout, ultimately submitting an order. You can also define several properties for the checkout flow in the configuration record.
- **Minimum Web Store Order Amount** — define minimum order amounts needed before a user can check out.
- **Checkout Preferences** — choose if your site generates cash sales or invoice forms at checkout.
- **Shopping Cart Options for Business Customers** — choose if all contacts at your business customers should share the same shopping cart.

For more advanced customization, you can:

- **Create Custom Fields Using an Extension** — you can add fields to request or provide additional information, such as shipping instructions, special order requests, and delivery time slots. This is done with the use of an extension.
- **Create new Extensions** — you can create a new extension leveraging the CheckoutComponent or CartComponent APIs. For details on the extensibility API see the help topics Extensions API and Frontend Extensibility API.
- **Customize the Checkout Application** — if you are using a SuiteCommerce Advanced implementation, you can fully customize your checkout experience using standard best practices.

**Note:** Whenever possible, advanced customization should be accomplished by creating new extensions. This allows for easier maintenance, portability, and release independence. Only implement advanced customizations by customizing the checkout application when the exposed extensibility APIs are not sufficient for your business use case.

Checkout Flows

SuiteCommerce supports three checkout flows. Each checkout flow guides the user through the same tasks, but uses a different sequence of pages as defined below. Since configuration is defined per domain, if you have multiple domains for a site you can configure different flows for each domain.

- **Standard checkout (default)** — the default and directs the user through the following sequence of pages:
  1. A Shipping Address page
  2. A Delivery Method page
  3. A Payment Method page
  4. An Order Review page

**Note:** This flow changes if the Multiple Ship To feature is enabled. In that case, users first select individual packages, then define a shipping method.

- **One Page checkout (OPC)** — The One Page checkout configuration directs the user through the same tasks as the Standard flow, but it does so using only two pages: the Checkout Page (complete
with shipping, addressing, payment processing, and gift certificate) and promotions processing, followed by an Order Review page.

- **Billing First checkout** — The Billing First checkout configuration directs the user through the following sequence of pages, prompting the user for billing information first by default:
  1. A Billing Address page
  2. A Shipping Method page
  3. A Payment Method page
  4. An Order Review page

**Note:** This flow changes if the Multiple Ship To feature is enabled. In that case, users first select individual packages, then define a shipping method.

**To configure Checkout configuration properties:**

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the **Checkout** tab.
3. Click the **Checkout Steps** field and select the desired Checkout flow.

**Important:** Use caution when changing this field as it has significant impact to the overall checkout experience.

4. Set other feature properties as required.
   There are many properties available as described in the configuration reference material. See the help topic **Checkout Tab** for details.
5. Save the Configuration record.

**Note:** For pre-Vinson implementations, you need to do advanced customization of your application if you want to use an alternate checkout flow. See the help topic **Customize the Checkout Application**.

**Minimum Web Store Order Amount**

You can restrict customers from checking out of your web store until they have reached a minimum total sales amount. If you have multiple subsidiaries and use multiple currencies in your web store, you can set a minimum order amount for each currency that is marked online. Use the following steps.

**To set a minimum order amount for web store sales:**

1. Go to Setup > SuiteCommerce Advanced > Setup Tasks > Set Up Web Site.
2. Click **Edit** next to a web site you want to edit.
3. On the **Shopping** tab, in the **Minimum Order Amount** field, enter the minimum amount the customer must spend to submit an order in the web store. A customer attempting to check out with less than this amount receives a warning and cannot continue with the order until more items are added to the order.

**Note:** If you use the Multiple Currencies feature, minimum order amounts are set per currency in the **Currency** list at the bottom of the **Shopping** subtab.

4. Click **Save**.
To set a minimum or maximum quantity limit for an item, see Order Quantity.

Checkout Preferences

You can determine preferences for sales orders and how to bill for web orders.

To set checkout preferences:

1. Go to Setup > SuiteCommerce Advanced > Setup Tasks > Set Up Web Site.
2. Click Edit next to a web site you want to edit.
3. On the Shopping tab (Checkout Preferences section) set preferences according to the following table.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Order Type</td>
<td>Select whether NetSuite should generate cash sales or invoice forms when you approve sales orders from your store.</td>
</tr>
<tr>
<td></td>
<td>▪ To let your customers decide how they want to pay, select Per Customer Basis.</td>
</tr>
<tr>
<td></td>
<td>▪ If you use a payment method with a payment processing profile that supports the sales request and does not support the authorization request, you must select the Standard Sales Order form.</td>
</tr>
<tr>
<td></td>
<td>▪ To only accept credit cards, select a Cash Sale form.</td>
</tr>
<tr>
<td>Credit Card Form</td>
<td>If you selected Per Customer Basis in the Sales Order Type field, select the form that should be generated when customers pay by credit card.</td>
</tr>
<tr>
<td>Invoice Form</td>
<td>If you selected Per Customer Basis in the Sales Order Type field, select the form that should be generated when customers choose to be invoiced. Set this field to a sales order or invoice form to allow users to see their transactions in the Transaction History area of their account. Customers must have terms set on the customer record and register in your site to be able to pay by invoice.</td>
</tr>
</tbody>
</table>

4. Click Save.

Shopping Cart Options for Business Customers

Business customers can place orders on websites in different ways. For example, a large corporation may have several contacts placing orders for their separate departments whereas small businesses may have one person in charge of ordering. Ordering could also be a collaborative process where two or three contacts work together to place orders. See the help topic Contacts for more information about contacts.

Depending on what is most appropriate for their business customers, administrators can choose from the following shopping cart sharing modes:
- **Separate shopping carts for each customer contact** – this option enables each contact defined for a business customer to shop and check out using their own shopping cart. One contact's cart is not visible to any other customer contact. This prevents situations where one contact removes items that another contact has added or where one contact checks out an order before other contacts have added all the items they need.

  **Note:** Though shopping carts are separate for each contact, contacts can see orders placed by all other contacts in the My Account section of the web store.
  
  If you want the My Account section to contain only the orders placed by the logged in contact, you must use SuiteCommerce or SuiteCommerce Advanced 2019.1 onwards.

- **Single shared shopping cart** – this option provides each business customer with a single shopping cart that is shared by all contacts who place orders for that customer.

For both options, there is only one set of payment details that is defined for the business customer.

**Shopping Cart Sharing Mode**

On the Web Site Setup record, you can choose the shopping cart sharing mode for the website. A different sharing mode can be defined for each website.

**To set the Shopping Cart Sharing Mode:**

1. Go to Setup > SuiteCommerce Advanced/ Site Builder > Set Up Web Site.
2. If you use the Multiple Web Sites feature, click Edit next to a website.
3. Click the Shopping subtab.
4. In the Shopping Basics section, select the option you need from the Shopping Cart Sharing Mode dropdown:
   - Single cart shared by all customer contacts – This is the default option.
   - Individual carts for each customer contact
5. Click Save.

If you switch from a single shared cart to individual carts for contacts, the existing shopping cart is retained and can still be accessed by anyone logging in using the main customer login details. Individual contacts receive new, empty carts when they log in.
If you switch from individual carts to a shared cart, contacts lose access to their separate carts. The individual carts are retained until they expire in about 30 days, but are not accessible unless you choose to switch back to individual carts.

Identify Order Creator

Business customers can identify which of their contacts placed a sales order by:

- Looking at the Relationships tab of the sales order form. The responsible contact is listed there with the ‘Order Creator’ role.
- By default, order email are sent only to the contact who placed the order. However, if the **CC Customer on All Emails Related to Orders Placed by Contacts** email preference is checked, business customers receive copies of all order email for orders placed by their contacts.

**To send copies of order email to the customer:**

1. Go to Setup > Company > Email > Email Preferences (Administrator).
2. On the Transactions subtab, select the **CC Customer on All Emails Related to Orders Placed by Contacts** checkbox.
3. Click **Save**.
Payment Options

Applies to: Commerce Web Stores

SuiteCommerce Advanced supports many different payment options. These topics will show you how to setup credit card payments, various Paypal options, and secure payment authentication.

Set Up Credit Card Payments Online

To successfully receive payment for web orders, you must set up accounting preferences in your NetSuite account to accept payments online. You must also configure payment methods and set up one or more credit card processing profiles.

Read the following for more information:
- Setting up Accounting Preferences for Your Commerce Web Store
- Creating Payment Methods
- Assigning Payment Processing Profiles to Your Website

Setting up Accounting Preferences for Your Commerce Web Store

Set accounting preferences so that your NetSuite account can process orders from your Commerce web store. The following steps guide you through setting up preferences for online payments, credit card transactions, and charging tax on web orders.

To set up accounting preferences for your Commerce web store:

1. Go to Setup > Accounting > Preferences > Accounting Preferences.
2. On the Items/Transactions subtab, in the Payment Processing section, check the Customers Can Pay Online box to allow customers to pay for the orders they place online using credit or debit cards.
3. Check the Use Card Security Code for Credit Card Transactions box to require customers to enter the 3 or 4 digit security code found on the back of the credit card being used. Checking this box adds a helper image to help customers locate this code.

   **Note:** To verify CSCs in the web site, you must check the Require Authorization for Credit Card Transactions box at .

4. Click Save.
5. Go to Setup > Accounting > Taxes > Set Up Taxes.
6. In the Charge Sales Tax on Store Orders field, select one of the following:
   - **Always** – Charge sales tax on every order
   - **Never** – Leave sales tax off orders in the web store
   - **Per Customer Basis** – Charge sales tax based on the Taxable check box on customer records

   **Note:** If you select Always or Per Customer Basis, you must either set up tax groups or select Tax Items Only in the Tax Code Lists Include field at Setup > Accounting > Taxes > Set Up Taxes.

7. Click Save.
Creating Payment Methods

Before you can assign credit card profiles to your website, you must create one or more payment methods. Create a payment method for each credit card and payment type that customers can use on your website. For more information, see the help topic Creating a Payment Method.

Assigning Payment Processing Profiles to Your Website

If you have multiple websites, you can assign a different credit card processing profile to each website. Before setting up a credit card processing profile in NetSuite, set up a merchant account with the gateway you plan to use in NetSuite. For more information, read the help topic Setting Up Credit Card Processing Profiles in NetSuite.

To assign a credit card processing profile to your Commerce web store:

1. Go to Setup > Accounting > Payment Processing Profiles.
2. Click Edit next to a profile.
3. Select one or more websites from the list in the Web Site field.
4. Click Save.

Note: If you assign a credit card processing profile that supports the sales request and does not support authorization, make sure you select Standard Sales Order in the Sales Order Type field of your web store checkout preferences. For more information, see the Checkout Preferences section of Shopping Preferences.

Credit Card Payer Authentication

Payer authentication is available for credit cards used in your NetSuite web site checkout, including Visa, MasterCard, Maestro, and JCB. With payer authentication a customer has the option to set up a password linked to his or her credit card. This password is used to verify that the person using the card is the card's owner and protect you from charge backs due to disputed charges.

When you enable payer authentication, you can add the respective Verified by Visa, MasterCard SecureCode, and Maestro SecureCode logos to your site. Customers are redirected to a payer authentication site after submitting an order using a credit card. On the payer authentication page, the customer can enter a password, create a password, or skip the step. The customer is then returned to the NetSuite confirmation page. The order is created in your NetSuite account when the shopper is returned to the confirmation page.

In addition, a Payer Authentication Status field is added to sales orders. For orders submitted using a credit card on the web site, the field shows whether the authentication was successful, failed, or skipped. On other sales orders this field is blank.

Payer authentication is currently offered through the following credit card gateways:

- Merchant e-Solutions
- CyberSource
- Payflow Pro
- SECPay
- WorldPay
- eWAY Rapid
For information about regional payment gateways, see the help topic Setting Up Regional Payment Gateways.

For information regarding payer authentication for eWAY Rapid, see the help topic Payer Authentication for eWay Rapid.

For integration with third party checkout providers like PayPal Express, and 3D Secure, see the help topic Integration with Third Party Checkout Providers.

**To enable payer authentication:**

Note that you must contact CyberSource and Merchant e-Solutions to add this feature to your account before you enable authentication in NetSuite. If you use Payflow Pro, you must enroll in PayPal's Buyer Authentication Service through your PayPal Manager account.

**Note:** Payflow Pro, owned by PayPal, is used for credit card processing. PayPal is the checkout method that enables you to enter or accept payment information.

1. Go to Setup > Accounting > Credit Card Processing.
2. Click **Edit** next to the credit card gateway you want to use payer authentication with.
3. On the payment processing profile editing page, check the **Payer Authentication** box.
4. Click **Save**.

Shoppers are now redirected to a payer authentication site after submitting an order using a credit card.

### 3D Secure Payment Authentication

This information refers to SuiteCommerce or the Kilimanjaro release of SuiteCommerce Advanced or later.

SuiteCommerce Advanced supports the use of 3D Secure authentication through payment provider accounts such as Cybersource or Merchant e-Solutions. 3D secure authentication provides for additional fraud protection by allowing users to create and assign a password to their credit and debit cards. The password is then verified when a user processes a transaction through your store.

Before you begin, you need to set up your credit card processing profiles for each payment gateway you use. See the help topic Setting Up Credit Card Processing Profiles in NetSuite.

**To enable 3D Secure authentication for your site:**

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the Checkout tab.
3. Check the **Enable 3D Secure Payments** field.
4. Save the Configuration record.

### 3D Secure Authentication Process

Once 3D secure authentication is enabled for your site, the following logic is followed for each credit card transaction:

1. A user begins the checkout process and enters their credit card number.
2. A third party payment processor determines whether the card is 3D Secure.
3. If the user has registered to be validated with 3D Secure, they are presented with a credit card authentication page where they enter their password.
4. The payment processor authenticates the password and returns the result of the authentication.
5. The transaction is processed or appropriate error messages are returned to the user.

Require Authorization for Credit Card Transactions

The Require Authorization on Credit Card Transactions option on the Web Site Setup page, is distinct from the Get Authorization on Customer Center Sales Order Transactions option, at Setup > Accounting > Accounting Preferences, on the Items/Transactions subtab.

- The Require Authorization on Credit Card Transactions option here applies to sales orders placed by your customers logged in to your website. If this option is enabled, when customers order from your website:
  - their credit cards are automatically processed and their payments are validated.
  - the credit card they use is automatically tokenized. Note that this only happens if the Payment Instruments feature is enabled and a payment processing profile, which is set up to tokenize credit cards, is selected for the website.
- The Get Authorization on Customer Center Sales Order option accounting preference applies to sales orders placed by your Customer Center users logged in to the NetSuite application.

You can enable one of these options at a time or both of them together. For more information, see the help topic Shopping Preferences.

Alternative Credit Card Payment Methods

If you want your customers to use payment methods other than credit cards on the Commerce web store, you can create custom payment methods that are displayed on the Commerce web store and accepted as valid payment methods for web orders.

You can also integrate alternative non-credit card payment methods provided by payment service providers (PSP) into your NetSuite account. For more information on these payment methods, see the help topic Alternative Non-Credit Card Payment Methods for Web Store Orders.

To set up an alternative non-credit card payment method:
1. Go to Setup > Accounting > Accounting Lists.
2. Filter Accounting Lists for Payment Methods. In the Type field, select Payment Methods.
3. Click New to create a payment method.
4. Leave the Credit Card box blank.
5. Check the Display in Web Site box.
6. If this payment method needs a payment processing profile, select a payment processing profile in the Supporting Merchant Accounts box.
7. If this payment method redirects your web store customers to check out on a third-party website, check the External Checkout box.

**Note:** Check this box for online alternative payment methods offered by payment service providers. With these payment methods, Commerce web store customers can check out using payment information that they have stored on the third-party website, without disclosing their credit card numbers or any other credentials on your Commerce web store.

8. Click Save.
After setting up the payment method, note that it does not automatically display on the Payment Information screen in the Commerce web store. You must set up your website to display non-credit card payment methods. Follow the steps below.

**Warning:** Before you expose non-credit card payment methods on your web site, make sure you have associated these payment methods with payment processing profiles, or you have set up a sales order processing workflow to collect payment for inventory shipped.

**To display a non-credit card payment method on the web site:**

1. Go to Setup > Site Builder > Set Up Web Site.
2. Click the **Shopping** subtab.
3. Check the **Allow non-credit card payment methods during checkout** box.
4. Click **Save**.

Now, the payment method you set up displays on a Site Builder site.

### PayPal Integration and Express Checkout

Enable the PayPal Integration feature in your account to accept PayPal as a payment method in your Commerce web store. An Administrator, or someone with Setup permission, can go to Setup > Enable Features. Click the Transactions subtab, and then check the box next to PayPal Integration.

Setting up a successful integration includes entering the API provided by NetSuite into your PayPal merchant account.

**Note:** PayPal requires Transport Security Layer (TLS) 1.2 for all HTTPS connections. If a user attempts to access PayPal payment systems using a browser that does not have TLS 1.2 enabled, the requested PayPal page does not load. To fix this issue, users should use a browser that supports TLS 1.2 and has TLS 1.2 enabled in browser settings.

### Setting Up PayPal Express Checkout

PayPal Express Checkout allows your customers to checkout using payment information that already exists in their PayPal accounts, so there is no need to register, or enter payment and address information on your web site. In addition, it lets you take advantage of specials and offers from PayPal and PayPal’s partners, such as occasional deals on transaction fees and enhanced placement in Yahoo® search results. Also, with PayPal Express Checkout integration, you can issue returns through PayPal.

After you set up PayPal Express Checkout, customers can click the PayPal button displayed in the shopping cart of your Commerce web store, and then they are temporarily redirected to the PayPal site to confirm or change payment and address information. Next, customers are returned to your site to enter any gift certificates or coupon codes and finally submit the order.

To set up PayPal Express Checkout successfully, you must first set up your PayPal merchant account with API access to NetSuite transactions, and then complete the PayPal Accounts setup page in NetSuite.

**To set up API access for PayPal Express Checkout:**

1. If you do not already have a PayPal merchant account, visit the PayPal site and set up an account.
   
   You can go to Setup > Accounting > Payment Processing > PayPal Accounts and click the link near the top of the page.
Important: Your PayPal account type must be either Premier or Business to setup the API access required for PayPal Express Checkout.

2. Log in to your PayPal merchant account, and use one of the following API Usernames, depending on your environment, for granting API Access to NetSuite:
   - For production accounts: `ppexpresscheckout_api1.netsuite.com`
   - For sandbox or demo accounts: `dwilli_1183500510_biz_api1.netsuite.com`

3. Check the following options in the list of APIs:
   - Use Express Checkout to process payments.
   - Issue a refund for a specific transaction.
   - Obtain information about a single transaction.
   - Search your transactions for items that match specific criteria and display the results.
   - Authorize and capture your PayPal transactions.

To complete PayPal Express Checkout setup in NetSuite:

1. Make sure the feature is enabled.
   Go to Setup > Company > Enable Features > Transactions.
2. On the Transactions subtab, check the PayPal Integration box.
3. Click Save.
4. Set up payment processing. Go to Setup > Accounting > Payment Processing > PayPal Accounts.
5. Enter information into the Account Basics section as described below:
   - In the Account Name field, enter a name for the payment method that will use PayPal.
   - In the Primary PayPal Email Address field, enter the email address you use to log in to your PayPal merchant account.
     Important: To receive customer payments, this email address must match the email address you use for your PayPal merchant account. This field is case sensitive. To determine the primary email address, log in to your PayPal account and open your profile.
   - Check the Test Mode box, if you are using the PayPal sandbox environment for testing the workflow.
   - Check the Express Checkout box to start using PayPal Express Checkout.
     Important: Checking this box means that API access must be set up in your PayPal Express merchant account to enable integration with NetSuite.
   - Check the Use Express Checkout with Bill Me Later box if you want to allow customers with Bill Me Later accounts to use this payment option.
   - If you do not want to use this PayPal account, and you do not want to see it in lists, then check the Inactive box.
6. Choose an account for PayPal transactions in the Payment Method section.
7. Click Save.

Integration with PayPal is validated when you click save on the PayPal Accounts page. If PayPal Express Checkout is set up correctly, you can save the page successfully. For more information about associating multiple PayPal accounts with your NetSuite account, see Using Multiple PayPal Accounts.
When the customer completes checkout, a sales order is created in NetSuite with payment authorized by PayPal. Depending on your accounting settings, the sales order status in NetSuite is either pending fulfillment or pending approval. When the order is billed, payment is received from PayPal.

**Note:** NetSuite does not send an email notification indicating that the order cannot be processed. After a funding error occurs in PayPal, the shopper is redirected back to PayPal where he or she can see a message about the error. The shopper can then select a new funding source and submit the order again.

### Using Multiple PayPal Accounts

You can use a separate PayPal account for each website you operate, and if you use NetSuite OneWorld, you can use a separate PayPal account for each of your subsidiaries.

**To set up multiple PayPal accounts:**

1. Visit PayPal to set up your merchant accounts.
2. Log in to NetSuite to create a PayPal account record that corresponds with each PayPal account. Go to . Click **New** to create additional PayPal accounts.
3. If you want to use PayPal Express Checkout, follow the instructions in **Setting Up PayPal Express Checkout**.
4. Go to Setup > Site Builder > Set Up Web Site to associate PayPal accounts with multiple web stores, or multiple subsidiaries in a OneWorld account. Follow the steps below:

   - **For multiple web stores** – on the **Setup** subtab, select the appropriate PayPal account in the Preferences section.

   ```
<table>
<thead>
<tr>
<th>Web Site Basics</th>
<th>Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://shopping.netSuite.com">http://shopping.netSuite.com</a></td>
<td>Web Site Scope</td>
</tr>
<tr>
<td>suitesxte</td>
<td>Full Web Store</td>
</tr>
<tr>
<td>Checkout URL https://</td>
<td>Price Level</td>
</tr>
<tr>
<td>checkout.netSuite.com</td>
<td>Online Price</td>
</tr>
<tr>
<td><strong>Home Page</strong></td>
<td></td>
</tr>
<tr>
<td>Web Site Home Page Type*</td>
<td>Scripting Template (Credit Card)</td>
</tr>
<tr>
<td>Hosted Web Page</td>
<td>Standard Online Order - Cash Sale</td>
</tr>
<tr>
<td>Web Site Home Page*</td>
<td>Scripting Template (Invoice)</td>
</tr>
<tr>
<td>Live Hosting Files: /site/index.html</td>
<td>Standard Online Order - Invoice</td>
</tr>
<tr>
<td>Default Hosting Root</td>
<td></td>
</tr>
<tr>
<td>Web Site Hosting F.../Live Hosting R</td>
<td>Show Uncategorized Items</td>
</tr>
<tr>
<td></td>
<td>Scriptable Cart and Checkout</td>
</tr>
<tr>
<td></td>
<td>Credit Sales Reps for Web Store Order</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>PayPal Account</td>
<td></td>
</tr>
<tr>
<td>PayPal</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5. Click **Save**.

After you have multiple PayPal accounts set up in NetSuite, you can track web orders from multiple web sites or subsidiaries.

**Authorization and Capture with PayPal Express Checkout**

After an order is created, NetSuite initiates an authorization request to PayPal for the full order amount. When the web store shopper approves the authorization, a three day honor period begins. PayPal places a hold on the shopper’s payment account for the amount of the order to ensure availability of the funds for capture.

During the three day honor period, you are guaranteed to capture the funds as long as the authorization is valid. Please contact PayPal for more information about their validation process.

You have three days from the time the order is created to fulfill the order and capture the funds. If you attempt to capture the funds after the three day honor period, NetSuite voids the original authorization, initiates a new authorization, and attempts to capture the funds. By default your PayPal account is restricted to a single authorization. NetSuite can initiate only as many authorizations as your paypal account allows within a 29 day period.

**Important:** Your PayPal account manager can determine how many authorizations are allowed in your PayPal merchant account and increase the limit for you if necessary.

**Managing Customer Records with PayPal Express Checkout**

When PayPal Express checkout is enabled in your NetSuite account, a new customer record is created each time the shopper uses express checkout.

- A new shopper to your web store will generate a new customer record in NetSuite.
- A shopper who already has a customer record in your NetSuite account will generate a new customer record when they checkout with PayPal Express.

Any duplicate customer records will appear in the list of customers with a number appended to the name. For example, if Jane Smith already has a customer record in the system, then a new record will appear with the name, Jane Smith1.

You can manage duplicate records by enabling the feature, Merge Duplicates from Setup > Enable Features > CRM. After that feature is enabled, you can periodically run the duplicate merge operation from the Search menu.

**Note:** If customers click the PayPal Express Checkout button before logging in or registering in your site, a customer record is created, but they do not have login or password information saved and cannot access the Customer Center or My Account page.

**Refunding Orders Paid by PayPal Express Checkout**

You can refund orders that are paid by PayPal Express Checkout from within NetSuite and do not need to log in to the PayPal web site separately. After PayPal Express Checkout is enabled and set up, transactions initiated using either the Express Checkout button or the PayPal payment option are both refundable.
You can apply a full refund, partial refund or multiple refunds to orders processed and captured using PayPal Express Checkout, as long as the total refund amount is less than or equal to the original transaction amount. You cannot refund transactions if funds have not yet been captured.

**Note:** If PayPal Express Checkout is not enabled, then transactions processed using the PayPal payment option cannot be refunded from within NetSuite.

### PayPal Integration Without Express Checkout

When you turn on the PayPal Integration feature but choose not to check the Use Express Checkout box, customers can still choose PayPal as a payment option during checkout. When customers choose PayPal, they click a **Pay With PayPal** button at the end of checkout in your site. When customers use this method, customer payments are deposited in your PayPal merchant account.

Note that if Express Checkout is not enabled, then transactions processed using the PayPal payment option cannot be refunded from within NetSuite. You must log in to the PayPal website separately.

### Checkout Process With PayPal Express Checkout

PayPal Express Checkout allows web store customers to select their payment method at various points in the checkout process. This contributes to a lower cart abandonment rate. The PayPal Express Checkout button is displayed in the shopping cart and the address information page. If the customer decides to select PayPal on the Payment Methods page, they will see the classic **Pay with PayPal** button on the last page of checkout, with Express Checkout functionality.

Customers click the PayPal Express Checkout button and are temporarily redirected to the PayPal site for confirmation of payment and address information.
Alternative Payment Methods

This feature is available in the Mont Blanc release of SuiteCommerce Advanced and later.

This information refers to the Mont Blanc release of SuiteCommerce Advanced or later.

SuiteCommerce Advanced supports checkout using payments processed by third party companies offering payment processing services, such as Google Wallet. With this feature enabled, the user can choose a payment option that communicates with an external payment gateway.

This option is available to users in the following locations on your site:
When choosing a payment method during checkout.
When paying for sales orders converted from a Request for Quote.
When making payments to an invoice.

When a user selects the external payment method, they are prompted to leave your site and enter the third-party payment site for authentication. If approved, the user returns to your site at an Order Confirmation page. If rejected, the user returns to your site's Payment Method page to choose a different payment method.

See Checkout for detailed information on configuring Checkout.

Configuring your SCA site to use the Alternative Payment Methods feature requires NetSuite account setup. The following sections direct you through the tasks for setting up alternative payment methods using external processing. Each step includes a link to detailed information for that task.

1. Set Up an External Payment Gateway
2. Create a New Payment Method
3. Create a Payment Processing Profile
4. Edit Website Settings
5. Set Up Account to Process Alternative Payment Methods
6. Restrict Payment Based on Customer Currency

Set Up an External Payment Gateway

To download and install a built-for-NetSuite-approved bundle from an accredited third party service provider, you must first choose the appropriate payment partner. The Apps are available for review on SuiteApp.com.
After choosing the appropriate partner, a direct commercial relationship must first exist between the merchant and the payment gateway. This also requires an acquiring relationship. Some of NetSuite's partners are **acquirer agnostic**, which lets you, the customer, maintain your existing acquiring relationship. Some payment partners require a new acquiring agreement to be in place. Careful selection needs to take place.

In situations where existing payment relationships do not meet your needs, contact the SuiteCloud Developer Network (SDN) for assistance.

**Note:** We only allow NetSuite-approved payment partnerships. To obtain a payment gateway, vendors must follow the official Built for NetSuite (BfN) process to be considered.

### Create a New Payment Method

Some SuiteApps automatically create a new Payment Method record in NetSuite after installation. Others do not. To allow alternative payments through third-party payment service providers, associate a payment method to the payment gateway that was included in the SuiteApp.

**To create a new Payment Method for external payment processing:**

1. Follow the steps outlined in *Creating a Payment Method*.
2. Give the payment method a name that clearly identifies it as an external payment method.
3. Ensure that the following boxes are enabled (checked):
   - External Checkout
   - Display in Web Site

### Create a Payment Processing Profile

A Payment Processing Profile is a NetSuite record that stores the connection information to the external payment gateway delivered with the associated SuiteApp. You must create at least one Payment Processing Profile to direct NetSuite to use the Payment Gateway when processing a payment for a transaction that uses the profile.

**To create a Payment Processing Profile:**

1. Follow the steps outlined in *Alternative Non-Credit Card Payment Methods for Web Store Orders*.
2. In the Processing Profile record's **Web Site** field, choose the website that will use this profile.
3. In the **Supported Payment Methods** field, choose the external Payment Method you created earlier. NetSuite automatically updates the Payment Method record to associate with this profile.
4. Make any other changes as required and save the profile.

### Edit Website Settings

After creating a Payment Processing Profile, perform the following account setup procedures:

- Allow payment processing in your Commerce web store
- Allow non-credit card purchases during checkout
To allow payment processing on your Commerce web store:

1. In NetSuite, select Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to website you are setting up.
3. Click the Shopping tab.
4. In the Shopping Basics section, check the Require Authorization for Credit Card Transactions box.

To allow non-credit card purchases during checkout:

1. In NetSuite, select Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to website you are setting up.
3. Click the Shopping tab.
4. In the Payments Page section, check the Allow Non-Credit Card Payment Methods During Checkout box.

Set Up Account to Process Alternative Payment Methods

Set up your NetSuite account to use processing profiles that connect to third-party payment providers.

To allow your account to process alternative payment methods:

1. In NetSuite, select Setup > Accounting > Accounting Preferences.
2. Click the Items/Transactions tab.
3. In the Payment Processing section, check the Enable Sale Payment Operations on a Sales Order by Automatically Creating a Customer Deposit box.

Restrict Payment Based on Customer Currency

You can restrict the payment method to the currency set in the Payment Processing Profile. With this preference enabled, only payment processing profiles that support the selected payment method and the customer's currency are displayed. If you use NetSuite OneWorld, the payment processing profile must also support the customer's subsidiary.

This takes precedence over the Restrict Payment Methods by Customer Currency shopping preference. This means that even if the shopping preference is disabled, only payment methods that support the shopper's currency are displayed. In addition, if no payment method matches the shopper's currency, no payment method shows on the Payment Information page.

To restrict the payment method based on the user's currency:

1. In NetSuite, enable your account for multiple currencies. See the help topic Customers and Multiple Currencies for detailed information.
2. Select Setup > Accounting > Accounting Preferences.
3. Click the Items/Transactions tab.
4. In the Payment Processing section, check the Use Strict Rules for the Selection of Payment Processing Profiles.
5. Set the Payment Processing Profile record's Charge Currencies field to the desired currencies. See the help topic Setting Up an Alternative Payment Method Processing Profile for detailed information.
SuiteCommerce Payment Instruments Integration

SuiteCommerce lets you take advantage of NetSuite’s Payment Instruments feature. This feature lets you use tokenized payment methods and additional payment gateways. See Tokenized Payment Instruments.

Requirements:

- SuiteCommerce or SuiteCommerce Advanced 2019.1 (or later)
- A domain with an active theme built using SuiteCommerce Base Theme 2019.1 or later. See the help topic SuiteCommerce Base Theme.

**Note:** The 2019.1 (or later) version of SuiteCommerce Base Theme includes the templates required to use tokenized payment instruments.

**Note:** Tokenized payment instruments are not supported on SiteBuilder Extensions.

With payment instruments support:

- Registered site users can manage their debit and credit card payment instruments. See Payment Card Management.
- Site administrators can add tokenized payment instruments as payment methods. See Tokenized Payment Instruments.

Payment Card Management

With Payment Instruments enabled, logged-in users can:

- Add new debit and credit cards to their account.
- See saved tokenized and non-tokenized debit and credit cards in Checkout.
- Enter payment information for a single transaction that is not saved for future purchases.
- Enter additional card payment instrument security information when required by the card issuer or payment gateway.

To enable the Payment Instruments feature in NetSuite, see the help topic Payment Instruments.

Tokenized Payment Instruments

Tokenized payment instruments increase payment security by substituting sensitive payment card data with a payment card token that does not include sensitive data.

After you set up tokenized payment instruments on your site, NetSuite creates a token the first time a shopper uses their payment card to complete a transaction. SuiteCommerce uses the token for all future transactions using that payment card.

**Important:** Activating the NetSuite Payment Instruments feature changes the structure of your payment records and is not reversible. Tokens created prior to enabling the Payment Instruments feature are inaccessible and cannot be used. Contact your NetSuite account manager to determine if you are eligible to use this feature.

After your NetSuite account manager adds the Payment Instruments feature to your NetSuite account, you can set up tokenized payment instruments.
See the help topic Tokenization for additional information about tokenization.

**Setting up tokenized payment instruments for SuiteCommerce**

To set up tokenized payment instruments for SuiteCommerce:

1. Set up accounting preferences to allow credit card payments from your web store. See Setting up Accounting Preferences for Your Commerce Web Store.
2. Enable the Payment Instruments record. See the help topic Payment Instruments.

   **Note:** The Payment Instrument feature check box is available when your NetSuite account manager adds this feature to your NetSuite account.

3. Create one or more payment methods for tokenized payment cards. See the help topic Creating a Payment Method.
   - In the **Type** field, select **Payment Card Token**.
   - Enable the **Display in Web Site** option.
   - On the **Payment Visuals** subtab, choose which images are used on the web store checkout page for this payment method.

4. Set up an alternative payment method processing profile for tokenized payments. See the help topic Setting Up an Alternative Payment Method Processing Profile.

5. Assign the new payment processing profile to your website. See Assigning Payment Processing Profiles to Your Website.


Your site users now benefit from the additional security of tokenized payment card transactions when using their debit and credit cards in Checkout.
Commerce Web Store Taxes

 Applies to: Commerce Web Stores

This topic explains the following:

- SuiteCommerce VAT, GST, PST Tax Support
- SuiteCommerce SuiteTax Support

For developer information about tax–related values returned by the Commerce API, see the help topic Commerce API.

SuiteCommerce VAT, GST, PST Tax Support

 Note: If you are a SuiteCommerce Advanced customer, you must be implementing the kilimanjaro release or later to take advantage of this feature.

SuiteCommerce supports the display of VAT, GST, and PST tax amounts for Canadian, UK, and Australian editions of NetSuite.

Before enabling display of VAT/GST/PST in your Commerce web store, you must have your NetSuite account set up with the proper tax types and tax codes. For detailed information on setting up taxes for your NetSuite account, see the help topic Taxation.

 Note: The display of VAT/GST/PST tax breakdowns is supported only in single Australian, UK, or Canadian editions or in One World editions with a single subsidiary configured.

To enable the display of VAT/GST/HST in your Commerce web store:

1. Select the website and domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. On the Shopping Catalog tab, enable the option If the Information is Available to your Country, shows detailed taxes in the cart.
3. Verify that the proper tax codes are entered on the Accounting tab of the Item records.
4. For Australian accounts, set the Prices Include Tax option on the Sales/Pricing tab of the Item record. Note the following behavior depending on the selection:
   - Prices Include Tax is enabled — This results in the display of the total cost including tax to display on the product page. On the checkout page, the breakdown of the item cost and tax are displayed separately.
   - Prices Include Tax is not enabled — This results in the display the cost without tax on the product display page. On the checkout page, the breakdown of the item cost and tax are displayed separately.

Once the display of VAT/GST/HST is configured for your account, users are shown the breakdown of VAT/GST/PST tax amounts during checkout.

 Note: For Canadian accounts, a user must be logged in and have a default address selected. If not, a tax code error is returned.

SuiteCommerce SuiteTax Support

If you are a SuiteCommerce Advanced customer, you must be implementing the 2019.1 release or later to take advantage of this feature.
Note: Requires SuiteScript 2.0 (SSP2) deployment on the same site and domain as SuiteScript 1.0 (SSP1). See the help topic Deploy and Undeploy SSP Applications.

SuiteCommerce supports the NetSuite SuiteTax feature for customers in the United States and Canada. SuiteTax helps you comply with location-specific tax requirements by letting you select third-party tax engines to calculate taxes. You can select a different third-party tax engine for each tax registration (nexus) on subsidiary records to enhance compliance with each tax jurisdiction or geographic area. For additional information about SuiteTax, see the help topic SuiteTax.

You can not use SuiteTax in combination with the Multiple Ship To feature.

With the SuiteTax feature set up on your Commerce web store, users can see the total tax for their order as soon as they add shipping details during checkout. The total tax recalculates when the site user:

- Adds or removes items
- Changes the item quantity
- Changes the shipping address
- Changes the shipping method
- Applies a promotion

### SuiteCommerce Capabilities with SuiteTax Enabled

<table>
<thead>
<tr>
<th>SuiteCommerce Capabilities with SuiteTax Enabled</th>
<th>Business-to-Consumer (B2C)</th>
<th>Business-to-Business (B2B)</th>
</tr>
</thead>
<tbody>
<tr>
<td>View a summary of the taxes grouped by tax type at checkout.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>See every tax applied in the returned order summary (in My Account Returns).</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>See every tax applied in the order, summarized by type (in My Account History).</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View the total taxes for previous orders (user must be logged in to their registered account).</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>See the total tax amount when creating a sales quote.</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>View the total tax amount when paying an invoice.</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

### Setting up SuiteTax for your Commerce Web Store

Important: After enabling SuiteTax, you cannot switch back to the legacy tax engine.

To set up SuiteTax:

1. Enable the SuiteTax feature. See the help topic Enabling the SuiteTax Feature.
2. Set up the tax engine for subsidiary tax registrations. See the help topic Selecting a Tax Engine for Tax Registrations on Migrated Subsidiary Records.
3. Set up accounting preferences for your Commerce web store. See Setting up Accounting Preferences for Your Commerce Web Store.
4. Confirm that your SuiteTax setup is complete and view the migration status. See the help topic Viewing the SuiteTax Data Migration Status.
Device Fingerprinting

Applies to: Commerce Web Stores

SuiteCommerce Advanced supports device fingerprinting for online orders as part of the advanced fraud management features available with CyberSource Decision Manager. Device fingerprinting collects information about the computer used to place an order through your web store to determine whether the device is trustworthy. Data gathered at checkout is analyzed by Decision Manager in real-time. Based on rules you define in Decision Manager, an order can be accepted, rejected, or placed on payment hold for review as part of your order management process in NetSuite.

Before using device fingerprinting in your Commerce web stores, the following prerequisites must be met:

- You must be using CyberSource Decision Manager to authorize credit card transactions. Check the Enable Device Fingerprinting box in your CyberSource gateway profile. For complete details read the help topic Using CyberSource Decision Manager for Fraud Management.
- Enable the Require Authorization for Credit Card Transactions checkbox for the desired site on the Shopping tab of the Web Site Setup record at Setup > SuiteCommerce Advanced > Set Up Web Site.

Once these prerequisites are met, when a user opens the final submit page in Checkout in your Commerce web store, information about their device along with a unique session ID is sent to the device fingerprinting server.

**Note:** Any calls to the device finger printer are excluded from the SEO page generator.

For releases prior to Vinson, you can customize your implementation to support device fingerprinting. Add the following code snippet just before the closing </body> tag of the checkout.ssp file at /CheckoutApplication@x.x.x/SuiteScript/checkout.ssp. For customization best practices, see the help topic Customize and Extend Core SuiteCommerce Advanced Modules.

```plaintext
<%# order.getDeviceFingerPrintingHtml() %>
```
Shipping Setup

**Applies to:** Commerce Web Stores

When you set up your Commerce web site, you can set preferences to determine how shipping works on your site and which shipping methods are available to shoppers.

On the Shopping subtab of the Web Site Setup page, you can:

- require shoppers to enter shipping information before checking out
- require shoppers to enter shipping address before billing address
- select a default shipping method for a web site
- enable shipping to all countries or limit shipping to specific countries
- choose a country to display by default in the Country field on the Shipping page in Web Store checkout.

For more information, read the following topics:

- Setting a Preferred Shipping Method for Your Site
- Shipping Estimator
- Restricting Ship To Countries in Your Commerce Web Store

For the complete listing of website shipping preferences, read the help topic Shipping Page.

Before you can select a default shipping method for your site, you must register your shipping accounts, set shipping preferences, and set up shipping items in NetSuite. For more information, read the topics listed below:

- Registering a FedEx® Account, Registering a UPS® Account, Registering a UPS® Account (UK), Register a USPS Account with NetSuite
- Getting Started with Australia Post Integration
- Setting Shipping Preferences
- Creating Shipping Items

Selecting a default shipping method for your site combined with any previous customer shipping preference determines what the shopper sees as the preferred carrier and available shipping options when checking out. In Checkout, the Shipping Method page displays a list of shipping items that are appropriate for the shipping address. If you select a Default Web Site Shipping Method, then a shipping method is preselected in Checkout based on information about the customer and your shipping preferences.

**Important:** If you use multiple locations, to calculate shipping correctly, the Location field must be displayed on the sales order form you use for your web site. For more information about displaying fields on transaction forms, see the help topic Configuring Fields or Screens.

With the SuiteCommerce Shipping Bar extension, you can inform shoppers of free or special rate shipping with dynamic messages that change to indicate how much more shoppers must spend to qualify for shipping. For more information on setting up the shipping bar feature in your website, read Shipping Bar.

### Setting a Preferred Shipping Method for Your Site

The preferred shipping method for an order is based on:
Setting a Preferred Shipping Method for Your Site

- Default Shipping Carrier
- Default Web Site Shipping Method
- Customer Information

Shoppers can always select a different shipping method and a different carrier, if available. You can display the Shipping Estimator on your site to help customers choose a shipping carrier.

**Default Shipping Carrier**

If you have shipping accounts with UPS, as well as FedEx, USPS, or other carriers, you can select a default shipping carrier for your NetSuite account. NetSuite shows the default carrier to Commerce web store shoppers if other preferences or customer address information cannot be used to determine an appropriate shipping method. Set this preference if you want to preselect a carrier for your shoppers when no other preference settings apply.

For more information about creating a default shipping carrier in NetSuite, see the help topic Selecting a Default Shipping Carrier.

**Default Web Site Shipping Method**

The Default Web Site Shipping Method is the preferred shipping carrier displayed in Checkout. Set this preference if you want customers to see this shipping method first when checking out. You can select a default shipping method for your web site whether you use multiple carriers or not.

**To select a default shipping method for a web site:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
   
   If you use the Multiple Web Sites feature, click Edit next to the web site you want to modify.

2. On the Shopping subtab, in the Shipping Page section, select a shipping method in the Default Web Site Shipping Method field.

3. Click Save.

**Customer Information**

If a shopper placed a previous order through your website, the customer record stores the shipping method selected for the last order. This information updates each time the customer selects a shipping method on the order form. The shopper's previous shipping method choice is preselected in Checkout.

**Shipping Estimator**

The shipping estimator displays in your website after your customer has added items to the cart. It displays the estimated shipping cost based on the Shipping Estimator Preference selected by the website administrator.

Note that the preference setting you select may not be applicable to a particular customer. For example, you might select a default shipping method that is not available for a particular customer address. In this case, a system of precedence determines the preference used to calculate the estimated shipping cost.
To estimate shipping cost, the Shipping Estimator only requires customers to enter a postal code and select a country. Customers are required to enter a full shipping address later in the checkout process, and can choose a different shipping method prior to submitting the order.

**Note:** Shipping estimates for orders shipped by FedEx from a Canadian location do not include Canadian tax.

To enable the user interface for the Shipping Estimator, check the **Enable Shipping Estimator in Cart** box. In SCA you have full control of the elements displayed on your website. To show the Shipping Estimator, you must design your ecommerce website to display it in the shopping cart.

**To use the shipping estimator:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site. If you use the Multiple Web Sites feature, click **Edit** next to the web site you want to modify.
2. Click the **Setup** subtab.
3. Check the **Enable Shipping Estimator in Cart** box.
4. Click the **Shopping** subtab.
5. Make a selection from the **Shipping Estimator Preference** list. For more information, read **Shipping Estimator Preference Options**.
6. Click **Save**.

**Shipping Estimator Preference Options**

After you select a Shipping Estimator Preference, the shipping estimator uses your selection to calculate the estimated shipping cost for the website customer. You can select from the following options:

- **Lowest Price Shipping Item** – shows the lowest priced shipping method available for the shopper’s address.
- **Default Web Store Shipping Item** – shows the default shipping method selected for the website. You can select the default setting on the Web Site Setup page.
- **Company Default Shipping Method** – shows the shipping method set as the default for the company. You can select the default setting at Setup > Accounting > Shipping.
- **Customer’s Previous Shipping Method** – shows the shipping method that the shopper used on the previous order.

**Shipping Estimator Order of Precedence**

The order of precedence is based on your Shipping Estimator Preference selection. If you select a preference option that cannot be applied to a particular website order, the next option in the order of precedence is applied.

For example, you might select the default web site shipping method as your Shipping Estimator Preference. If that shipping method is not available for a particular customer address, then the shipping estimator will use the shipping method that the customer used on a previous order. If this is the first time the customer is ordering from your site, then the third item in the order of precedence is used, which is the company default method, and so on.
The shipping estimator relies on the following order of precedence to calculate the estimated shipping cost for web orders.

**Restricting Ship To Countries in Your Commerce Web Store**

If you only provide domestic shipping or cannot ship to certain countries, you can designate which countries you want customers to be able to select in your Commerce web store.

**Note:** You can set up shipping and handling rules when you create a shipping item to specify the countries it can ship to or the web sites it is available on. See: Creating Shipping Items.

**To designate countries you ship to:**

1. Go to Setup > Site Builder > Set Up Web Site..
2. If you use the Multiple Web Sites feature, click Edit next to a web site.
3. On the Shopping subtab, in the Shipping Page section, clear the Web Store Ships to all countries box.
4. In the Countries Web Store Ships To field, select the countries your customers should be allowed to select at Checkout in the web store.
5. Click Save.

Your customers can only have orders shipped to the countries you have listed.
Shipping Items in your OneWorld SuiteCommerce Website

When customers place orders on a website associated with a OneWorld account, the only shipping items available are associated with the subsidiary displayed on the website. When you create each shipping item in NetSuite, you must select a Subsidiary on the shipping item record. Shoppers on your website only see shipping items based on the following criteria:

- the subsidiary they choose in a Site Builder website or the default subsidiary set on a SuiteCommerce Advanced (SCA) website,
- and the shipping preferences you define on the Shopping subtab of the Web Site Setup page.

If the shopper has not registered or logged in, the Shipping Estimator displays the lowest shipping rate from your list of shipping items. For instructions on how to display the shipping estimator in your site, read Shipping Estimator.

**Note:** By default, new customers registering on the web store are assigned a customer role that you specify. If the subsidiary is not defined on the default customer role, then shipping options and other information may not be available to the customer. For more information, see the help topic Setting the Default Customer Role. See also, OneWorld CRM

Shipping Bar

**Applies to:** Commerce Web Stores | Site Management Tools

The Shipping Bar extension lets you add a shipping bar and banners to your website to inform shoppers of how much they have to spend to qualify for free or special rate shipping.

**Important:** SuiteCommerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

**Note:** If you are a SuiteCommerce Advanced customer, you must be implementing the Aconcagua release or later to take advantage of extensions.

Overview

The shipping bar and optional banners display various messages to customers based upon how much progress they have made towards free or special rate shipping. When the cart value meets the minimum required for free or special rate shipping, a congratulations message is displayed. While the Shipping Bar extension already contains default progress and congratulatory messages, you can customize the text if necessary.

Additionally, the Shipping Bar allows for multiple currencies to accommodate users in various countries. To use multiple currencies with this extension, you must enable the Multiple Currency feature and add additional currencies on your Web Site Setup record. For more information, see the help topics Enabling the Multiple Currencies Feature and Multi-Currency.

Integrate Shipping Bar with Shipping Promotions

To use the SuiteCommerce Shipping Bar extension in conjunction with auto-applying free or discounted shipping, you must have already completed the following tasks for your Commerce web store:
1. Create a new shipping item to apply free or special rate shipping automatically. You use this shipping item as your default shipping method. See the help topic Creating Shipping Items.
2. Select the new shipping method as your preferred shipping method in the website setup. See Setting a Preferred Shipping Method for Your Site.

**Important:** The SuiteCommerce Shipping Bar extension considers cart values when making calculations. The extension does not take into account any shipping promotions that you may have set up in your account using SuitePromotions or advanced promotions that are not reflected in the cart through auto-apply.

### Shipping Bar Display Options

You can choose to display the shipping bar in the following ways:

- **Header bar** — this bar displays in the header of your website. The bar displays an initial, progress, or congratulations message depending on your cart's total value. You can choose the position of the header bar and link to a specific page. For example, you can customize an alternate message to link to a shipping terms and conditions page.

- **Product banner** — this banner displays on product detail pages (PDP). Users see a banner that indicates whether they meet the minimum value to qualify for shipping if they add that item to the cart. If the cart total with that item does not meet the minimum value, shoppers are informed of how much more they need to spend to qualify.

- **Cart banner** — this banner displays on the cart page. The banner displays an initial, progress, or congratulations message depending on your cart's total value.

Using the Shipping Bar fields in the Site Management Tools (SMT) Theme Customizer, you can customize the style and display settings of the header bar, product banner, and cart banner. You can choose the font, background and text colors, border size, and more to make each display fit your needs. For more information on using the Theme Customizer in SMT, see the help topic Theme Customizer.

### Configure Shipping Bar

Use the SuiteCommerce Configuration record to turn on the header bar, product banner, and cart banner. Additionally, this record lets you set the shipping bar URLs and messages, and you can use the multi-currency feature to set up the shipping bar for use in several countries.

**To configure Shipping Bar:**

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where the Shipping Bar extension is activated and click **Configure**.
3. Navigate to the **Extensions** tab.
4. In the **Shipping Bar** subtab, fill out the listed fields for each category, using the tables below as references.
5. Click **Save**.

### Shipping Bar Configuration Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipping Goal Value</td>
<td>Sets the minimum order value that the shopper must spend to get free or special rate shipping.</td>
</tr>
<tr>
<td>Currency Symbol</td>
<td>Determines the symbol or abbreviation to display with the amount to denote the currency type.</td>
</tr>
</tbody>
</table>
### Shipping Bar

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Header Bar Position</strong></td>
<td>Sets the position of the header bar.</td>
</tr>
<tr>
<td></td>
<td>You can choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Above Header</strong> — header bar displays above the website header</td>
</tr>
<tr>
<td></td>
<td>• <strong>Fixed to Top</strong> — header bar remains visible at the top of the page while scrolling</td>
</tr>
<tr>
<td></td>
<td>• <strong>Below Header</strong> — header bar displays below the website header</td>
</tr>
<tr>
<td><strong>Initial Message URL</strong></td>
<td>Determines the full URL to which you want the header bar Initial Message to link.</td>
</tr>
<tr>
<td><strong>Alternate Message 1 URL</strong></td>
<td>Determines the full URL to which you want the header bar Alternate Message 1 to link. For example, you can use this field to link to a Terms &amp; Conditions page or a landing page promoting a sale.</td>
</tr>
<tr>
<td><strong>Alternate Message 2 URL</strong></td>
<td>Determines the full URL to which you want the header bar Alternate Message 2 to link. For example, you can use this field to link to a Terms &amp; Conditions page or a landing page promoting a sale.</td>
</tr>
</tbody>
</table>

### Messaging Fields:

In the Messaging fields, you can use the following placeholders, which are replaced by their associated values automatically:

- `[[value]]` — shipping goal value
- `[[to-value]]` — remaining amount required to qualify for free or special rate shipping

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Header Bar</strong></td>
<td>If checked, displays the header bar at the top of all pages of your site.</td>
</tr>
<tr>
<td><strong>Initial Message - Header Bar</strong></td>
<td>Sets the message to display in the header bar.</td>
</tr>
<tr>
<td><strong>Alternate Message 1 - Header Bar</strong></td>
<td>Sets the alternate message to display in the header bar.</td>
</tr>
<tr>
<td></td>
<td>The header bar displays a new message every five seconds or when a user clicks on the side arrows.</td>
</tr>
<tr>
<td><strong>Alternate Message 2 - Header Bar</strong></td>
<td>Sets the alternate message to display in the header bar.</td>
</tr>
<tr>
<td></td>
<td>The header bar displays a new message every five seconds or when a user clicks on the side arrows.</td>
</tr>
<tr>
<td><strong>Progress Message - Header Bar</strong></td>
<td>Sets the message to display when the user adds an item to the cart but has not reached the shipping goal value required to qualify for free or special rate shipping.</td>
</tr>
<tr>
<td><strong>Congratulations Message - Header Bar</strong></td>
<td>Sets the message to display when the user meets the shipping goal value to qualify for free or special rate shipping.</td>
</tr>
<tr>
<td><strong>Show Product Banner</strong></td>
<td>If checked, displays the product banner on PDPs.</td>
</tr>
<tr>
<td><strong>Progress Message - Product Banner</strong></td>
<td>Sets the message to display on the PDP when a customer has not reached the shipping goal value required to qualify for free or special rate shipping. This message appears below the item selection options.</td>
</tr>
<tr>
<td><strong>Item Qualifies Message - Product Banner</strong></td>
<td>Sets the message to display on the PDP if the shopper qualifies for free or special rate shipping if they add the item to the cart. This message appears below the item selection options.</td>
</tr>
</tbody>
</table>
### Shipping Bar

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Cart Banner</td>
<td>If checked, displays the shipping banner on the cart page.</td>
</tr>
<tr>
<td>Initial Message - Cart Banner</td>
<td>Sets the message to display on the cart page.</td>
</tr>
<tr>
<td>Progress Message - Cart Banner</td>
<td>Sets the message to display on the cart page when the user has not reached the shipping goal value required to qualify for free or special rate shipping.</td>
</tr>
<tr>
<td>Congratulations Message - Cart Banner</td>
<td>Sets the message to display on the cart page when the user meets the shipping goal value to qualify for free or special rate shipping.</td>
</tr>
</tbody>
</table>

### Multi-Currency Support Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>Determines an additional currency available for the shipping bar.</td>
</tr>
<tr>
<td>Shipping Goal Value</td>
<td>Sets the shipping goal value required to qualify for free or special rate shipping for this currency.</td>
</tr>
<tr>
<td>Currency Symbol</td>
<td>Determines the symbol or abbreviation to display with the amount to denote the currency type.</td>
</tr>
</tbody>
</table>

### Multiple Ship To

Applies to: SuiteCommerce Advanced

This information refers to the Denali release of SuiteCommerce Advanced or later.

The Multiple Ship To (MST) feature lets shoppers send items or groups of items to separate shipping addresses. This feature is available with any of the three Checkout flows (Standard, One Page Checkout, and Billing First). See Checkout for more information on configuring Checkout.

With MST enabled, shoppers can:

- Define different shipping methods for each shipping address.
- Specify a quantity of items for checkout and split that quantity to ship to multiple addresses as needed.

**Note:** Although shoppers can define a different shipping method for each address, they cannot define multiple shipping methods for one address within the same order.
When using MST, shoppers typically proceed through the following flow:

1. A user adds items with specified quantities to the Cart and proceeds to checkout.
2. The shopper chooses an address and selects the items in the cart to ship to that address. If the shopper has more than one shippable item, they can choose to split their order to ship to multiple addresses at this time by defining the quantity to be sent to the selected addresses. Remaining quantities are available when an additional address is selected.

   **Note:** If no shipping addresses exists, the site prompts the shopper to enter one. Shoppers also have the option to create additional shipping addresses. If only single address is selected, shoppers can continue, but the site returns to the configured Checkout Flow.

3. The user creates additional shipments until all items have been allotted to a shipping address.
4. The shopper defines a delivery method for each shipment.
5. The shopper selects a payment method and completes the order.

Set Up NetSuite

Perform the following setup tasks in your NetSuite account to enable this feature:

**To set up NetSuite for the Multiple Ship To feature:**

1. Enable Multiple Shipping Routes for your account. See the help topic Multiple Shipping Routes for detailed information.
2. Configure your site record to use the Standard Sales Order type.
   a. In NetSuite, go to Setup > SuiteCommerce Advanced > Set Up Web Site.
   b. Click Edit for the website record you are configuring.
   c. Locate the Preferences section of the Setup subtab.
   d. Select the Standard Sales Order option in both the Scripting Template (Credit Card) and Scripting Template (Invoice) fields.

Configure Feature Properties

Follow the correct configuration procedures below, depending on the version of SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic Checkout Tab.

**To enable multiple shipping:**

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the Checkout tab. This tab includes properties across various subtabs.
3. To enable MST, check the Enable Multiple Shipping checkbox.

**To enable multiple shipping (pre-Vinson):**

1. Create a custom module that includes the backend Configuration object as a dependency. See the help topic Configure Properties for details.
2.  
Redefine the `isMultiShippingEnabled` property in the custom module to true. This property is set to false by default.

3.  
Save and deploy to your site.

### Known Limitations

Known limitations regarding Multiple Ship To include the following:

- Promo codes are not supported in the Multiple Ship To flow. When a user attempts to enter a Promo code, the site returns an error. If a user has already entered a promo code while defining a single ship to order and switches to MST, the site also returns an error and removes the promo code automatically.

- Multiple Ship To is limited to defining one shipping method per shipping address. Shoppers cannot create multiple shipping methods for the same address. For example, a user cannot order one set of items to ship Home using the Standard shipping methods and another set of items shipping Home using a One Day shipping method.

- A performance impact exists during the Proceed to Checkout step if using a shipping method with real-time rates. This impact is more obvious for orders using MST. NetSuite recommends running performance tests before going live when using real-time rates.

- Customized Online Forms are not supported.

- Minimum quantity is set as a shipping minimum and not as an order minimum. You must comply with minimum quantity limitations on each of the lines/shipments of your order. MST does not take into account more items on another line.

- Multiple Ship To is not compatible with Scriptable Cart.

- MST Multiple Ship To is not compatible with Pickup In Store.

- Multiple Ship To is not compatible with SuiteTax.
Overview

1. **Applies to:** Commerce Web Stores | SuiteCommerce InStore

When shoppers visit your web store, you want them to quickly find the items that they are looking for with minimum navigation. The Item Search service speeds up this process by returning search results for the search query provided by the shopper. NetSuite offers all the tools you need to enhance the item search capabilities of your Commerce web stores and SCIS. You can:

- Configure your item search settings, which includes defining Search Fields, Facet Fields, Sort Fields, and Field Sets
- Understand the Search Index, which ensures that the search requests are more targeted and search times are reduced
- Use the Item Search API to retrieve data from the item records that have been indexed
- Use Search Synonyms to define variants of terms in your product catalog

**Important:** The procedures in this topic assume that you have already set up Item Records for Web Stores. For more information, see Item Availability.

**Search Settings Overview**

The factors that impact your search results are your product catalogue, your item search settings, and the search query provided by the shopper. Although you cannot control the search query that your shoppers provide, you can make an educated guess of what they might search for and configure the search settings accordingly.

**Search Index Overview**

When you configure and save your item search settings for the first time, the Search Index is built. The Search Index is defined by the fields that you configure in your search settings, and the indexing process prepares your item records for use with the Item Search API.

**Item Search API**

The Item Search API is an interface that helps you retrieve the indexed items. By specifying the input parameters with the Item Search API, you can retrieve a subset of indexed items in the JSON response. Web Developers can use this API to build facet filtering and keyword search on item data.
Search Synonyms

Search Synonyms enables shoppers to easily find the products they are looking for using the language that comes naturally to them.

Search Analytics

Search Analytics enables you to view standard workbooks showing the top search queries your shoppers used to find products on your website and the most frequently used shopper queries yielding zero search results.
Search Settings Overview

Applies to: Commerce Web Stores | SuiteCommerce InStore

Watch a related video.

You can enhance the item search capabilities of your website by configuring the item search settings with your preferences. The following illustration shows how item search settings relate to your web store:

- **Search Fields** influence the default sort order of the search results, which is relevance. For more information, see Select Search Fields.
- **Facet Fields** help a shopper narrow down the search results. For more information, see Select and Configure Facet Fields.
- **Sort Fields** define how results can be sorted beyond relevance to a search query. For more information, see Select and Configure Sort Fields.
- **Field Sets** are a grouping of item fields taken from item records, used to display information to your shoppers. For more information, see Define Field Sets.

**Prerequisites**

Before you configure the item search settings, you should:

- Complete **Item Availability**, which includes setting up item records for display on your web store, setting up item records for search index, and setting up item inventory in web stores.
- Review the **FieldSetsList** spreadsheet, which lists all the fields that are available for keyword search, faceting, sorting, and for use in field sets.
- Review the **Sample Search Fields Setup**.
- Read the best practices to **Improve Relevance of your Search Results**.
- Identify the item record fields that contain keywords, which shoppers might use to search for products on your website.
- Identify the item record fields that shoppers might use to efficiently narrow down the search results.
- Create necessary custom fields for use as facet fields.
- Identify the item record fields that shoppers might use to sort the search results.
- Create necessary custom fields for use as sort fields.
- Identify the item record fields that you want to include in each field set.

**Select Search Fields**

When a search is initiated in the web store, the system searches based on the type of match and order of the fields configured on the Search Fields subtab.

**Select the Right Type of Match**

Before you select the type of match for your Search Fields, review the usage of each type of match. Also, observe the definitions for each type of match as it would be applied to the item attribute text "wifi router":

<table>
<thead>
<tr>
<th>Type of Match</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exact</strong></td>
<td>Matches the exact text of the item field contents. For example, if the shopper types &quot;wifi router&quot; in the search box, the search matches &quot;wifi router.&quot;</td>
<td>Exact match holds good in situations where a shopper might provide the exact search string when searching for a product. Ideal for the SKU and Online Name fields where there are chances that a shopper remembers the full name and provide the exact search string.</td>
</tr>
</tbody>
</table>

**Note:** If the search query provided by the shopper includes a non-alphanumeric character, the word order is preserved as if it were a phrase search for Exact match type. For example, consider that Drywall Screw is an item in your catalog and the name specified in the Product Name field is 4*128mm Drywall Screws. If you do not want the non-alphanumeric character * to be ignored during search, you must configure the Product Name field as a search field with an Exact match type.

| **Keyword**   | Appears anywhere in the text. For example, if the shopper types "router" in the search box, the search matches "wifi router." | Keyword holds good for fields with a lot of text. Ideal for fields with description such as Detailed Description or in case of the |

**Note:** If you select the same search field multiple times and use it with different types of match, define exact match at the top of the list for that search field.
<table>
<thead>
<tr>
<th>Type of Match</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starts with</td>
<td>Behaves the same as Keyword search but only for the first 20 characters of every word in a field. For example, if the shopper types “wifi” in the search box, the search matches “wifi router.”</td>
<td>You should use Starts With only if your site uses Type Ahead search and only use it on fields such as Online Name.</td>
</tr>
<tr>
<td>Starts With Exact</td>
<td>Matches the exact text from the beginning of a field but only up to the first 20 characters. For example, if the shopper types “wifi” or “wifi rou” in the search box, the search matches “wifi router.”</td>
<td>Starts With Exact holds good in situations where a shopper provides the exact first few characters (up to 20 characters) as the search string. Ideal for the SKU field where a shopper might provide only the first few characters of the SKU number.</td>
</tr>
</tbody>
</table>
| Fuzzy         | Matches similar text or misspellings depending on the length of the search term specified. Following rules are applicable when the type of match is Fuzzy:  
  - Fuzzy matching is not applied for search term with three or fewer characters.  
  - Search term with four or five characters will fuzzy match against one character being different.  
  - Search term with six or more characters will fuzzy match against up to two characters being different.  
  For example, if the shopper types “mifi” in the search box, the search matches “wifi router.” | Since fuzzy matches can return irrelevant items (skirt versus shirt) in the search results, use the Fuzzy type of match only if you have a valid use case. If you wish to include the Fuzzy type of match in your Search Settings, put it at the bottom of the list. Since the list of search fields is ranked in order, top to bottom, fuzzy matches near the top of the list can return irrelevant items at the top of the search results list. |

**Note:** To avoid false positives in your search results, ensure that the item descriptions do not repetitively use terms associated with other unrelated items in your catalog.

**Note:** If the search query provided by the shopper includes a non-alphanumeric character, it is treated as white space for Keyword, Starts With, Starts With Exact, and Fuzzy match types.

### Sample Search Fields Setup

NetSuite provides default search field settings to get you started. However, it is recommended that you reconfigure the Search Fields based on the data in your item records.

You can also consider the following search fields setup as a starting point for your environment:

<table>
<thead>
<tr>
<th>Search Field</th>
<th>Item Record Field Name</th>
<th>Field ID</th>
<th>Search Type</th>
</tr>
</thead>
</table>
To select the search fields

1. Complete the prerequisite tasks as described in Prerequisites.
2. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
3. Click Edit next to your SuiteCommerce Advanced site.
4. Click the Search Index sub tab and then click Search Fields.
5. If the default setting is relevant to your website, go to Step 8 without making any changes.
6. (Optional) If you want to rearrange the search fields, you can drag and drop rows.
7. (Optional) If you want to delete a search field, you can select the field and click Remove.
8. (Optional) If you want to add a new search field:
   1. Select the search field from the Search dropdown.
   2. Select the match type for the Search Field from the Type of Match dropdown.
   3. Click Add.
9. Once you have finalized the Search Fields, click Save.

Select and Configure Facet Fields

Facets are a way of filtering the search results based on the values in the item fields. When a shopper clicks a facet value, the search results are reduced to only the items that have that value, and additional clicks continue to refine the search results. Commerce web stores and SCIS use modern faceted navigation for displaying item results.

Typically, a variety of item attributes are used as facets. For example, some of the popular facet fields for an apparels website are brand, gender, color, and size.

Adding a Facet Field under Search Index enables faceting for that field. You can then use this facet field with the Item Search API.

**Note:** Avoid adding excessive Facets or Facet Values as it might impact search performance. It is recommended that you use 40 facets or less.

To select the facets:

1. Complete the prerequisite tasks as described in Prerequisites.
2. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
3. Click Edit next to your SuiteCommerce Advanced site.
4. Click the Search Index sub tab and then Facet Fields.
5. From the Facet Field Name dropdown, select the fields that you would like to use as facets and click Add.
6. (Optional) If you want to delete a Facet Field from the list, you can select the field and click Remove.
7. Once you have finalized the Facet Fields, click Save.

After you select the facet fields, you can configure the facet fields for your site using the SuiteCommerce Configuration record. For more details, see Configure Facet Fields.

Configure Facet Fields

After you select the facet fields, the navigational area on your website automatically displays the facet. Configuring facet field properties is not required; however, facets may not display as you intend by default. For example, you define a custom field, custitem40 as a facet field in the web site record. A line item for that field should be added under the Facets subtab on the SuiteCommerce Configuration record and configured so that the facet is not displayed as custitem40 in the web store.

Note the following when configuring facets:
- Facet fields must be set up in NetSuite to appear on the site.
- If the facet's URL Component is not set in NetSuite, the site will display the default field ID.
- Not specifying a set facet on the Facets subtab results in the default appearance for the associated facet.
- Not specifying a property in the Facets subtab results in the default appearance for the associated property.
- If using products that use a dash (-) in the product name, avoid using dashes in the id property. The Facets Router sees these dashes as separators, and the website will not load.
- With Elbrus release of SuiteCommerce Advanced and later, you can configure facets as URL parameters or as part of the URL path. This decision can impact SEO. For more details, see Facets as Parameters.

Follow the correct configuration procedures, depending on the version of SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the following sections:
- Facets Subtab
- Color Palettes Subtab
- Facets Delimiters Subtab
- Facets SEO Subtab

To configure the facet fields:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the site that you want to configure from the Select Website list.
3. Select the specific domain that you want to configure from the Select Domain list.
4. Click Configure.
5. On the SuiteCommerce Configuration record page, click the Shopping Catalog tab.
6. Click the Facets subtab and configure your facet options as required.
7. Click Save to save the Configuration record.

For example, you want to configure the color facet field to display on your website in the following ways:
- Display the facet title as Item Color
- Display in the URL as a parameter
- Appear expanded when loaded
- Be collapsible
- Appear first in the list of facets on your website
Select and Configure Facet Fields

Your customized Facets entry might look like this:

![Facet Field Configuration](image1.png)

Your resulting facet will display on your website like this:

![Facet Display](image2.png)

Facets as Parameters

This section applies to the **Elbrus** release of SuiteCommerce Advanced and later.

When using Faceted Navigation, any selections concatenate into a single URL as users refine their search criteria. You can configure how each facet is included in the URL. This section explains the different options and how each affects search engine optimization. For details on each configurable property, see the help topic **Facets Subtab**.

You can:
- Configure all facets as part of the URL path (default).
- Configure all facets to act as URL parameters.
- Configure individual facets as either URL parameters or as part of the URL path.

**Note:** Any changes made to facet fields require that you re-index your site. You may experience a 30 to 60 minute cache delay before changes to this property take effect on your site.

Facets as URL Path

When a user filters their search by adding more facets, the number of facet combinations can become large. If you configure facets as part of the URL path, the current facet value displayed in the URL grows as the facets increase. This increases the number of unique pages indexed by search engines and can have a negative impact on SEO.

Using facets as part of the URL path results in the following:
- You must manually update robots.txt to block URLs from being indexed to accommodate any facets added to your site. See the help topic **SEO and Robots.txt** for details.
- The SEO Page Generator executes each possible path when indexing your site. This can add multiple filtering combinations and overwhelm the SEO Page Generator with unnecessary information.
- The large number of facet combinations can have an adverse effect on any sitemaps produced.
- Search engine web crawlers can reach your content though many different URLs.

When treating facets as part of the URL path, the SEO Page Generator considers the entire path in the index, as shown in the following example:

```
www.site.com/facet1/value1/facet2/value2/
```
Facets as URL Parameters

Using Facets as URL parameters results in fewer unique pages indexed by search engines, thus optimizing searches and improving your web store's rank. As parameters, any faceted URL information is treated as a parameter and not considered by the SEO Page Generator when indexing your site.

Note: You need not edit the robots.txt file to ensure search engine optimization for facets configured as URL parameters.

When configuring facets as URL parameters, the SEO Page Generator considers only the web store domain in the index as shown in the following example (www.site.com):

www.site.com?facet1=value1&facet2=value2

Select and Configure Sort Fields

Using a sort field, a shopper can sort the search results by that field instead of the default relevance field. It may not always be obvious on which field you should or should not sort, but you need to ensure that all item records contain data for the fields you choose as sort fields, especially if you select an item record field where values are optional. Items with empty fields are placed last when sorting by that field. For example, when sorting by price, the search service will place items that have no price last.

Note: Relevance is the default sort field, and you cannot remove Relevance from the list. But you can select other item fields to use as sorting options for your site. By default, the onlinecustomerprice field is added as an additional sort option, and additional configuration is not required to support sorting by price. Commerce web stores are pre-configured to display two pricing options: Sort by price, low to high and Sort by price, high to low.

Adding a Sort Field under Search Index enables sorting for that field. You can then use this sort field with the Item Search API but the sort field is visible in the web store only after you configure it.

To add the sort fields:

1. Complete the prerequisite tasks as described in Prerequisites.
2. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
3. Click Edit next to your SuiteCommerce Advanced site.
4. Click the Search Index subtab and then Sort Fields.
   - Field Name — (Required) Select an item record field. Select item attributes that you want shoppers to use for sorting search results.
   - Field ID — (View only field) Displays the field's internal ID.
   - Sort Order — Choose ascending or descending order. This is the order in which products are sorted in search results.

After you select the sort fields, you can configure the sort fields for your Commerce web stores using the SuiteCommerce Configuration record. Configuring a Sort Field ensures that the sort field is available to the shoppers in the web store.

To configure the sort fields

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. Select the site that you want to configure from the **Select Website** list.
3. Select the specific domain that you want to configure from the **Select Domain** list.
4. Click **Configure**.
5. On the SuiteCommerce Configuration record page, click the **Search** tab and then click the **Result Sorting** subtab.
6. Define and configure your sort options. For details, see the help topic **Result Sorting Subtab**.
   For example, if a custom field, `custitem41` has been defined as a sort field in the web site record, a line item for that field must be added to the Desktop, Phone, and Tablet sections before the selection is available in the web store on the applicable device.
7. Click **Save**.

To configure sort fields for pre-Vinson SuiteCommerce Advanced implementations, the `sortOptions` array in the `SC.Shopping.Configuration.js` configuration file must be extended to include the new sort field. For guidance on extending your implementation, see the help topic **Customize and Extend Core SuiteCommerce Advanced Modules**.

For example, if a custom field `custitem41` has been configured as a sort field in the web site record, a line item for that field must be added to the `sortOptions` array before the selection is available on the web store.

```javascript
sortOptions: [
    {id: 'relevance:asc', name: _('Sort by relevance').translate(), isDefault: true},
    {id: 'onlinecustomerprice:asc', name: _('Sort by price, low to high').translate()},
    {id: 'onlinecustomerprice:desc', name: _('Sort by price, high to low ').translate()},
    {id: 'custitem41:desc', name: _('Sort by best seller, low to high ').translate()}]
```

For information on handling Matrix Item sorting and combining Sort Fields using the Item Search API, see **Sorting Best Practices**.

### Sorting Best Practices

When working with Matrix items, ensure that sorting values are consistent between the child and parent records. For fields defined as sortable, define those fields in child items with the **same** values as defined for the parent items. If values differ, you will see inconsistent sorting results.

For example, suppose you have added a custom field, Best Seller, to your item record. If the value for Best Seller is set on the parent record but the same value is not set on the child records, sorting on Best Seller may not return the parent records in the expected order.

Note that parent items are assigned a sort value defined as the lowest sort field value from amongst their children. The parent items are then sorted according to those selected sort values.

### Combine Sort Fields Using Item Search API

Even if the default sort order is by the relevance score, you can manipulate the sort order by using a custom item field along with the relevance field. This is beneficial when two or more items in the search results have the same relevance score, and you want to use another parameter as a tie breaker to display the search results. For example, you could use Most Popular or Best Seller as another parameter.

Since API calls override default settings in NetSuite, you can use an Item Search API request to combine multiple sort fields and display the search results.

For example, suppose you add a custom field, Rating (`custitem_rating`), to your item record to record the item review rating. Enter a value in the custom field on item records, assigning numbers 1 – 5, with 5 being the best rated item. Then, use an Item Search API request to sort by price and rating.
Select and Configure Sort Fields

/api/items?sort=pricelevel5:asc,custitem_rating:desc

For information on Item Search API, see the help topic Item Search API. For the complete list of parameters supported by the Item Search API, see Item Search API Input Parameters.

Define Field Sets

You can expose information from the item records in NetSuite to your website by defining field sets. Once you define the field sets, a web developer can use the Item Search API to access field values in the field sets.

For example, you might create a field set for the product details page, which includes fields that display product name, product images, product description, product availability details, and price. You could also create a different field set for the search results page, which includes fields that just display an image thumbnail, product name, and price.

Note: Field Sets are made public on the internet. Since any field type can be selected for use in field sets, you must consider which fields you choose to expose.

You can leverage the Field Set Setup Script to quickly populate your site with required Field Sets. To run a script to create the field sets, see Set Up Initial Field Sets.

You can also define your own field sets on the Web Site Setup page. To define your own field sets, follow the inline procedure.

To define your own field sets:

1. Complete the prerequisite tasks as described in Prerequisites.
2. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
3. Click Edit next to your SuiteCommerce Advanced site.
4. Click the Field Sets subtab.
5. In the Name field, enter a name for the new Field Set. This name is only displayed internally on the Field Sets list page and in dropdown lists on the Web Site Setup page. Name each Field Set based on the product views you create for your site.

Important: The Field Set to return item details is typically named details. If a different name is used, you must update the searchApiMasterOptions property. See Search Results Subtab for more details on configuring this property.

6. In the Field Set ID field, enter an ID, which you need to later use with the Item Search API as an input parameter to specify the field set. The Field Set ID must be alphanumeric, lowercase, and contain no spaces or special characters. The Field Set ID is displayed internally, on the Field Sets list page and in dropdown lists on the Web Site Setup page.
7. The Record Type field is pre-populated with the value Item as only item records are supported.
8. The Description field is an optional field where you can enter a description of this field set. The description only shows on Field Set records, the Field Set list page, and on the Web Site Setup page.
9. To populate the Fields Included in Field Set field, click the Set icon next to this field. A Field Set window opens.
10. In the Field Set window, select the item record fields from the Field Name dropdown one by one and click Add. Once you have selected all the fields, click Submit. The values of the Field ID and Field Type fields are auto populated for the selected field. You can use the Field ID to refer to
Define Field Sets

When writing SuiteScript, it is important to specify fields. This is also the field ID returned in the JSON response when using the Item Search API. The Field Type refers to the NetSuite field type. Field types provide information about the type of data web developers can expect in the JSON response to Item Search API queries.

11. After you have selected fields for this field set, click Submit. The Field Set window closes.

12. Click Add to add the new field set.

13. Click Save on the Web Site Setup page to save your changes.

Defining field sets is the final task in configuring item search settings. When you click Save on the Web Site Setup page after defining field sets, the item search indexing process is triggered. For more information, see Search Index Overview and Check the Search Index Job Status.

Field Set Reference

We have provided a Microsoft Excel worksheet listing all the fields available for field sets. You can use this list to find information such as, field IDs and field types. The list also identifies fields that are available for faceting, sorting, and keyword search. In addition to the fields on the item records, there are additional fields that include derived values. These fields are identified on the worksheet as Synthetic fields.

To access the worksheet, click this link: FieldSetsList.xls

**Note:** Depending on the features enabled in your account, some of the fields in the spreadsheet may or may not appear in your account.

Derived Fields for Field Sets

In addition to the fields on the item records, there are additional fields that include derived values. These fields are known as derived fields or synthetic fields. You can use these derived fields in field sets to retrieve additional information.

<table>
<thead>
<tr>
<th>Derived Field Name</th>
<th>Field ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| Available for Backorder | Isbackorderable | Displays a Boolean value, which indicates whether an item can be back ordered when it is out of stock. One of the following conditions must be met for an item to back orderable:  
- The item's out of stock behavior is set to Allow back orders with no out-of-stock message or Allow back orders but display out-of-stock message.  
- The item's out of stock behavior is set to Default and the site is configured to display out of stock items. |
| Available for Purchase | Ispurchasable   | Displays a Boolean value, which indicates whether an item is in stock or back orderable.                                                     |
| Commerce Categories | Commercecategory | Displays the Name, ID, URLs, and URL fragment aliases of each Commerce Category containing the item.                                        |

**Note:** The same details are also displayed for each category in the primary path to the item when navigating through the category hierarchy.

<p>| Correlated Items (Detail) | Correlateditems_detail | Displays the details of all the correlated items associated with an item. The correlateditems fieldset defines the fields to be returned for each correlated item. |</p>
<table>
<thead>
<tr>
<th>Derived Field Name</th>
<th>Field ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Category (Detail)</td>
<td>defaultcategory_detail</td>
<td>Displays the path to the item's default Site Builder category on the current site with the help of label and URL component fields.</td>
</tr>
<tr>
<td>Default Item Ship Method</td>
<td>defaultitemshipmethod</td>
<td>Displays the default shipping method for the specified item.</td>
</tr>
</tbody>
</table>
| Display Out-of-Stock Message | showoutofstockmessage | Displays a Boolean value, which indicates whether a message should be displayed to indicate that the item is out of stock. The item must be out of stock and one of the following conditions must be met for the out of stock message to be displayed:  
  - The item's out of stock behavior is set to **Allow back orders with no out-of-stock message** or **Allow back orders but display out-of-stock message**.  
  - The item's out of stock behavior is set to **Default** and the site is configured to display out of stock items. |
| In Stock | isinstock | Displays a Boolean value, which indicates whether an item should be considered to be in stock depending on the item type and item availability. |
| Item Carrier | itemcarrier | Displays the carrier used to ship an item. For example, UPS, FedEx, and so on. |
| Item Images (Detail) | itemimages_detail | Lists the URL and alt text of all the images associated with the item. |
| Item Options (Detail) | itemoptions_detail | If an item has item options, this field returns all the item options, their values in case of list-type options, and their default values.  
  For example, for gift certificate items, this field returns the sender name, recipient name, recipient email address, and message. For matrix items, this field indicates whether the item is a matrix parent or child. Also, for matrix child items, the field returns the internal ID of the matrix parent item. |
| Matrix Child Items | matrixchilditems_detail | Displays the details of all the matrix child items that exist for the matrix parent item, including which item option values define each child item. The **matrixchilditems** fieldset defines the fields to be returned for each matrix child item. |

**Note:** Even if you have defined the default field set `correlateditems` as described in Set Up Initial Field Sets, you can overwrite the default field set with any other field set using the Item Search API parameter `correlateditems_fieldset`. For more information, see Item Search API Input Parameters.

**Note:** The default URL for each image is displayed, not the URL of the resized image. For information on image file naming convention, see Renaming Image Files with an Item Identifier.
### Define Field Sets

<table>
<thead>
<tr>
<th>Derived Field Name</th>
<th>Field ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price (Formatted)</td>
<td>pricelevel*</td>
<td>Each price field has a formatted counterpart. For example, the field ID of the Base Price field is pricelevel 1. The field ID of the derived field Base Price (Formatted) is pricelevel1_formatted. The regular price field returns a numeric value. The *_formatted variant of the price field returns the formatted price with a currency symbol along with appropriate number of decimal places based on regional rounding conventions.</td>
</tr>
<tr>
<td>and Price Level</td>
<td>formatted</td>
<td>Notes: Even if you have defined the default field set matrixchilditems as described in Set Up Initial Field Sets, you can overwrite the default field set with any other field set using the Item Search API parameter matrixchilditems_fieldset. For more information, see the help topic Item Search API Input Parameters.</td>
</tr>
</tbody>
</table>
| Price for Current  | onlinecustomerprice | Returns a JSON object with all the available information about the item's current price. If a customer is logged in, the price displayed on the website applies to the logged-in customer, including special pricing and quantity pricing. If the item has quantity pricing, the price schedule is returned. If the item is a donation item, information defining the donation parameters such as minimum and default amount are included. This field consists of the following subfields:  
  * onlinecustomerprice - Price for the current customer, or in case of matrix items, this is the lowest child item price.  
  * onlinecustomerprice_formatted - Formatted version of onlinecustomerprice  
  * priceschedule - Pricing for specified quantities of the item, which can be set up on the item record.  
  * Nopricemessage - This message is displayed when the price is unavailable for an item.  
  * Maximumvariableamount - This subfield is displayed if the item is a donation item and it displays the maximum donation amount.  
  * Showdefaultvariableprice - This subfield is displayed if the item is a donation item and it displays the item's show default amount option. |
| Customer (Detail)  |                | Related Items (Detail) | relateditems_detail | Displays the details of all the related items associated with an item. The relateditems fieldset defines the fields to be returned for each related item. |

---

**SuiteCommerce Store Front**
Define Field Sets

<table>
<thead>
<tr>
<th>Derived Field Name</th>
<th>Field ID</th>
<th>Description</th>
</tr>
</thead>
</table>

**Note:** Even if you have defined the default field set relateditems as described in Set Up Initial Field Sets, you can overwrite the default field set with any other field set using the Item Search API parameter relateditems_fieldset. For more information, see the help topic Item Search API Input Parameters.

Improve Relevance of your Search Results

Following are some of the best practices for improving the relevance of your search results:

- Search results are mainly driven by the data in your item catalog. Good data in your item catalog generates good search results. Therefore, ensure that the item descriptions do not repetitively use terms associated with other unrelated items in your catalog.
- For items displayed in the web store, ensure that the items records are complete. At least specify values for all the fields of the item record that are being used as search fields, facet fields, and sort fields.
- Your settings on the Search Fields tab influence the default sort order (relevance) of the search results. Therefore, identify item record fields that contain keywords that customers might use to find products, and then select those fields on the Search Fields subtab. For more information, see Sample Search Fields Setup.
- The top row on the Search Fields list shows the item field and the type of match that result in highest relevance ranking. Therefore, define a search field at the top of the list whose value is most likely to be searched by shopper. For example, define Online Name (Field ID: storedisplayname) or Name (Field ID: itemid) at the top of the list.
- If you select the same search field multiple times and use it with different types of match, define exact match at the top of the list for that search field.
- Use the Starts With type of match for the Online Name search field only if your site uses Type Ahead Search.
- Since fuzzy matches can return irrelevant items (shirt versus skirt, or cat versus hat) in the search results, use the Fuzzy type of match only if you have a valid use case. If your intention is to return accurate ordering of search results (for example, return all items that match Shirt at the top of list), then do not include fuzzy match fields at the top of the list of Search Fields. Since the list of search fields is ranked in order, top to bottom, fuzzy matches near the top of the list can return irrelevant items at the top of the search results list.
- Avoid adding excessive search fields as it can have performance implications and result in less relevant search results.
- Only certain fields on item records are supported for faceted navigation based on the field type. For more information, see Field Set Reference.
- Avoid adding excessive Facets or Facet Values. For more information, see the help topic SEO Page Generator Best Practices.
- You must limit the length of facet field values to 200 characters. If the facet field value exceeds the maximum character length, the search index fails to rebuild.
- If Google Analytics is enabled in your account, you can see analysis of the search terms used by your shoppers in due course. In your Google Analytics account, you can navigate to Behaviour > Site Search.
> Search Terms to view all the search terms. By analyzing these search terms used by your shoppers, you may identify areas in your Search Settings that you can tweak to provide even more relative search results to the shoppers visiting your website.

**Troubleshoot Unexpected Search Results**

Search results are driven by the items in your item catalog, data in your item record, configurations in your search settings, and the search query that is provided. Based on these factors, you might get any of the following in your search results:

- Relevant items are returned at the top
- Irrelevant items are returned before relevant items
- Irrelevant items are returned intermittently
- Relevant items are not returned
- No items are returned

**Relevant items at the top** implies that you have configured the right fields in your search settings for the items published in your web store. Therefore, no action is required at this point in time.

However, if Google Analytics is enabled in your account, you can analyze the search terms used by your shoppers to refine your Search Settings as described in **Improve Relevance of your Search Results**.

**Irrelevant items might be returned before relevant items** because of your Search Settings. Modify you Search Settings to see if you can get better search results.

Also, the search query specified by the shopper might have been repetitively used in the item description of a completely irrelevant product causing the irrelevant item to appear in the search results. Consider rewording such item descriptions to resolve this issue.

**Irrelevant items might be returned intermittently** because of stemming, which can be sub-optimal in some situations. Stemming is a process of reducing words to their root form, and words are stemmed at both index and query time. Consequently, when two or more words have the same stem, and when the type of match for the search field is set to Keyword, irrelevant items might be returned intermittently in the Search Results along with relevant items.

For example, generator, generic, and general are all stemmed and stored as `gener` in the Search Index, and all these items are returned in the search results when you search for generator.

If **relevant items are not returned** even though the items being searched are published in your web store, you might have added a different field under Search Fields or you might not have assigned the right type of match for the selected Search Field.

For items to be searchable:

- The field on the item record and the field in our search fields sublist should be the same. For example, the Web Store Display Name field on the Item Record is represented as Online Name in the Search Fields dropdown. Therefore, to ensure that you have selected the intended field, always verify the Field ID of a field using the `FieldSetsList.xls` spreadsheet.
- Item fields that you add under Search Fields should have values assigned to them in the item record.
- The type of match that you assigned for the selected Search Field should be appropriate for the data in your item record and the search query provided.

If **no items are returned** in the search results even though you have configured the right fields in your search settings, and the item being searched is published in your web store, it could be because the Item Search API is not returning items. To troubleshoot this issue, rebuild the search index manually as described in **Rebuild the Search Index Manually**.
Improve the Performance of the Search Results Page

You can improve the performance of search result pages in Commerce web stores and SCIS by tweaking the field sets.

Prerequisites

You have:
- Complete understanding of Item Search API, including the usage of Item Search API Input Parameters.
- Complete understanding of Field Sets.

Background

Fields such as Matrix Child Items (Detail), Related Items (Detail), and Correlated Items (Detail) use the default field sets and retrieve a large number of item fields for each item. Consequently, the performance of pages that retrieve lot of matrix child items, related items, or correlated items degrade.

For example, the Matrix Child Items (Detail) field retrieves matrix child item fields from the matrixchilditems reserved field set. The matrixchilditems field set has the following fields configured as part of Set Up Initial Field Sets:

- onlinecustomerprice_detail, internalid, quantityavailable, outofstockbehavior, outofstockmessage, stockdescription, isinstock, isbackorderable, ispurchasable, showoutofstockmessage, itemid, minimumquantity, itemtype, isfulfillable, istorepickupallowed, quantityavailableforstorepickup_detail

Solution

When retrieving item fields for the search result pages, you can specify an alternate field set to be loaded instead of the default field set using the Item Search API input parameters.

Use the following Item Search API parameters to override the default field set with any other field set:

- For the Matrix Child Items (Detail) field, use the Item Search API parameter matrixchilditems_fieldset.
- For the Related Items (Detail) field, use the Item Search API parameter relateditems_fieldset.
- For the Correlated Items (Detail) field, use the Item Search API parameter correlateditems_fieldset.

Example

In the following example, you can observe that for each matrix child item about 15 item fields are retrieved. Consequently, the performance of pages that retrieve lot of matrix child items degrades.

```
http://www.mywebstore_suite.com/api/items?fieldset=details
```

```json
{
    "total": 10,
    "items": [
```
To improve the performance of search result pages, you can now overwrite the default field set with any other field set using the Item Search API parameter `matrixchilditems_fieldset`. Consider that
we have created a new field set `matrixchilditems_mini`, which has only four item fields. For more information, see To define your own field sets:

In the following example, fewer matrix child item fields are returned as we have overwritten the default field set with a field set `matrixchilditems_mini` (using the Item Search API parameter `matrixchilditems_fieldset`):

```
http://www.mywebstore_suite.com/api/items?fieldset=details&matrixchilditems_fieldset=matrixchilditems_mini
```

```json
{
   "total": 10,
   "items": [
   {
      "isinstock": true,
      "metataghtml": "",
      "custitem_ns_pr_item_attributes": "&nbsp;",
      "matrixchilditems_detail": [
      {
         "itemid": "H2201100-110",
         "onlinecustomerprice_detail": {
            "onlinecustomerprice_formatted": "$15.99",
            "onlinecustomerprice": 15.99
         },
         "internalid": 7541,
         "quantityavailable": 100,
      },
      {
         "itemid": "H2201100-274",
         "onlinecustomerprice_detail": {
            "onlinecustomerprice_formatted": "$15.99",
            "onlinecustomerprice": 15.99
         },
         "internalid": 7542,
         "quantityavailable": 0,
      }
      ],
   },
   ...
   ...
   ...
   }
}
```

If your search results page includes Related or Correlated items, you can further improve the performance by using the Item Search API parameters `relateditems_fieldset` and `correlateditems_fieldset` to overwrite the default field sets of the Related Items (Detail) and Correlated Items (Detail) fields respectively.
Search Index Overview

Appplies to: Commerce Web Stores | SuiteCommerce InStore

The Search Index powers item search by ensuring that the search times are reduced and requests are more targeted. For the items set up to be included in the Search Index, the Search Index retrieves the item attribute values of the defined search fields, sort fields, and facet fields and uses it for result ordering. The search index is first built when you click Save on the Web Site Setup page after selecting the item search settings for the first time. Whenever you make changes to your item record or item search settings, the search index is updated or rebuilt factoring in the changes that you made.

Note: If you delete your Commerce website, the index for the site is also deleted.

To learn more about the Search Index, refer to the following sections:
- Events that Trigger Search Index Rebuild
- Events that Trigger Search Index Update
- Check the Search Index Job Status
- Rebuild the Search Index Manually

Events that Trigger Search Index Rebuild

Any of the following changes in your NetSuite account trigger a search index rebuild:
- Changing facets, search, and sort options (on the Search Index subtab of the Web Site Setup page).

Note: When you remove a search field and save your changes, the search index is rebuilt only if you have removed all types of matches for that particular search field.
- Adding or removing languages.
- Adding or removing Subsidiary accounts.
- Changing site currencies when the site has currency-based fields defined as facets or sort options. For example, fields such as price or cost.
- Changing the preference, Include Out Of Stock Items in Web Store on the Web Site Setup Page.
- Reactivating an inactive website. See the help topic Making a Website Inactive for more information.

Note: Saving an item record triggers an index update, not an index rebuild. For information on events that triggers a search index update, see Events that Trigger Search Index Update.

Events that Trigger Search Index Update

Any of the following changes in your NetSuite account trigger a search index update:
- Any Item record change

Note: This includes changes on item records as a result of using a CSV import.
- Item Availability
- Item Pricing
- URL Components for Facets
- Web Site Tabs
- Site Builder Categories
- Commerce Categories
- Customer Segment Manager
- Personalization Rules tab on Customer Group record
- Customer Segments tab on Item Collections record

For information on events that trigger the search index to rebuild, see Events that Trigger Search Index Rebuild.

### Check the Search Index Job Status

You can use the Job Status page to check the status of the search index process. Navigate to Setup > SuiteCommerce Advanced > Set Up Web Site, and click View in the Search Index Status column.

The Job Status page shows elapsed time as the item search index is processing. Click Refresh to update information on the page.

**Note:** Changes to the item record trigger an index update. The Records Finished column on the Job Status page always indicates the total number of records being processed.

The job names on the Job Status page describe whether the search index is being built for the first time, rebuilt or updated. The job names also provide information about why the index is being updated. The job names on the Job Status page describe whether the search index is being built for the first time, rebuilt, or updated. The job names also provide information about why the index is being updated. For every item update, an entry is made on the Job Status page unless the rate of item updates is high. If the rate of item updates is particularly high, item updates will be processed in batches resulting in fewer entries on the Job Status page in comparison with the number of item records updated.

The following table lists all possible job names; your NetSuite configuration determines which of these you will see.

<table>
<thead>
<tr>
<th>Job Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>The full search index is being built for a newly created site.</td>
</tr>
<tr>
<td>Reindex for site config change</td>
<td>The full search index is being rebuilt because changes were made to the site configuration.</td>
</tr>
<tr>
<td>Index regeneration</td>
<td>The full search index is being rebuilt because an ad hoc rebuild has been triggered, or a feature has been enabled or disabled that requires a new search index to be built.</td>
</tr>
<tr>
<td>Index is live</td>
<td>The newly rebuilt search index is being made available for search queries.</td>
</tr>
<tr>
<td>Feature Change</td>
<td>The search index is being updated because a feature was toggled, for example, Commerce Categories.</td>
</tr>
<tr>
<td>Item Type Feature Change</td>
<td>The search index is being updated because a feature related to item type was toggled, for example, the Download Items and Gift Certificates features.</td>
</tr>
<tr>
<td>Item Update</td>
<td>The search index is being updated because one or more items were added or updated.</td>
</tr>
<tr>
<td>Item Removal</td>
<td>The search index is being updated because one or more items were removed from the webstore.</td>
</tr>
<tr>
<td>Commerce Category Update</td>
<td>The search index is being updated because a Commerce Category was added, updated, or deleted.</td>
</tr>
</tbody>
</table>
## Search Index Overview

<table>
<thead>
<tr>
<th>Job Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Builder Category Update</td>
<td>The search index is being updated because a Site Builder Category was added, updated, or deleted.</td>
</tr>
<tr>
<td>Synonyms Updated</td>
<td>The full search index is being rebuilt due to the addition, modification, or removal of Synonyms.</td>
</tr>
</tbody>
</table>

### Rebuild the Search Index Manually

Even though certain changes that you make in your NetSuite account automatically trigger the search index to rebuild, you can manually rebuild the search index for your site. For information on events that trigger the search index to rebuild, see [Events that Trigger Search Index Rebuild](#).

Manual rebuild of the search index is typically done when you want to force a rebuild, and not wait for the changes that you made in your NetSuite account to automatically trigger the rebuild.

After you initiate the search index rebuild process, it may take up to 10 minutes to start rebuilding the search index. The time it takes to complete the process is relative to the number of items being indexed.

**Note:** There is a limit to the number of times you can request a rebuild of the search index. In a 24-hour period, you are allowed only two requests.

### To manually rebuild the search index for your site:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click **Edit** next to your website.
3. On the Web Site Setup page, choose Actions > Rebuild Search Index.
   
   A popup message appears stating that there is a limit to the number of times you can request a rebuild of the search index.

   **Note:** The Rebuild Search Index option is still available if the site is checked as Inactive. However, selecting the option does not initiate a rebuild of the search index.

4. In the popup message dialog box, click **OK** to rebuild the search index for this website.
5. (Optional) Open the Job Status page to check the status of the rebuild process. For more information, see [Check the Search Index Job Status](#).
Overview

**Applies to:** Commerce Web Stores

When users visit your Commerce web store, you want to make ordering online quicker and easier for users to track.

With SuiteCommerce, you can:

- Offer quantity discounts to web store users
- Speed up the ordering process with SKU/reference ordering
- Provide users with the option to pick up in store
- Help users find your physical stores

**Quantity Pricing**

Offer users price discounts according to the various quantities ordered and encourage upsell.

**Quick Order**

Let users add multiple items to their cart quickly. Speed up the order process for users who are familiar with your catalog and prefer to shop using a stock-keeping unit (SKU), part number, or other reference numbers.

**Pickup In Store**

Allow users to collect orders at physical retail stores. Configure locations to accept pickup in store and limit pickup to certain hours within the day.

**Store Locator**

Help users find their nearest physical store or show a specified store address on a map. Combine with the Pickup In Store feature to allow users to pick up their purchases instead of having them shipped.
Quantity Pricing

 Applies to: Commerce Web Stores

This feature is available in the Elbrus release of SuiteCommerce Advanced and later.
This information refers to the Elbrus release of SuiteCommerce Advanced or later.

Note: Quantity Pricing feature relies on the Search API and is not available with SiteBuilder Extensions.

SuiteCommerce Advanced provides a Quantity Pricing feature for customers who offer quantity-based price breaks. This feature uses the Search API to return an item's quantity pricing details from NetSuite (in JSON format) and display results in a chart describing the pricing discounts available by quantity ordered. This information is collapsed by default and available at the shopper's request by clicking or tapping on a link.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-49</td>
<td>$24.99</td>
</tr>
<tr>
<td>50-99</td>
<td>$22.99</td>
</tr>
<tr>
<td>100-199</td>
<td>$20.00</td>
</tr>
<tr>
<td>+200</td>
<td>$18.00</td>
</tr>
</tbody>
</table>

Quantity pricing information is available to shoppers in the following areas of your website:

- Product details page
- Quick View modal window
- Quick Order page (Quick Order must be enabled)
- Request for Quote page (Quotes must be enabled)
- Product List Details page in My Account
- Re-Order List Page in My Account

To enable this feature, you must perform the tasks detailed in Set Up Quantity Pricing in NetSuite.
To disable this feature, edit the distro.json file as described in Disable Quantity Pricing.

Set Up Quantity Pricing in NetSuite

The JavaScript module for this feature is available by default with the Elbrus release bundle, but you must configure NetSuite to enable quantity pricing capabilities. For instructions on how to enable this feature in NetSuite, see the help topic Using Quantity Pricing.

Disable Quantity Pricing

Disabling this feature within NetSuite prevents quantity pricing data from appearing on your website. However, NetSuite recommends disabling this feature by editing the distro.json file. This method enhances response time and customer experience in your Commerce web store.
To disable the Quantity Pricing feature:

1. Open the distro.json file in the root directory of the SuiteCommerce Advanced source code.
2. Delete the following line, or otherwise disable within comment tags (where X.X.X equals the revision):

   ```json
   "suitecommerce/QuantityPricing": "X.X.X",
   ```

3. Search for and remove or disable any other lines that include `QuantityPricing` from the distro.json file.
Order Quantity

You can configure item records to enforce a minimum or maximum quantity on web store orders. You can define a minimum quantity limit, a maximum quantity limit, or both. Customers can submit an order only if the quantity of the item in the shopping cart complies with the limit you defined.

For SuiteCommerce, the Maximum Quantity for checkout is supported on Aconcagua and later releases.

Note: Enforcing maximum quantities is not supported when using Site Builder extensions.

To set a minimum or maximum quantity limit for an item:

1. Go to Lists > Accounting > Items.
2. Click Edit next to the item for which you want to restrict the quantity for sale.
3. On the Sales/Pricing subtab, use the appropriate field to set minimum or maximum quantity for checkout:
   - In the Maximum Quantity field, enter the greatest quantity of this item you want customers to be able to buy in the web store.
   - In the Minimum Quantity field, enter the lowest quantity of this item you want customers to be able to buy in the web store. For example, if the lowest quantity you want to sell is three, enter 3. If the customer tries to change this quantity to a lower number, a warning message is displayed.

   Note: You can edit the warning message at Setup > Site Builder/SuiteCommerce Advanced > Customize Text.

4. (Optional) Check the Enforce Minimum Internally box to apply the minimum quantity limit to sales orders placed in NetSuite as well as orders placed in the web store.
5. Click Save.
Quick Order

Applies to: Commerce Web Stores

This feature is available in the Elbrus release of SuiteCommerce Advanced and later. This information refers to the Elbrus release of SuiteCommerce Advanced or later.

Note: The Quick Order feature relies on the Search API and is not available with SiteBuilder Extensions.

Commerce web sites provide a Quick Order feature for shoppers who prefer to quickly search for and add multiple items to their cart. This feature is designed for merchants who allow catalog ordering or provide wholesale products on their site. Quick Order assists shoppers who are familiar with a merchant's catalog and wish to shop for items by Stock Keeping Unit (SKU), Part Number, or other identifier.

Shoppers can access the feature by clicking a link in the header or by entering their Cart and expanding the Quick Add accordion. Here, shoppers can quickly search for, add, and remove items. Shoppers can also adjust quantities in a list format, as opposed to browsing through the web store.

This feature is enabled by default with the Elbrus and later releases bundle of SuiteCommerce Advanced, but you must perform tasks detailed in Set up Quick Order in NetSuite to ensure proper operation.

To disable this feature, edit the distro.json file as described in Disable Quick Order.

More Information

Before setting up the Quick Order feature on your Commerce website, understand the following information:

- This feature does not support subsidiaries.
- Handling costs are not displayed in the summary total of the order, but they are added to the order total after the order becomes a purchase.
Set up Quick Order in NetSuite

Perform the following setup tasks in NetSuite:

- **Set up Search Fields**
- **Ensure Field Sets are Defined**

### Set up Search Fields

To allow customers to search your site for items in a quick order, you must create specific Search Fields in NetSuite. This optimizes searches by Stock Keeping Unit (SKU).

**To set up Search Fields for Quick Order:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click **Edit** next to the website you are setting up.
3. Click the **Search Index** tab and **Search Fields** subtab.
4. Add the following Search Fields and search criteria in the order listed:

<table>
<thead>
<tr>
<th>Search Field</th>
<th>Type of Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Starts With</td>
</tr>
<tr>
<td>Name</td>
<td>Exact</td>
</tr>
<tr>
<td>Name</td>
<td>Fuzzy</td>
</tr>
</tbody>
</table>

See [Select Search Fields](#) for detailed information on Search Fields.

### Ensure Field Sets are Defined

Before the Quick Order feature can function properly on your site, you must expose specific field sets to your website.

**To ensure Field Sets are defined:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click **Edit** next to the website you are setting up.
3. Click the **Field Sets** tab.
4. Ensure that the Items Searcher: itemsssearcher Field Set is in place as defined below.

<table>
<thead>
<tr>
<th>Name</th>
<th>Field Set ID</th>
<th>Fields Included in Field Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items Searcher</td>
<td>itemsssearcher</td>
<td>itemimages_detail: Item Images (Detail)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>displayname: Display Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>itemid: Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>storedisplayname2: Store Display Name 2</td>
</tr>
<tr>
<td>Name</td>
<td>Field Set ID</td>
<td>Fields Included in Field Set</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>urlcomponent</td>
<td>Field Set ID</td>
<td>URL Component</td>
</tr>
<tr>
<td>custitem_ns_pr_count</td>
<td>Field Set ID</td>
<td>Product Reviews Count (Custom)</td>
</tr>
<tr>
<td>custitem_ns_pr_rating</td>
<td>Field Set ID</td>
<td>Product Reviews Rating (Custom)</td>
</tr>
<tr>
<td>minimumquantity</td>
<td>Field Set ID</td>
<td>Minimum Quantity</td>
</tr>
<tr>
<td>itemoptions_detail</td>
<td>Field Set ID</td>
<td>Item Options (Detail)</td>
</tr>
<tr>
<td>matrixchilditems_detail</td>
<td>Field Set ID</td>
<td>Matrix Child Items (Detail)</td>
</tr>
<tr>
<td>isinstock</td>
<td>Field Set ID</td>
<td>In Stock</td>
</tr>
<tr>
<td>showoutofstockmessage</td>
<td>Field Set ID</td>
<td>Display Out-of-Stock Message</td>
</tr>
<tr>
<td>outofstockmessage</td>
<td>Field Set ID</td>
<td>Out of Stock Message</td>
</tr>
<tr>
<td>onlinecustomerprice_detail</td>
<td>Field Set ID</td>
<td>Price for Current Customer (Detail)</td>
</tr>
<tr>
<td>pricelevel1 formatted</td>
<td>Field Set ID</td>
<td>Retail Formatted</td>
</tr>
<tr>
<td>itemtype</td>
<td>Field Set ID</td>
<td>Type</td>
</tr>
<tr>
<td>ispurchasable</td>
<td>Field Set ID</td>
<td>Available for Purchase</td>
</tr>
</tbody>
</table>

See [Define Field Sets](#) for detailed information on Field Sets.

### Disable Quick Order

Disabling this feature requires editing the distro.json file.

**To disable the Quick Order feature:**

1. Open the distro.json file in the root directory of the SuiteCommerce Advanced source code.
2. Delete the following lines, or otherwise disable within comment tags (where X.X.X equals the revision):

```json
"suitecommerce/QuickOrder": "X.X.X",
"suitecommerce/QuickOrderAccessPoints": "X.X.X",
```

3. Search for and remove or disable any other lines that include `QuickOrder` or `QuickOrderAccessPoints` within the distro.json file.
Pickup In Store

 Applies to: Commerce Web Stores

This feature is available in the Elbrus release of SuiteCommerce Advanced and later. This information refers to the Elbrus release of SuiteCommerce Advanced or later.

Note: This feature is not supported in SiteBuilder Extensions. This feature does not support Multiple Ship To.

Pickup In Store offers a new order fulfillment choice for NetSuite customers. When you enable this feature, your customers have the option to pick up their orders at retail locations instead of paying to ship the items. This increases foot traffic and cross-selling opportunities at your retail locations.

Commerce web stores work with Order Management in NetSuite to provide the complete Pickup In Store feature. There are multiple Order Management tasks to configure in NetSuite.

- Configure your retail locations to allow Pickup In Store.
- Specify hours for pickup and give customers a cutoff time for pickup on the same day.
- Optionally, add location specific information in a memo field to be displayed on the Product Details Page.
- Create or modify a customized sales order form to fit Pickup In Store.
- Enable the Store Locator feature to show the nearest location to the customer.
- Set up inventory items to indicate whether they are eligible for pickup at retail locations.
- Set a stock buffer so that an item only appears as available for pickup if you have a specific amount of items in stock at the given location.

Review the following Order Management topics for more information.

- Store Pickup
- Store Locator
- Order Fulfillment and Shipping

In addition to the Order Management tasks, there are specific tasks to complete for a Commerce web store.

- Update Field Sets.
- Add the customized sales order form ID to your Commerce web store.

Limitations

Pickup In Store is not compatible with Scriptable Cart.

Prerequisites for Pickup In Store

Important: Before you set up the Pickup In Store feature on your Commerce web store, the Advanced Order Management module must be provisioned on your NetSuite account.

To ensure your account is ready for Pickup In Store:

1. Verify that the required features are enabled at Setup > Company > Enable Features:
Prerequisites for Pickup In Store

1. Go to the Company subtab in the Classifications area and verify that Locations is enabled.

2. Go to the Transactions subtab, scroll to the Shipping & Receiving area and verify that these features are enabled.
   - Advanced Shipping
   - Pick, Pack and Ship
   - Fulfillment Request
   - Store Pickup
   - Multiple Shipping Routes

3. Go to the Items & Inventory subtab in the Inventory area and verify that Multi-Location Inventory is enabled.

2. Set up automation as needed for your company. Enabling Run Automation is optional but considered a best practice.
   a. Go to Setup > Order Management > Advanced Order Management and in the Automation subtab under Shipping Orders, enable Run Automation according to your company needs.

   Enabling this setting automates a business event workflow in the back end of NetSuite. When business events occur on a sales order, NetSuite runs the corresponding automation processes according to the advanced order management settings. See the help topic Order Fulfillment Automation. For complete information, review all related topics.

   b. Under the Automation Process area, select Automatic Location Assignment or Both as needed for your company.

   The Pickup In Store feature requires that you select Automatic Location Assignment or Both so that a latitude and longitude can be added to the location record. Automatic Location Assignment works with the Store Locator feature to provide a geolocation for nearby stores based on the customer's current location. See the help topic Automatic Location Assignment for more information.

3. Verify that the Store Locator feature has been set up and configured according to the needs of your company.

   You must set up elevated permissions for the service file record. See Set up Store Locator in NetSuite for detailed instructions.

   You can also configure properties such as distance units, default location types, and Google Maps. See Configure Feature Properties and Google Maps Implementation for more information.

Set up Locations and Items

Complete these Order Management tasks in NetSuite to setup your locations and inventory items for Pickup In Store.

- Configure your retail locations to allow Pickup In Store.
- Set up inventory items to indicate whether they are eligible for pickup at retail locations.
- Create or update your customized sales order form for store pickup.

**Important:** When you customize a Sales Order Form for Pickup In Store, you add the Fulfillment Choice and Location fields as line item columns. Make note of the customized Sales Order Form ID so that you can assign the new form to your website.

For detailed instructions on setting up locations and items, see the help topic Setting Up Store Pickup.
Set up Pickup In Store in NetSuite

**Important:** For Pickup In Store to function, the Advanced Order Management module must be provisioned on your NetSuite account and you must enable specific features. See Prerequisites for Pickup In Store.

You must perform the following setup tasks in NetSuite to use Pickup In Store on your Commerce web store:

- Ensure Field Sets are Defined
- Enable Pickup In Store for SuiteCommerce Advanced

**Note:** The Commerce API has been updated to accommodate the Pickup In Store feature. See the help topics `updateItemFulfillmentPreferences(item)` and `updateItemsFulfillmentPreferences(items)` for details.

Two new fields have also been added to accommodate Pickup In Store for the Item Search API. See the help topic Sample Search Query for Returning Items Available for Store Pickup for more information.

**Ensure Field Sets are Defined**

Before the Pickup In Store feature can function properly on your site, you must expose specific field sets to your website.

**To ensure Field Sets are defined:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click **Edit** next to the website you intend to modify.
3. Click the **Field Sets** tab.
4. Ensure that each Field Set is in place as defined below.

**Important:** These fields are specific to the Pickup In Store feature and are additions to Field Sets that are already established. Do not replace entire field sets with these fields. See Define Field Sets for detailed information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Field Set ID</th>
<th>Fields Added to Field Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>details</td>
<td>isfulfillable: Can be Fulfilled/Received</td>
</tr>
<tr>
<td></td>
<td></td>
<td>istorepickupallowed: Store Pickup Allowed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quantityavailableforstorepickup_detail: Available For Store Pickup (Detail)</td>
</tr>
<tr>
<td>Matrix Child</td>
<td>matrixchilditems</td>
<td>isfulfillable: Can be Fulfilled/Received</td>
</tr>
<tr>
<td>Items</td>
<td></td>
<td>istorepickupallowed: Store Pickup Allowed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quantityavailableforstorepickup_detail: Available For Store Pickup (Detail)</td>
</tr>
<tr>
<td>Search</td>
<td>search</td>
<td>istorepickupallowed: Store Pickup Allowed</td>
</tr>
<tr>
<td>Order</td>
<td>order</td>
<td>istorepickupallowed: Store Pickup Allowed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>quantityavailableforstorepickup_detail: Available For Store Pickup (Detail)</td>
</tr>
</tbody>
</table>
Enable Pickup In Store for SuiteCommerce Advanced

Store Pickup has been enabled as part of the Order Management tasks. Now you must enable Pickup In Store as part of the SuiteCommerce advanced tasks.

**To enable Pickup In Store for SuiteCommerce Advanced**

1. Select the website and domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. Click Continue.
3. Click on the Checkout tab.
4. Check Enable Pickup In Store.
5. Enter the Pickup In Store Sales Order Custom Form ID.
   See the help topic Customizing the Sales Order Form for Store Pickup for details if you have not already completed this Order Management task.
6. Click Save.

Disable Pickup In Store

To disable Pickup In Store, you must complete these two tasks:

- Disable the feature in SuiteCommerce Advanced configuration.
- Remove the Pickup In Store fields from the field sets.

**To disable the Pickup In Store feature:**

1. Select the website and domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. Click Continue.
3. Click on the Checkout tab.
4. Clear the Enable Pickup In Store box.
5. Click Save.

**To remove the Pickup In Store fields:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to the web site.
3. Click the Field Sets subtab.
4. Remove the Fields related to Pickup In Store. See the table at Ensure Field Sets are Defined.
5. Click Save.
Store Locator

 Applies to: Commerce Web Stores

The Store Locator feature lets customers find physical store locations by searching your NetSuite account's Location records and returning results within proximity of the customer's location or any specified address. Besides locating a physical store in which to shop, the Store Locator is helpful for orders where the customer will pick up their items instead of having them shipped.

Important: The Store Locator feature uses the Google Maps JavaScript API. For this feature to work properly on your site, you must acquire an authentication API key from Google.

With this feature enabled, customers can:

- View store locations as a list and on an interactive map
- View stores near their current location
- Search for stores near a specific address, city, or zip code
- Choose from a list of results to view information about a location, including address and store hours
- View a complete list of all stores
- Get directions to a particular store

Customers access this feature by clicking the Store Locator link in the header. When the Store Locator page loads, customers have the option to enable geolocation. If enabled, SCA employs the customer's current location as the search origin point from which to find nearby stores. At any time, the shopper can enter a specific address as the search origin point.

The Store Locator feature relies on code within the Location module to perform search queries on NetSuite Location records. The StoreLocator Module extends these methods to return only specific locations based on settings you configure.
Example

You configure your site to return stores within 60 miles of the search origin point. The origin point can be an address entered by the customer or a point based on their location. You also set up your site to show the nearest three stores if no stores exist within the specified radius.

Later, a customer searches for stores on your site, using their current location as the search origin point. StoreLocator.Model.js extends methods in Location.Model.js in the backend. These models return only store locations based on your configuration settings (returning only stores within 60 miles of the customer’s location). If no stores exist within this radius, StoreLocator.Model.js returns the nearest three stores, ordered in descending distance from the search origin point.

**Note:** Currently, SuiteCommerce Advanced uses the secure domain associated with the Checkout application to display the Store Locator feature. This is largely transparent to the shopper, but the URL will reflect this.

Set up Store Locator in NetSuite

**Important:** For Store Locator to function, you must first set up Location records for your account. See the help topic Locations Overview for details.

To enable Store Locator on your site, set up Elevated Permissions for the StoreLocator.Service.ss file in NetSuite. When you install SuiteCommerce Advanced, NetSuite creates a custom Advanced Customer Center Role. You will use this role when setting up Store Locator.

To set Elevated Permissions for the service file record:

1. In NetSuite, go to Documents > Files > File Cabinet.
2. Browse to Web Site Hosting Files > Live Hosting Files > SSP Applications > [Applicable Bundle Folder] > Development > services.
4. In the File record, check the Enable without login option.
5. Click the Permission subtab.
6. Check the Enabled option.
7. In the Execute as role field, choose the custom Advanced Customer Center.
8. Check the Run Script without login option.
9. Save the record.

Configure Feature Properties

To configure Store Locator, use the SuiteCommerce Configuration record. Properties for the Google Maps API and general settings for the Store Locator feature are included in the Store Locator tab.

For more information on each configurable property, see the following sections:

- Store Locator Google Maps Subtab
- Store Locator Subtab
To configure properties for Store Locator:
1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the Store Locator tab.
3. Set feature properties as required.
4. Save the Configuration record.

Google Maps Implementation

SuiteCommerce Advanced uses Google Maps as the default map engine for Store Locator.

SCA uses a façade design pattern to implement Google Maps. This façade can be used as a guideline to integrate a new façade for a different maps engine.

SCA uses a JavaScript façade design pattern to implement Google Maps. This exists as the following modules and files:

- **StoreLocatorReferenceMapsImplementation.js**: contains the reference map façade to be used for any map implementation. It defines the properties to be configured and the methods used to implement the maps engine. The StoreLocator module’s Router and Views rely on this code, so do not make any customizations to this module.
  - **ReferenceMap.js**: contains signatures of operations that will override the logic specific to the maps implementation.
  - **ReferenceMap.Configuration.js**: serves as the façade for the Google Maps configuration. It declares the methods used to communicate with configuration options as defined in your NetSuite account.
- **GoogleMapsImplementation**: contains all the logic necessary to implement Google Maps as the base map for the Store Locator feature. The files within this module override each corresponding file in the StoreLocatorReferenceMapsImplementation module. If you want to implement a map engine other than Google Maps, you must create a new module to replace this one. Any new module must reference the StoreLocatorReferenceMapsImplementation façade.
  - **GoogleMap.js**: contains all the required implementation code to override the ReferenceMap.js file of the reference façade and allows the application to communicate with the Google Maps engine.
Google Maps Implementation

- **Google.Configuration.js**: serves as the façade to implement Google Maps as the base map when using the Store Locator feature. This file overrides the methods within the ReferenceMap.Configuration.js of the reference implementation.

Google Maps API Terms of Use and Usage Limits

To use the Google Maps API, you must agree to Google's license terms, obtain a Google Maps API key, and provide your API key to NetSuite.

**Note:** The standard Store Locator configuration results in a site that complies with Google licensing terms. Ensure that your site policies and any customizations you make to this feature do not violate Google Maps API terms.

Key points in the Google Maps API terms include:

- Your site must provide Store locator as a free service and must not be behind a firewall.
- Your company's Terms and Conditions page must contain a link to Google Maps APIs Terms of Service and state that Store Locator customers are bound by these Google terms.
- Your company's Privacy Policy must contain a link to the Google Privacy Policy.
- Your site must not remove or obscure Google branding.

Refer to the Google Maps APIs Terms of Service for the complete list of Google terms of service.

**Important:** Google Maps APIs are free for a wide variety of use cases; however, if you have a high-traffic website, be aware of Google Maps API usage limits. You can purchase a premium license from Google, or you can enable Google billing for high-traffic sites. See Google Map APIs Pricing and Plans for current Google pricing and plan details. To monitor daily map usage, use the Google API Console.

Implementing Alternate Maps Engines

Suite Commerce Advanced provides a way to implement alternative map engines.

**To integrate a different maps engine:**

**Note:** The following procedure uses XyzMap as an example. You can use the existing GoogleMap.js and Google.Configuration.js as a template for creating a new implementation.

1. Create a new module to replace the StoreLocatorGoogleMapsImplementation module. This new module must define the specific map engine implementation. Such a module might be titled StoreLocatorXyzMapImplementation.
2. Within this new module, create a new implementation file titled XyzMap.js, where Xyz is the name of the map engine you are implementing. This file will contain all the required implementation logic for making the specific maps engine function with SCA. This file must define ReferenceMap as a dependency and also implement all the functions defined as required for the map engine.
3. In the same manner, create a new Xyz.Configuration.js file. This file serves as the façade for the map engine configuration options. Make sure this module defines ReferenceMap.Configuration as a dependency and implements all the functions defined as required for the map engine.
4. Edit the distro.json file to reference your new module. Store Locator supports only one map engine, so you must delete the following line, or otherwise disable it behind comment tags. For example: Your edited distro.json code might look like this:
5. Deploy your code.

Disable Store Locator

This feature is enabled by default. To disable it, you must edit the distro.json file.

To disable the Store Locator feature:

1. Using code editor software, open the distro.json file in the root directory of the SuiteCommerce Advanced source code.
2. Delete (or disable within comment tags) any lines that include StoreLocator.
   For example:

   ```json
   "suitecommerce/StoreLocatorReferenceMapImplementation": "X.X.X",
   "suitecommerce/Location.SCA": "X.X.X",
   "suitecommerce/StoreLocatorAccessPoints": "X.X.X",
   "suitecommerce/StoreLocator": "X.X.X",
   "suitecommerce/StoreLocatorGoogleMapsImplementation": "X.X.X",
   "StoreLocatorAccessPoints",
   "StoreLocator"
   "StoreLocator.Model"
   "StoreLocator.ServiceController"
   ```
3. Delete (or disable within comment tags) the following line:

   ```json
   Location.sca
   ```
4. Save and redeploy the distro.json file.
Web Store Order Workbook Template

The SuiteAnalytics Web Store Order workbook template enables you to retrieve and visualize information related to web store orders based on the criteria you specify. You can group orders by item and the customers who ordered them, or you can group by customer and the items they ordered.

Accessing the web store order workbook template

1. In NetSuite, on the top navigation menu, click Analytics.
2. On the Analytics Home page, expand the list under Workbook Templates and click Web Store Orders.
   
   This displays the Web Store Orders workbook template.

   **Note:** At this stage, you may see a note displayed: Transactions in SuiteAnalytics Workbook. It provides information on how to use the Transaction record type in SuiteAnalytics Workbook. If you do not wish to see this message again, check the Don't show me again box and then click Let's start.

3. The workbook user interface includes multiple tabs:
   - The Dataset tab, which enables you to customize your workbook source data and criteria
   - The Pivot tab, which enables you to pivot your workbook source data
   - The Chart tab, which enables you to create visualizations such as charts using your workbook source data
   
   For more information about each tab, see the help topic Navigating SuiteAnalytics Workbook.

Workbook Overview

Charts

The following charts are included in this workbook:

- **Total Ordered Items per Website.** This chart displays the total number of items sold through the web store.
- **Total Item Value per Website.** This chart shows the sum of the totals from all orders made from a web store. Since the transactions can be made in different currencies, all amounts are converted to the base currency of your default subsidiary.

Workbook Configuration

<table>
<thead>
<tr>
<th>Root Record</th>
<th>Joined Records</th>
<th>Custom Formula Fields</th>
<th>Data Grid</th>
<th>Criteria Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction</td>
<td>Transaction Lines</td>
<td>The following custom formula fields are included in the workbook source data:</td>
<td>The following fields are included in the workbook source data:</td>
<td>The following criteria is used to filter the workbook source data:</td>
</tr>
<tr>
<td></td>
<td>Items</td>
<td>Quantity is calculated as:</td>
<td>Date(Transaction)</td>
<td>Date on or after start of this month</td>
</tr>
<tr>
<td></td>
<td>Entity Records</td>
<td></td>
<td>Internal ID(entity)</td>
<td>Source any of Web and SCIS</td>
</tr>
</tbody>
</table>

SuiteCommerce Store Front
### Custom Formula Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$\text{ABS}((\text{transactionlines.quantity})$</td>
</tr>
<tr>
<td></td>
<td>$\text{NVL}((\text{transactionlines.item}^{\text{item.stockunit.conversionrate}}), 1))$</td>
</tr>
</tbody>
</table>

### Data Grid

<table>
<thead>
<tr>
<th>Field</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal ID</td>
<td>$\text{ID}([\text{transaction})$</td>
</tr>
<tr>
<td>Item Name/Number</td>
<td>$\text{Name}([\text{item})$</td>
</tr>
<tr>
<td>Total Amount</td>
<td>$\text{Total Amount}([\text{Transaction})$</td>
</tr>
<tr>
<td>Website</td>
<td>$\text{Website}([\text{Transaction})$</td>
</tr>
</tbody>
</table>

### Criteria Filters

- Type is Sales Order
- Transaction Line: ID not equal 0
- Item: Display in Web Site is true
- Item: Inactive is false
- Item: Type any of Inventory Item and Assembly/Bill of Materials and Kit/Package and Non-inventory Item and Other Charge and Service and Discount and Download Item

## New Fields

The Web Store Order Workbook Template uses a new Website field that is not available in the NetSuite Report application.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Record Location in SuiteAnalytics Workbook</th>
<th>Join Path in SuiteAnalytics Workbook</th>
</tr>
</thead>
<tbody>
<tr>
<td>Website</td>
<td>Transation Website</td>
<td>Transation &gt; Website</td>
</tr>
</tbody>
</table>

### Pivot Tables

The following pivot tables are included in this table:

- **Web Store Orders.** This is a summary of the transactions submitted from the web store by item name. The Aggregate column lists the number of ordered items, the number of orders, and the number of unique customers. If you need to see the data segmented by year, quarter, or month, you can do so by adding the **Date** field to the table **Columns**, in the **Layout** panel. Note that the default criteria for this workbook includes data from SuiteCommerce InStore sites.

- **Items Ordered by Customers.** This pivot table displays the list of items purchased, the customers who bought them, and the web store the items were purchased through.

- **Customers Ordering Items.** This pivot table displays the list of customers that purchased items, the items that were purchased, and the web store the customers purchased those items through.
Order Status

Applies to: Commerce Web Stores | Site Management Tools

The Order Status extension lets you display billing and shipping information of a purchase order to users on your website.

After providing an order number and email address or Zip Code, both guests and registered users can view the following:

- Order fulfillment progress
- Payment summary
- Shipping details, including tracking numbers
- Pickup in store details, including store location

Registered users can log in to view their full purchase history, and guests have the option to register.

Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

To configure properties for the Order Status feature:

1. After activating the Order Status extension in a NetSuite Account, go to Setup > SuiteCommerce Advanced > Configuration.
   For more information on activating an extension, see Manage Themes and Extensions.
2. Select the website and domain where you want to set up the Order Status extension and click Configure.
3. Navigate to the Extensions tab.
4. In the Order Status subtab, fill out the listed fields for each category, using the tables below as references.
5. Click Save.

General Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Path</td>
<td>This sets the URL path for the order status page.</td>
</tr>
<tr>
<td>Page Title</td>
<td>This sets the text to display as the title of the Order Status and Order Details pages as displayed on your website.</td>
</tr>
</tbody>
</table>

Landing Page Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Description - Landing Page</td>
<td>This sets general information for the Order Status page.</td>
</tr>
<tr>
<td>Order Help Link - Landing Page</td>
<td>This sets the text to display for the Order Help link.</td>
</tr>
</tbody>
</table>
### Order Status Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Order Status Fields:</strong></td>
<td></td>
</tr>
<tr>
<td>Order Title - Order Status Page</td>
<td>This sets the title for the Order Status Page.</td>
</tr>
<tr>
<td></td>
<td>The placeholder {{ordernumber}} is replaced by the order number automatically.</td>
</tr>
<tr>
<td>Pending Approval - Order Status</td>
<td>This sets the status to display when the NetSuite order status is Pending Approval.</td>
</tr>
<tr>
<td>Pending Fulfillment - Order Status</td>
<td>This sets the status to display when the NetSuite order status is Pending Fulfillment.</td>
</tr>
<tr>
<td>Partially Fulfilled - Order Status</td>
<td>This sets the status to display when the NetSuite order status is Partially Fulfilled.</td>
</tr>
<tr>
<td>Pending Billing - Order Status</td>
<td>This sets the status to display when the NetSuite order status is Pending Billing.</td>
</tr>
<tr>
<td>Fulfilled - Order Status</td>
<td>This sets the status to display when the NetSuite order status is Fulfilled.</td>
</tr>
</tbody>
</table>
### Order Status

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billed - Order Status</td>
<td>This sets the status to display when the NetSuite order status is <strong>Billed</strong>.</td>
</tr>
<tr>
<td>Canceled - Order Status</td>
<td>This sets the status to display when the NetSuite order status is <strong>Canceled</strong>.</td>
</tr>
<tr>
<td>Closed - Order Status</td>
<td>This sets the status to display when the NetSuite order status is <strong>Closed</strong>.</td>
</tr>
</tbody>
</table>
| Date Ordered Label - Order Status | This sets the text to display the date on which the order was placed.  
  The placeholder `{orderdate}` is replaced by the order date automatically. |

### Order Summary Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary label - Order Summary Section</td>
<td>This sets the label for the Order Summary section.</td>
</tr>
<tr>
<td>Subtotal label - Order Summary Section</td>
<td>This sets the label for the Subtotal amount displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Discount Total label - Order Summary Section</td>
<td>This sets the label for the Discount Total amount displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Tax Total label - Order Summary Section</td>
<td>This sets the label for the Tax Total amount displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Shipping Total label - Order Summary Section</td>
<td>This sets the label for the Shipping Total amount displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Gift Certificate label - Order Summary Section</td>
<td>This sets the label for the Gift Certificate amount displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Order Total label - Order Summary Section</td>
<td>This sets the label for the Order Total amount displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Payment Information label - Order Summary Section</td>
<td>This sets the label for the Payment Information dropdown menu displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Payment Method label - Order Summary Section</td>
<td>This sets the label for payment method information displayed in the Order Summary section.</td>
</tr>
<tr>
<td>Credit Card label - Order Summary Section</td>
<td>This sets the label for the Credit Card field.</td>
</tr>
<tr>
<td>Billing label - Order Summary Section</td>
<td>This sets the label for billing information displayed in the Order Summary section.</td>
</tr>
</tbody>
</table>

### Order Table Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Item Column - Order Table   | This sets the label for the Item column in the Order Table.  
  This column displays the item name. |
| Quantity Column - Order Table | This sets the label for the Quantity column in the Order Table.  
  This column displays the amount ordered. |
| Status Column - Order Table | This sets the label for the Status column in the Order Table.  
  This column displays the status of the item. |
Shipping Status Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Without Fulfillment - Shipping Status Label</td>
<td>This sets the status to display when the NetSuite shipping status is Without Fulfillment.</td>
</tr>
<tr>
<td>Picked - Shipping Status Label</td>
<td>This sets the status to display when the NetSuite shipping status is Picked.</td>
</tr>
<tr>
<td>Packed - Shipping Status Label</td>
<td>This sets the status to display when the NetSuite shipping status is Packed.</td>
</tr>
<tr>
<td>Shipped - Shipping Status Label</td>
<td>This sets the status to display when the NetSuite shipping status is Shipped.</td>
</tr>
<tr>
<td>Ships To Different Address - Shipping Status Label</td>
<td>This sets the item shipping status label to display when multiple items on the same order are being shipped to different addresses.</td>
</tr>
<tr>
<td>Track Package - Shipping Status Label</td>
<td>This sets the label for the tracking number link.</td>
</tr>
</tbody>
</table>

Pickup Status Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Without Fulfillment - Pickup Status Label</td>
<td>This sets the status to display when the NetSuite pickup in store status is Without Fulfillment.</td>
</tr>
<tr>
<td>Picked - Pickup Status Label</td>
<td>This sets the status to display when the NetSuite pickup in store status is Picked.</td>
</tr>
<tr>
<td>Picked Up - Pickup Status Label</td>
<td>This sets the status to display when the NetSuite pickup in store status is Picked Up.</td>
</tr>
</tbody>
</table>

Additional Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Details Label</td>
<td>This sets the label for the link to the popup window outlining Shipping or Pickup in Store details.</td>
</tr>
</tbody>
</table>
| New Search Button | This sets the label for the New Search button.  
This button resets the customer’s current search to allow for a new one. |

After configuring the Order Status extension, both guests and registered users can view order status on your website.
Product Lists

**Applies to:** Commerce Web Stores

Product Lists (Wish Lists) provide the ability to group lists of items to be purchased from your web store. Using product lists, users in a business-to-business (B2B) or business-to-customer (B2C) environment can do the following:

- Flag items to be added to a product list as they are browsing in your web store.
- Create new lists when flagging items.
- Edit item order details from within the Product Lists pages.
- Move items between Product Lists.
- Add an entire list of products to the shopping cart with a single click.
- Use Product Lists to reorder lists of items.

**Note:** Product Lists are supported for SuiteCommerce sites only.

With Product Lists, users can add items to either a predefined Product List (Wish List) or to their own private list:

- **Predefined Product Lists:** Predefined lists are lists that are automatically available to your web store users. By default, a single predefined list, My List, is available. You can define multiple predefined lists for your store or configure your store with no predefined lists so that users must always create their own.
- **Private Product Lists:** By default, users can create their own private lists. They can add these lists on the Product Lists pages or create them when adding an item to a list. You can disable the ability for users to create their own private lists.

For example, you could provide two predefined lists for your web store, such as Gifts and Favorites. A user could then add to either of these predefined lists or they could create a new list, such as Christmas, and add the item to that list.

**Note:** Currently, both Predefined and Private product lists can only be viewed by the currently logged in user within a web store.

For more information on configuring a site for Predefined and Private lists, see Configuring Product Lists.

Product List Custom Records

When using the Product List feature, custom records are used to store and manage product lists for each customer. These custom records are accessed from the custom **SuiteCommerce Extensions** tab of the Customer record at Lists > Relationships > Customers > [customer record]. The Custom record components are installed as a separate bundle, **Reference Product Lists Records**. For detailed information on installing this bundle, see the help topic **Install Your Commerce Web Store Applications**.

**Note:** The Reference Product Lists Records bundle is required for the Elbrus release of SuiteCommerce Advanced even if Product Lists records are not leveraged for your implementation.

The following custom record components are added on installation of the bundle:

- **Lists:**
- **Product Lists Items Priority**: Defines the priority of each list. Currently this field is unsupported but in future releases this field will be used to enable the ability for sorting items within a list based on priority.

- **Product Lists Scope**: Defines the scope for the list as private, public or shared. Currently, only private lists are supported and each list is set as private by default. Private lists can be viewed and managed by the currently logged in user only. Public and shared lists will be supported in future releases.

- **Product Lists Type**: Defines the list as default, later, or predefined. All lists added by a user are automatically set to default. Lists set as predefined are available as a list for the user by default without them needing to create it. The later type is not currently implemented.

**Note:** We recommend defining predefined lists in the backend configuration file as described in Configure Properties. When predefined lists are defined in the configuration file, the list is automatically available to all users. The list is not defined on any customer record until that customer has added an item to that predefined list. When adding a predefined list to a customer record, it is available only for that customer.

- **Record Types:**
  - **Product Lists**: This record is used to manage product list data.
  - **Product Lists Items**: This record is used to manage item data associated with a product list record.

- **Subtabs**: A single SuiteCommerce Extensions subtab is used to display Product List data on the Customer record. This subtab is also used to display Product Review data on Item records.

You can customize these records as needed. For detailed information on working with custom records, see .

**Note:** If the Product List Custom Record bundle is not installed, Product Lists are not available in the Product Lists menu of My Account and errors are received when a user attempts to add an Item to a Product List within ShopFlow.

### SuiteCommerce Extensions Subtab

From the SuiteCommerce Extensions > Product Lists Subtab on the Customer Record you can manage Product Lists. You can drill down into each List and modify list attributes or modify Item attributes as needed.

**Important:** Generally, these records are intended to store and display data gathered from the web store frontend and in most cases should not be edited directly.
Note the following:

- Editing Product List attributes modifies that list for the current customer only, even if the List is a predefined template. The procedures to modify available predefined template attributes for all users depends on the version of SCA you are implementing. For details, see the help topic Wishlist Subtab.

- After a predefined template is modified or an item is added to a predefined product list in a Customer record, the existing template attributes take precedence over the corresponding predefined template attributes in the configuration file.

- For example, to change the Christmas list name to Christmas 2014 for the Customer record in this example, drill down into the Christmas list field and change the name field to Christmas 2014. Similarly, to change the My List list predefined template name for the current Customer only, drill down into the My List record and change the name field as needed. To change the My List record name attribute for all users, edit the name parameter for that template in the configuration file.

Note: Predefined templates are not intended to be modified on a per customer basis. To modify predefined templates, you should always edit the attributes in the configuration file to ensure changes are available for all customers.

- The scope attribute for a Product List is not supported by default in the ShopFlow or My Account application frontend. Changing this setting has no impact.

- The Item Options field on the Product Lists Items record reflects selected item options by the user. It is not intended to be directly edited. For example, for gift certificates, the recipient email and address are stored in this field.

Configuring Product Lists

Follow the correct configuration procedures below, depending on the version of SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic Wishlist Subtab.

Configuring Predefined Templates

Note: Only the default predefined list, My List, is automatically translated. When adding additional predefined lists, ensure that you edit the translation files as needed. Private lists created by users are not translated. For detailed information on translation see the help topic Localization.

To add predefined templates:

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the Shopping tab and the Wishlist subtab.
3. Set feature properties as required.
4. Save the Configuration record.

To add predefined templates (pre-Vinson):

1. In the SC.Configuration.MyAccount.js file, duplicate the list_templates function and rename the list.
2. Add predefined templates.
Configuring Item Display Options

**To configure display options:**

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the **Shopping** tab and the **Wishlist** subtab.
3. Set feature properties as required.
4. Save the Configuration record.

**To configure display options (pre-Vinson):**

1. Create a custom module that includes SC.MyAccount.Configuration object as a dependency. See the help topic **Configure Properties** for details.

   ![Note: Do not edit the original SC.MyAccount.Configuration.js source file directly. See the help topic Customize and Extend Core SuiteCommerce Advanced Modules for information and best practices on customizing JavaScript.]

   2. Redefine the `product_lists_templates` array in the custom module. For details on these properties, see the help topic **Display Modalities for Product List Items**.

The following example shows a possible configuration.

```javascript
, product_lists_templates: [
  {
    'templateid': '1',
    'name': 'My List',
    'description': 'sample predefined template',
    'scope': {
      'id': '2',
      'name': 'private'
    }
  },
  {
    'templateid': '1',
    'name': 'New List',
    'description': 'new sample predefined template',
    'scope': {
      'id': '2',
      'name': 'private'
    }
  }
]
```
```json
{
  id: 'list',
  name: 'List',
  columns: 1,
  icon: 'list-header-view-icon-list',
  isDefault: true
},
{
  id: 'condensed',
  name: 'Condensed',
  columns: 1,
  icon: 'list-header-view-icon-condensed'
}
```
Transaction Lists

 Applies to: Commerce Web Stores

SuiteCommerce and SuiteCommerce Advanced let you configure how your site displays historical transaction information in the My Account area of your site.

You can configure the following transaction lists to include specific fields as columns. You can also add custom fields and the order in which each column displays.

- Returns
- Quotes
- Order History
- Open Invoices
- Paid Invoices

**To configure transaction columns:**

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the site that you want to configure from the Select Website list.
3. Select the specific domain that you want to configure from the Select Domain list.
4. Click **Configure**.
5. Click on the My Account tab and the Transaction List Columns subtab.
6. Enable each type of transaction list you want to configure. You can choose from the following:
   - Return Authorization Columns
   - Quotes Columns
   - Order History Columns
   - Invoice Columns

   **Important:** If you enable column management for a list, the configuration settings on the Transaction List Columns subtab take precedence over any other configuration. For example, if you are integrating SCIS with your site and enable columns management, your My Account transaction columns render according to these settings. To retroactively add any columns from your SCIS integration, you must create them manually.

7. Configure the Transaction List Columns table for each list you enabled.
   Add a line for each field you want to display on your site as a column. The list order determines the order in which columns display on your domain (top-to-bottom, left-to-right), as shown in the example below.
   - The ID property must match the Field ID of the field being displayed.
   - The Label property sets the label that displays on your domain.

   **Note:** Some columns, such as Purchase No. are mandatory and cannot be configured.

See the help topic Transaction List Columns Subtab for more details on each configuration property.
Save For Later

Applies to: Commerce Web Stores

Using Save For Later, users can move items from the Cart to a list for later reference and then add items from the Save For Later list directly to the Cart.

Note: The Save for Later feature is built on the same architecture as Product Lists.

Save for Later provides the following functionality:

- Items in the Save for Later list are restored with each login session.
- By default, users can change the quantities in the Save for Later list.
- When an item in a Save for Later list goes out of stock, that item can no longer be added to the Cart and an out of stock message is displayed.
- When a shopper is not logged in they are redirected to the Login page when the Save for Later button for an item in the cart is clicked.

Prerequisites

The following are prerequisites for using Save for Later on your site:

- Installed Reference Product Lists Records bundle: By default the Save For Later module is enabled but you must have the Reference Product Lists Records bundle installed in your account for the feature to work correctly. This bundle installs the custom records used to store and manage items in Save for Later lists for each logged in user. Note that a Save for Later list is just a type of a Product List so we leverage the same custom records used for Product Lists. For details on using the Reference Product List Records, see Product List Custom Records.
- Login: Before shoppers can move an Item to the Save For Later list, they are prompted to login.

Configuration Options

The correct configuration procedure depends on the version of SuiteCommerce Advanced you are implementing.

To configure the a Product List as Save for Later:

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the Shopping tab and the Wishlist subtab.
3. To create a list as Save for Later, enter 2 for the Type ID. Set the remaining fields as desired. For more information on, see the help topic List Templates.

To configure the a Product List as Save for Later (pre-Vinson):

By default, a Save for Later template is defined within the product_lists object in the backend configuration file.

1. Create a custom module that includes the backend Configuration object as a dependency.
2. Modify the **description** and **name** parameters as desired.

   The Type ID must be set to 2 for the list to function as a Save for Later list.

   ```javascript
   { 
      templateid: '2'
      , name: 'Saved for Later'
      , description: 'This is for the cart saved for later items'
      , scope: { 
          id: '2'
          , name: 'private'
        }
      , type: { 
          id: '2'
          , name: 'later'
        }
    }
   ``

3. Save and deploy to your site.
Quotes

Applies to: Commerce Web Stores

This feature is available in the Mont Blanc release of SuiteCommerce Advanced and later.
This information refers to the Mont Blanc release of SuiteCommerce Advanced or later.

Note: In NetSuite, quotes or quotations are often referred to as estimates.

Commerce web sites offer a feature for customers to create quotes online. With this feature enabled, a Request a Quote link appears by default to all customers (logged in or not) in your site's Shopping and My Account header. These links direct customers to a page where they can search for and add items, enter shipping information, and add optional comments to build a quote request. After the customer submits the quote, Commerce web stores automatically create an Estimate record in NetSuite. Only customers with permissions to build quotes have this option. Customers without permissions are prompted to contact the merchant. An Add to Quote button also appears on the PDP for any customers with request-a-quote permissions.

Customers can eventually make purchases from a quote, but only after the quote reaches a certain status in the corresponding Estimate record. You configure the status that triggers this functionality. You can also configure the time (in days) that all quotes expire after initial submittal.

More Information

Before setting up the Quotes feature on your Commerce website, understand the following information:

- This feature does not function in Site Builder Basic. Site Builder Premium supports making purchases from a quote, but only Commerce web stores support creating a quote.
- This feature does not support subsidiaries.
- Customers can add items to a quote, regardless of the item's out of stock behavior.
- Handling costs are not displayed in the summary total of the quote, but they are added to the order total after the quote becomes a purchase.
- Parent matrix items cannot be added to a quote, only specific child items.
- The Multiple Ship To feature is not available.
- The product details page displays an Add to Quote button. This is only visible by customers with permissions to create a quote.
- Gift Certificates cannot be added to quotes.
- When a customer submits a quote, Commerce web stores do not automatically send an e-mail notification of the submission by default. This action can be set up in NetSuite as a Workflow Action (see the help topic Workflow Elements) or as a User Event Script (see the help topic User Event Scripts).

Set up Quotes in NetSuite

Perform the following setup tasks in NetSuite to enable Quotes on your site:

- Edit Customer Center Role Permissions
Set up Quotes in NetSuite

- Enable Features
- Set up Search Fields
- Ensure Field Sets are Defined
- Customize the Standard Quote Form

NetSuite also recommends installing the latest Reference Product List Records bundle. This bundle includes the custom records used to store and manage items in quotes for each logged in customer.

Note: The Quotes feature functions without the Reference Product List Records bundle installed. However, items built in a product list will be non-persistent and will be lost if the customer leaves the site before submitting the quote. Installing the Reference Product List Records bundle ensures that product list items are persistent. Shipping information and comments are non-persistent, regardless of bundle installation.

See the help topic Install Your Commerce Web Store Applications for details on installing bundles.

Edit Customer Center Role Permissions

To let shoppers create quotes and view their quote basket, you must edit the Customer Center role in NetSuite.

To edit the Customer Center role permissions for Quotes:

1. Navigate to Setup > Users/Roles > Manage Roles.
2. Click Customize next to the Customer Center role.
3. On the Transactions subtab, change the level of access for the Estimate permission to Create.
4. Click OK to accept the change.
5. Click Save to save your changes.
6. Provide customer access to the Customer Center role. See the help topic Giving Customers Access for detailed information.

Note: Customers can add and remove items to the product list when they build a quote. However, after submitting the quote, customers cannot edit them.

Enable Features

To allow customers to convert quotes to an order, verify that the Online Ordering and Customer Access features are enabled.

To enable Online Ordering and Customer Access features:

1. Go to Setup > Company > Enable Features.
2. Click the Web Presence subtab.
Set up Quotes in NetSuite

4. Click Save.

**Note:** If these features are not enabled, the Review and Place Order button is not displayed in the web store.

Set up Search Fields

To allow customers to search your site for items, you must create specific Search Fields in NetSuite. This optimizes searches by Stock Keeping Unit (SKU). This step is required for a search to function, even if the customer chooses not to search by SKU.

**To set up search fields for quotes:**

1. Navigate to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to the website you are setting up.
3. Click the Search Index tab and Search Fields subtab.
4. Add the following Search Fields and search criteria in the order listed:

<table>
<thead>
<tr>
<th>Search Field</th>
<th>Type of Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Starts With</td>
</tr>
<tr>
<td>Name</td>
<td>Exact</td>
</tr>
<tr>
<td>Name</td>
<td>Keyword</td>
</tr>
</tbody>
</table>

See Select Search Fields for detailed information on Search Fields.

Ensure Field Sets are Defined

Before the Quotes feature can function properly on your site, you must expose specific field sets to your website.

**To ensure field sets are defined:**

1. Navigate to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to the website you are setting up.
3. Click the Field Sets tab.
4. Ensure that the Items Searcher: itemssearcher Field Set is in place as defined below.

<table>
<thead>
<tr>
<th>Name</th>
<th>Field Set ID</th>
<th>Fields Included in Field Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items Searcher</td>
<td>itemssearcher</td>
<td>itemimages_detail: Item Images (Detail)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>displayname: Display Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>itemid: Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>storedisplayname2: Store Display Name 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>urlcomponent: URL Component</td>
</tr>
<tr>
<td></td>
<td></td>
<td>custitem_ns_pr_count: Product Reviews Count (Custom)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>custitem_ns_pr_rating: Product Reviews Rating (Custom)</td>
</tr>
</tbody>
</table>
Set up Quotes in NetSuite

<table>
<thead>
<tr>
<th>Name</th>
<th>Field Set ID</th>
<th>Fields Included in Field Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>minimumquantity</td>
<td></td>
<td>Minimum Quantity</td>
</tr>
<tr>
<td>itemoptions_detail</td>
<td></td>
<td>Item Options (Detail)</td>
</tr>
<tr>
<td>matrixchilditems_detail</td>
<td></td>
<td>Matrix Child Items (Detail)</td>
</tr>
<tr>
<td>istinstock</td>
<td></td>
<td>In Stock</td>
</tr>
<tr>
<td>showoutofstockmessage</td>
<td></td>
<td>Display Out-of-Stock Message</td>
</tr>
<tr>
<td>outofstockmessage</td>
<td></td>
<td>Out of Stock Message</td>
</tr>
<tr>
<td>onlinecustomerprice_detail</td>
<td></td>
<td>Price for Current Customer (Detail)</td>
</tr>
<tr>
<td>pricelevel1</td>
<td></td>
<td>Retail pricelevel1</td>
</tr>
<tr>
<td>formatted</td>
<td></td>
<td>Retail (Formatted)</td>
</tr>
<tr>
<td>itemtype</td>
<td></td>
<td>Type</td>
</tr>
<tr>
<td>ispurchasable</td>
<td></td>
<td>Available for Purchase</td>
</tr>
</tbody>
</table>

See Define Field Sets for detailed information on Field Sets.

Customize the Standard Quote Form

Commerce web stores rely on NetSuite's Estimate record to manage each quote. The Estimate record uses the Standard Quote form, which does not display shipping information by default. You must customize the Standard Quote form to allow the customer to edit the shipping address. This is also required for the customer to make a purchase from a quote.

To customize the Standard Quote Form:

1. In NetSuite, go to Customization > Forms > Transaction Forms.
2. Click Customize next to the Standard Quote form (Form Type: Quote).
3. Click the Screen Fields tab and the Shipping subtab.
4. Check the box in the Show column next to the Ship To label to display the shipping address.
5. Save your changes.

Configure Feature Properties

Follow the correct configuration procedures, depending on the version of SuiteCommerce or SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic Quotes Subtab.

Set the Customer Internal ID

For a customer to make a purchase from a quote, configure the Internal ID of the Customer Status that will allow the quote to be purchased.
After a customer submits a quote request, any website links to Review or Purchasing pages are disabled. This prevents customers from making a purchase from that quote until the merchant allows it.

In NetSuite, the Estimate record's **Status** field lists all available Customer Statuses for the quote. When the merchant manually changes this field to the Customer Status whose Internal ID matches the **purchaseReadyStatusId** property, all website links to Review or Purchasing pages are enabled. The customer can then make a purchase.

**Note:** Additionally, the customer must have the correct Customer Center role permissions, a shipping address and method must be defined, the merchant must have a sales rep associated to the quote, and no gift certificates can be associated with the quote in NetSuite.

The Customer Status List (Setup > Sales > Customer Statuses) displays the Customer Statuses configured for your account and their associated Internal IDs. You declare the Internal ID of the Customer Status in your site configuration.

### Example

You want your quotes to be available for purchase when they reach the **Qualified** status.

In NetSuite, you set up your account to include the **Qualified** Customer Status. You navigate to Setup > Sales > Customer Statuses and see that NetSuite has assigned an Internal ID of 7 for this status. You redefine the **purchase_ready_status_id** property to 7.

Later, a customer creates a quote on your site. Seven days later, your sales team changes the associated Estimate record’s **Status** field to **Qualified**. The **purchase_ready_status_id** property now matches the Customer Status record's Internal ID, and the quote is available for purchase. The **Review and Place Order** button is now enabled, and the customer can continue with the purchase. After the customer places an order, the quote becomes a Sales Order record in NetSuite.

**Note:** For detailed information on working with sales orders and customizing sales order forms, see the help topic **Sales Orders** under Order Management.

Follow the correct configuration procedures, depending on the version of SuiteCommerce or SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic **Quotes Subtab**.

**To configure the Customer Status Internal ID:**

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the My Account tab and the Quotes subtab.

3. Enter the Customer Status Internal ID for the Purchase Ready Status ID.

**To configure the Customer Status Internal ID (pre-Vinson):**

1. In NetSuite, navigate to Setup > Sales > Customer Statuses.

2. Note the Internal ID of the Customer Status you want that will allow customers to make purchases. You will use this Internal ID to configure code later in this procedure.

**Note:** The Customer Status List displays the Internal IDs for all Customer Statuses set up in your account. The Customer Status you choose cannot be a closed status. A closed status is one that indicates the customer either already purchased (100% probability) or will not purchase (0% probability). Open Estimate records can only be given open Customer Statuses. See the help topic Customer Statuses for information on adding a Customer Status.

3. Create a custom module that includes the backend Configuration object as a dependency. See the help topic Configure Properties for details.

**Note:** Do not edit the original Configuration.js source file directly. See the help topic Customize and Extend Core SuiteCommerce Advanced Modules for information and best practices on customizing JavaScript.

4. Redefine the purchase_ready_status_id property in the custom module. Enter the value of the Customer Status record's Internal ID as noted above.

**Important:** This value must match a valid Internal ID for Customer Status as defined in NetSuite. Leaving this value empty prevents any quote from becoming a purchase. This property has a default value of 12, which is associated with the Purchasing Customer Status.

5. Save and deploy to your site.

**Set Quote Expiration**

After a customer makes a purchase, the quote is considered closed and NetSuite creates a Sales Order record linked to the original Estimate Record. Quotes that have expired cannot become purchases, regardless of the quote's status. You specify a positive value equal to the number of days you want all quotes to remain valid.

**Example**

You want your quotes to remain valid for 14 days after the initial RFQ. You configure the days_to_expire property to 14. Any quote created on your site has 14 days to become a purchase after initial submittal. If the customer in this example waits 15 days to make a purchase, the customer will no longer be able to make a purchase from this quote.

Follow the correct configuration procedures, depending on the version of SuiteCommerce or SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic Quotes Subtab.

**To configure the quote's expiration:**

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the My Account tab and the Quotes subtab.

3. Enter the days until expiration in the Days to Expiration field. A value of 0 results in the value in the sales preference record determining the quote expiration date.

4. In the Days Before Expiration Notification field, enter the number of days before a quote expires that you want an expiration notification to display on your website.

To configure the quote's expiration (pre-Vinson):

All quotes use the same configurable expiration, in days. After this time expires, the quote can no longer become a purchase.

1. Create a custom module that includes the backend Configuration object as a dependency. See the help topic Configure Properties for details.

Note: Do not edit the original Configuration.js source file directly. See the help topic Customize and Extend Core SuiteCommerce Advanced Modules for information and best practices on customizing JavaScript.

2. Redefine the days_to_expire property in the custom module.

Define an Invoice Form

To let customers create a purchase from a quote, you must specify the transaction form used to create the purchase.

Important: Without a transaction form, customers cannot create a purchase from a quote. See the help topic Sales Orders for detailed information.

Follow the correct configuration procedures, depending on the version of SuiteCommerce or SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic Quotes Subtab.

To define the invoice form:

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.

2. In the SuiteCommerce Configuration record, navigate to the My Account tab and the Quotes subtab.

3. Enter the invoice form ID in Invoice Form ID.

To define the invoice form (pre-Vinson):

1. In NetSuite, navigate to Customization > Forms > Transaction Forms.

2. Find the Standard Sales Order - Invoice form.

Note: As a best practice, NetSuite recommends using the Standard Order - Invoice form with this feature. NetSuite cannot guarantee the outcome when using customized forms of different types.

3. Note the Internal ID of the form in the Custom Transaction Forms list.

4. Create a custom module that includes the backend Configuration object as a dependency. See the help topic Configure Properties for details.
5. Redefine the `invoice_form_id` property in the custom module to match the Internal ID of the form as noted above.

Customize Sales Representative Information

You can customize the sales representative information that appears on your site's Quote Details page. What displays on your site depends on the `SalesRep` field on the quote's Estimate record in NetSuite.

- If the `SalesRep` field for the quote lists a sales representative whose contact information (phone number and e-mail address) is set up in NetSuite, that information will appear on the Quote Details page.
- If the `SalesRep` field lists a sales representative whose contact information is not set up in NetSuite, your site will default to display customizable contact information found in the configuration.
- If the `SalesRep` field is blank, your site will display two disclaimer messages, one under the Order Summary and one at the bottom of the page. You can customize the text of these messages in the configuration, as shown below.

Follow the correct configuration procedures, depending on the version of SuiteCommerce or SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic Quotes Subtab.

To customize the SalesRep information:

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the My Account tab and the Quotes subtab.
3. Configure `defaultPhone`, `defaultEmail`, `disclaimer`, and `disclaimerSummary` properties as required.
4. Save the Configuration record.

To customize the SalesRep information (pre-Vinson):

1. Create a custom module that includes the SC.MyAccount.Configuration object as a dependency.

   **Note:** Do not edit the SC.MyAccount.Configuration.js file directly. See the help topic Customize and Extend Core SuiteCommerce Advanced Modules for information and best practices on customizing JavaScript.

2. Redefine the `defaultPhone` and `defaultEmail` properties in the custom module to match the desired information. For example:
3. Configure `defaultPhone`, `defaultEmail`, `disclaimer`, and `disclaimerSummary` properties as required.
4. Save and deploy to your site.

Customize Request a Quote Properties

You can customize the following Request a Quote properties for your site:
To customize the Request a Quote properties:

1. Select the domain to configure at Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the My Account tab and the Quotes subtab.
3. Configure the Request a Quote Bottom Message, Request A Quote Business Days, Show ‘Request a Quote’ Hyperlink, and Hyperlink Text properties as required.
4. Save the Configuration record.

Disable Quotes

After setting up the Quotes feature, a Create a Quote link appears by default to all customers (logged in or not) in the Shopping and My Account header, letting customers create their own quotes. You can configure SuiteCommerce or SuiteCommerce Advanced to disable this functionality, allowing shoppers to view quotes and make purchases, without creating quotes directly using your site.

To disable the Create a Quote functionality:

1. Open the distribution file (distro.json).
   The distro.json file is located in the root directory of your SCA distribution (above the Modules directory).
2. Remove all lines within this file that contain either of the following references:

   RequestQuoteAccessPoints
   RequestQuoteWizard

3. Save the distro.json file and rebuild the distribution.
Overview

Applies to: Commerce Web Stores

An attractive and functional design is only the start of making your web store effective. You also need to actively reach out and attract new customers and offer an interactive and engaging omnichannel experience for shoppers, guiding them through the shopping process. SuiteCommerce offers all the tools you need to manage your marketing efforts. You can:

- Offer various types of promotions and discounts
- Generate new sales opportunities with correlated and related items
- Personalize your website with merchandising zones to display complementary products based on search criteria or custom content delivery pages
- Communicate directly with customers by using personalized email templates and newsletter subscriptions
- Convert shoppers into your brand ambassadors with social sharing

Promotions in Commerce Web Stores

Attract shoppers to your web store by offering various types of promotions or discounts, including Item, Fixed Price Item, Order, Shipping, and Free Gift promotions and let them combine coupon codes with other promotions. With SuitePromotions, you can combine promotions on the same transaction and automatically apply eligible promotions.

Storefront Merchandising Tools

Generate up-sell opportunities by suggesting complementary and best-selling products and offering pre-paid gift certificates.

Advertising

Inform customers about your products and advertise your brands and success stories.

SuiteCommerce Customer Management

Determine the registration process for your website, allowing users to sign in as new or existing customers or check out as guest shoppers.
Communications

Personalize how you address customers by customizing web store email templates, manage newsletter subscriptions and add social sharing capabilities.

Product Reviews

Configure and manage product reviews. With product reviews, users can submit reviews for items and review ratings submitted by other users.

Product Comparison

Allow users to create a side-by-side comparison of up to four products. You can configure the comparison page and select the item fields to include in the comparison table.
Promotions in Commerce Web Stores

Applies to: SuiteCommerce Advanced | Elbrus | Kilimanjaro | Aconcagua

SuitePromotions set up transactions that provide various types of discounts to users including:

- **Item**: A percentage or currency amount discount on items
- **Fixed Price Item**: A fixed discounted price on items
- **Order**: A discount applied at the order level
- **Shipping**: A discount providing free shipping on specific shipping methods
- **Free Gift**: A discount in the form of an item provided free to users meeting specific order criteria (available in Aconcagua only)

To apply an item, fixed price item, order, or shipping promotion in the web store, users enter a coupon code associated with a NetSuite promotions record.

**Note:** Although you must specify a coupon code when creating a Free Gift promotion, users do not need to enter the code to receive the free gift offer. Free Gift promotions are automatically applied during the checkout process in the web store. Free Gift is not supported in the My Account Request a Quote workflow.

Site users can:

- Apply or remove multiple promo codes in their shopping cart and when reviewing their order during checkout.
- View an error message if a promo code cannot be added to an order.
- View discount totals.
- View applied promotions on the Order Details page.
- Apply single-use and multi-use coupon codes.
- Remove a free gift from the shopping cart page.

Site administrators can:

- Configure the site to automatically apply eligible promotions to a transaction.
- Automatically apply the best promotion to transactions eligible for multiple promotions.
- Audit promotions activity to view and track promotions applied to a transaction.

**Note:** NetSuite does not provide default policies for promotions. Use Site Management Tools (SMT) to create a landing page and add the details of the free gift Terms and Conditions and Returns policies to that page. Also using SMT, you can add a link to the landing page in your site footers.

Set Up SuitePromotions for Commerce Web Stores

To prepare your site to use SuitePromotions:

1. Enable SuitePromotions features.
2. Set up SuitePromotions records.

**Step 1: Enable SuitePromotions Features**

1. In NetSuite, go to Setup > Company > Enable Features.
2. On the Transaction tab, check the following boxes in the Sales section:
   - Promotion Codes
   - SuitePromotions
   - Auto-apply Promotions
3. Save the record.

**Step 2: Set Up SuitePromotions Records**

Follow these steps using the referenced help topic links:

1. Create SuitePromotions. See the help topic SuitePromotions.
2. Apply promotions and view the status of applied promotions. See the help topic Applying Promotions and Discounts to a Transaction.
3. Get the most out of SuitePromotions. See the help topic SuitePromotions Best Practices.

**Step 3: Configure SuiteCommerce Advanced to use SuitePromotions**

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain to configure then click Continue.
3. On the Shopping Catalog tab, check Allow Adding More Than One Promocode.
4. Click Save.
5. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
6. Click the Edit link for your website.
8. Click Save.

**Known Limitations of SuitePromotions on Commerce Web Stores**

Be aware of the following known limitations of SuitePromotions when used in Commerce and Site Builder web stores:

- SuitePromotions are not supported on Site Builder extensions.
- SuitePromotions require SuiteCommerce or the Kilimanjaro release of SuiteCommerce Advanced and later.
- SuitePromotions uses Audience to support the Partners types of promotions. See the help topic Setting Customer Eligibility on SuitePromotions for details.
- Users can view the aggregate discount, but they cannot view line-item discount amounts.
- Posting types can not be mixed. Any associated discount and mark-up items must be all posting discounts or all non-posting discounts. See the help topic Discount and Markup Items in Advanced Revenue Management for details.
- The **Apply Discount To** property can only be set to **All Sales**. Otherwise unexpected issues can arise with your site.
- Auto-Apply promotions have a limit of 30 promotions per transaction.
- Auto-Apply Promotions cannot be removed manually or by using the Commerce API.
- Free Gift promotions do not work with the **Multi Ship To** feature.
- Best Offer logic does not apply to Free Gift promotions.
- Parent matrix items cannot be selected as a free gift.
- Items with options cannot be selected as a free gift.

### SuitePromotion Notifications on Commerce Web Stores

When properly configured to use Auto-Apply promotions, the application provides a list of applied promo codes based on rules defined in the promotions record. Notifications are displayed to help users understand which promotions are applied to their order as they shop.

Changes in the list of applied promotions can occur when users do the following:

- Add or remove items in the cart
- Increase or decrease the item quantity
- Add or remove a promo code
- Change the shipping address or method

The following notifications can be returned:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>When the promo code is applied</td>
<td>Promotion PROMOCODE is now affecting your order</td>
</tr>
<tr>
<td>When the promo code is not applied because of best offer logic</td>
<td>We have chosen the best possible offer for you. Promotion PROMOCODE is not affecting your order.</td>
</tr>
<tr>
<td>When the promo code is not applied because requirements are not met</td>
<td>Promotion PROMOCODE is not affecting your order. ERROR_MESSAGE.</td>
</tr>
</tbody>
</table>

### Developer Reference

This section includes some technical details that may be useful for developers when troubleshooting or performing more advanced implementations.

- **Auto-Apply Promotions API**
- **URL Parameters for Promotions**

### Auto-Apply Promotions API

When the Auto-Apply feature is enabled, the `applyPromotionCode(promocode)` order method behaves in the following manner:
If the promotion code that you are applying delivers a better value to the shopper than the exclusive promotion, the promotion code is accepted and the exclusive promotion is removed.

From both manually and automatically applied promotions, the best combination of promotions is computed and applied to a transaction.

When troubleshooting auto-apply promotions, the following fields in the promocode JSON object results can be useful:

- **is_auto_applied**: determines if the promotion code is applied manually or automatically.
- **applicability_status**: determines if the promotion code is actually applied to the sales order or not.
- **applicability_reason**: determines the reason a promotion code was not applied.

**Note:** You can also determine the auto-apply statuses from NetSuite promotion records. See the help topic Viewing the Status of Applied Promotions.

### URL Parameters for Promotions

Several URL parameters for promotions are available. These are query strings that can be passed through the URL to automatically add specific promotions to the user's shopping cart. URL parameters are useful for tracking marketing campaigns and during e-mail campaigns.

The following Promotions URL parameters are available:

<table>
<thead>
<tr>
<th>URL Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>promocode</td>
<td>To add multiple promotion codes, you can specify the promocode parameter in the URL multiple times.</td>
</tr>
<tr>
<td></td>
<td>For example, ?promocode=FIFTYPERCENT&amp;promocode=10OFF10.</td>
</tr>
<tr>
<td>promocodeaction=add</td>
<td>Specifying promocodeaction=add mimics the default behavior and is not required. The default behavior is to add any promocodes specified in the URL to the order.</td>
</tr>
<tr>
<td>promocodeaction=overwrite</td>
<td>Setting promocodeaction=overwrite causes the promocodes passed to overwrite any existing promocodes previously set in that domain.</td>
</tr>
<tr>
<td></td>
<td>Use the overwrite URL parameter to sync promocodes when bridging between domains.</td>
</tr>
<tr>
<td></td>
<td>For example: Suppose a shopper has added items to the cart. The shopper then applies promocodes to that order in the checkout domain but then returns to the shopping domain and specifies new promocodes. Setting promocodeaction=overwrite causes the promocodes specified in the shopping domain to overwrite those specified in the checkout domain.</td>
</tr>
</tbody>
</table>
Marketing strategy and planning is about getting your products to consumers at the right place, at the right time, and at the right price.

Commerce web stores let you:

- Guide consumers in their decision-making by suggesting complementary products
- Generate up-sell opportunities by personalizing the static items to be displayed in conjunction or automating the selection based on the consumer’s buying behavior
- Highlight top-selling items prominently by allowing shoppers to sort product lists by best sellers
- Feature entire product categories and individual items to attract consumers' attention
- Encourage business by offering customers gift wrap options and prepaid stored-value money cards for future purchases
- Promote collections featuring various curated looks by displaying a look book of must-have styles

Product Merchandising

The Product Merchandising SuiteApp lets you define and display merchandising zones on your ecommerce site. Merchandising zones display complementary, cross-sell or up-sell products. The content for merchandising zones is generated from interactive elements that display dynamic groups of items based on search rules you define.

For example, on a sporting goods store website, a shopper has narrowed the search criteria on a page to display men's featured items. You want to market various accessories to this shopper too. You define a merchandising rule to search for accessories and display the results in a merchandising zone on the page whenever the search criteria are narrowed to display men's shirts.

With Product Merchandising, you can:

- Add merchandising zones within the site's template
- Easily incorporate custom content in merchandising zones
- Create merchandising rules to target content display based on specific selection criteria
Important: The Product Merchandising SuiteApp is currently only available with the SuiteCommerce Advanced feature.

Product Merchandising Overview

When using the Product Merchandising SuiteApp, a product merchandiser or marketing manager must work with a web developer to set up site templates with merchandising zones. After the initial setup is complete, these zones can be targeted with different content defined within merchandising rules without the need to rely on a developer for further customization.

Note: Good initial planning in the types of merchandising zones required will simplify the maintenance of sites and reduce the need for development costs.

The workflow for how a merchandising zone is implemented is as follows:

- First, the product merchandiser works with a developer to define the selection criteria that would result in certain products to display. Selection criteria is based on available facets and sort options defined during the SuiteCommerce Advanced Web Site Setup.
- The developer adds merchandising zones to website template files or creates new templates as needed to accommodate the desired display. These templates call the merchandising rule that initiates a query to the item search API, which then returns item data as requested by the rule.

Note: If Content Delivery pages are used for the display of the Merchandising Rules, these pages must be defined after the Product Merchandising rules are defined. See the help topic Content Delivery Integration for details on using the Content Delivery SuiteApp.

- The developer provides the product merchandiser with the Merchandising IDs to be used when setting up merchandising rules.
The product merchandiser defines the Product Merchandising rules based on the information used from the developer.

Create a Product Merchandising Rule

Product Merchandising rules can be defined after you have coordinated with your developer to define the merchandising zones that will be available on your website. Refer to Product Merchandising Overview.

To create a merchandising rule:


2. Enter a Merchandising ID for this merchandising rule.
   This ID is used as a key by your website template to display the corresponding merchandising rule parameters. A list of available IDs should be provided by your website developer.

   **Note:** If desired, you could first define the Product Merchandising rules and then provide your developer with the appropriate Merchandising IDs. The Merchandising IDs must match EXACTLY to what the developer is using when defining the content templates. When Content Delivery pages are used for defining merchandising zones, active Product Merchandising IDs are automatically available for selection during the Enhance or Landing page setup.

3. Enter a Title for your merchandising rule.
4. In the Description field, enter a short description of this rule.
5. Enable Inactive if this rule should NOT be used in the website at this time.

   **Important:** Merchandising rules that are defined as Inactive are NOT available in Content Delivery records.

6. Select the website this rule is displayed in.
   Merchandising rules are only available in SuiteCommerce Advanced websites.
7. Select a field set to define the information your website uses when displaying item results. Field sets are defined during the initial site setup at Setup > SuiteCommerce Advanced > Set Up Web Site > Field Sets. Only those field sets associated with the selected website are available.

8. Enter the maximum **Number of Results** you want the rule to return. The number entered here should match the ideal number that can be accommodated by the page design for these items in your website.

   **Note:** Use a value only between 0 and 100 for the **Number of Results**.

9. Enter your **Filter** criteria:

   You can filter items based on Search Index Facet Fields defined for your website at Setup > SuiteCommerce Advanced > Set Up Web Site > Search Index. Facet fields are defined during the initial Web Site Set Up and are used in the website to determine item filter criteria available on the website. For detailed information on defining Facet Fields, refer to **Select and Configure Facet Fields**.
1. If desired, enable the **Apply on Current Selections** check box. When enabled, the current search criteria is included in the query to the item search API.

2. In the **Filter** column, select a field from the dropdown menu. The fields displayed are determined by the website chosen in Step 6. After a filter is selected, a popup for setting up values opens. Depending on the type of field selected the options available for your filter vary. Fill in the filter criteria you need for your rule.

![Screenshot of Filter setup](image)

**Note:** Depending on the type of field you can again select whether the item will only be displayed if it matches the search criteria of the current session as described in Step 9. If desired, enable the **Apply on Current Selections** check box by enabling **Current Selection**.
Important: When working with matrix items, you may get inconsistent results if values set for custom fields vary from the matrix parent compared to the matrix child. To avoid this, set the custom field for the desired result on the parent item and then use More Actions > Update Matrix to set the child items as needed.

3. Click Set to close the popup, and then Add to save the line.

10. Enter your Sort criteria:

You can sort items based on Sort defined for your website at Setup > SuiteCommerce Advanced > Set Up Web Site > Sort Fields. Sort fields are defined during the initial Web Site Set Up and are used in the website to determine the sort order of search results. For detailed information on defining Sort Fields, refer to Sort Fields.

1. In the Sort column, select which field you want results sorted by.

Fields available are determined by the website chosen in Step 6. After a filter is selected, a popup for setting up values opens. Depending on the type of field selected the options available for your filter vary. Fill in the filter criteria you need for your rule.

2. Select Ascending or Descending in the Sort Option column.

3. Click Add.

Sorting is applied in the order each field is entered.

11. Define Advanced options:

In the Advanced tab you can specify Items to exclude and whether a custom template should be used for this rule. Check with your developer if a custom template needs to be specified. If left blank the default template is used.

12. Click Save.

Product Merchandising rules are now available for your website. If not already done, your developer will need to set up Product Merchandising zones that call these rules from your website template files. After rules are defined and called from a website you can modify the rule as needed without need for further development work.

If you use the Content Delivery SuiteApp, you can also use merchandising rules to define the search results to display in a content area. For more information, see the help topic Content Delivery Integration.

Prepare Pages for Product Merchandising Zones

This section describes how to prepare Commerce web store pages for Product Merchandising zones. Preparing pages for Product Merchandising zones should be done by your web application developers as it involves editing code within the related page.

Configure the Reference Implementation

To call Merchandising Rules from your site pages, you must first configure the SuiteCommerce Advanced SSP to include the merchandising script.

To include the Product Merchandising script:

1. Go to Setup > SuiteCommerce Advanced > SSP Applications.

2. Click Edit next to the SuiteCommerce Advanced SSP application used for the web site where product merchandising is used. For example, SuiteCommerce Advanced — Dev [version].
3. In the **Libraries** subtab under **Scripts**, click **Add**.

4. Navigate to the path of the `dynamic_merchandising_library_v2.js` file in the Product Merchandising reference installation.

5. Click **Save**.

**Merchandising Zone Content**

Merchandising Rules are defined in your NetSuite account. SuiteCommerce SMT enables you to place merchandising zone content on a page by dragging it from the side panel and dropping it in a pre-defined area on the page. The scope of the area where you place the merchandising zone determines when it is displayed.

- If the scope of the area is **all pages**, then the merchandising zone displays on any page that contains that area.
- If the scope of the area is **page type**, then the merchandising zone displays on any page of that type.
- If the scope of the area is **this page**, then the merchandising zone displays only on the page to which you add it.

For more information on creating merchandising rules, see [Product Merchandising](#).

**Merchandising Zone Template File**

The formatting of the merchandising zone content and the information that is displayed is defined by the merchandising zone template file. For more information on the merchandising zone template file, see [Merchandising Zone Template](#).

**Note:** Any changes including additions, edits, or deletions must be published before they are available on the site.

**To add merchandising zone content:**

1. Go to the page where you want to add the merchandising zone content.
2. Click **Add** on the site management toolbar.
3. Drag the merchandising zone content from the side panel and drop it in the area where you want to place it. When you drop the content, the Merchandising Zone Settings are displayed in the side panel.
4. Set the content visibility options. See the help topic [Visibility Dates](#).
5. Select the **Merchandising Rule** from the dropdown list.
The list displays all merchandising rules defined in your NetSuite account.

6. Click Save.

Note: The Exclude items in shopper's cart and Exclude item shopper is viewing boxes only report the settings for the rule in NetSuite. You cannot change those settings here.

To remove merchandising zone content:

1. Go to the page that contains the merchandising zone.
2. Point to the merchandising zone. This highlights the zone and displays the content controls.
3. Click Remove. This displays a warning that asks if you want to expire the content.
4. Click OK.

See the help topic Discard Content Vs Expiring Content.

To change merchandising zone content:

1. Go to the page that contains the merchandising zone.
2. Point to the merchandising zone. This highlights the zone and displays the content controls.
3. Click Edit, and the side panel displays the Merchandising Zone Settings.
4. Make your change.
5. Click Save.

Merchandising Zone Template

Any merchandising zone added to an area uses the standard SMT merchandising zone template by default. This template is applied to the zone automatically if the merchandising rule does not specify a different template. You can use this default template file or you can create custom merchandising zone templates to format the merchandising zone to display exactly the way you want.

Default Merchandising Zone Template

The default SMT merchandising zone template is located in the file cabinet at:

Web Site Hosting Files > Live Hosting Files > SSP Applications > NetSuite Inc. — CMS > CMS > [Application Name] > Published > Templates > merchzone_default.txt

The default merchandising zone template displays the item image and a See More button for each listed item. Clicking the image or the button takes the visitor to the item detail page for the selected item.

merchzone_default.txt

```html
<% var items_per_row = 4, grid_columns= 12 / items_per_row; %>
<aside>
  <div class="row-fluid">
    <% _.each(data.items, function (item, index) { %>
```
Correlated and Related Items

**Applies to:** Commerce Web Stores

Correlated and related items create up-sell opportunities by displaying additional items to shoppers. Related items represent static item relationships that are defined on individual item records within NetSuite. These can be items that you want to promote or complementary items associated with the item in the shopping cart. For example, if you are selling a T-shirt, you may want to suggest a pair of pants or a sweatshirt.

Correlated items are dynamically created from the site statistics based on the shopper’s buying behavior, such as the ratio of items added to the shopping cart versus those that were ultimately purchased. The list of correlated items is updated every 30 days.

In Commerce web stores, you can:

- Customize the related items to be displayed
- Display correlated and related items on the item’s Product Details and View Cart pages of your website
- Define the correlation and lift thresholds to be used for calculating correlated items
- Specify how many correlated and related items are displayed on your website
Architecture Overview

The correlated and related items architecture functions in the following manner:
1. The Item.Details.View.js file contains two child views, one for correlated items and one for related items.

2. The ItemRelations.Correlated.View.js and ItemRelations.Related.View.js child views invoke a fetch request to the corresponding collection.

3. The ItemRelations.Correlated.Collection.js and the ItemRelations.Related.Collection.js modules call the Search API for correlated and related items, respectively.

4. The Search API syncs with the data stored in NetSuite.

5. The ItemRelation.Correlated.View.js and ItemRelation.Related.View.js files receive the correlated or related items from the Search API.

Set Up NetSuite

To display correlated and related items on your web store, you need to perform the following steps:

- Add related items on item records
- Define required field sets

Step 1. Add Related Items on Item Records

Related item definitions must first be added to an item record to display in a web store. See Related Items for detailed information.
Correlated and Related Items

Note: For performance reasons, a maximum of 100 related items per item record is recommended.

Note: Correlated items are not customizable. These are determined by the purchasing history and are automatically stored on each Item Record as read-only information.

Step 2. Define Required Field Sets

Important: If you are using the Checkout Application within a Site Builder site (Site Builder Extensions edition), the required Fields Sets are defined in the configuration within the SspLibraries module. Normally, you do not need to do additional configuration for the related and correlated items to display.

ItemsKeyMapping

The ItemsKeyMapping.js file defines three Related Items properties, which map information returned from the Item Search API. The following snippet shows these mappings. This file is located within the Item module. However, for pre-Elbrus releases of SCA, this file is located within the ItemsKeyMapping module.

```javascript
// @property _relatedItems Related items
  , _relatedItems: 'related_items'

// @property _relatedItemsDetail _relatedItemsDetail Related items in the PDP.
  , _relatedItemsDetail: 'relateditems_detail'

// @property _correlatedItemsDetail Correlated (Up-sell) items in the PDP.
  , _correlatedItemsDetail: 'correlateditems_detail'
```

To ensure that the necessary information from the Search API is available, you must define the following required Field Sets in your Web Site Setup page. For more information on defining Field Sets, see Define Field Sets.

Note: For detailed descriptions of these fields, see Derived Fields for Field Sets.

<table>
<thead>
<tr>
<th>Name</th>
<th>Field Set ID</th>
<th>Fields Included in Field Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correlated Items</td>
<td>correlateditems</td>
<td>All the same fields as included for search</td>
</tr>
<tr>
<td>Correlated Items Details</td>
<td>correlateditems_details</td>
<td>correlateditems_detail: Correlated Items (Detail)</td>
</tr>
<tr>
<td>Related Items</td>
<td>relateditems</td>
<td>All the same fields as included for search</td>
</tr>
<tr>
<td>Related Items Details</td>
<td>relateditems_details</td>
<td>relateditems_detail: Related Items (Detail)</td>
</tr>
</tbody>
</table>

If you are using a setup script, these field sets are automatically defined. See the help topic Set Up Initial Field Sets for detailed information.

For search fields required, see the help topic Set Up Web Site Record

Related Items

You can use related items in your web store to cross-sell products that complement each other.
For example, an electronics web store created a related items group containing cables, extension cords and surge protectors. When a customer views a monitor on the site, the list of related items displays, and she can navigate to the additional products she needs.

There are two ways you can use related items in NetSuite:

- **Related Item Groups** – You first create groups of related items. Then, you add these groups to items you sell in your website.
- **Related Items** – You can also associate individual items to items you sell on your website.

### Create Related Item Groups

A related items group is a set of items you can choose to recommend with other items in your website.

For example, Wolfe Electronics creates a related items group that contains items like cables, extension cords and surge protectors. Wolfe chooses to include this related item group with monitors it sells in its website. When customers view Wolfe’s monitors, they can navigate to the other products they need.

**To create a related item group:**

1. Go to Setup > Suite Commerce Advanced > Related Items Categories > New.
2. In the Category field, enter a name for this related item group. You will select this Category name when adding related item groups to items later in Step 10.
3. (Optional) In the Brief Description field, enter a short message describing this group.
4. On the Basic subtab, select an item from the list. Each item’s brief description appears in the Item Description field.
5. Click Add.
6. Repeat steps 4 and 5 to add other items to this group.
7. When you have finished, click Save.
8. Go to Web Site > Publishing > Items.
9. Click Edit next to the item with which you want to associate the related items group.
   a. Click the Related Items subtab
   b. In the Related Item column, select the related item group from the list of categories.
   c. Click Add.
10. Click Save.

Your related items group now appears with the item you are selling in your website.

**Note:** If you use multiple websites, note that items only display on websites specified on the item record. For example, if you include item A and item B in the same related items group, then you must publish both items to the same websites, if you want the two items to always appear together.

### Associate Individual Related Items

If you do not want to associate an entire group of items with an item, you can select individual related items on an item record.

**To associate related items to an item you sell online:**

1. Go to Go to Web Site > Publishing > Items.
2. Click **Edit** next to the item you want to add a related item to.
3. Click the **Web Store** subtab.
4. Find the **Related Items** sublist.
5. In the **Related Item** column, choose an item to associate with the item you are selling.
6. Click **Add**.
   Click **Add Multiple** to add several items quickly.
7. When you have finished, click **Save**.

Now your related items appear beneath the item you are selling in your website.

### Configure Views

By default, the number of correlated and related items displayed is only limited by the number of correlated and related items set up in NetSuite. The view displays these items within one row. You can change the number of correlated or related items displayed and how they are displayed by customizing the associated view files.

**To specify the number of correlated or related items to display:**

1. Create a custom module that includes the following objects as dependencies, depending on the views you are customizing.
   - **ItemRelations.Correlated.View** – to set the behavior of Correlated Items displayed.
   - **ItemRelations.Related.View** – to set the behavior of Related Items displayed.

   **Note:** Do not edit the original **ItemRelations.Correlated.View.js** or **ItemRelations.Related.View.js** source files directly. See the help topic **Customize and Extend Core SuiteCommerce Advanced Modules** for information and best practices on customizing JavaScript.

2. Customize either **ItemRelations.Correlated.View** or **ItemRelations.Related.View**, depending on the manner of your customization:
   - To edit the number of items displayed per row, customize the appropriate view and extend the **viewsPerRow** property of the initialize method. Replace **Infinity** with a number equal to the number of items you want to display.
   - To add rows displaying correlated or related items, customize the appropriate view to add the **rowCount** property to the initialize method. Specify a number for the value equal to the number of rows you want to display. Without specifying a **rowCount**, the default is one row.

### Best Sellers

**Applies to:** Commerce Web Stores

The Best Sellers extension adds a sorting option that lets you showcase best-selling items in your web store. Best Sellers can be used in several ways:

- Sort your product list page by best-selling items
- Set up specific merchandising zones to showcase best-selling items
Best Sellers adds additional fields to your item records that are considered when calculating best-selling item sorting. You can choose to exclude specific items or override the best seller calculation to highlight specific items in the product list, custom landing pages, and merchandising zones. You can use either sales quantity or sales amount to determine whether an item is a best seller for a given period.

Installation

The Best Sellers extension does not require activation for a specific website or domain. However you need to install the SC Best Sellers SuiteApp. For more information, see Install Theme and Extension SuiteApps.

To install the SC Best Sellers SuiteApp:

1. In NetSuite, go to Customization > SuiteBundler > Search & Install Bundles.
2. In the Keywords field, enter the Bundle ID or ‘best sellers’ and click Search.
3. Verify that the SC Best Sellers SuiteApp is returned in the search and select it.
4. Review the SuiteApp details and then click Install.

Best Seller Fields in the Item Record

When you install the Best Sellers extension, the following fields are added to your Item record, in the SuiteExtensions tab, Best Sellers subtab:

- Exclude From Calculation
- Override Calculation
- Last 7 Days – Sales Quantity
- Last 30 Days – Sales Quantity
- Last 90 Days – Sales Quantity
- Last 365 Days – Sales Quantity
- Last 7 Days – Sales Amount
- Last 30 Days – Sales Amount
- Last 90 Days – Sales Amount
- Last 365 Days – Sales Amount

Best Seller Calculation

When the Best Sellers extension is installed, all items are automatically included in the calculation by default. When the best seller calculation script is run, the item's accumulated sales quantity and amount for a given period are entered in the best seller fields in the Item record. These values are used to create a list of items with the highest sales amount or highest sales quantity. The script is run when the Best Sellers extension is installed for the first time to take into account all existing transactions. It is then run daily at the end of the day to consider the current day's transactions.
Exclude Items From Best Seller Sorting

You may decide that you do not want an item to appear as a best seller in your web store if it is a low-margin item, for example. You can choose to exclude it from the automatic calculation by selecting the Exclude From Calculation box. When you select this option, all sales amount and sales quantity fields are set to 0 for this item and you cannot change the values. The item is no longer included in the calculation.

If you want to re-include an item in the best seller calculation, clear the Exclude From Calculation box. The sales amount and sales quantity for the given periods are re-calculated when the best-seller calculation script is run again.

Override Best Seller Sorting

You may decide that you want an item to appear as a best seller in your web store, even though it has a lower sales turnover. You can manually change the best seller calculation by selecting the Override Calculation box. When you select this option, you can enter values in the sales amount and the sales quantity fields for the various periods. To force an item to be listed as the best seller, you must enter the highest sales quantity or sales amount value for that period. You can determine this value by executing a saved search with the appropriate criteria.

You can choose to override the best seller calculation for all periods or for a specific period. The fields that you do not change retain the values from the last calculation.

To remove the override, clear the Override Calculation box. The sales amount and sales quantity for the given periods are re-calculated when the best seller calculation script is run again.

Set Up Best Sellers in the Web Store

To make best-selling items available as a sorting option, facet, or search criteria in your web store, you must first add it to your Web Site Setup record.

To set up a best seller field as a search, facet, or sort field for your website:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site and click Edit for the website where you want to set up best seller sorting.
2. Navigate to the Search Index tab.
3. Go to the Search Fields, Facet Fields, or Sort Fields subtab, depending on whether you want to use Best Sellers as a search, facet, or sort option.
   For more information on search settings, see Search Settings Overview.
4. In the Field Name list, select the best seller custom fields and click Add.
   You can add any or all of these fields according to whether you want to determine best-selling items by sales quantity or sales amount.
5. Click Save.

Best Seller Fields

The SuiteCommerce Best Sellers extension adds the following fields to the Item record to calculate the best seller rating:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last 7 Days – Sales Amount</td>
<td>custitem_ns_sc_ext_ts_7_amount</td>
</tr>
<tr>
<td>Last 7 Days – Sales Quantity</td>
<td>custitem_ns_sc_ext_ts_7_quantity</td>
</tr>
</tbody>
</table>
Apply Best Seller Sorting in the Web Store

You can use the Best Sellers extension in several ways in your web store:

- Sort option for product lists
- Facet for filtering product list pages
- Selection criteria for product merchandising rules

Best Sellers in Product Lists

When you have set up best sellers as a sort field for your web store, you can use it for sorting your product list page.

To include best seller sorting in your product list page:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Select your website and domain and click Continue.
3. In the Search tab, Results Sorting subtab, in the ID column, enter the field ID of the best seller sort option you want to display in your web store for Desktop, Phone and Tablet screen formats and the sort order.
   
   For example, custitem_ns-sc_ext-ts-30-amount:asc for best sellers from the last 30 days, sorted in ascending order.

   For a list of the sort options available, see the Best Seller Fields table.
4. Enter the text you want to display for the sort option in the Name field and click Add.
5. Click Save.

Best Sellers as Facets

You can access a product list page containing only best-selling items by setting up the best seller field as a facet and using it as a URL parameter. For example, domain.com/search?order=custitem_ns-sc_ext-ts-30_amount:desc. For more information on using facet fields as URL parameters, see Facets as Parameters

Best Sellers in Product Merchandising Zones

You can also use best seller sorting in a merchandising rule to feature your best sellers more prominently in a merchandising zone.

To do this, you first must create a merchandising rule. For more information on how to set up merchandising rules, see Product Merchandising.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last 30 Days – Sales Amount</td>
<td>custitem_ns_sc_ext_ts_30_amount</td>
</tr>
<tr>
<td>Last 30 Days – Sales Quantity</td>
<td>custitem_ns_sc_ext_ts_30_quantity</td>
</tr>
<tr>
<td>Last 90 Days – Sales Amount</td>
<td>custitem_ns_sc_ext_ts_90_amount</td>
</tr>
<tr>
<td>Last 90 Days – Sales Quantity</td>
<td>custitem_ns_sc_ext_ts_90_quantity</td>
</tr>
<tr>
<td>Last 365 Days – Sales Amount</td>
<td>custitem_ns_sc_ext_ts_365_amount</td>
</tr>
<tr>
<td>Last 365 Days – Sales Quantity</td>
<td>custitem_ns_sc_ext_ts_365_quantity</td>
</tr>
</tbody>
</table>
When you have created a best sellers merchandising rule, you can then add a merchandising zone with this rule to your website using Site Management Tools. For more information, read Merchandising Zone Content.

Featured Category

ℹ️ Applies to: Commerce Web Stores | Site Management Tools

The Featured Category extension lets you highlight a commerce category on your website. This extension allows you to customize your featured category's appearance and behavior. You can choose how many items you want to show and add a button to link to the category page. For each item highlighted in the featured category section, you can display the product image, name, and price. Clicking on an item takes users to the product detail page (PDP) for more information and purchasing options.

To use this extension, you must enable Commerce Categories for your Commerce web stores and create at least one category. To set up a commerce category, see Commerce Categories.

⚠️ Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

ℹ️ Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

This topic explains how to:
- Add a Featured Category
- Configure a Featured Category
- Remove a Featured Category

Use Site Management Tools (SMT) to add, configure, or delete a featured category on multiple areas of your website. Adding this content type to enhanced or custom landing pages allows you to promote a category in the place and style you want. For more information on Site Management Tools, see the help topic SMT Overview.

Add a Featured Category

To add a featured category to your webstore, add the Featured Category content type to a page of your site using SMT.

**To add a featured category:**

1. In your website, navigate to the page where you want to add a featured category.
2. Log in to SMT.
   For more information on logging in to SMT, see the help topic Users and Roles.
3. In Edit mode, click Add on the Site Management toolbar.
4. Drag the Featured Category content type to the page.

ℹ️ Note: If you do not see this content type, ensure that the extension has been installed and is active. Click Settings on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

You can drag a Featured Category content type to multiple areas on the page.
Configure the settings to best fit your needs.
See Configure a Featured Category.

Configure a Featured Category

Configure properties to customize your featured category. You can decide how to sort the items, adjust the display options, and choose the header and button texts.

The following procedures explain how to:

- Configure general settings
- Configure layout and style settings

**To configure general settings:**

1. While logged in to SMT on your website, navigate to the page that contains the featured category.
2. In the **Featured Category** box, click **Edit**.
   This displays the Featured Category Settings in the side panel.
3. In the **General** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sets the name for the featured category banner.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Determines the visibility option that determines when you want to make the featured category visible. For more information on visibility options, see the help topic Visibility Dates.</td>
</tr>
<tr>
<td>Category ID</td>
<td>Links the internal ID of the commerce category you want to feature with this content type. To find the internal ID, navigate to the Commerce Category record in NetSuite (Lists &gt; Web Site &gt; Commerce Categories).</td>
</tr>
<tr>
<td>Item Sorting</td>
<td>Determines the sorting option for the featured products. You can only use the best sellers sorting options if you have installed SC Best Sellers. For more information, see Best Sellers.</td>
</tr>
<tr>
<td>Show Item Names</td>
<td>If checked, displays the item name with the item picture in the featured category section.</td>
</tr>
<tr>
<td>Show Item Prices</td>
<td>If checked, displays the item price with the item picture in the featured category section.</td>
</tr>
<tr>
<td>Tags</td>
<td>Sets keywords to help filter your content in the Review Changes list. For more information on content tags, see the help topic Content Tags and Filter Tools.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**To configure layout and style settings:**

1. While logged in to SMT on your website, navigate to the page that contains the featured category.
2. In the **Featured Category** box, click **Edit**.
This displays the Featured Category Settings in the side panel.

3. In the **Layout & Style** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Sets the title for the featured category section. Basic HTML formatting tags are supported.</td>
</tr>
<tr>
<td>Header Alignment</td>
<td>Determines how you want to position the header in the featured category section.</td>
</tr>
<tr>
<td>Link Header</td>
<td>If checked, links the header to a commerce category or a custom URL. You can list the custom URL in the <strong>Custom Category URL</strong> field.</td>
</tr>
<tr>
<td>Category Button Text</td>
<td>Sets the button text. This button redirects shoppers to the commerce category page. If you leave this field blank, the button does not appear.</td>
</tr>
<tr>
<td>Category Button Style</td>
<td>Sets the button style. The button style definition is taken from your theme.</td>
</tr>
<tr>
<td>Custom Category URL</td>
<td>Determines the custom URL (relative or absolute) to which you want the header and button to link. If you leave this field blank, the header and category button direct users to the linked commerce category page (determined by the <strong>Category ID</strong> field in the <strong>General</strong> tab). For the header to link to this custom URL, check the <strong>Link Header</strong> box. For the button to link to this custom URL, enter a label in the <strong>Category Button Text</strong> field.</td>
</tr>
<tr>
<td>Number Of Items - Mobile</td>
<td>Determines how many items you want to display on mobile devices.</td>
</tr>
<tr>
<td>Number Of Columns - Mobile</td>
<td>Determines how many columns you want to use to display items on mobile devices.</td>
</tr>
<tr>
<td>Number Of Items - Tablet &amp; Desktop</td>
<td>Determines how many items you want to display on tablet and desktop devices.</td>
</tr>
<tr>
<td>Number Of Columns - Tablet &amp; Desktop</td>
<td>Determines how many columns you want to use to display items on tablet and desktop devices.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

### Remove a Featured Category

Depending on whether you have published the content to your website, use SMT to delete the featured category content type from your site in one of two ways:

- **Discard** the featured category if you have not published the content.
- **Remove** the featured category if you have already published the content.

**To discard a featured category (Unpublished Content):**

1. While logged in to SMT on your website, select the **Review & Publish Changes** list from the Site Management toolbar.
2. Select the **Featured Category** content in the list.
3. Click **Discard**.
4. Click **OK**.

**To remove a featured category (Published Content):**

1. While logged in to SMT on your website, navigate to the page that contains the featured category content you want to remove.
2. In **Edit** mode, click the **Featured Category** box.
   - This highlights the featured category content and displays the content controls.
3. Click **Remove**.
4. Click **OK**.

**Featured Product**

ℹ️ **Applies to:** Commerce Web Stores | Site Management Tools

The Featured Product extension lets you highlight a recommended product on your website in a featured section. You can customize the appearance and the behavior of the Featured Product section. You can display the item's availability and price, and add a ribbon to the product. You can display the product image or upload a new image to be shown.

⚠️ **Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see [Commerce Extensions](#).

ℹ️ **Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

When you enter a product ID, the product information is retrieved from the Item record. You can choose to hide or show the product's availability.

You can use the product image taken directly from the Item record or upload a new image. If there are multiple images associated with the Item record, the first image is displayed. Your theme's image placeholder is used if there are no images in the Item record or if you have entered the ID of a matrix child item.

If you make pricing information available to all customers, the item's price is also shown. For matrix items with different prices, a price range is displayed.

You can add a featured product to multiple areas on your website using Site Management Tools. For more information on Site Management Tools, see the help topic [SMT Overview](#).

**To add a featured product:**

1. Go to the page where you want to add a featured product.
2. Click **Add** on the Site Management toolbar.
3. Drag the **Featured Product** content type to the page.

ℹ️ **Note:** If you do not see this content type, check that the extension has been installed and is active. Click the **Settings** button on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

You can drag the Featured Product content type to multiple areas on the page:
If you drag it to an area marked as all pages, then the content displays on any page that contains that area.

- If you drag it to an area marked as page type, then the content displays on any page of that type.
- If you drag it to an area marked as this page, then the content displays only on the page that you add it to.

4. In the **Product ID** field, enter the item ID.
   
   This is the internal ID of the item record. To get the ID, go to Lists > Accounting > Items and view the Item record.
   
   When you enter a valid item ID, the product name, image, price, and availability is displayed in the page preview.
   
   This field is required to display Featured Product on your website.

   **Note:** With Featured Product, you can only feature one item at a time. If you want to feature more than one item, create a special commerce category for the items you want to display and use the Featured Category extension. See [Featured Category](#).

5. Check the **Hide Product Price** box if you do not want to display the item's price.
   
   If you have set up your website to restrict pricing to registered users and do not check this box, the item's price is only displayed when the user is logged in.

6. Check the **Hide Product Availability** box if you do not want to display the item's stock availability.
   
   If you have set up your web store to show products when out of stock and do not check this box, the item is displayed as out of stock.

   If you have set up your web store to hide products when out of stock, the Featured Product section is not displayed.

7. Use the **Change Image** field to override the item's image.
   
   Click **No File Chosen** to upload a new image using the Image Manager.

   **Note:** This overrides the image setting in Featured Product only. It does not change the image associated with the Item record.

8. In **Ribbon Text**, enter the text to be displayed on the image.

   For example, you can use this field to add the text “special offer”. The ribbon style is taken from your theme.

   If you leave this field blank, the ribbon does not appear.

9. In the **Button Text** field, customize the text that appears on the button.

   The button links to the product page. The default value is **Open Product Page**.

10. Select the type of button you want to use in the **Button Style** field.

   The button definition is taken from your theme.

11. Use the **Tags** field to enter keywords that help you filter your content in the Review Changes list.

   See the help topic [Content Tags and Filter Tools](#).

12. Click **Save**.

If you have not published your featured product and you decided to remove it, you can discard it. If you have already published your featured product, you can remove it directly from the page where it is located. For more information on the differences between discarding or expiring content, see the help topic [Discard Content Vs Expiring Content](#).
To discard the featured product:
1. Go to the Review & Publish Changes list.
2. Select the Featured Product content in the list.
3. Click Discard.
4. Click OK.

To remove the featured product:
1. Go to the page that contains the featured product you want to remove.
2. Click the Featured Product box.
   This highlights it and displays the content controls.
3. Click Remove.
4. Click OK.

To change the product image:
1. Go to the page that contains the featured product.
2. Click the Featured Product box, and then click the Settings button.
   This displays the Featured Product settings in the side panel.
3. Click Remove Image and then click No File Chosen to select another image.
4. Click Save.

Gifts

With Commerce web stores, you can add shopping features to your web store that make it easier for customers to shop for other recipients.
- offer digital gift certificates that give users store credit for your web store
- allow users to add gift wrapping and personalized messages to the orders

Gift Certificates

ℹ️ Applies to: Commerce Web Stores

You can sell gift certificates on your website that allow customers to purchase store credit they can send to someone as a gift.

Gift Certificates are set up as items in NetSuite. For more information on setting up Gift Certificates, see the help topic Gift Certificates.

After setting up Gift Certificates, see the following topics for more information on working with Gift Certificates:
- Buy Gift Certificates in the Web Store
- Apply Gift Certificates in the Web Store
- Gift Certificate Management
Buy Gift Certificates in the Web Store

Applies to: Commerce Web Stores

To purchase a gift certificate, a user enters the recipient's information and their own information in the fields displayed on the Web store page and then adds the gift certificate to the shopping cart. When the user submits the transaction, a notification email is automatically sent to the recipient indicating that a gift certificate has been purchased for them.

A corresponding sales order is generated in your account. After you bill that sales order, the recipient receives another email with the gift certificate authentication code. They can use the authentication code to redeem the gift certificate in the web store.

To use the gift certificate in the web store, see Apply Gift Certificates in the Web Store.

Apply Gift Certificates in the Web Store

Applies to: Commerce Web Stores

To use a gift certificate on a web store order, the user enters their gift certificate authentication code in the corresponding field on the Payment Method page. A message is displayed to the user indicating whether or not the gift certificate code is valid. Multiple gift certificates can be applied to a single web store order.

Gift certificates are applied in the order that they are entered. Customers cannot change the amount that is applied from each gift certificate.

The Gift Certificate field displays at two points during the checkout process: on the payment information page, and on the order confirmation page. On the last page of checkout, each discount applied to the order displays in the item list.

If there is a remaining balance on the order that is not covered by the gift certificate or by multiple gift certificates, or if the gift certificates have expired, the user is not allowed to submit the order until they enter their credit card information.

If the amount of the gift certificate is greater than the order total, the user is allowed to submit the order, and use the gift certificate code again.

You can view the remaining value on a gift certificate in the list at Lists > Accounting > Gift Certificates. For more information about gift certificate status, see the help topic Viewing and Editing Gift Certificate Status.

You can also add a Gift Certificate value check page using the SuiteCommerce Gift Certificate Value Check extension where gift certificate recipients can view their balance. For more information, see Gift Certificate Management.

Gift Certificate Management

Applies to: Commerce Web Stores

The Gift Certificate Management extension lets you do the following:

- **Group Gift Certificates in Your Web Store** — group existing Gift Certificates to display them as item options in your web store.
- **Add Gift Certificate Value Check** — allow users to check the remaining balance of gift certificates on a new landing page.
- **Display Gift Certificates in My Account** — let users check the remaining balance of gift certificates, review gift certificate details, and store the gift certificates in their My Account.

- **Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

- **Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

### Prerequisites

To take advantage of the Gift Certificate Management extension, you must have previously set up Gift Certificates for your site. For more information, see the help topic Setting Up Gift Certificates.

### Group Gift Certificates in Your Web Store

This extension introduces Gift Certificate Groups, which lets you display related gift certificates together on the Product Listing Page (PLP) and Product Detail Pages (PDP) of your site, instead of listing each gift certificate individually.

For example, you can create one group called $50–$500 Gift Certificates and one group called $1000–$1500 Gift Certificates. On the PLP, you can choose to only show the two groups. When users click on a category of gift certificates, the PDP shows all gift certificates in that group as item options for sale.

The result of this approach mimics matrix items, but by using Gift Certificate Groups as the mechanism behind the item options you retain more control over how the gift certificates display on your site.

To set up Gift Certificate Groups for your site, you must:

1. **Configure Gift Certificate Groups**
2. **Update Field Sets**
3. **Enable Gift Certificate Groups for a Gift Certificate**
4. **Create a Gift Certificate Group**
5. **Add Facet Fields**

### Configure Gift Certificate Groups

Use the SuiteCommerce Configuration record to enable the gift certificate grouping feature and determine how the gift certificate item options display on your site.
To configure Gift Certificate Groups:

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where the Gift Certificate Management extension is activated and click Configure.
4. In the Gift Certificate Item Options section, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Certificates as Item Options</td>
<td>If checked, enables the grouping feature that displays gift certificates as item options. Sets the title that appears before the gift certificate item option on the PDP.</td>
</tr>
<tr>
<td>Item Options Title — Gift Certificates</td>
<td></td>
</tr>
<tr>
<td>Show Image Options Swatch</td>
<td>If checked, enables images for the gift certificate item options.</td>
</tr>
</tbody>
</table>
| Item Options Button Label — Gift Certificates | Sets the label for the gift certificate item option button. You can use the following placeholders, which are replaced by their associated values automatically:  
  - [[name]] - item name  
  - [[price]] - item price  
  If Require Login for Pricing is enabled on the Web Site Setup record, this label will omit the price. If the only tag or text present is [[price]], the label displays the gift certificate name. For more information on the Require Login for Pricing field, see the help topic Shopping Preferences. This field is overridden by the Item Options Button Label field on the Item record. |
| Hide Inventory Types from Facets | If checked, hides Inventory Types from Facets filters that are automatically added by the extension in order to group the certificates. |
| Price Range | Sets the label for the price range of the gift certificate group to display on the PLP. You can use the following placeholders, which are replaced by their associated values automatically:  
  - [[minPrice]]  
  - [[maxPrice]] |

5. Click Save.

Update Field Sets

The field sets for a website determine the data that is exposed to site templates. To employ the Gift Certificate Management grouping feature, you must add the Item Options Button Label and Gift Certificate Group ID fields to the site’s details field sets. For more information on field sets, see Define Field Sets.

To add Gift Certificate Management fields to the Web Site Setup Record:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Click Edit next to the website to which you are adding Gift Certificate Management.
3. Navigate to the Field Sets subtab.
4. Add the Item Options Button Label and Gift Certificate Group ID fields to the details field set. For each field, perform the following steps:
a. Locate the **Fields Included in Field Set** column of the **details** field set and click the **Set** button.
b. Select the fields from the **Field Name** list and click **Add**.
c. In the Field Set window, click **Submit**.
d. In the Field Set row, click **OK**.

5. After adding both fields to the field set, click **Save**.

Enable Gift Certificate Groups for a Gift Certificate

To group items using Gift Certificate Management, the extension must be enabled at the item level. Using the Item record, you can associate the gift certificate with a group and determine how you want to display the item on your site. You can use this record to designate one gift certificate in each group to be visible on the PLP, while making the others only appear on the PDP.

**To enable Gift Certificate Groups for a gift certificate:**

1. In NetSuite, go to Lists > Accounting > Items.
2. Click **Edit** next to the item which you want to add to a gift certificate group.
   
   Navigate to the **SuiteCommerce Extensions** tab and the **Gift Certificate Advanced** subtab.
3. Set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Options Button Label</td>
<td>Sets the label for the gift certificate item option buttons.</td>
</tr>
<tr>
<td></td>
<td>You can use the following placeholders, which are automatically replaced by their associated values:</td>
</tr>
<tr>
<td></td>
<td>- [[name]] - item name</td>
</tr>
<tr>
<td></td>
<td>- [[price]] - item price</td>
</tr>
<tr>
<td></td>
<td>If <strong>Require Login for Pricing</strong> is enabled on the Web Site Setup record, this label will omit the price. If the only tag or text present is [[price]], the label displays the gift certificate name. For more information on the <strong>Require Login for Pricing</strong> field, see the help topic <strong>Shopping Preferences</strong>.</td>
</tr>
<tr>
<td></td>
<td>This field overrides the <strong>Item Options Button Label</strong> field on the SC Configuration record.</td>
</tr>
<tr>
<td>Only Show in Product Detail Page</td>
<td>If checked, hides this gift certificate from the PLP, Search results, and Filter results. The Gift Certificate Group determines which item options to display on the PDP.</td>
</tr>
<tr>
<td></td>
<td>For example, you can choose one gift certificate in each group to display on both the PLP and PDP; for the other gift certificates in the group, check this box to make it only appear on the PDP.</td>
</tr>
<tr>
<td>Gift Certificate Group</td>
<td>Determines the Gift Certificate Group to which the gift certificate is linked.</td>
</tr>
<tr>
<td></td>
<td>You can choose an existing group from the drop-down list or make a new group. For more information, see <strong>Create a Gift Certificate Group</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Create a Gift Certificate Group

Gift Certificate Groups let you choose which gift certificate items you want to associate with each other.

**To create a gift certificate group:**

1. In NetSuite, go to Lists > Accounting > Items.
2. Click **Edit** next to the item which you want to add to a gift certificate group.

3. Navigate to the **SuiteCommerce Extensions** tab and the **Gift Certificate Advanced** subtab.

4. In the **Gift Certificate Group** field, click the **New** button.
   
   This opens the new Gift Certificate Group record.

5. In the **Name** field, enter a group name.

6. Click **Save**.
   
   This closes the Gift Certificate Group record and lists the new group in the **Gift Certificate Group** field.

7. Click **Save**.

   **Tip:** The **Name** field displays as the Gift Certificate Group name on the PLP. Using the example from above, you can set the **Name** field as **$10–$50 Gift Certificates** and select this group for each gift certificate you want to include in the group. Doing this displays the group name on the PLP and PDP, while still showing the individual gift certificate options as item options on the PDP.

---

**Add Facet Fields**

To set up facets for Gift Certificate Management, select facet fields on the Web Site Setup record.

Follow the instructions for selecting facet fields in **Select and Configure Facet Fields**, ensuring that you add the following facet fields on the Web Site Setup record:

- **Type**
- **Only Show in Product Detail Page**
- **Gift Certificate Group ID**

---

**Add Gift Certificate Value Check**

The Gift Certificate Management extension lets you add a value check feature to your website so users can check the balance on their gift certificates. This topic explains how to add a predefined page where gift certificate recipients can check the balance without having to log in and visit their My Account page.

Shoppers can check the status of gift certificates by entering the gift certificate code in the field. They can view the gift certificate's balance and the expiration date, if applicable. If the gift certificate has expired, a message is displayed to the user indicating the expiration date.

This topic explains how to:

- **Configure Gift Certificate Value Check**
- **Link to the Gift Certificate Value Check Page**

This extension also lets you include the value check feature on the My Account page. To enable features on the My Account page, see **Display Gift Certificates in My Account**.

---

**Configure Gift Certificate Value Check**

Use the SuiteCommerce Configuration record to enable the gift certificate value check application, set a URL path for the landing page, and customize labels and messages to fit your needs.

**To configure Gift Certificate Value Check:**

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.

2. Select the website and domain where the Gift Certificate Management extension is activated and click **Configure**.
3. Navigate to the Extensions tab, Gift Certificate Value Check subtab.
4. Check the Enable Gift Certificate Value Check box to show the Gift Certificate Value Check application on a landing page of your website.
5. Fill out the listed fields for each category, using the tables below as references.
6. Click Save.

**Landing Page Fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Path</td>
<td>Determines the URL path for the Gift Certificate Value Check page.</td>
</tr>
<tr>
<td>Page Title — Landing Page</td>
<td>Sets the title for the Gift Certificate Value Check page.</td>
</tr>
<tr>
<td>Input Label — Landing Page</td>
<td>Sets the label for the input field where users supply a gift certificate code.</td>
</tr>
<tr>
<td>Input Placeholder</td>
<td>Determines the placeholder for the input field to give users an example of a gift certificate code.</td>
</tr>
<tr>
<td>Check Button Label</td>
<td>Sets the label for the check balance submit button.</td>
</tr>
<tr>
<td>Field Help</td>
<td>Determines the field level help for the Gift Certificate input field.</td>
</tr>
<tr>
<td>Paste Icon Help</td>
<td>Determines the help message for the paste icon.</td>
</tr>
<tr>
<td>Field Min. Length</td>
<td>Sets the minimum length for the gift certificate code.</td>
</tr>
<tr>
<td>Field Max. Length</td>
<td>Sets the maximum length for the gift certificate code.</td>
</tr>
<tr>
<td>Save to My Account Button Label</td>
<td>Sets the label for the button that saves the certificate to My Account after login.</td>
</tr>
</tbody>
</table>

The user is first directed to a login page if not logged in.

**Messaging Fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Code Warning</td>
<td>Determines the message to display when a user enters an invalid code.</td>
</tr>
<tr>
<td>Expired Code Warning</td>
<td>Determines the message to display when a user enters an expired code.</td>
</tr>
<tr>
<td>Inactive Code Warning</td>
<td>Determines the message to display when a user enters an inactive code.</td>
</tr>
<tr>
<td>Remaining Value Label</td>
<td>Sets the label to display the remaining value of the gift certificate.</td>
</tr>
<tr>
<td>Gift Certificate Code Label</td>
<td>Sets the label to display the code of the gift certificate.</td>
</tr>
<tr>
<td>Past Expiration Date</td>
<td>Sets the label to display when a gift certificate expired.</td>
</tr>
<tr>
<td>Future Expiration Date</td>
<td>Sets the label to display when a gift certificate will expire.</td>
</tr>
</tbody>
</table>

**Link to the Gift Certificate Value Check Page**

You access the Gift Certificate Value Check page by adding the path entered in the URL Path field on the SC Configuration record to your website domain (the default path is gift-certificate-balance).

You can add the Gift Certificate Value Check page URL as a link on your website footer using Site Management Tools (SMT). For more information on how to add a hyperlink to your website footer using SMT, see Adding Text to an Area.

**Display Gift Certificates in My Account**

The Gift Certificate Management extension lets you include a gift certificate section on shoppers’ My Account pages. Users can use this section to check the remaining balance of their gift certificates and store gift certificates in one place.
When a user orders a gift certificate, the extension checks if the recipient's email address is associated with an account of your web store. If the recipient has an account, the extension automatically stores the gift certificate in the gift certificate section of the recipient's account.

After storing a gift certificate, users can see the following gift certificate details:

- Code number
- Remaining balance
- Expiration date
- Sender
- Date sent
- Original amount

**Note:** This extension does not currently allow for the gift certificate section of My Account to appear on mobile devices. Mobile users can still use the gift certificate value check feature on a landing page.

### Configure Gift Certificates in My Account

Use the SC Configuration record to enable gift certificate value check and storage on the My Account page. You can determine the feedback messages and appearance of the Gift Certificate Table in My Account.

**To configure Gift Certificates in My Account:**

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where the Gift Certificate Management extension is activated and click Configure.
4. In the Gift Certificate My Account section, check the Enable Gift Certificates in My Account box to show Gift Certificates in the My Account application.
5. Fill out the listed fields for each category, using the tables below as references.
6. Click Save.

**My Account Fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Title — My Account</td>
<td>Sets the title for the My Account page.</td>
</tr>
<tr>
<td>Available Balance Label — My Account</td>
<td>Sets the label to display the available balance of a gift certificate.</td>
</tr>
</tbody>
</table>

**Table Fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title — Gift Certificate Table</td>
<td>Sets the title for the gift certificate table.</td>
</tr>
<tr>
<td>Description — Gift Certificate Table</td>
<td>Determines the description for the gift certificate table.</td>
</tr>
<tr>
<td>Code — Gift Certificate Table</td>
<td>Sets the label for the gift certificate code column of the gift certificate table.</td>
</tr>
<tr>
<td>Remaining Balance — Gift Certificate Table</td>
<td>Sets the label for the remaining balance column of the gift certificate table.</td>
</tr>
</tbody>
</table>
Gift Wrap & Message

**Applies to:** Commerce Web Stores

The Gift Wrap & Message extension lets you offer gift wrap options in your web store and allow users to add personalized messages to their orders. You can:

- create multiple gift wrap items, organizing your options by size, color, and type
- determine items to be gift wrapped and the gift wrap options to be used
Gifts

- display gift wrap colors and images in the web store
- customize the messages displayed to users

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

Gift options are displayed in the product detail page and in the cart summary. Users see a link to add gift wrap below the product options. When they click this link, the gift wrap options available for the product are shown. You can include gift wrap options as images or text, and a description. The gift wrap price is displayed.

You can set up different gift wrap variations for each item or a single gift wrap option for all items. Items only display the gift wrap options that can be used.

You can also allow users to add a personalized message to their order. They can enter their name, the recipient's name and add a personalized text message. You can then print the message and attach it to the order's packing slip.

**Installation**

SuiteCommerce Gift Wrap & Message is an extension SuiteApp. You need to install the SuiteApp and activate the extension for a specific website or domain. For more information, see Install Theme and Extension SuiteApps and Manage Themes and Extensions.

**Set Up Gift Wrap**

To set up SuiteCommerce Gift Wrap & Message in your web store, you need to perform the following steps:

1. Add Gift Wrap Fields to the Website Setup
2. Create Gift Wrap Items
3. Assign Gift Wrap Options to Web Store Items

**Add Gift Wrap Fields to the Website Setup**

To check whether an item can be gift wrapped and the gift wrap options applicable, you need to add the gift wrap fields to the detail field set for your website. You also need to add the gift wrap item to the facet fields to hide the gift wrap items from your web store search.

When you add the gift wrap fields to your website setup record, they are displayed on all domains. For more information on how to hide gift wrap fields in other domains associated with your website, see Disable Gift Wrap.

**To add the gift wrap fields to the setup:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. Navigate to the Field Sets tab.
3. In the Fields Included in the Field Set field for the details Field Set ID, add the following fields:
Gift Wrap Options — custitem_ns_sc_ext_gw_options
Can Be Gift Wrapped — custitem_ns_sc_ext_gw_iswrappable

4. Click Add.
5. Navigate to the Search Index tab, to Facet Fields subtab.
6. Select Gift Wrap Item in the Facet Field Name dropdown field and click Add.
7. Save the website setup record.

Create Gift Wrap Items

Gift wrap items represent the different gift wrap options you make available to users in your web store. You can create gift wrap items as inventory or non-inventory items.

If you want to offer a range of options (such as colors, sizes, and patterns) for a gift wrap category, you create a matrix item. For example, if you want to offer gift wrap boxes in various colors, you create the box as the parent matrix item and create the various colors as child matrix items. You should create a new matrix item per wrap variation. For example, one matrix item for standard wrapping & colors and a second matrix item for premium wrapping.

To create a gift wrap item:

1. Go to Lists > Accounting > Items > New.
2. In the Web Store tab, select the Display in Web Store box.
3. Set up the gift wrap as an item for the web store.
   Enter information in the following fields:
   - Item Name
   - Item Price
   - Web Store Display Name
     If you do not enter a value in this field, the item's display name is taken.
   - Display Name
     Add up to 30 characters as a description for the gift wrap in the Web Store Description field. This is displayed beside the gift wrap option in the web store.
     For more information on setting up items for your web store, see Item Setup for SuiteCommerce.
4. Attach images to display in the web store for the gift wrap item.
   For example, if you offer different gift wrap patterns, you can display a sample of the wrap. See Item Images.
5. Navigate to the SuiteCommerce Extensions tab, to the Gift Wrap subtab.
6. Check the Gift Wrap Item box.
7. Click Save. If you create a Matrix Item, click Create Matrix.

Assign Gift Wrap Options to Web Store Items

Gift wrap options are determined at item level. You assign all gift wrap options that can be used for the item in the Item record.

You can edit each item individual or update the gift wrap options using a mass update script. For more information on how to update options using mass update, see the help topic Mass Update Scripts.
To select the gift wrap options for an item:

1. Go to Lists > Accounting > Items > New.
2. Navigate to the SuiteCommerce Extensions tab, to the Gift Wrap subtab.
3. Check the Can be gift wrapped box.
4. In the Gift Wrap Options box, select all gift wrap options that can be used for the item.
5. Click Save. If the item is a matrix item, click Update Matrix.

Customize Gift Wrap

When you install SuiteCommerce Gift Wrap & Message, gift wrap options are displayed in the product detail page and in the cart summary. By default, the gift message section is hidden.

Gift options in the product detail page use the selector template set up in your site configuration for matrix items. If you associate images with the gift wrap item record, SuiteCommerce Gift Wrap & Message uses these images to show the gift wrap options.

Default label text is provided for all Gift Wrap fields.

Configure Gift Wrap Display Options

You can determine how the gift option is displayed in the web store. You set up the color options for gift wrap as transaction item options. See the help topic Custom Transaction Item Options.

If you want gift wrap item options to use a different selector template, you need to create separate item options for gift wrap.

You can set up images for each gift wrap item that allows the user to view different patterns, for example.

To determine the display option for gift wrap items:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Navigate to the Shopping Catalog tab, Item Options subtab.
3. In the Item Options and Custom Transaction Column Fields section, enter the ID of the item option you have set up for gift wrap colors in the Cart Option ID field.
4. In the Selector Template, select the template that you want to use to select gift wrap option such as colors or patterns.
   - Use product_views_option_tiles.tpl to display gift wrap options as text, and product_views_option_color.tpl to display gift wrap options as colors or images. If you do not specify this value, the default used is product_views_option_tiles.tpl.
5. Click OK.
6. Save the Configuration record.

To display gift wrap images:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Navigate to the Shopping Catalog tab, Multi-Image Option subtab.
3. In the Multi-Image Option column, enter the ID of the transaction item option field that you used for the gift wrap item.
4. Click OK.
5. Save the Configuration record.

**Customize Gift Wrap Text**

You customize the text used for Gift Wrap & Message field labels in the SuiteCommerce Configuration record. The text fields that can be customized are the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title - Gift Options</td>
<td>Title displayed above the gift options on the product page.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Buying a gift?</strong></td>
</tr>
<tr>
<td>Product Page - Loading</td>
<td>Message displayed when loading the gift options for the item.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Loading...</strong></td>
</tr>
<tr>
<td>Product Page – Loading Error Text</td>
<td>Message displayed when an error occurred while loading the gift options for the item.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Gift Wrap options failed to load. Please retry.</strong></td>
</tr>
<tr>
<td>Add Gift Wrap Button Label</td>
<td>Text displayed on the button to view gift wrap options. This field is required.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Add Gift Wrap</strong></td>
</tr>
<tr>
<td>Description - Gift Options</td>
<td>Text displayed to describe the gift wrap options.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>We'll add a gift message to the packing slip and hide the prices.</strong></td>
</tr>
<tr>
<td>Price Label - Gift Options</td>
<td>Label to indicate the price of the gift wrap option. Use the {{price}} placeholder to replace the value.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Price: {{price}}</strong></td>
</tr>
<tr>
<td>Default Wrap Item - Gift Options</td>
<td>Select the default gift wrap item to be used for items where no wrap has been specified.</td>
</tr>
<tr>
<td></td>
<td>If you do not specify a default gift wrap, the first gift wrap option for the item is taken.</td>
</tr>
<tr>
<td>Show Message Section</td>
<td>Check this box if you want to allow users to add personalized messages to their gift order.</td>
</tr>
<tr>
<td>Section Label - Message</td>
<td>Text to describe the personalized message area.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Add a personalized gift message to your order!</strong></td>
</tr>
<tr>
<td>Sender Label - Message</td>
<td>Text used to indicate the field where the user enters the sender's name.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>From:</strong></td>
</tr>
<tr>
<td>Recipient Label - Message</td>
<td>Text used to indicate the field where the user enters the recipient's name.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>To:</strong></td>
</tr>
<tr>
<td>Message Area Label - Message</td>
<td>Text used to describe the personalized message field.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Add Gift Message:</strong></td>
</tr>
<tr>
<td>Remove Gift Button Label</td>
<td>Text displayed on the button to remove the gift wrap options on the product page. This field is required.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Remove Gift Wrap</strong></td>
</tr>
<tr>
<td>Gift Wrap Info - Cart Summary &amp; Checkout</td>
<td>Text indicating that gift wrap items are counted in the cart's item total.</td>
</tr>
<tr>
<td></td>
<td>Default value: <strong>Gift wrap included in the item count.</strong></td>
</tr>
</tbody>
</table>
To change the gift wrap default text:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the My Extensions tab.
3. On the Gift Wrap & Message subtab, customize the text as required.
4. Click Save.

To enable the gift message section:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. In the SuiteCommerce Configuration record, navigate to the My Extensions tab.
3. On the Gift Wrap & Message subtab, check the Show Message Section box.
4. Click Save.

Disable Gift Wrap

When you install the SuiteCommerce Gift Wrap & Message extension, gift wrap options are displayed in all domains associated with the Website Setup record by default. You can disable gift wrap for specific domains in the SuiteCommerce Configuration record. When you have disabled the extension for a specific domain, you must clear the domain cache.

**Important:** If you are using the Kilimanjaro release of SuiteCommerce Advanced or earlier, you need to disable gift wrap fields by modifying the source code template. For more information, see the help topic Disabling Display of SuiteCommerce Gift Wrap & Message Extension Transaction Line Fields.

To disable SuiteCommerce Gift Wrap & Message:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where you want to disable SuiteCommerce Gift Wrap & Message.
3. In the SuiteCommerce Configuration record, navigate to the My Extensions tab.
4. On the Gift Wrap & Message subtab, clear the Enable Gift Wrap box.
5. Click Save.

To clear the domain cache:

1. Go to Setup > SuiteCommerce Advanced > Cache Invalidation Requests.
2. Click New Invalidation Request.
3. Double-click on the domain for which you want to clear the cache.
4. Choose the **Clear cache for the whole domain(s)** option.
5. Click **Submit**.
6. Click **OK**.

## Look Book

### Applies to: Commerce Web Stores

The Look Book extension lets you create a visual portfolio on your site, representing individual looks of a larger collection. Look Book lets you showcase new items, engage customers through images to convey a theme, highlight corresponding items within a collection, and drive additional sales. The Look Book displays as a slider of Looks that are linked to a collection of Look Items. Users can browse through the high impact slides to shop the Look that is right for them. In addition, they can see a **Looks Good With** section on the product detail page (PDP) of an included item that links to other Look Items in a Look.

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see [Commerce Extensions](#).

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

For example, if you have a clothing store, you can create a Look Book for each season, with each season highlighting a men’s look, a women’s look, and a children’s look. Each of these Looks can then feature Look Items that are ready for purchase. In the diagram below, you can see how you select items (Oxford Sports Shirt, Relaxed-Fit Jeans, and Men’s Textured Slip-On Shoe) to include in the Men’s Fall Look of the Fall Look Book.

- **Look Item** — A Look Item is a product that you choose to display with other associated items on the Look page. Related Look Items appear as part of a **Looks Good With** section, which is created with the extension on the PDP.
- **Look** — A Look is a collection of related Look Items, with multiple Looks comprising a Look Book. You can display your various Looks in the Look Book slider, with each Look getting its own slide. By clicking on a Look slide, you can reach a Look page containing its Look Items.
- **Look Book** — A Look Book is a collection of related Looks. This is the first thing users see when visiting the Look Book page of your site. It displays as a photo slider, which users can interact with to...
click through the included Look slides. You can create different Look Books for different occasions, each highlighting different Looks. Look Books must be accessed through the URL path, so you can choose how to link to the Look Book page from your site.

Each element has a corresponding record in NetSuite, which you can configure to change how the element displays. After creating a Look Book record in NetSuite, you can add Look records to associate with the Look Book. Each Look record then allows you to add corresponding Look Item records.

To enable the Look Book feature for your site, you must:

1. Configure the Look Book extension
2. Create a Look Book
3. Add Looks to a Look Book
4. Add Look Items to a Look

Configure the Look Book extension

Use the SuiteCommerce Configuration record to determine the Look Book section titles and display style.

To configure the Look Book:

1. In NetSuite, go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where the Look Book extension is activated and click Configure.
3. Navigate to the Extensions tab.
4. In the Look Book subtab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDP Section Title</td>
<td>Sets the title for the Look Book section appearing on the PDP.</td>
</tr>
<tr>
<td>Look Subtitle</td>
<td>Determines the subtitle for the Look page.</td>
</tr>
<tr>
<td>Look Details Title</td>
<td>Sets the title for the Details section of the Look page.</td>
</tr>
<tr>
<td>Display Look Book Slide</td>
<td>If checked, your domain displays the Look Book title and description on the first slide of the Look Book slider. If cleared, your domain displays the Look Book title and description in the header above the slider.</td>
</tr>
</tbody>
</table>

5. Click Save.

After configuring the extension, you can create a Look Book. See Create a Look Book.

Create a Look Book

You can create multiple Look Books to present a variety of collections. You can determine the name, image, descriptions, and text color of the Look Book to find a display that fits your needs. After creating the Look Book, you can then add the associated Looks.

To create a Look Book:

1. In NetSuite, go to Lists > Web Site > Look Book > New.
2. Set the following fields:
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sets the name for the Look Book.</td>
</tr>
<tr>
<td>Inactive</td>
<td>If checked, the Look Book is inactive and does not appear on your site.</td>
</tr>
<tr>
<td>URL</td>
<td>Determines the URL path for the Look Book page.</td>
</tr>
<tr>
<td></td>
<td>This URL is appended to the Look Book prefix. The final URL for the Look Book page should end in <code>lookbook/[URL]</code>, where <code>[URL]</code> equals the value of this field.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Sets the short description for the Look Book.</td>
</tr>
<tr>
<td></td>
<td>This displays above the Long Description.</td>
</tr>
<tr>
<td>Long Description</td>
<td>Sets the long description for the Look Book.</td>
</tr>
<tr>
<td></td>
<td>This displays below the Short Description.</td>
</tr>
<tr>
<td>Right Align Text</td>
<td>If checked, aligns the text on the Look slides to the right.</td>
</tr>
<tr>
<td>Text Color</td>
<td>Determines the color of the text on the slides.</td>
</tr>
<tr>
<td></td>
<td>This field supports text, HEX, or RGB.</td>
</tr>
<tr>
<td>Image</td>
<td>Sets the background image for the Look Book title slide.</td>
</tr>
<tr>
<td></td>
<td>To use a Look Book title slide, Display Look Book Slide (located on the SC Configuration record) must be checked.</td>
</tr>
<tr>
<td>Title Tag</td>
<td>Determines the title tag used for third-party indexing.</td>
</tr>
<tr>
<td>Meta Description</td>
<td>Determines the meta description used for third-party indexing.</td>
</tr>
<tr>
<td>Meta Keywords</td>
<td>Determines the meta keywords used for third-party indexing.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

After saving, a **Custom** tab is created on the Look Book record, where you can add Looks. For more information on adding Looks to a Look Book, see Add Looks to a Look Book.

### Add Looks to a Look Book

After you create your Look Book, you can add Looks to the Look Book record.

Looks allow you to present a variety of subcategories within a unified Look Book. Each Look appears as a slide of the Look Book slider. When a user clicks on a Look slide, they launch your Look page, which contains the relevant Look Items. After creating a Look record in NetSuite, you can then add the associated Look Items.

**To add Looks to a Look Book:**

1. In NetSuite, go to Lists > Web Site > Look Book.
2. Click **Edit** next to the Look Book to which you want to add Looks.
3. In the **Custom** tab, click **New Look**, or click **Edit** to modify an existing Look.
4. In the Look record, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sets the name for the Look.</td>
</tr>
<tr>
<td>Inactive</td>
<td>If checked, the Look is inactive and does not appear on your site.</td>
</tr>
<tr>
<td>Sequence Number</td>
<td>Determines the position of the Look in the Look Book slider.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>URL</td>
<td>Determines the URL path for the Look page. This URL is appended to the Look Book URL (determined by the URL field of the Look Book record). The final URL for the Look page should end in <code>/lookbook/\[URL\]</code>, where <code>[URL]</code> equals the value of this field.</td>
</tr>
<tr>
<td>Look Book</td>
<td>Associates the Look with a Look Book.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Sets the short description for the Look. This displays above the Long Description.</td>
</tr>
<tr>
<td>Long Description</td>
<td>Sets the long description for the Look. This displays below the Short Description.</td>
</tr>
<tr>
<td>Text Color</td>
<td>Determines the color of the text on the Look page. This field supports text, HEX, or RGB.</td>
</tr>
<tr>
<td>Right Align Text</td>
<td>This property is reserved for use in a future release.</td>
</tr>
<tr>
<td>Link Text</td>
<td>Sets the label for the link that appears on the Look slide of the Look Book. The link points to the Look page.</td>
</tr>
<tr>
<td>Carousel Image</td>
<td>Sets the image for the Look slide.</td>
</tr>
<tr>
<td>Main Look Image</td>
<td>Sets the main image for the Look page.</td>
</tr>
<tr>
<td>Alternative Look Image</td>
<td>Sets an additional image to appear on the Look page. If a Main Look Image and Alternative Look Image are both added, then a slider with both pictures appears on the Look page.</td>
</tr>
<tr>
<td>Title Tag</td>
<td>Determines the title tag used for third-party indexing.</td>
</tr>
<tr>
<td>Meta Description</td>
<td>Determines the meta description used for third-party indexing.</td>
</tr>
<tr>
<td>Meta Keywords</td>
<td>Determines the meta keywords used for third-party indexing.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

After saving, a **Custom** tab is created on the Look record, where you can add Look Items. For more information on adding Look Items to a Look, see **Add Look Items to a Look**.

### Add Look Items to a Look

After you create a Look, you can edit the Look record in NetSuite to add Look Items.

On your site, Look Items appear on the associated Look page and include a picture, description, price, and link to the item's PDP. Additionally, a **Looks Good With** section appears on the item's PDP, which includes other Look Items. In NetSuite, you customize the Look Item record to designate a name, picture, and description for the item that highlights the Look without changing the inventory item information.

### To edit the Look Item record:

1. In NetSuite, go to Lists > Web Site > Look Book.
2. Click **Edit** next to the Look Book that contains the Look to which you want to add Look Items.
3. In the **Custom** tab of the Look Book record, click **Edit** to modify an existing Look.
4. In the **Custom** tab of the Look record, click **New Look Item**, or click **Edit** to modify an existing Look Item.
5. Set the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sets the name for the Look Item. This is the name for the item that appears on the Look page and <strong>Looks Good With</strong> section of the PDP. The item name on the PDP header remains the same as the Item record.</td>
</tr>
<tr>
<td>Inactive</td>
<td>If checked, the Look Item is inactive and does not appear on your site.</td>
</tr>
<tr>
<td>Item</td>
<td>Associates the Look Item with an Item record.</td>
</tr>
<tr>
<td>Sequence Number</td>
<td>Determines the position of the Look Item on the Look page and <strong>Looks Good With</strong> section of the PDP. Look Items appear in ascending order.</td>
</tr>
<tr>
<td>Look</td>
<td>Associates the Look Item with a Look.</td>
</tr>
<tr>
<td>Description</td>
<td>Sets the Look Item description to display on the Look page and <strong>Looks Good With</strong> section of the PDP.</td>
</tr>
<tr>
<td>Link Text</td>
<td>Sets the label for the link that appears on the Look page and <strong>Looks Good With</strong> section of the PDP. The link points to the Look Item page.</td>
</tr>
<tr>
<td>Image</td>
<td>Determines the image to display with the Look Item on the Look page and <strong>Looks Good With</strong> section of the PDP.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

After you set up the extension, users can visit a Look Book page with a slider of Looks, select a Look to view the Look Items, and shop related Look Items from an associated product.
Advertising

Informing your customers about your brand is an ongoing task that requires careful planning and consideration. Customers need to know about your products and you want to build brand loyalty. Commerce web stores let you:

- Share your product inventory with third-party solutions so you can present your brand consistently in multiple sales channels.
- Feature your success stories prominently on your website to encourage new business.
- Highlight key brands in attractive formats.

Product Feeds

Applies to: Commerce Web Stores | Aconcagua

A product feed contains a list of items and their attributes that can be used by third-party solutions for marketing purposes. You can use product feeds to advertise your products in marketplaces, shopping channels, and product comparison search engines. With product feeds, you can share your product inventory in a structured format and present your brand consistently in multiple sales channels. You can incorporate promotions data in your Google product feed to display promotions in Google Shopping ads.

**Important:** Commerce web store extensions are only available if they are provisioned and set up in your account. For more information, see Commerce Extensions.

The SuiteCommerce Product Feeds extension lets you create product feeds for the following services:

- Google Shopping
- Google Shopping with Merchant Promotions
- Facebook Dynamic Ads
- Custom CSV output

**Note:** SuiteCommerce Product Feeds requires SuiteCommerce or the Aconcagua release of SuiteCommerce Advanced and later. It also requires installation of the SuiteCommerce Configuration bundle.

Product Feed Overview

SuiteCommerce Product Feeds is an extension SuiteApp that includes the Product Feed record, the Promotion Feed record, a Status page, and basic saved search templates for creating your product feeds.

SuiteCommerce Product Feeds lets you create product and promotion feeds containing the following item types:

- Inventory items (and matrix items)
- Non-inventory items (and matrix items)
- Download items
- Kit/Package items (not including Assembly items)
- Gift certificates
The workflow for generating a product feed is identical for all data feed types, though the attributes for each data feed type may vary according to the destination and the nature of the product. You use the Product Feed record to determine the settings required to retrieve information about your product inventory, compile the data, and export it in the desired feed format.

The product feed output is generated using data from two sources: item cache and saved searches. When you install SuiteCommerce Product Feeds for the first time or when you update the SuiteApp, an item caching process is triggered to obtain information about all the items that are displayed in the web store. The information obtained relates to the item's in-stock status, whether it is a matrix item, its URL component, and the URLs of the images associated with the item. This process may take up to several hours depending on the number of items to be cached. You can also manually trigger an item cache rebuild in Lists > Feeds > Status. The caching process is specific to SuiteCommerce Product Feeds only.

To ensure the item cache stays up to date, SuiteCommerce Product Feeds checks every 15 minutes for any changes in item availability, or in item and image links. For example, if your web store is set up to hide items when out of stock and the inventory stock for an item is 0, information for that item will not be retrieved during the item caching. When the item comes back into stock, it is included during the next caching process. An optimized full rebuild of the item cache is performed every 2 hours.

When you create a product feed, you associate a saved search in the Product Feed record. The saved search retrieves information for all supported items (or those items that match the search criteria, if specified in the Criteria tab) and displays all the fields indicated in the Results tab. The default saved search templates provided with SuiteCommerce Product Feeds have been set up to include all the required and optional feed attributes as custom labels.
When you generate the product feed, the product feed generator runs the selected saved search and compares the items returned with the item details previously cached. Only items with information that has been cached and that match the saved search criteria are included in the feed output. The product feed generator then takes the result of this combination in the feed output and exports the fields specified in the saved search with the custom label field.

The product feed output can be accessed at a public URL indicated in the Product Feed record. You can either download the output or allow the third-party service to fetch the product feed at this public URL. You can schedule the product feed generator to automatically refresh your product feed at a specific time interval to ensure your product feed is always up-to-date with the latest changes in inventory.

The attributes for each product feed type vary from merchant to merchant. You may need to configure the default saved search templates to include additional data depending on the service and the items you want to include. Items must be inventory items. For example, requirements may vary if the item is apparel or electronics, or there may be specific requirements for the target country. You enter values for these product feed-specific fields on the Item record:

- Editing each individual Item record manually
- Using Mass Update to update all item records based on specific criteria
- Using the CSV import tool

**Product Feed-Specific Fields**

When you install the SuiteCommerce Product Feeds extension SuiteApp, product feed-specific fields are added to the Feeds tab on the Item record. According to your product feed implementation, the fields on the Item record may vary from the fields here, but they may include the following:

**Shared Fields** subtab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age Group (Feeds)</td>
<td>Demographic for which your product is intended.</td>
</tr>
<tr>
<td>Category (Feeds)</td>
<td>Product category to which you want to assign your item. By default, Google Product categories have been provided.</td>
</tr>
<tr>
<td>Color (Feeds)</td>
<td>Used to describe the item's physical characteristics. Use this field to indicate color variations in matrix items.</td>
</tr>
<tr>
<td>Condition (Feeds)</td>
<td>Condition of the product.</td>
</tr>
<tr>
<td>Custom Label (Feeds)</td>
<td>You can use these attribute fields to add additional labels to your product feed.</td>
</tr>
<tr>
<td>Gender (Feeds)</td>
<td>Gender for which your product is intended.</td>
</tr>
<tr>
<td>Material (Feeds)</td>
<td>Used to describe the item's main fabric or material.</td>
</tr>
<tr>
<td>Pattern (Feeds)</td>
<td>Used to describe the item's graphic print or pattern.</td>
</tr>
</tbody>
</table>

**Google** subtab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adult (Feeds)</td>
<td>Indicates a product includes nudity or sexually suggestive content.</td>
</tr>
<tr>
<td>AdWords Redirect (Feeds)</td>
<td>A URL used to specify additional parameters for your product page.</td>
</tr>
<tr>
<td>Energy Efficiency Class (Feeds)</td>
<td>Energy label.</td>
</tr>
<tr>
<td>Is Bundle? (Feeds)</td>
<td>Indicates a product is a merchant-defined custom group of different products featuring one main product.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ID Exists? (Feeds)</td>
<td>Indicates whether the product has a unique product ID.</td>
</tr>
<tr>
<td>Max. Energy Efficiency Class (Feeds)</td>
<td>Energy label. Used in conjunction with Energy Efficiency Class.</td>
</tr>
<tr>
<td>Max. Handling Time (Feeds)</td>
<td>The longest amount of time between when an order is placed for a product and when the product ships.</td>
</tr>
<tr>
<td>Min. Energy Efficiency Class (Feeds)</td>
<td>Energy label. Used in conjunction with Energy Efficiency Class.</td>
</tr>
<tr>
<td>Min. Handling Time (Feeds)</td>
<td>The shortest amount of time between when an order is placed for a product and when the product ships.</td>
</tr>
<tr>
<td>Multipack (Feeds)</td>
<td>Identifies the number of identical products sold within a merchant-defined multipack.</td>
</tr>
<tr>
<td>Shipping Height (Feeds)</td>
<td>Height of the product used to calculate the shipping cost by dimensional weight.</td>
</tr>
<tr>
<td>Shipping Label (Feeds)</td>
<td>Label that you assign to a product to help assign correct shipping costs in Google Merchant Center account settings.</td>
</tr>
<tr>
<td>Shipping Length (Feeds)</td>
<td>Length of the product used to calculate the shipping cost by dimensional weight.</td>
</tr>
<tr>
<td>Shipping Width (Feeds)</td>
<td>Width of the product used to calculate the shipping cost by dimensional weight.</td>
</tr>
<tr>
<td>Size System (Feeds)</td>
<td>Country of the size system used by product.</td>
</tr>
<tr>
<td>Size Type (Feeds)</td>
<td>Your apparel product's cut.</td>
</tr>
</tbody>
</table>

For more information on the product feed specifications for Google Merchant Center, see Google Shopping Product Data Specification.

**Before You Begin**

Be aware of the following important information:

- **Set up all required settings in your merchant account before generating the product feed in NetSuite.** The data requirements may vary from merchant to merchant.
  - **Google Shopping:** You must have previously signed up for a Google Merchant account and performed basic setup operations (for example, transport and tax options). For more information on setting up a Google Merchant Center account, see Google Merchant Center Help.
  - **Facebook:** You must have a Facebook ad account and a Facebook page. You must first create a catalog in Facebook and associate it with your Facebook ad account. For more information, see Facebook Catalog Setup for Dynamic Ads.
- **Mark your product as display in website and active.** SuiteCommerce Product Feeds performs an item caching process to fetch all web store items. If you do not mark them as active and display in website, they are not considered.
  - For more information on how to ensure items are retrieved, see Item Record Settings.
- **Ensure that item image names are as per the guidelines in Image File Naming Guidelines.** If item image names do not follow these guidelines, their URLs may not be correct, which can cause merchants to reject the product feed.
Determine the number of items to be included in the feed output. The product feed generator supports up to 60,000 items within a single feed, including matrix items. If you want to export a larger number of items, use complex formulas, or calculate values in real time, split your items into smaller feeds.

**Note:** A product feed is a scheduled script and subject to the same performance limitations. For more information, see the help topics SuiteScript Governance, Optimizing SuiteScript Performance, and the SuiteAnswers article SuiteScript Error SSS_TIME_LIMIT_EXCEEDED for more details.

If you want to include **promotions as part of your Google product feed**, enable the SuitePromotions feature and set up SuitePromotions Item Promotions. For more information on creating item promotions in SuitePromotions, see the help topic Creating Item Promotions

- An item included in the product feed can only have a **maximum of 10 promotions** associated. For more information on setting up a Google Merchant Promotions, see Create a Promotion Feed.
- Google Merchant Center only allows you to include up to **500 promotions** in one promotion feed. If the number of promotions associated to the feed exceeds this number, the feed is rejected. For more information, see Google Merchant Promotions Participation Criteria and Policies.
- Promotion feeds undergo an approval process in Merchant Promotions. This process may take up to 24 hours. See Google's Promotion Approval Process.

Set Up Product Feeds

Before you start to create your product feed using the SuiteCommerce Product Feeds extension, you must first set up the service where you want to use the product feed and identify the requirements for the data feed. You also need to update your item records with the required information for the product feed type.

You can create product feeds that contain the following item types:

- Inventory items (and matrix items)
- Non-inventory items (and matrix items)
- Kit/Package items (not including Assembly items)
- Download items
- Gift certificates

Required Features

Before installing Product Feeds, check that the following features are enabled in your NetSuite account.

- **Items & Inventory** subtab:
  - Matrix Items
  - Inventory
- **Transactions** subtab:
  - Promotion Codes
  - SuitePromotions
- **Commerce** subtab:
Installation

The SuiteCommerce Product Feeds extension does not require activation for a specific website or domain. However, you need to install the SC Product Feeds SuiteApp. For more information, see Install Theme and Extension SuiteApps.

To install the SC Product Feeds SuiteApp:

1. In NetSuite, go to Customization > SuiteBundler > Search & Install Bundles.
2. In the Keywords field, enter the Bundle ID or ‘product feeds’ and click Search.
3. Verify that the SC Product Feeds SuiteApp is returned in the search and select it.
4. Review the SuiteApp details and then click Install.

Update Product Feed Fields

When you install the SuiteCommerce Product Feeds extension, product feed-specific fields are added to the Feeds tab in your Item records to collect product-feed specific information. For a list of the fields added to the Item record, see Product Feed-Specific Fields.

⚠️ Important: Required fields for the target product feed type must not be left blank in the Item record. Otherwise, an error will be triggered in the service when you upload the product feed.

According to the product feed type you want to create, these attributes are considered either mandatory or optional for the item and vary from merchant to merchant.

- Google Shopping
- Google Merchant Promotions
- Facebook Dynamic Ads
- Other Services

You can update these fields manually on each individual Item record, use the Mass Update menu option, or use CSV import.

Google Shopping

Product feeds to be imported into the Google Merchant Center should contain at least the following fields:
- ID
- Title
- Description
- Link
- Image link
- Availability
- Price
- Condition
- Google product category

Other attributes may be required depending on the item type to be included and the target country of the product feed. For more information on the specific requirements for your feed, see the Google Shopping Product Specifications.

**Google Merchant Promotions**

Product feeds including promotion information to be imported into the Google Merchant Center should contain at least the following fields:

- Google Shopping fields, and
- Promotion ID
- Product applicability
- Offer type
- Long title
- Promotion effective dates
- Redemption channel

All the required attributes are mapped to existing fields in the Promotion record in NetSuite. For a list of the attributes that can be provided in the promotion feed, see the Merchant Promotions feed specifications.

**Facebook Dynamic Ads**

Product feeds to be imported into a Facebook Catalog for Dynamic Ads should contain at least the following fields:

- ID
- Availability
- Condition
- Description
- Image link
- Link
- Title
- Price
- GTIN, MPN, or brand
Other attributes may be required depending on the item type to be included. For more information on the specific requirements for your feed, see Facebook Product Catalog Specifications.

Other Services

SuiteCommerce Product Feeds can also be used to create a custom CSV output, which can be used as a data feed for other marketplaces, shopping channels, and product comparison search engines. The attributes required for these services vary according to the product type to be included. You should verify the fields required for each specific case before updating the Item record.

To update the product feed fields using Mass Update:

2. Enter a description for the mass update in the Title of Action field.
3. Filter the items using advanced search criteria.
   For example, you can restrict item selection by using name as a filter, setting contains as the name, and entering an item keyword. For more information on how to filter items in Mass Update, see the help topic Advanced Search Criteria Filters.
4. On the Mass Update tab, enter the values for all the product feed-specific fields you want to update on the Item record.
   For example, you may want to update the Category field to contain the Google product category. Select the Category box, and then enter the percent sign (%) and a keyword such as apparel to display all categories containing the keyword apparel.
5. Click Save.

You may need to repeat this operation several times to update all the fields for the items you want to include in your product feed. For more detailed information on setting up the Mass Update to update item fields, see the help topic Defining a Mass Update.

To import using CSV import

1. Go to Lists > Search > Saved Searches > New.
2. Restrict the search using Advanced Search Criteria Filters to retrieve the items you want to update.
3. Click Preview.
4. In the list of search results, click Export — Microsoft Excel and save the export file.
5. In the resulting export file, change the fields you want to update as required.
6. Save the product catalog export file in CSV format.
7. Go to Setup > Import/Export > Import CSV Records.
8. Import the updated product catalog file.
   For more detailed information on how to import data using the Import Assistant, see the help topic Importing CSV Files with the Import Assistant.

Next Steps

When you have updated the Item record with all the required and the optional fields, you are now ready to create a product feed.

- Create a Product Feed: Set up a data feed for Google Shopping, Facebook Catalogs, or in CSV format.
Create a Promotion Feed: Set up a data feed for use in Google Shopping with Merchant Promotions.

Create a Product Feed

The SuiteCommerce Product Feeds extension SuiteApp contains the Product Feed record that lets you create product data feeds for marketplaces, shopping channels, and product comparison search engines.

The SuiteCommerce Product Feed extension includes default saved searches for Google, Facebook and custom CSV. You can use these templates to create a new saved search with additional information that you may want to include in your product feed. Only saved searches created within the Product Feed record are displayed in the Saved Search field.

The Product Feed record lets you create product feeds for Google Shopping, Facebook Catalog, and custom CSV output. The fields displayed vary depending on the feed type selected.

The steps for creating a product feed are:

1. Create the Product Feed record
2. Select the Product Feed type
3. Restrict the items to be returned
4. Determine the fields to be returned
5. Generate the product feed

Note: Before you start to create a new product feed, ensure you have considered all requirements for product feeds. See Before You Begin.

To create a new product feed:

2. In the Name field, enter a title to help you identify the product feed.
3. In Feed Type, select the product feed type you want to create.
   You can create feeds for Google Merchant Center, Facebook Catalogs, and in custom CSV format. For more information, see Product Feed Overview.
4. In Web Site, select the website of your web store.
   The website is used to determine the web store items retrieved. It is also used in the product link. For example, if the product feed is imported into Google, users are redirected back to this website when they click the item.
5. In Domain, select the domain of the web store to be used for the product feed.
   This field is used in the same way as Website, to filter the items retrieved.
6. In Saved Search, select the saved search you want to use to map item fields to the product feed attributes.
   The saved search template used should match the product feed type selected in the Feed Type field.
If you want to change the default saved search settings, click **Open Selected Search** to edit the criteria and attributes and save a copy. Only saved searches created from the Product Feed record are displayed in the list.

For more information on using saved search to restrict items and determine product feed attributes, see **Set Product Feed Attributes**.

7. In the **Feed Description** field, add a detailed description of the product feed. This information can be particularly useful if you need to separate your items into several product feeds or want to assign different attributes.

8. In the **Feed Schedule** section, you define the feed generation frequency settings:
   - In the **Generate Feed** field, select the frequency for product feed generation.
   - If you select **Manually**, the product feed is only generated when you click the **Generate Now** button after saving the record.

   **Note:** If you want the target service to fetch the data feed from the public link, take into account the interval with which the service fetches and processes the data feed when choosing a value for the feed schedule.

9. If you choose Google product feed as the feed type and want to incorporate promotion data for use in Merchant Promotions, select the **Promotions Feed Configuration** to be used.

   For more information, see **Create a Promotion Feed**.

10. If you select custom CSV as the feed type, the **Custom CSV Export Settings** section is shown:
   - a. Check the **Hide CSV Header** box if you do not want to export the attribute labels as headers in the resulting CSV output file.
      Otherwise, the attributes defined in the saved search in the Custom Label column are exported as a header row.
   - b. Check the **Item Link** box if you want to export an extra column that includes a link to the product item in the output.
      If you select this box, enter the label to be used for item links in the **Item Link Label** field.
      The default value is `link`. Item Link is a required attribute for Google and Facebook product feeds.
   - c. Check the **Image Link** box if you want to export an extra column that includes a link to the item's product image in the output.
      If you select this box, enter the label to be used for image links in the **Image Link Label** field.
      The default value is `image_link`. Image Link is a required attribute for Google and Facebook product feeds.
   - d. Check the **Availability** box if you want to export an extra column that includes the item's availability in the output.
      If you select this box, enter the label to be used for availability status in the **Availability Label** field.
      The default value is `availability`. Availability is a required attribute for Google and Facebook product feeds.
   - e. Check the **Parent Record ID (Matrix Item)** box if you want to export the ID of the parent record for each child item exported in the output.
      If you select this box, enter the label to be used for parent record ID in the **Parent Record ID Label (Matrix Items)** field.
      The default value is `item_group_id`.

11. Click **Save**.

When you have saved the Product Feed record, you can proceed to generate the feed. See **Generate the Product Feed**.
Set Product Feed Attributes

SuiteCommerce Product Feeds includes default saved searches for Google, Facebook, and custom CSV. These saved searches have been set up to include all the required and optional attributes for the product feed type as custom labels. However, you may want to include additional information in your product feed that is not defined in these saved searches or select other custom fields as the data source.

When you select a saved search for a specific product feed in the Saved Search field, you can choose to keep the standard settings defined for the default saved search. Alternatively, you can click the Open Selected Search button and create a customized copy of the saved search. This new search can then be selected when you create subsequent product feed records.

When you click the Open Selected Search button, a popup window appears in which you can refine the saved search by entering specific criteria for selecting the items to be included in the product feed and for mapping the NetSuite fields to the custom label to be used for the product feed type. If you do not see the popup window, check that your browser does not block popup windows.

Using the Criteria tab, you can restrict the items retrieved. Items retrieved by the saved search are compared with items in the cache during the feed generation process. For more information on how to set filters in the Criteria tab, see the help topic Advanced Search Criteria Filters.

The Results tab defines the display options for the saved search results. In Product Feeds, this tab is used to determine the product feed attributes exported for the feed type selected. In the Columns subtab, the Field column contains either NetSuite standard fields or formulas that are used when generating the product feed. For fields with the Formula (Text) value, you determine specific values or the source fields to be taken during generation. The Custom Label column contains the product feed attribute label that is used in the feed output. The values in the Custom Label may change depending on the saved search template selected.

**Note:** Formula (Text) fields have been used as placeholders in the default saved searches to ensure all product feed attributes are included in the Custom Label field. If you leave these fields blank, they are not included in the feed. Make sure you specify the field source for these attributes if you want to include them.

For more information on refining saved searches, see the help topic Defining a Saved Search.

Change Currency in Facebook Feeds

The default currency in Facebook product feeds is USD. A different currency can be used by modifying the product feed saved search settings.

**To change the currency in a Facebook Feed:**

1. On the Product Feeds page, click Open Selected Search.
2. On the Results tab of the Saved Search, locate currency_iso_code in the Custom Label column.
3. Change USD in the Formula column to the currency you need. For example, for AUD, change the value in the Formula column to UPPER('AUD').
4. If the Multiple Currencies feature is enabled, do the following additional steps:
   1. On the Criteria tab of the Saved Search, select Pricing Fields... in the Filter column.
   2. In the Saved Item Search popup window, select Currency from the Pricing Filter list, select the required currency, and click Set.
   3. In another row on the Criteria tab, select Pricing Fields... in the Filter column.
4. In the popup window, select Price Level from the Pricing Filter list, select the required price level, and click Set.

5. On the Results tab, click on Online Price and select Pricing Fields... from the list.

6. In the popup window, select Unit Price from the Pricing Field list and click Ok.

7. Click Save.

If you were using the default saved search for Facebook product feeds, then enter a new name in Search Title and click Save As. Ensure that the new search is selected in the Saved Search field on the Product Feed page.

Additional Considerations For Matrix Items

- Child matrix items may not contain all the required information. Check that the parent item and child item have all the required values and they are mapped correctly to the corresponding attribute in the Results tab. For example, check that the field used to source the data for the following attributes is correct:
  - **Title**: By default, the Name field is used for the title product feed attribute. For matrix items, the child item name may result from a combination of the parent name and the matrix option. If you want to use the parent name instead, after the Name field, insert a new field Parent Fields... > Name and use title as a custom label.
  - **Description**: The store description may only be defined on the parent matrix item. To ensure this attribute is not left empty, insert an additional field, Parent > Store Description, after the Description field and enter description as the custom label.

Ensure you do not overwrite the existing Name and Description fields, as these are used for non-matrix items. The order in which the values are taken for matrix items is determined by their position in the list. For example, if a value is present for Store Description, it is taken; if not, the value for Parent > Store Description is taken.

- The Google and Facebook product feeds use the parent matrix item ID to group product variants. The item_group_id attribute is mapped to the parent item ID in the default saved searches for these feed types. For more information, see Google Product Feed specifications.

- To ensure that product images are displayed correctly, check that the image names are as per the guidelines in Image File Naming Guidelines. It is particularly important that the image file names for child matrix items have a non-numeric value after the last delimiter in the image file name. If an image name ends in a numeric value, Google may refuse to accept the product feed.

**Note:** Required fields must not be left blank in the Item record. Otherwise, an error will be triggered in your merchant center when you upload the product feed. See Update Product Feed Fields.

When you have entered the criteria for filtering the items and verified the field mapping, click Save to return to the Product Feed record.

Generate the Product Feed

When you have set up the product feed, determined the item selection criteria, and mapped all required and optional attributes using the saved search, you generate the product feed. The feed generation process compares the items cached previously with those returned by the saved search. It exports the matching items with the information fields specified in the saved search in the output.

With the SuiteCommerce Product Feeds extension, you can generate the product feed in two different outputs depending on the product feed type selected:
XML output file
Custom CSV output

The product feed is generated automatically or manually. If you select an interval in the Generate Feed field when creating the product feed, the product feed is refreshed according to the interval set. If you select Manually in the Generate Feed field, the product feed is only refreshed with the latest data when you click the Generate Feed Now button.

The Product Feed record contains the timestamp of the last feed generation and a public URL where you can access the product feed output. These fields are empty until you generate the product feed for the first time.

You can view the status of the generation in the Generation History list. This list shows the last 20 generation tasks for the Product Feed record. If you want to view the status of several feeds simultaneously, see View the Feed Status.

To generate a product feed manually:

2. Click View for the product feed you want to generate.
3. In the Product Feed record, click Generate Feed Now.

If the item cache has not yet been built for the feed, the Generate Feed Now button is replaced by the message Caching Website Items.

The status of the product feed generation is shown in the Generated At field at the top of the form.

Note: The first time the product feed is generated, the process may take up to one hour. Subsequent product feed generation is likely to be faster, but the time taken depends on the number of items to be included in the feed.

When the product feed has been generated, a public URL link is shown in the Feed Link field.

If you have selected the Google or Facebook product feed type, you can copy and paste this public URL into your service settings so that the service can fetch and process the product feed automatically.

Alternatively, you can click the Download Feed button to access an XML output and download a static copy of the product feed. If the product feed type is custom CSV and you click Download Feed, you download the CSV output.

Create a Promotion Feed

The SuiteCommerce Product Feeds extension SuiteApp includes the Promotion Feed record that enables you to incorporate NetSuite promotions data in the Google product feed for use in Merchant Promotions as part of Google Shopping ads.

Promotion Feed Overview

The Promotion Feed uses the Product Feed and Promotion Feed records to collect the necessary data for export. The mechanism for obtaining the data included in the promotion feed is identical to that of the Product Feed, with additional promotional information retrieved by the Promotion Feed record. See Product Feed Overview.

You create a Promotion Feed record where you specify the promotions you want to include in the feed. You then link to this record when you create the product feed. When you generate the product feed, the product feed generator retrieves the data for the promotions indicated in the Promotion Feed record.
Promotions included as part of the promotions feed must meet the following criteria:

- Be a SuitePromotions item promotion. For more information on setting up item promotions in NetSuite, see Creating SuitePromotions
- Use the default Item Promotion form
- Have no specific items in the Buy conditions
- Be available to all customers. Promotions limited to specific customers are not supported
- Be available to all sales channels. Promotions limited to specific locations are not supported
- Be applicable to the website selected in the product feed record
- Adhere to Google Merchant Promotions requirements. See Google Merchant Promotions Program Policy and Editorial Guidelines

For more information on considerations to bear in mind before creating a promotion feed, see Before You Begin.

The steps for creating a Google product feed with Merchant Promotions are the following:

1. Create the Promotion Feed record
2. Select the promotions to be included
3. Create the Product Feed record
4. Select the Product Feed type
5. Restrict the items to be returned
6. Determine the fields to be returned
7. Select the Promotion Feed record
8. Generate the feed
4. Select the Product Feed type
5. Restrict the items to be returned
6. Determine the fields to be returned
7. Select the Promotion Feed record
8. Generate the feed

**Create a Promotion Feed Record**

The Promotion Feed record creates a link to the Promotion record. The product feed generator uses the Promotion Feed record to get the promotion data associated with the items retrieved in the feed.

**To create a new promotion feed record:**

1. Go to Lists > Feeds > Promotion Feeds > New.
2. In the **Name** field, enter a title to help you identify the promotion feed.
   This is particularly useful if you need to create several promotion feeds to separate your items into smaller product feeds.
3. In the **Feed Description** field, you can add a detailed description of the promotion feed.
4. In the **Promotions Included** tab, select all the promotions you want to include in the feed.
   The promotions are identified by the **Coupon Code**. Select the coupon code in the field and click **Add**.
5. In the **Linked Promotion** tab, select all the promotions you want to include in the feed.
   The promotions are identified by the **Coupon Code**. Select the coupon code in the field and click **Add**.
6. Click **Save**.

**Create a Product Feed Record**

The next step in creating a promotion feed is to create a Google product feed. To do this, you select Google Product Feed as the feed type, and then select either the default saved search for Google product feeds and enter your specific criteria, or select an existing saved search that has been defined for Google product feeds.

For more information, read Create a Product Feed.

**Link the Promotion Feed Record**

You need to associate the Promotion Feed record with the Product Feed record so that the required information can be retrieved from the Promotion records and included in the product feed output with the corresponding Google Merchant promotion attributes.

**To associate the promotion feed with the Google product feed:**

1. Create a new product feed and select Google product feed as the feed type.
   See Create a Product Feed.
2. In the **Saved Search** field, select the default Google feed item search or create a new saved search to map NetSuite fields to Google attributes.
   See Set Product Feed Attributes.
3. Determine the feed generation settings in the Feed Schedule section.
4. In the Promotion Feed Configuration, select the promotion feed record you created.
5. Click Save.

**Generate the Promotion Feed**

When you have created the Promotion Feed and Product Feed records, linked the Promotion Feed on the Product Feed record, and saved the settings, you can generate the promotion feed. You generate it in the same way as the product feed by either setting an interval or clicking Generate Feed Now. For more information, see Generate the Product Feed.

You can access the link to the promotion feed from the Promotion Feed record.

**View the Feed Status**

SuiteCommerce Product Feeds includes an overview of your product and promotion feeds. To access the Feed Status page, go to Lists > Feeds > Status.

You can check the generation status of product and promotion feeds, synchronize Google categories, and view information on the processes run to cache information about website items.

Web store item details such as the item's in-stock status, whether an item is a matrix item, the URL component for the item, and the URLs of the images associated with the item are cached when you install SuiteCommerce Product Feeds for the first time or when you update the SuiteApp.

SuiteCommerce Product Feeds automatically checks the item details every 15 minutes to detect any additions or updates made to the item details already in cache. You can view when a check was last performed in Cache Update End. An optimized rebuild process is run automatically every 2 hours to detect any changes in existing information for items, and the item details for any items that have been added or removed from the product inventory are updated in the cache.

You can trigger the item caching process manually by clicking Rebuild Item Cache. The item cache is cleared, and then fully rebuilt. For more information on the item caching process performed by SuiteCommerce Product Feeds, see Product Feed Overview.

If a feed generation fails or results in an error, the previous, successful feed output is retained until the next time the feed is generated successfully.

With Feed Status, you can synchronize Google product categories. When you click Sync Google Categories, the product feed generator obtains the latest version of the Google product taxonomy for use in the Item record.

Feed Status also displays a list of the feed generation tasks performed for product feeds and promotion feeds on the Product Feed Generation History and Promotion Feed Generation History subtabs, respectively. The Caching History subtab contains a log of all caching jobs performed. The generation history subtabs display the following information:

- feed type
- website domain
- creation date
- generation start date and time
- generation end date and time
- generation status

If you click View, you can view the associated Product or Promotion Feed record.
Testimonials

⚠️ Applies to: Commerce Web Stores | Site Management Tools

The Testimonials extension lets you add up to 3 testimonials that combine text and image to your web page. You can select horizontal or vertical layout. You can add a header, body quotes, and caption and label text for each testimonial. You can link each testimonial to an internal or external URL. For example, with Testimonials, you can showcase your existing customers and feature press mentions.

⚠️ Important: Commerce web store extensions are only available if they are provisioned and set up in your account. For more information, see Commerce Extensions.

>Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

You can add a testimonial to multiple areas on your website using Site Management Tools. For more information on Site Management Tools, see the help topic SMT Overview.

To add a testimonial:

1. Go to the page where you want to add testimonials.
2. Click Add on the Site Management toolbar.
3. Drag the Testimonials content type to the page.

>Note: If you do not see this content type, check that the extension has been installed and is active. Click the Settings button on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

You can drag the Testimonials content type to multiple areas on the page:

- If you drag it to an area marked as all pages, then the content displays on any page that contains that area.
- If you drag it to an area marked as page type, then the content displays on any page of that type.
- If you drag it to an area marked as this page, then the content displays only on the page that you add it to.

4. In the General tab:
   a. Use the Name field to enter a description of your new content.
      See the help topic Content Tags and Filter Tools.
   b. Set the content visibility options.
      See the help topic Visibility Dates.
   c. In the Header field, enter the title for the section.
      A preview displays in the page.
   d. In the Layout field, select horizontal or vertical layout.
      On mobile screen sizes, the layout is always vertical. However, you can choose horizontal layout for desktop and tablet screens.
   e. In the Image Display field, select round or square to determine the image shape you want to display.
f. In the **Text Color** field, choose the color you want for the text fields.

By default, the Header, Caption, and Label text fields use different colors that are taken from your theme. If you select **Dark**, all text fields use the dark text color defined in your theme. If you select **Light**, all text fields use the light text color defined in your theme.

g. In the **Area to Link** field, select the area of the testimonial you want to link.

The options are:
- Caption
- Label
- Image
- Entire Area
- No Link

h. If you want the URLs to open in a new window or tab, select the **Open in New Window** box.

i. Use the **Tags** field to enter keywords that help you filter your content in the Review Changes list.

See the help topic *Content Tags and Filter Tools*.

5. In the **Testimonials** tab:
   a. Select the image you want to display using the Image Manager.

   See *Image Manager*.

   The form of the image is determined by **Image Display** in the General tab.

   b. In the **Alt Text** field, enter a description of the image.

   This text is used to improve web accessibility for visually impaired users and for SEO purposes.

   c. Enter your testimonial text in the **Block Quote** field.

   d. Enter text in the **Caption** and **Label** fields.

   If you do not want to display any text, leave these fields blank.

   You can use these fields to include your customer’s name and company, for example.

   e. If you want to link the testimonial to an internal or external page, enter the URL in the **Link** field.

   This link is opened when the user clicks the area you selected in the **Area to Link** field in the General tab. You can enter absolute URLs (http://www.example.com) and relative URLs (/ search).

6. Repeat step 5 to add up to 2 additional testimonials.

7. Click **Save**.

If you have not published your testimonials and you decided to remove them, you can discard them. If you have already published your testimonials, you can remove them directly from the page where they are located. For more information on the differences between discarding or expiring content, see the help topic *Discard Content Vs Expiring Content*.

**To discard testimonials:**

1. Go to the Review & Publish Changes list.
2. Select the Testimonials content in the list.
3. Click **Discard**.
4. Click **OK**.
To remove testimonials:

1. Go to the page that contains the testimonials you want to remove.
2. Click the Testimonials box.
   This highlights it and displays the content controls.
3. Click Remove.
4. Click OK.

To change an image link or alternative text:

1. Go to the page that contains the testimonial.
2. Select the Testimonials box, and then click the Settings button.
   This displays the Testimonials Settings in the side panel.
3. In the Testimonials tab, enter the URL for the link in the Link field or enter the alternative text in the Alt Text field.
4. Click Save.

Logo List

 Applies to: Commerce Web Stores | Site Management Tools

The Logo List extension lets you add up to 12 images to your web page, include descriptive text, and specify an internal or external URL for each image. You can choose grid or carousel layout and determine how many images to display per line according to screen size. For example, with Logo List, you can display your top brands or partners, highlight certifications and awards, or showcase promotions.

Important: Commerce web store extensions are only available if they are provisioned and set up in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

You can add a logo list to multiple areas on your website using Site Management Tools. For more information on Site Management Tools, see the help topic SMT Overview.

To add a logo list:

1. Go to the page where you want to add a logo list.
2. Click Add on the Site Management toolbar.
3. Drag the Logo List content type to the page.

Note: If you do not see this content type, check that the extension has been installed and is active. Click the Settings button on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

You can drag the Logo List content type to multiple areas on the page:

- If you drag it to an area marked as all pages, then the content displays on any page that contains that area.
If you drag it to an area marked as page type, then the content displays on any page of that type.
- If you drag it to an area marked as this page, then the content displays only on the page that you add it to.

4. In the General tab:
   a. Use the Name field to enter a description of your new content.
      See the help topic Content Tags and Filter Tools.
   b. Set the content visibility options.
      See the help topic Visibility Dates.
   c. In the Header field, enter the title for the content.
      A preview displays in the page.
   d. In the Layout field, choose either grid or carousel layout for your logo list.
   e. In the Logos per Line - Desktop, Logos per Line - Tablet and Logos per Line - Phone fields, select the number of logos you want to display per line for each device type.
   f. In the Text Color field, choose the color you want for the text fields.
      By default, the color is taken from your theme. If you select Dark, the text uses the dark text color defined in your theme. If you select Light, the text uses the light text color defined in your theme.
   g. If you want the URL links to open in a new window or tab, select the Open in New Window box.
   h. Use the Tags field to enter keywords that help you filter your content in the Review Changes list.
      See the help topic Content Tags and Filter Tools.

5. In the Logos tab:
   a. Select the image you want to display using the Image Manager.
      See Image Manager.
   b. In the Alt Text field, enter a description of the image.
      This text is used to improve web accessibility for visually impaired users and SEO purposes.
   c. Enter the logo description in the Caption field.
      This text is displayed below the image. If you do not want to include any text, leave this field blank.
   d. If you want to link the image to an external page, enter the URL in the Link field.
      You can enter absolute URLs (http://www.example.com) and relative URLs (/search).

6. Repeat step 5 for as many logos as you want to display. You can add up to 12 logos. All images should have the same resolution for optimum display.

7. Click Save.

If you have not published your logo list and you decided to remove it, you can discard it. If you have already published your logo list, you can remove it directly from the page where it is located. For more information on the differences between discarding or expiring content, see the help topic Discard Content Vs Expiring Content.

To discard a logo list:

1. Go to the Review & Publish Changes list.
2. Select the Logo List content in the list.
3. Click Discard.
4. Click OK.

**To remove logo list content:**
1. Go to the page that contains the logo list you want to remove.
2. Click the Logo List box.
   This highlights it and displays the content controls.
3. Click Remove.
4. Click OK.

**To change an image link or alternative text:**
1. Go to the page that contains the logo list.
2. Click the Logo List box, and then click the Settings button.
   This displays the Logo List Settings in the side panel.
3. In the Logos tab, enter the URL to link to the logo in the Link field or enter the alternative text in the Alt Text field.
4. Click Save.
SuiteCommerce Customer Management

Managing your customers and leads efficiently while making the sign-up process easier for customers is key to the success of your web store. Commerce web stores let you adapt your web store to your shoppers' registration preferences, avoiding cart abandonment. You can track customers' movements and shopping behavior with specific records in NetSuite.

Web Store Registration

Your web store's registration flow can be customized as required. By default, all new customers who register in your web store and have yet to complete an order are created as Lead records. Using Lead records, you can track potential customers and follow up with specific marketing actions such as email campaigns and promotions to encourage sales and conversion. When a new customer completes an order, the Lead record is converted into a Customer record.

Shoppers may decide not to create a web store account and proceed as a guest shopper. You can still track their sales activity with a Lead record.

You may want only existing NetSuite customers to access your web store and provide them with specific login credentials to do so.

After customers register on your website, the information displayed on the My Account pages can also be customized to adapt to your business requirements. Customers can view their purchase history, request a return, update billing or shipping information, and even create or view an estimate.

Not all users registering on your website remain active customers. Passwords expire for web store customers who meet either of the following criteria:

- The customer has not logged in within the previous three years.
- It has been more than 90 days since the customer registered a login name and created a password, and the customer never logged in again.

If such a customer attempts to log in, they receive an error message that their password has expired. They can create a new password using the standard 'forgot password' functionality.

Customer Registration Flow

There are 3 ways shoppers can proceed with an order in your web store:

- Guest Shopper
- New Customer
- Existing Customer

Different flows and actions are triggered depending on the type of customer.
Guest Shopper

Shoppers can submit an order without having to create a login and password. However, even though the shopper is not logged in, you can track the shopper’s movements to determine patterns in shopping behavior and identify sales trends.

To enable the Guest Shopper flow:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. On the Shopping subtab, in the Registration Page section, set the Customer Registration Is field as either disabled (for Guest Checkout only) or optional (Existing Customer, New or Guest Shopper).
3. Click Save.
When shoppers choose to check out as a guest, they must enter a name and an email address in the form that appears so that an order confirmation message can be sent after the order has been completed. The information entered in this form is used to create a Lead record. If you do not use auto-generated numbers, the customer ID is automatically generated as Guest Shopper XY, where XY is a sequential number. This means that if you search for the customer or lead by name, it appears as Guest Shopper XY.
Customer Registration Flow

268

Note: If Customer records in your account use Auto-Generated Numbers, the Customer ID of the Lead record is created using the company’s set numbering sequence with New Customer, not as Guest Shopper XY. For more information, see the help topic Set Auto-Generated Numbers.

When the shopper places the order, the Lead record is converted into a Customer record. The sales order that the shopper has just completed appears in the Sales subtab of this guest shopper record, in Transactions.

If the shopper decides to create an account after completing the order, the existing Customer record is modified to add any additional information provided.

Note: Since no customer-specific record is created, shoppers who choose the guest shopper option need to enter personal information every time they purchase from your web store.

New Customer

The New Customer flow enables shoppers to create an account in the web store. With an account, shoppers can view their purchase history, perform item returns, and configure default shipping and payment options to use when they purchase.

To enable the New Customer flow:

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. On the Shopping subtab, in the Registration Page section, set the Customer Registration Is field as either optional (for Existing Customer, New Customer or Guest Shopper) or required (Existing or New Customer).
3. Click Save.
When shoppers register as new customers, a standard registration form containing fields such as First and Last Name, Email Address and Password is displayed.

Using the registration form, customers can opt in or out of email marketing campaigns. For more information about how customer email subscriptions are managed in NetSuite, see the help topic Subscription Management.

When the shopper has submitted the required information, a number of actions are triggered. If Web Site Duplicate Email Management is enabled, a check is performed to ensure there is no existing Lead or Customer record with the same email address. If a duplicate Lead or Customer record with the same email address is found, the shopper is notified with an alert message. For more information, see Detect Duplicate Customer Email.

If email duplication detection is not enabled, a new Lead record is created.
The shopper enters a shipping address and a contact phone number, selects the desired delivery method, and enters a payment method. Depending on the checkout flow enabled, the information entered is added to the Lead record either after each step or when the order is submitted. For more information on the checkout flow, see Checkout Flows.

When the shopper places the order, the Lead record is converted into a Customer record. The sales order reference is added to the Sales subtab, in Transactions.

Existing Customer

In this flow, a Customer record has been created previously, either by the customer or by the Site Administrator. This flow is particularly useful in a B2B scenario where the organization wants to provide partners or customers with login credentials. Information such as shipping and payment information, as well as any special pricing conditions, for example, can be automatically taken from the Customer record.

**To enable the Existing Customer flow:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. On the Shopping subtab, in the Registration Page section, set the Customer Registration Is field as optional (Existing Customer, New or Guest Shopper), required (Existing Customer or New) or existing customer only (Existing Customer).
3. Click Save.
The customer enters the login credentials provided by the website administrator or the email address and password used originally to create the account in the existing customer form.

During checkout, the default shipping address, delivery method and payment method are taken from the Customer record. The customer can optionally edit these default options if required. If any changes are made to shipping, delivery or payment details, the information is updated in the Customer record either after each step (in multi-step checkout) or when the order is submitted.

Since the customer already has a Customer record, no conversion takes place, however the sales order is added to the **Sales** subtab, **Transactions**.

**Configure Customer Website Settings**

This section provides information on how to set up your web store for customers. It involves a number of steps:
Configure Customer Website Settings

<table>
<thead>
<tr>
<th>Set up the customer registration flow</th>
<th>Configure Site Registration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine specific permissions for customers</td>
<td>Create the Website Customer Center Role</td>
</tr>
<tr>
<td>Prevent customers from signing up several times using the same email address</td>
<td>Detect Duplicate Customer Email</td>
</tr>
</tbody>
</table>

**Configure Site Registration**

To set up your website for customers, you need to determine the registration workflow for your web store. There are four possible site registration scenarios:

- Existing Customer, New Customer or Guest Shopper
- Existing Customer only
- Existing Customer or New Customer
- Guest Shopper only

Depending on the requirements of your business, you may choose one of the various options. For a more detailed description on the various registration flows and their operation, see Customer Registration Flow.

**To configure site registration:**

1. Go to Setup > SuiteCommerce Advanced > Set Up Web Site.
2. On your Web Site Setup record, click **Edit**.
3. On the **Shopping** subtab, **Registration Page** section, select the desired option in the **Customer Registration Is** field. The options are: disabled, optional, existing customer only, and required.
   - To enable all possible registration flows, select **optional**.
   - To only enable Existing Customer or New Customer registration flows, select **required**.
   - To enable Guest Shopper registration flow only, select **disabled**.
   - To enable Existing Customer registration flow only, select **existing customer only**.

   For more information on the different flows, see Customer Registration Flow.

4. Click **Save**.

**Note:** If you have multiple websites, you may want to ensure that a customer only has access to a specific site. Customers are assigned to all sites by default. To change this behavior, see the help topic Assign Customers to Websites.

**Create the Website Customer Center Role**

You should create a specific Customer Center role for your website. The Customer Center role determines the information shown in the My Account section of your website, and the login access permissions given to customers. All new customers are automatically assigned this role when they register.

**Note:** In the following scenario, the standard Customer Center role is used; however, it is recommended that you customize this role to suit your web store requirements.

**To customize the Customer Center role:**

1. Go to Setup > Users/Roles > Manage Roles.
2. Click **Customize** next to the Customer Center role.

3. In the **Name** field, enter a name for your custom Customer Center role. For example, Website Customer Center.

4. In the **Subsidiaries** field, select the subsidiary your website is associated with.

5. Click the **Permissions** subtab.
   1. On the **Transactions**, **Lists**, and **Setup** subtabs, click the name of the task for which you want to change access.
   2. In the **Level** column, adjust the permission level for the task.
      For example, to prevent customers from generating statements from their My Account page, change the value from **Create** to **None**.
   3. Click **OK**.

6. Click the **Forms** subtab. On Transaction and CRM, check the box in the Preferred column next to the form.

7. Click **Save** to create the custom role.

The table below gives some of the permissions available for the standard Customer Center and their impact on your website's My Account section. The default permission level for the standard Customer Center is given. For a full list of the standard role permissions defined for the Customer Center, read the help topic **Standard Roles Permissions Table**.

### Transaction subtab

<table>
<thead>
<tr>
<th>Permission</th>
<th>Standard Customer Center Permission</th>
<th>Action in My Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate</td>
<td>View</td>
<td>Customers can view quotes created by their sales representative in My Account.</td>
</tr>
<tr>
<td>Generate Statements</td>
<td>Create</td>
<td>Customers can print a statement that lists all transactions, including invoices, credit memos and payments, for a given date range.</td>
</tr>
<tr>
<td>Invoice</td>
<td>View</td>
<td>Customers can view their invoice history.</td>
</tr>
<tr>
<td>Return Authorization</td>
<td>Create</td>
<td>Customers can request item return directly from My Account.</td>
</tr>
<tr>
<td>Sales Order</td>
<td>Edit</td>
<td>Customers can view their purchase history in My Account.</td>
</tr>
</tbody>
</table>

### Lists subtab

<table>
<thead>
<tr>
<th>Permission</th>
<th>Standard Customer Center Permission</th>
<th>Action in My Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issues</td>
<td>View</td>
<td>If you have set up Issue Management, customers can view issues and their status.</td>
</tr>
<tr>
<td>Cases</td>
<td>Edit</td>
<td>If you have set up Support Management, customers can view cases and their current status.</td>
</tr>
</tbody>
</table>

For more detailed information on configuring the Customer Center role to suit your requirements, see the help topic **Customizing the Customer Center Role**.
To set the default customer role for your website:

1. Go to Setup > Company > General Preferences.
2. In the Default Role for New Customers field, select the newly customized Website Customer Center role.
3. Click Save.

Detect Duplicate Customer Email

The Website Duplicate Email Detection feature prevents web store shoppers from creating duplicate customer accounts on your website. This feature detects duplicate email addresses when a customer chooses to register for an account. If a duplicate email address is detected, the customer is notified with an alert message, but the web store checkout workflow can proceed.

To set up duplicate email management for your website:

1. Enable the feature.
   a. Go to Setup > Company > Enable Features.
   b. On the Web Presence subtab, check the box next to Web Site Duplicate Email Management.
   c. Agree to the terms of service.
   d. Click Save.
2. Go to Setup > Company > General Preferences.
3. Under Web Site Duplicate Email Management, select Enable Duplicate Detection.
4. Click Save.

After you enable website duplicate email detection, shoppers cannot sign up for a customer account with an email address that belongs to an existing customer. If a duplicate email address is detected, the shopper can either register with a new email address or reset the password for their customer account. In OneWorld accounts, shoppers are not allowed to register with an email address that is already assigned to an existing customer in the same subsidiary.

Exceptions to Duplicate Website Email Detection

Duplicate customer email management only affects customer registration on your website. Note the following cases when the system does not block the customer from entering a duplicate email address.

Duplicate email addresses are allowed in the following cases:

- PayPal Express Checkout.
- Contacts with web store access using the same email address as the associated Customer.
- Customers in a OneWorld account who register in different subsidiaries. (They are only blocked from signing up with the same email address in the same subsidiary.)
Customers and Leads without web store access, such as in guest checkout. (A new Anonymous or Default Customer record is created with each guest checkout. Duplicate email addresses are not blocked.)

Customize the Error Message Shown when a Duplicate Email Address is Detected

You can customize the error message that is displayed to the shopper when a duplicate email address is detected. Shoppers who try to register with an existing email address are shown an error message indicating that the email address is already in use. The error message that is displayed by default prompts the customer to log in with the original password or enter a different email address. You can customize the message that notifies the shopper of the duplicate email address.

To customize the alert message for duplicate website email detection:

1. Go to Setup > SuiteCommerce Advanced > Customize Text.

   ![Note: Refer to Using Web Site Text Groups for general instructions on working with the Customize Web Site Text user interface.]

2. Click on the Error Messages subtab.

   The Default Text column displays the default value for each block of text that appears in the web store. The blank fields in the Customization column are for your customized changes to the existing text. The Description column provides more information about some of the fields.

3. Use the browser search to find the following block of text on the page. You can modify the text of the alert message that customers see when they try to register on your website with an email address that already exists:

   You registered as a new customer, but a customer already exists with the email, {1}. Please log in with the original password, or enter a different email address.

   ![Note: The variable in the message, {1}, is replaced with the duplicate email address.]

4. Copy the HTML in the Default Text column, make your changes, and then paste your customized HTML in the Customization column.

5. Click Save.

Customize Customer Registration Communications

The registration process is a key point of contact in the shopping cycle. Reaching out to customers in a language they understand is important for encouraging lead conversion and increased sales. Commerce web stores let you customize the email templates used during the registration process so that you can personalize the shopping experience and process leads more efficiently.

Registration Confirmation Template

When a new customer has completed registration on the website, an email message is sent that confirms customer registration. The template used for this email message can be customized. For more information on customizing the default email template for registration confirmation, see Registration Confirmation Email Messages.
Communications

Applies to: Commerce Web Stores

Communications are a key part of your marketing strategy and aim to optimize customer engagement. Commerce web stores let you personalize your messages, so that your communications achieve the maximum effect and build brand awareness.

You can:

- Create custom templates to be used for email communications from your website
- Choose the default template to be used for different communication types, such as order status emails, password recovery emails, and checkout error alerts
- Determine the sender address for email communications
- Manage users' subscription status for newsletters
- Add social sharing capabilities to your website

Email Management

Applies to: Commerce Web Stores

There are a number of tasks you can perform to manage customer email communication in the web store. Refer to the following topics for detailed information.

- Web Store Email Setup
  - Website Email Settings — this topic describes how to select web store email preferences including when the email is sent, to whom the email is sent, and the content of the email.
  - Templates for Website Email Messages – this topic describes how to define the content of web store email.
- Change Email Address

For information on email communications sent from NetSuite, see the help topic Sending Email from NetSuite.

Website Email Settings

On the Web Site Setup page, you can set preferences for sending email messages for Commerce web stores.

- See Set Website Email Preferences for information on how to set the default from email address and the header and footer of website email.
- See Select Email Templates for your Web Site for information on how to set email preferences, such as when the email is sent, to whom the email is sent, and the content of the email, for different types of email messages sent from the web store.

If you use the Multiple Web Sites feature, you can set preferences and select different email message templates for each site.
Set Website Email Preferences

On the Web Site Setup record, you can set preferences and choose the content of different types of email sent from Commerce web stores. If you use the Multiple Web Sites feature, you can set preferences and select different email message templates for each site.

To set preferences for email messages sent from your website:

1. Go to Setup > SuiteCommerce Advanced/ Site Builder > Set Up Web Site.
2. If you use the Multiple Web Sites feature, click Edit next to a website.
3. Click the Email subtab.
4. (Optional) In the Default Web Store Email From field, enter the email address to show in the From field when email notification messages are sent to website customers. Ensure that you have set up a DKIM key for the domain from which you want to send email. For more information on DKIM, see the help topic DomainKeys Identified Mail (DKIM).
   
   Note: This address is only used if you leave the Email From Address field blank on any of the email template settings.

5. (Optional) To control the content in the header and footer of email, create files for the header and footer, upload them to the File Cabinet, and include them in the system email templates using the #include directive. For more information, see the help topic Inserting Subtemplates into Templates.

6. You can set preferences and select email content for each email type on each of the subtabs displayed on the page. See Select Email Templates for your Web Site, for a complete list of the preferences and settings available.

7. After you set your preferences, click Save.

Select Email Templates for your Web Site

Email templates define the content used in your website email.

See Templates for Website Email Messages for more information.

On the Web Site Setup page, use the subtabs on the Email tab to set preferences and to choose content for each of the following types of web store email message:

- Order Emails
- Digital Delivery Email
- Other Emails

Order Emails

On the Order Emails subtab, you can set preferences for email messages generated at each stage of a web order: Order Received, Order Approved, Order Canceled, and Order Fulfilled. The Order subtab contains a section for each email type and the following procedure applies for all of them.

To set preferences for web store order email:

1. Select the Send Email box, to send an email message to customers when an order is received, approved, canceled or fulfilled.
   
   If the shopper is a business customer that has one or more contacts placing orders on its behalf, the email preference CC Customer on All Emails Related to Orders Placed by Contacts
determines the email addresses to which the order email message is sent. See Identify Order Creator for more information.

2. In the Email From Address field, enter the email address to use as the email's From address.

![Note: Ensure that you have set up a DKIM key for the domain from which you want to send email. See the help topic DomainKeys Identified Mail (DKIM) for more information.]

3. If you want to receive copies of the order email messages sent to your customers, select the Send BCC Emails box and enter the email address in the following field.

   You can enter more than one address separated by a comma.

4. Select the email template you want to use from the Select a System Email Template list. If you use multiple languages in your site, you can define multiple language versions in the same email template. See Templates for Website Email Messages for more information.

5. (Optional) Click on the Preview icon to see what your email will look like when it is sent. You can preview only those email that are based on system email templates. See Preview Website Email Templates for information on the preview options available.

Digital Delivery Email

On the Digital Delivery emails subtab, you can set preferences for email messages generated when a customer orders a downloadable item or a gift certificate.

To set preferences for web store digital delivery email:

1. Select the Send Email box, in the appropriate section, to send an email message to customers.

   If the shopper is a business customer that has one or more contacts placing orders on its behalf, the email preference CC Customer on All Emails Related to Orders Placed by Contacts determines the email addresses to which the order email message is sent. See Identify Order Creator for more information.

2. In the Email From Address field, enter the email address to use as the email's From address.

![Note: Ensure that you have set up a DKIM key for the domain from which you want to send email. See the help topic DomainKeys Identified Mail (DKIM) for more information.]

3. If you want to receive copies of the message sent to your customers when a gift certificate is purchased on your website, select the BCC Gift Certificate Emails box and enter the email address in the following field.

   You can enter more than one address separated by a comma.

![Note: On the digital delivery subtab, you only have the option to BCC gift certificate email messages.]

4. Select the email template you want to use from the Select a System Email Template list. If you use multiple languages in your site, you can define multiple language versions in the same email template. See Templates for Website Email Messages for more information.

5. (Optional) Click on the Preview icon to see what your email will look like when it is sent. You can preview only those email that are based on system email templates. See Preview Website Email Templates for information on the preview options available.

Other Emails

On the Other Emails subtab, you can set up the following email notifications:
Checkout Error Alerts

You can receive alerts if an order is not submitted because of an error that occurred at checkout. Email alerts sent to you include a ticket number that refers to the error logged in NetSuite. If you receive several alerts, please contact NetSuite Customer Support with these ticket numbers to expedite a resolution.

To set preferences for checkout error alerts:

1. Select the **Send Email** box, to accept email alerts if a customer is unable to submit an order because an error was logged from your website.
2. In the **Email From Address** field, enter the email address to use as the email's From address. You can use this field to filter the alert messages you receive. For example, this can be useful if you choose to forward error alerts to your mobile phone.

   **Note:** Ensure that you have set up a DKIM key for the domain from which you want to send email. See the help topic [DomainKeys Identified Mail (DKIM)](https://www.netsuite.com/) for more information.

3. In the **Email To** box, enter the email address where you want to receive web store alert messages. You can enter multiple email addresses separated by commas.
4. Select the email template you want to use from the **Select a System Email Template** list. If you use multiple languages in your site, you can define multiple language versions in the same email template. See [Templates for Website Email Messages](https://www.netsuite.com/) for more information.
5. (Optional) Click on the Preview icon to see what your email will look like when it is sent. You can preview only those email that are based on system email templates. See [Preview Website Email Templates](https://www.netsuite.com/) for information on the preview options available.

Web Store Password Recovery Email Messages

You can customize the password recovery email message delivered when web store customers want to reset the passwords they use to login on your website. By creating a custom email template specifically for password recovery purposes, you can apply the same company branding that you apply to other messages customers receive from your site.

**Note:** The password recovery link expires one hour after it is sent.

To set preferences for web store password recovery email messages:

1. Select the **Send Email** box, to send an email message when a customer on your site makes a request to reset a password.
2. In the **Email From Address** field, enter the email address to use as the email's From address.

   **Note:** Ensure that you have set up a DKIM key for the domain from which you want to send email. See the help topic [DomainKeys Identified Mail (DKIM)](https://www.netsuite.com/) for more information.

3. Select the email template you want to use from the **Select a System Email Template** list. If you use multiple languages in your site, you can define multiple language versions in the same email template. See [Templates for Website Email Messages](https://www.netsuite.com/) for more information.
4. (Optional) Click on the Preview icon to see what your email will look like when it is sent. You can preview only those email that are based on system email templates. See Preview Website Email Templates for information on the preview options available.

Registration Confirmation Email Messages

You can set preferences for registration confirmation email messages on the Other Emails subtab of the Web Site Setup page.

To set preferences for registration confirmation email messages:

1. Select the Send Email box, to send a registration confirmation email message to customers who sign up on your website.
2. In the Email From Address field, enter the email address to use as the email's From address. If you operate multiple sites, you can enter a different address for each site.

   ![Note:](#) Ensure that you have set up a DKIM key for the domain from which you want to send email. See the help topic DomainKeys Identified Mail (DKIM) for more information.

3. If you want to receive copies of the registration confirmation email message, select the BCC Registration Confirmation Email box and enter the email address in the following field. You can enter more than one address separated by a comma.
4. Select the email template you want to use from the Select a System Email Template list. If you use multiple languages in your site, you can define multiple language versions in the same email template. See Templates for Website Email Messages for more information.
5. (Optional) Click on the Preview icon to see what your email will look like when it is sent. See Preview Website Email Templates for information on the preview options available.

Templates for Website Email Messages

System email templates are used for all types of system-automated email in NetSuite including website email. These templates are highly customizable and give you good control over the appearance and content of email sent from your web store. For example, you can customize how ordered items are displayed and you can add product pictures.

If you have the Multi-Language feature enabled, you can set up multiple language versions of the same email template without needing to create individual templates for each language. Web store users receive the email message in their preferred language.

Website email templates have a preview facility that enables you to see what the email will look like when it is sent to the web store customer. In the preview page, you can choose the website from which the email is sent, the language in which it is sent, and other key details, resulting in a preview that is an accurate representation of the email the web store customer will receive. For more information, see Preview Website Email Templates.

The following default email templates are available for website email messages at Setup > Company > Email > System Email Templates. They are mobile-friendly and are available in all languages supported by NetSuite:

- **Template Category: Web Site Order Notifications**
  - Standard Web Site Order Received
  - Standard Web Site Order Canceled
  - Standard Web Site Order Approved
You can select which email templates you want to use in the web store on the Web Site Setup page. See Select Email Templates for your Web Site for more information.

Create and Modify Email Templates

You can create new email templates and modify existing ones from Setup > Company > Email > System Email Templates. The process for creating and modifying email templates for website email is the same as that for creating and modifying other types of email templates. For more information see:

- Customizing Templates for System-Automated Email
- Scriptable Templates
- Synthetic Fields for Scriptable Templates

It is important to remember, that when you create a new email template for a website email, you must attach it to one or more of the following template categories:

- Web Site Order Notifications
- Web Site Digital Delivery Notifications
- Web Site Other Notifications

For more information about template categories, see the help topic System-Automated Template Categories.

Preview Website Email Templates

This functionality shows you what the selected website email will look like to a web store customer. If you have multiple websites in your account or multiple languages defined in the email template, you can quickly see what the email will look like when sent in different languages from different websites. Depending on the type of email you are viewing, you can also select other options on the preview page to create a preview of a specific email.

Note: Email preview is available only for system email templates for web stores. It is not available for other types of system email templates.

View the Preview System Email Templates video
To preview a website email:

1. Go to Setup > SuiteCommerce Advanced/ Site Builder > Set Up Web Site.
   If you use the Multiple Web Sites feature, click Edit next to the website whose email you want to preview.
2. Click the Email subtab.
3. Click the subtab that contains the email you want to preview. For example, if you want to preview the Order Received email, click the Order Emails subtab.
4. Locate the email type you want to preview, for example, Order Received. Ensure the email template you want to preview is selected in Select a System Email Template, and click the preview icon next to it.
   
   **Tip:** If you cannot see the preview icon, move your mouse over the Select a System Email Template field. The preview icon is displayed to the right of the field.

5. In the preview window, select the language in which to view the email. Multiple languages are available if the Multi-Language feature is enabled and if multiple languages are defined in the system email template.
6. (Optional) If you have more than one website set up in your account, you can change the website for which you want to see the email preview.
7. Depending on the Email Type you are viewing, other preview options may be available. These include:
   - **Sales Order** - the sales order for which you want to preview the email. This list is available for the email types: Order Received, Order Canceled, Order Approved, Gift Certificate, and Gift Certificate Confirmation.
   - **Fulfilment** - the item fulfilment number for which you want to preview the email. This list is available for the email type Order Fulfilled.
   - **Gift Certificate** - the gift certificate for which you want to preview the email. The name and recipient email address of each gift certificate in the selected sales order is displayed in the list. This list is available for the email types: Gift Certificate, and Gift Certificate Confirmation.
   - **Cash Sale** - the cash sale number for which you want to preview the email. This list is available for the email types: Download Available, Gift Certificate Confirmation, and License Code.
   - **Customer** - the name of the customer for whom you want to preview the email. This list is available for the email types: Checkout Errors, Password Recovery, and Registration Confirmation.

   **Note:** These lists contain the most recent values. You can also type in the value.

8. Click Preview.

You can generate previews with different combinations of preview options in the same preview window. For example, you can see what the Order Received email will look like in different languages and for different sales orders just by changing the preview options.

**Records and Fields Available in Website Email Templates**

The following table lists all the records and synthetic fields that are supported in the Text Editor field on the System Email Templates page and in template files you create and attach there. In addition to the synthetic fields, you can also use the standard record fields belonging to the listed records. System email templates use the same record, field, and sublist IDs that are used in SuiteScript. Refer to the SuiteScript.
Records Browser for a complete list of these IDs. For more information about the sublists and synthetic fields supported for website system email templates see the help topic Web Site Notification Fields.

<table>
<thead>
<tr>
<th>Record</th>
<th>Field</th>
<th>Available for Email Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Site</td>
<td>customerCenterUrl</td>
<td>Order Received, Order Approved, Order Cancelled, Order Fulfilled</td>
</tr>
<tr>
<td></td>
<td>url</td>
<td>Download Available, License Code</td>
</tr>
<tr>
<td></td>
<td>domain</td>
<td>Gift Certificate, Gift Certificate Confirmation, Password Recovery, Checkout Errors, Registration Confirmation</td>
</tr>
<tr>
<td></td>
<td>downloadLink</td>
<td>Download Available, License Code</td>
</tr>
<tr>
<td></td>
<td>recoveryPasswordUrl</td>
<td>Password Recovery</td>
</tr>
<tr>
<td></td>
<td>errorTicket</td>
<td>Checkout Errors</td>
</tr>
<tr>
<td>Sales Order</td>
<td>cartContents</td>
<td>Order Received, Order Approved, Order Cancelled, Order Fulfilled</td>
</tr>
<tr>
<td></td>
<td>trackingLink</td>
<td>License Code</td>
</tr>
<tr>
<td></td>
<td>overviewTable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>itemAvailabilities</td>
<td>This field can be used to calculate whether or not an item is out of stock. The calculation to obtain this information depends on how you have set up the ordering workflow in NetSuite. See <a href="#">Include Out of Stock Information in Website Email</a> for more information.</td>
</tr>
<tr>
<td></td>
<td>licenses</td>
<td>License Code</td>
</tr>
<tr>
<td>Cash Sale</td>
<td>licenses</td>
<td>License Code</td>
</tr>
<tr>
<td>Item Fulfilment</td>
<td>trackingLink</td>
<td>Order Fulfilled</td>
</tr>
<tr>
<td></td>
<td>overviewTable</td>
<td></td>
</tr>
</tbody>
</table>

The following synthetic fields are not associated with a record but are available for use in website email templates:

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
<th>Available for Email Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>itemurls</td>
<td>Provides the URL of the item detail page.</td>
<td>Order Received, Order Approved, Order Cancelled, Order Fulfilled</td>
</tr>
<tr>
<td><strong>Usage format:</strong></td>
<td>${itemurls[item.internalId]}</td>
<td></td>
</tr>
</tbody>
</table>
Include Out of Stock Information in Website Email

The `itemAvailabilities` synthetic field contains the number of items available for sale, taking into consideration items in warehouses minus items already committed to other orders. The exact formula to calculate whether or not an item is out of stock depends on how you have set up the ordering workflow in NetSuite. For example, it is possible to use scripts and custom workflows to change the point in the ordering process at which an order is fulfilled, thus affecting the items available in the warehouse. If your setup allows items to be set to ‘backordered’, this also affects the number of items available. Therefore, you should evaluate your workflows to determine how to use `itemAvailabilities` to calculate whether an item is out of stock. You can use the result of the calculation in an email template to display whether the item is out of stock or not.

**Note:** `itemAvailabilities` applies only to inventory items, kits, and assembly items.

The following are some sample formulas that could be used to calculate whether an item is out of stock:

**Workflow in which order needs to be approved after it is placed**

```html
<#if (itemAvailabilities[itemline.item.internalId])?has_content && (itemAvailabilities[itemline.item.internalId]?number - itemline.quantity <0)>
  This item is currently out of stock and may be back ordered.
</#if>
```

**Workflow in which order is approved immediately after it is placed**

```html
<#if (salesorder.status == 'Pending Approval')>
  <#if (itemAvailabilities[itemline.item.internalId])?has_content && (itemAvailabilities[itemline.item.internalId]?number - itemline.quantity <0)>
    This item is currently out of stock and may be back ordered.
  </#if>
</#if>

<#elseif (salesorder.status == 'Pending Fulfillment')>
  <#if (itemline.backordered?number gte 0)>
    This item is currently out of stock and was back ordered.
  </#if>
</#if>
```
Change Email Address

Applies to: SuiteCommerce Advanced | Kilimanjaro | Aconcagua

With Commerce and Site Builder web store extensions, users can change their registered email address in the My Account application on the Profile Information page:

1. To change the email address in Commerce web stores, users can go to Home > My Account > Profile Information. The registered address can be updated under Email.
2. To change the email address in Site Builder, users can go to the My Account tab, and then to Change Email under Settings.

Once a user submits the change request, they receive emails to confirm the change. When the user clicks the confirmation link, a confirmation message is displayed within the login/checkout screen.

Note the following default behavior:

- Once a user submits an email change request, two confirmation emails are generated as follows:
  - **Sent to the original email address:** this email informs the user that a change of email address has been requested with instructions to contact the site if they believe the message is generated in error.
  - **Sent to the new email address:** this email contains a confirmation link. When the user clicks the confirmation link for the new email address, they must be logged into the account with their original email before the email change is complete.

- Email changes can be audited on the Customer record at System Information > System Notes. The Change to the email field is recorded with the old and new values.

- The email communication generated for users when they request a change of email are security-sensitive. Therefore, these emails are not recorded in the communication tab of the Customer record. Only the owner of the email address is sent the communication.

- Expiration date for the confirmation is displayed in the confirmation email. A user can resubmit a request at any time to generate a new confirmation email.

- The confirmation email is a system-generated email and cannot be customized.

- Users can continue to log in with their current email address and password until the new email address is verified.

**Note:** This feature is available by default in the Kilimanjaro release of SuiteCommerce Advanced. For instructions on backporting the feature to previous releases of SuiteCommerce Advanced, see the help topic [Change Email Address Patch](#).

Newsletter

Applies to: Commerce Web Stores

Newsletter lets you manage the email subscription status of website visitors, allowing them to sign up to an established email marketing campaign.

SuiteCommerce validates the email address entered in the newsletter subscription form against any existing NetSuite Customer or Lead records with a matching address. For each newsletter subscriber,
SuiteCommerce updates the NetSuite Customer record for existing customers or creates a new Lead record for new users.

**Note:** This is an email subscription opt-in feature only. It is not a marketing campaign or content management tool. After users opt in, it is the merchant's responsibility to manage subscriptions for each Lead or Customer record. See the help topic Subscription Management for details.

For detailed information on creating and managing an email marketing campaign using NetSuite, see the help topic Email Marketing Campaigns.

The Newsletter feature is available as a SuiteCommerce extension SuiteApp. SuiteCommerce Newsletter Sign Up lets you add a newsletter subscription form to your website using Site Management Tools.

**SuiteCommerce Advanced Implementations**

For Aconcagua release of SuiteCommerce Advanced, the Newsletter feature can be implemented as an extension or in the site template as part of the source code. If you choose to implement the Newsletter feature as an extension, you must disable the newsletter form in the source code. See Disable the Newsletter Form.

For the Kilimanjaro Release of SuiteCommerce Advanced and earlier, the Newsletter feature is implemented in the site template as part of the core source code. See Newsletter Sign Up Using Core SCA Source Code.

**Email Subscription Overview**

When a user signs up for a newsletter and enters an email address, SuiteCommerce checks for any existing Customer or Lead records in NetSuite that contain a matching address.

If the address already exists within a Customer or Lead record, SuiteCommerce checks the value of the Global Subscription Status field.

**Note:** The preferred record is the Customer record. If both a Customer record and a Lead record contain a matching address, SuiteCommerce only updates the Customer record. SuiteCommerce updates matching Lead records only if no Customer records are returned.

The values that can be set in the Global Subscription Status field are the following:

- **Soft Opt-In** (globalSubscriptionStatus = 1)
- **Soft Opt-Out** (globalSubscriptionStatus = 2)
- **Confirmed Opt-In** (globalSubscriptionStatus = 3)
- **Confirmed Opt-Out** (globalSubscriptionStatus = 4)

For more information on the subscription statuses, see the help topic Subscription Management.

Depending on the value of the Global Subscription Status field, SuiteCommerce proceeds as follows:

- If the value is Soft Opt-In, no change is made to the Customer or Lead record. A message informs the user that they are already subscribed to the newsletter.
- If the value is Soft Opt-Out, SuiteCommerce changes the Global Subscription Status value in the Customer or Lead record to soft opt-in. A message informs the user that they have signed up for the newsletter.

SuiteCommerce Store Front
- If the value is Confirmed Opt-In, no change is made to the Customer or Lead record. A message informs the user that they are already subscribed to the newsletter.

- If the value is Confirmed Opt-Out, no change is made to the Customer or Lead record. A message informs the user that they can not sign up for the newsletter.

If no Customer or Lead records with a matching address exist, SuiteCommerce creates a new Lead record and sets the Global Subscription Status field to Soft Opt-In. SuiteCommerce then uses the generic lead name and company name set up in SuiteCommerce Configuration field to populate the record’s required Name or Company Name fields. The website then displays a message informing the user that they have signed up for the newsletter.

Set Up Newsletter

SuiteCommerce leverages NetSuite’s subscription management to manage the email preferences for your site’s newsletter.

To use the Newsletter feature, you must enable subscriptions in NetSuite, install and activate the SuiteCommerce Newsletter Sign Up extension, and add the Newsletter Sign Up content type to your site using Site Management Tools.

Note: For the Kilimanjaro Release of SuiteCommerce Advanced and earlier, the Newsletter feature is implemented in the site template as part of the core source code. You need to set up elevated permissions for the Newsletter service manually. See Newsletter Sign Up Using Core SCA Source Code.

To enable subscriptions:

1. In NetSuite, go to Setup > Company > Enable Features > CRM tab.
2. In the Basic Features section, check the Marketing Automation option. This enables the Global Subscription Status in Customer and Lead records.
3. In the Marketing section, check the Subscription Categories and Sales Campaigns options. This enable these campaigns.
4. Click Save.

To install and activate the SuiteCommerce Newsletter Sign Up extension:

1. Go to Customization > SuiteBundler > Search & Install Bundles.
2. Install the SC Newsletter Sign Up bundle.
4. Activate the SuiteCommerce Newsletter Sign Up extension. For more information, see Manage Themes and Extensions.

When you have activated SuiteCommerce Newsletter Sign Up for your domain, you use Site Management Tools to add the newsletter subscription form to your website. See Newsletter Sign Up.

Newsletter Sign Up with Aconcagua

For the Aconcagua Release of SuiteCommerce Advanced, the newsletter sign up feature can be implemented using the SuiteCommerce extension or using the newsletter sign up form incorporated in the site template as part of the core source code.

If you implement the Newsletter feature using the SuiteCommerce extension, you must hide the Newsletter sign up form in the core source code. For more information on how disable the newsletter sign up form, see Newsletter Sign Up Using Core SCA Source Code.

Newsletter Sign Up

The Newsletter Sign Up extension lets you add a newsletter sign up form to your website using Site Management Tools (SMT). After activating this extension, you can:

- Determine how the lead record is created in NetSuite.
- Decide which fields to display on the sign up form.
- Choose the layout and style of the sign up form.
- Customize the error and confirmation messages displayed to users.

The SuiteCommerce Newsletter Sign Up extension is available for SuiteCommerce and for the Aconcagua Release of SuiteCommerce Advanced or later. If you are implementing the Aconcagua Release of SuiteCommerce Advanced, you must disable the Newsletter feature implemented in the core source code. See Disable the Newsletter Form.

> **Important:** SuiteCommerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Before you can implement the Newsletter Sign Up extension, you must first:

2. Install and activate the SuiteCommerce Newsletter Sign Up extension. See Themes and Extensions.

This topic explains how to:

- Add a Newsletter Sign Up Form
- Configure a Newsletter Sign Up Form
Remove a Newsletter Sign Up Form

Use SMT to add, configure, or delete a newsletter sign up form on multiple areas of your website. Adding this form to enhanced or custom landing pages allows you to promote your newsletter in the place and style you want. For more information on Site Management Tools, see the help topic SMT Overview.

Add a Newsletter Sign Up Form

To add a newsletter sign up form to your web store, add the **Newsletter Sign Up** content type to a page of your site using SMT.

**To add a newsletter sign up form:**

1. In your website, navigate to the page where you want to add a newsletter sign up form.
2. Log in to SMT.
   For more information on logging in to SMT, see the help topic Users and Roles.
3. In **Edit** mode, click **Add** on the Site Management toolbar.
4. Drag the **Newsletter Sign Up** content type to the page.
   
   **Note:** If you do not see this content type, verify that the extension has been installed and is active. Click **Settings** on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Types list.

   You can drag a **Newsletter Sign Up** content type to multiple areas on the page.

   For more information on the scopes of different SMT areas, see the help topic Site Management Tools Areas.
5. Click **Save**.

Configure a Newsletter Sign Up Form

Configure properties to customize your newsletter sign up form. You can decide how leads are created in NetSuite, adjust the display options, and choose the field and feedback message texts.

The procedures in this topic explain how to:

- Configure Properties in NetSuite
- Configure General Settings
- Configure Message Settings
- Configure Layout and Style Settings

Configure Properties in NetSuite

To set up the Newsletter Sign Up extension, you must set your preferences in NetSuite.

When a user signs up for the newsletter, SuiteCommerce checks for matching customer or lead records. If no matching record is found, a new lead record is created using the Standard Customer Form as a default.

SuiteCommerce then sets this new record’s **Global Subscription Status** field to Soft Opt-In. If the user does not provide a first name, last name, or company, then the record populates with the **Default First Name**
Name, Default Last Name, or Default Company, which you can set when configuring properties in NetSuite.

For more information on the newsletter subscription process, see Email Subscription Overview.

To configure properties in NetSuite:

1. After activating the Newsletter Sign Up extension for a domain, go to Setup > SuiteCommerce Advanced > Configuration.
   For more information on activating an extension, see Manage Themes and Extensions.
2. Select the website and domain where you want to set up the extension and click Configure.
3. Navigate to the Extensions tab.

   Important: If you previously implemented the Newsletter feature as part of a SuiteCommerce theme built prior to the 2018.2 release of SuiteCommerce or the Aconcagua release of SuiteCommerce Advanced, the properties for this feature are located in the Legacy tab, Newsletter subtab.

   You can only configure the Generic First Name, Generic Last Name, and Company Name properties. See the help topic Newsletter Subtab for details.

4. In the Newsletter Sign Up subtab, set the listed fields, using the table below as a reference.
   You can use the placeholder [[email]] to automatically populate the default fields with the user’s email address. This enables you to identify a user who chooses to leave the name or company fields blank. For example, you can send a personalized marketing email generated from the lead record saying "Welcome user@email.com!" if a name is not known. This placeholder can be used with the following fields:
   - Default First Name
   - Default Last Name
   - Default Company

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marketing Campaign for Lead</td>
<td>Sets the marketing campaign you want to use to track leads when a user subscribes to the newsletter.</td>
</tr>
<tr>
<td>Default First Name</td>
<td>Sets the default text to display in the First Name field of the lead record if a first name is not supplied by the user.</td>
</tr>
<tr>
<td>Default Last Name</td>
<td>Sets the default text to display in the Last Name field of the lead record if a first name is not supplied by the user.</td>
</tr>
<tr>
<td>Create Lead as Company</td>
<td>If checked, creates newsletter sign up leads as companies, rather than individuals. This setting applies to newsletter sign up only.</td>
</tr>
<tr>
<td>Associate Lead To</td>
<td>Determines the subsidiary with which you want the lead to be associated.</td>
</tr>
<tr>
<td>Default Company</td>
<td>Sets the default text to display in the Company field of the lead record if a first name is not supplied by the user.</td>
</tr>
</tbody>
</table>

5. Click Save.

Configure General Settings

Set the general fields in SMT to set up your newsletter sign up form. You can determine the name and display options for fields, as well as button and privacy policy text.
To configure general settings:

1. While logged in to SMT, navigate to the page that contains the newsletter sign up form.
2. In the **Newsletter Sign Up** box, click **Edit**.
   - This displays the Newsletter Sign Up Settings in the side panel.
3. In the **General** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visibility</strong></td>
<td>Determines the visibility option that determines when you would like to make the form visible.</td>
</tr>
<tr>
<td></td>
<td>For more information on visibility options, see the help topic <a href="#">Visibility Dates</a>.</td>
</tr>
<tr>
<td><strong>Header</strong></td>
<td>Sets the title you want to display at the top of the newsletter sign up form.</td>
</tr>
</tbody>
</table>
| **Subtitle**           | Sets the descriptive text you want to display below the header text.  
| **Email Field Label**  | Sets the label for the **Email** field.                                                                                                       |
| **Email Field Hint**   | Sets the text you want to use as a placeholder for the **Email** field.  
| **Show First Name Field** | If checked, displays the **First Name** field to the user.                                                                               |
| **Optional First Name**| If checked, makes the **First Name** field optional.                                                                                         |
|                        | If the **First Name** field is left blank, the **Default First Name** field (SC Configuration record > Extensions > Newsletter Sign Up) is used for the **First Name** field of the lead record. |
| **First Name Field Label** | Sets the label for the **First Name** field.                                                                                   |
| **First Name Field Hint** | Sets the text you want to use as a placeholder for the **First Name** field.                                                           |
| **Show Last Name Field** | If checked, displays the **Last Name** field to the user.                                                                        |
| **Optional Last Name**  | If checked, makes the **Last Name** field optional.                                                                                       |
|                        | If the **Last Name** field is left blank, the **Default Last Name** field (SC Configuration record > Extensions > Newsletter Sign Up) is used for the **Last Name** field of the lead record. |
| **Last Name Field Label** | Sets the label for the **Last Name** field.                                                                                           |
| **Last Name Field Hint** | Sets the text you want to use as a placeholder for the **Last Name** field.                                                        |
| **Show Company Field**  | If checked, displays the **Company** field to the user.                                                                                |
| **Optional Company**    | If checked, makes the **Company** field optional.                                                                                       |
|                        | If the **Company** field is left blank, the **Default Company Name** field (SC Configuration record > Extensions > Newsletter Sign Up) is used for the **Company** field of the lead record. |
| **Company Field Label** | Sets the label for the **Company** field.                                                                                     |
| **Company Field Hint**  | Sets the text you want to use as a placeholder for the **Company** field.                                                            |
| **Button Text**         | Determines the text you want to display on the submit button.                                                                        |
| **Privacy Policy Label** | Determines the text you want to display as a link to a privacy policy page.                                                        |
Configure Message Settings

You can determine the feedback messages shown to users by editing the message fields in SMT.

To configure message settings:

1. While logged in to SMT, navigate to the page that contains the newsletter sign up form.
2. In the Newsletter Sign Up box, click Edit.
   This displays the Newsletter Sign Up Settings in the side panel.
3. In the Messages tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty First Name Field</td>
<td>Determines the message to display when a required First Name field is left blank.</td>
</tr>
<tr>
<td>Empty Last Name Field</td>
<td>Determines the message to display when a required Last Name field is left blank.</td>
</tr>
<tr>
<td>Empty Email Address Field</td>
<td>Determines the message to display when a required Email Address field is left blank.</td>
</tr>
<tr>
<td>Empty Company Field</td>
<td>Determines the message to display when a required Company field is left blank.</td>
</tr>
<tr>
<td>Invalid Email Address</td>
<td>Determines the message to display when an invalid email address is entered.</td>
</tr>
<tr>
<td>Opt-In Subscription Confirmation</td>
<td>Determines the message to display when the user successfully subscribes to the newsletter.</td>
</tr>
<tr>
<td>Already Opt-In</td>
<td>Determines the message to display when the user is already signed up for the newsletter.</td>
</tr>
<tr>
<td>Confirmed Opt-Out</td>
<td>Determines the message to display when the user has opted out of the newsletter.</td>
</tr>
<tr>
<td>Unexpected Error</td>
<td>Determines the message to display when there is an unexpected error during sign up.</td>
</tr>
</tbody>
</table>

4. Click Save.

Configure Layout and Style Settings

You can customize the look of the newsletter sign up form by setting the layout and style fields in SMT.

To configure layout and style settings:

1. While logged in to SMT, navigate to the page that contains the newsletter sign up form.
2. In the Newsletter Sign Up box, click Edit.
   This displays the Newsletter Sign Up Settings in the side panel.
3. In the **Layout & Style** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Newsletter Layout</strong></td>
<td>Determines the layout for the newsletter sign up form.</td>
</tr>
<tr>
<td>■ Vertical</td>
<td>fields stacked in the middle of the container</td>
</tr>
<tr>
<td>■ Horizontal</td>
<td>fields listed horizontally across the container</td>
</tr>
<tr>
<td>■ Align Left</td>
<td>fields stacked in the left side of the container</td>
</tr>
<tr>
<td>■ Align Right</td>
<td>fields stacked in the right side of the container</td>
</tr>
<tr>
<td></td>
<td>On mobile devices, the layout automatically appears as <strong>Vertical</strong>.</td>
</tr>
<tr>
<td><strong>Background Image</strong></td>
<td>Determines the image to use as the newsletter sign up form background.</td>
</tr>
<tr>
<td></td>
<td>Images are aligned to center-middle of the container and cover the full background.</td>
</tr>
<tr>
<td><strong>Image Resize ID</strong></td>
<td>Sets the image resizing option you want the <strong>Background Image</strong> to use.</td>
</tr>
<tr>
<td></td>
<td>To use this option, you must enter an enabled <strong>Image Size ID</strong> found in the <strong>Image Resizing</strong> section of the Web Site Setup record (Setup &gt; SuiteCommerce Advanced &gt; Set Up Web Site &gt; Images).</td>
</tr>
</tbody>
</table>

4. Click **Save**.

### Remove a Newsletter Sign Up Form

Depending on whether you have published the content to your website, use SMT to delete the newsletter sign up form from your site in one of two ways:

- **Discard** the newsletter sign up form if you have not published the content.
- **Remove** the newsletter sign up form if you have already published the content.

**To discard a newsletter sign up form (Unpublished Content):**

1. While logged in to SMT on your website, select the **Review & Publish Changes** list from the Site Management toolbar.
2. Select the **Newsletter Sign Up** content in the list.
3. Click **Discard**.
4. Click **OK**.

**To remove a newsletter sign up form (Published Content):**

1. While logged in to SMT on your website, navigate to the page that contains the newsletter sign up form you want to remove.
2. In **Edit** mode, click the **Newsletter Sign Up** box.
   - This highlights the newsletter sign up content and displays the content controls.
3. Click **Remove**.
4. Click **OK**.

### Newsletter Sign Up Using Core SCA Source Code

**Applies to:** SuiteCommerce | Aconcagua | Kilimanjaro | Elbrus | Vinson

If you are using SuiteCommerce themes from SuiteCommerce Aconcagua, or SuiteCommerce Advanced Vinson, Elbrus, Kilimanjaro, or Aconcagua, the Newsletter Sign Up form is incorporated in your site’s
source code. The form leverages NetSuite's elevated permissions feature to enable email subscriptions for your site.

Configuration properties are located on different tabs in the SuiteCommerce Configuration record, depending on your implementation. For more information, see Configure a Newsletter Sign Up Form.

Set Up Newsletter

SuiteCommerce Advanced releases Vinson, Elbrus, Kilimanjaro, and Aconcagua use elevated permissions that need to be set up manually.

- Enable subscriptions
- Create a custom center
- Create a custom role
- Set up elevated permissions for the service file record

To enable subscriptions:

1. In NetSuite, go to Setup > Company > Enable Features > CRM tab.
2. In the Basic Features section, check the Marketing Automation option. This enables the Global Subscription Status in Customer and Lead records.
3. In the Marketing section, check the Subscription Categories and Sales Campaigns options. This enable these campaigns.
4. Click Save.

To create a custom center:

1. In NetSuite, go to Customization > Centers and Tabs > Centers > New.
2. In the Label field, enter any string to label your new center.
   For example: Custom Employee Center.
3. Click Save.

To create a custom role:

1. In NetSuite, go to Setup > Users/Roles > Manage Roles > New.
2. In the Name field, enter a name for your new custom role.
   For example: Custom Newsletter.
   You select this name when assigning elevated permissions in the Service File record.
3. In the Center Type field, select the custom center you created earlier.
   For example: Custom Employee Center.
4. If you are using NetSuite OneWorld, in the Subsidiary field, select the subsidiaries that are marked as default and online in the Website Setup record.
5. Click the Permissions and Lists subtabs.
6. Set the Level for the Customers permission to Edit.
7. Click Save.
To set Elevated Permissions for the service file record:

1. In NetSuite, go to Documents > Files > File Cabinet.
2. Browse to Web Site Hosting Files > Live Hosting Files > SSP Applications > [Applicable Bundle Folder] > Development > services.
3. Click **Edit** next to the **Newsletter.Service.ss** file.
4. In the File record, check the **Available without login** option.
5. Click the **Permission** subtab.
6. Check the **Enabled** option.
7. In the **Execute as role** field, choose the custom role you created earlier.
   For example: Custom Newsletter.
8. Check the **Run Script Without Login** option.
9. Click **Save**.

### Disable the Newsletter Form

The Newsletter form is incorporated in the core source code of SuiteCommerce Advanced. You must edit the distro file to remove the form.

If you implement the Aconcagua version of SuiteCommerce Advanced and use the SuiteCommerce Newsletter Sign Up extension, you must first disable the Newsletter form. Otherwise, your site displays two sign up forms, one in your site's footer and the new newsletter form you add using Site Management Tools.

To disable the Newsletter feature:

1. Open the distro.json file in the root directory of the SuiteCommerce Advanced source code.
2. Search for and remove or disable any lines that include **Newsletter** within the distro.json file, where \texttt{x.x.x} equals the version.
   For example:
   ```json
   "suitecommerce/Newsletter": "x.x.x",
   "Newsletter.ServiceController",
   "Newsletter"
   ```
3. Save and redeploy the distro.json file.

### Social Media

\textbf{Applies to:} Commerce Web Stores

Commerce web stores let you add a social dimension to your website by incorporating social media share buttons on your product detail pages. Drive more traffic to your website and offer shoppers a richer experience by letting them share items with their favorite social networks.
You can add:

- Pinterest product rich pins that are automatically populated with key item details such as product image, pricing, and availability
- Twitter cards that enable consumers to attach rich photos, videos and media experiences of your products to Tweets
- Facebook Share buttons so that shoppers can share their favorite products with their friends on their timeline or via Facebook Message

### Pinterest

Commerce web stores support Product Rich Pins from Pinterest in the product details page. By default, shoppers can point to an image and then click the Pinterest icon or click the Pinterest button in the cart details region. The Pinterest entry automatically populates with item details such as the product image, pricing, or availability.

The data collection method used for Pinterest is Open Graph semantic markup. With this method, product metadata is included in the HTML header of the product page. The following metadata tag mappings for Pinterest are defined in the `SC.Shopping.Configuration.js` file in the `ShoppingApplication@x.x.x` module:

```javascript
metaTagMapping: {
  // [Open Graph](http://ogp.me/)
  'og:title': seo_title
}
```
For more information and details on supported fields, refer to the Pinterest developer documentation at Pinterest Rich Pins Overview.

The following screenshot shows Open Graph data collected in the HTML header output.

```
<meta property="og:title" content="Topout Shorts">
<meta property="og:url" content="http://coolsuite.com/product/426">
<meta property="og:site_name" content="CooSuite">
<meta property="og:description" content="Our popular, classically-styled hiking short is better than ever. The Cargo Short remains a favorite with its timeless combination of comfort, performance and attention to detail. The seams at the hip have been rotated away so they'll never pinch under a pack. The integrated webbing belt adjusts easily. UPF 50 fabric blocks out UV rays.">
<meta property="og:price:standard_amount" content="24.99">
<meta property="og:availability" content="InStock"/>
```

Configure Pinterest

You can edit Pinterest settings by creating a custom ShoppingApplication@x.x.x module and making your changes to the `SC.Shopping.Configuration.js` file. You can enable Pin It Hover or the Pin It button or both options. Other configuration options are available as shown in the following code snippet. For detailed instructions on creating a custom SuiteCommerce Advanced Module see the help topic Customize and Extend Core SuiteCommerce Advanced Modules in the SuiteCommerce Advanced Developer's Guide

```
// hover_pin_it_buttons
, hover_pin_it_button: {
    enable_pin_it_hover: true
    enable_pin_it_button: true
    image_size: 'main' // Select resize id to show on Pinterest
    popupOptions: {
        status: 'no'
        resizable: 'yes'
        scrollbars: 'yes'
        personalbar: 'no'
        directories: 'no'
        location: 'no'
        toolbar: 'no'
        menubar: 'no'
        width: '680'
        height: '300'
        left: '0'
        top: '0'
    }
}
Important: Within the `SC.Shopping.Configuration.JS` file, there is also a Pinterest setting within the `addThis.servicesToShow` function. Enable Pinterest using the `hover_pin_it_button` function instead of the `addThis.servicesToShow` function. Due to the single page configuration of SuiteCommerceAdvanced, enabling Pinterest from the `addThis` function can result in incorrect product information displayed in the users Pinterest board.

Validate Rich Pins

You must validate your rich pins and apply to have Pinterest enable them. To validate your Pinterest Rich Pins, use the [Rich Pins Validator](https://developers.pinterest.com/pinvalidator/) tool on the Pinterest developer's site. To use this tool, enter the URL for the product to test. The validator returns a success or error message. If the test is successful, the validator displays the item details that are used for pinning that product.

After the pin is validated, you must click the **Apply now** button to verify your domain. The domain field will be automatically populated with your domain. After your domain is verified, your pins will show on Pinterest within the hour.

Note: You need to validate and click the apply button for only one link on your site. This validation applies to all pins on your site.

Twitter Product Cards

Commerce web stores support Twitter Product Cards which enable shoppers to attach media experiences to Tweets that link to product detail pages. Shoppers can Tweet your products by clicking the Twitter button on the product details page and a card visible to all of their followers is automatically added to their Tweet. This Card can show item details including an image, a description, and two other key item details such as price, availability, sizes or colors.

For more information on Twitter Product Cards see [Product Cards](https://developer.twitter.com/docs/cards/types/product-card).

Configure Twitter Product Cards

Follow the correct configuration procedures below, depending on the version of SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic [Configuration Properties Reference](https://docs.oracle.com/cd/E24927_01/commerceapps/SC_Shopping/Configuration.html).

Required Twitter Product Cards properties are automatically configured within the `SC.Shopping.Configuration.JS` file in the ShoppingApplication module. These include product details such as title, description, and image:

```javascript
// [Twitter Product Card](https://dev.twitter.com/docs/cards/types/product-card)
,   'twitter:card': seo_type
,   'twitter:site': seo_twitter_site
,   'twitter:creator': seo_twitter_creator
,   'twitter:title': seo_title
,   'twitter:description': seo_twitter_description
,   'twitter:image:src': seo_image
,   'twitter:domain': seo_domain
,   'twitter:label1': seo_twitter_price
,   'twitter:label1': seo_twitter_label_one
,   'twitter:availability'
```
The following screenshot shows the Twitter data collected in the HTML header output.

```html
<meta property="twitter:card" content="product">
<meta property="twitter:title" content="Your Athletic Shoe">
<meta property="twitter:creator" content="#famous">
<meta property="twitter:product" content="Trekkin Thermal Henley Shirt">
<meta property="twitter:description" content="A performance twist on a classic. We designed this shirt to combine the look and comfort of a classic long-sleeve top...">
<meta property="twitter:domain" content="http://coursuite.com" />
<meta property="twitter:thanks" content="$49.99 USD">
<meta property="twitter:label1" content="PRICE">
<meta property="twitter:label2" content="In Stock">
<meta property="twitter:label3" content="AVAILABILITY">
```

In addition to the required card properties Twitter Product Cards support two custom data types. By default, these are configured to return the item price and item availability. It is recommended that you keep the default configuration for these properties.

To disable Twitter Product Cards create a custom ShoppingApplication module and edit `SC.Shopping.Configuration.JS`. Set the `enable` parameter to `false` in the `twitter` function. This removes the Twitter button from the product details page and disables Twitter functionality. For detailed instructions on creating a custom SuiteCommerce Advanced Module see the help topic Customize and Extend Core SuiteCommerce Advanced Modules in the SuiteCommerce Advanced Developer's Guide.

The following code snippet lists the twitter configuration options in the `SC.Shopping.Configuration.JS` file:

```javascript
// @property {Object} twitter twitter Social Sharing Service
  , twitter: {
    enable: true
    , popupOptions: {
      status: 'no'
      , resizable: 'yes'
      , scrollbars: 'yes'
      , personalbar: 'no'
      , directories: 'no'
      , location: 'no'
      , toolbar: 'no'
      , menubar: 'no'
      , width: '632'
      , height: '250'
      , left: '0'
      , top: '0'
    }
  }
```

Facebook Share

Commerce web stores enable you to add a Facebook Share button on your item detail pages to make it easier for visitors to share items on your site. This button is enabled by default. For sharing to work, you must obtain an appId from Facebook and associate the appId with your shopping domain. See the following help topics for more information:

- Facebook Share
- Facebook Open Graph
- Configure Facebook Share
Facebook Share

The Facebook Share button lets visitors share an item from your site on Facebook. When a visitor clicks the Share button, the Share on Facebook window is displayed and lets the visitor enter comments about the page and choose how it is shared. Sharing options include:

- Own timeline
- Friend's timeline
- In a group
- On a page the visitor manages.
- Private

If the visitor is not logged in to Facebook, then the Facebook log in form is displayed first.

Facebook Open Graph

Facebook uses Open Graph markup for data collection. With this method product metadata is included in the HTML header of the product page. The following open graph metatag mappings are defined in the shopping configuration file.

```javascript
metaTagMapping: {
  // [Open Graph](http://ogp.me/)
  'og:title': seo_title,
  'og:type': seo_type,
  'og:url': seo_url,
  'og:image': seo_image,
  'og:site_name': seo_site_name,
  'og:description': seo_description,
  'og:provider_name': seo_provider_name,
  'og:price:standard_amount': seo_price_standard_amount
}
```
Configure Facebook Share

Follow the correct configuration procedures below, depending on the version of SuiteCommerce Advanced you are implementing. For information on configurable properties, regardless of your implementation, see the help topic Configuration Properties Reference.

See the Facebook developer documentation at https://developers.facebook.com/docs/plugins for more information on the Facebook Share plugin.

Pre-Vinson

Facebook Share options are set in the shopping configuration file. To change the configuration, you must create a custom ShoppingApplication module and set your configuration in the custom SC.Shopping.Configuration.js. You can find the file at modules/suitecommerce/ShoppingApplication@x.x.x/JavaScript in the local SuiteCommerce Advanced source files. For detailed instructions on creating a custom SuiteCommerce Advanced Module, see the help topic Customize and Extend Core SuiteCommerce Advanced Modules.

The following code sample from the SC.Shopping.Configuration.js file is used to enable and set options for Facebook Share. The Facebook share button is enabled by default, but you do need to set the appId for your site.

```javascript
facebook: {
    enable: true,
    appId: '123456789012345',
    popupOptions: {
        status: 'no',
        resizable: 'yes'
    }
}
```
Vinson and Later

To configure properties in NetSuite (Vinson and later):

1. Access the SuiteCommerce Configuration Tool for your site.

   **Note:** See the help topic Configure Properties for more information.

2. In the SuiteCommerce Configuration tool, navigate to the Integrations tab and the Facebook subtab.

3. Set feature-properties as required. For more information on each configurable property, see the help topic Facebook Subtab.

Facebook appId and Domain Association

As part of configuring the Facebook share button on your site, you must obtain an appId from Facebook and associate it with your shopping domain. To obtain the appId, register as a developer with Facebook at http://developers.facebook.com.

To obtain an appId and associate your domain:

2. Click Create a New App.
3. In the Display Name field, enter the name of your web store or site.
4. The Namespace field is optional, but you can set it to a unique identifier for your app.
5. From the Category dropdown list, select the category that best describes your site.
6. Click the Create App ID button.
7. Complete the security check.
8. Click the Settings menu.
9. Click Add Platform.
10. Click Website.
11. In the Site URL field, enter the URL for your site.
12. In the App Domains field, enter your shopping domain.
13. Take note of the App ID. This is the value to enter as the appId in the shopping configuration file.
14. Click Save Changes.
Website Content

Applies to: Commerce Web Stores | Site Management Tools

An important part of managing your website is controlling the content you put on the site. The type of content can be vast and varied, from a banner image on the home page to marketing copy promoting a sale. See the following help topics to learn more about the types of content you can add to your site, and how to add them.

Text Content
See these help topics to learn how to add text to pages on your site.

Image Content
Images are an important aspect of the information you present on your site. See the help topics here to learn how you can add images to your site and how to use the SMT Image Manager.

HTML Content
Are you comfortable working with HTML and JavaScript? See these help topics to learn how you can add HTML, JavaScript, or HTML-based content with Site Management tools.
Text Content

Applies to: Commerce Web Stores | Site Management Tools

The text on your site can originate in many places. For example, the text for item descriptions is defined on the Item Record in NetSuite. The text for your category labels comes from the Category Record. And the labels for your facet navigation comes from the SuiteCommerce Configuration record.

There are other types of text content you can add to your site that are not determined by item or configuration records. This is text based content that you add directly to your site. For example, you may want to add marketing copy to promote an upcoming sale, or you may want to add a history of your company on your About Us page. See the following help topics for information on adding text to your site:

- SMT Text Content
- Columns
- Blog

SMT Text Content

Site Management Tools let you drag and drop text content to the predefined areas on each page. The text you add can serve a variety of purposes. Some of the most common include:

- A notification that displays on select pages or all pages, for example, an upcoming sale, free shipping, or other special event

Mojo Flannel Shirt

No Reviews yet

SIZE:

[Small] [Medium] [Large] [X-Large] [XX-Large]

FREE SHIPPING ON ORDERS OVER $50.00

SKU: 12021008

$49.99

QUANTITY

1

Add to Cart

- A header area for an image or merchandising zone such as related or similar products or closeouts
- A block or paragraph of text that contains a hypertext link to another page on your site or to an external site

$18.99

QUANTITY

1

Add to Cart

Add to Wishlist

Add to Quote

OL4554

Tweet   Google +   Pinit

All purchases subject to return policy.

- Text or notifications that are specific to a product or facet list
These are a few examples of common uses for text content. Depending on your business and the design of your site, you may identify many more uses.

You can place text content in any area on a page. The scope of the area determines when the text content displays.

- If the scope of the area is **all pages**, then the text content displays on any page that contains that area.
- If the scope of the area is **page type**, then the text displays on any page of that type.
- If the scope of the area is **this page**, then the text displays only on the page to which you add it.

**Adding Text to an Area**

To add text to an area on a page, you drag the text content from the side panel and drop it in the area where you want to place it. If the area already contains content, then a Drop Indicator identifies the position within that area where the content can be placed. When you drop the content, the page automatically displays the text editor and enables you to add your text.

**Text Editor**

The text editor is a WYSIWYG editor that lets you add formatted text and images to your site. The toolbar provides you with several formatting controls.
2. Alignment
3. Bold
4. Italic
5. Block Quote
6. Unordered List
7. Numbered List
8. Insert Hyperlink
9. Switch to HTML View
10. Insert Image (See Image Manager)
11. Expand Editor

To add text content:
1. Go to the page where you want to add text content.
2. Click Add on the Site Management toolbar. This displays the side panel.
3. Drag the text content from the side panel to the page.
4. Position the content over the area and drop it. If the area contains one or more pieces of content, a Drop Indicator, denoted by a horizontal line, indicates where the content will be placed.
5. Enter a name for the text content. This name appears in review and publish list and also in the visibility timeline.
6. Set the content visibility options. See the help topic Visibility Dates.
7. Enter your text in the text field. You can use the formatting controls on the toolbar to apply formatting to the text.
8. Add tags to the tag field. See the help topic Content Tags and Filter Tools.
9. Click Save.
10. Publish your changes.

To add an image to text:
1. Position your cursor in the text editor where you want to insert the image.
2. Click Image Manager on the Text Editor toolbar. See Image Manager.
3. In the Image Manager select an existing image or upload a new image.
4. Click Select on the Image Manager. This inserts your image in the text editor.
5. Point to the image in the Text Editor to display the image menu.
6. Set the alignment for the image. Available alignment options include left, center, and right.

7. Click **Image Settings** to specify the image settings.

8. Enter the **Alt Text** for the images. This is important for SEO.

9. Set the **Spacing** for top, right, bottom, and center. This determines the amount of space between the image and the text.

10. Set the **Dimensions** for the image. If you enter the width, the height is automatically calculated to maintain the aspect ratio. Likewise, if you enter the height, the width is automatically maintained to maintain the aspect ratio.

SuiteCommerce Store Front
11. Click Save.

**To edit text content:**
1. Go to the page where the text content is located.
2. Point to the text content. This displays the content controls.
3. Click Edit to open the text in the text editor.
4. Make the changes to your text.
5. Click Save.

**To remove text content:**
1. Go to the page where the text content is located.
2. Point to the text content. This highlights the content and displays the content controls.
3. Click Remove. This displays a warning that asks if you want to expire the content.
4. Click OK.

See the help topic *Discard Content Vs Expiring Content*.

**Columns**

The Columns extension lets you add up to 3 columns of text with images and call-to-action buttons using Site Management Tools. You can choose to add one, two, or three columns, and the layout adapts to fit the width, according to the screen size. With Columns, you can organize your content into easy-to-read blocks.

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

You can add columns to multiple areas on your website using Site Management Tools. For more information on Site Management Tools, see the help topic *SMT Overview*.

**To add a column:**
1. Go to the page where you want to add a column.
2. Click Add on the Site Management toolbar.
3. Drag the Columns content type to the page.

**Note:** If you do not see this content type, check that the extension has been installed and has been activated. Click Settings on the Site Management toolbar to access the Content Manager. Drag the content type from Inactive Content Types to Active Content Type.

You can drag the Columns content type to multiple areas on the page:
- If you drag it to an area marked as all pages, then the content displays on any page that contains that area.
- If you drag it to an area marked as page type, then the content displays on any page of that type.
If you drag it to an area marked as this page, then the content displays only on the page that you add it to.

4. In the General tab:
   a. Use the Name field to enter a description of your new content.
   b. Set the content visibility options.
      See the help topic Visibility Dates.
   c. In the Header field, enter the title for the section.
      A preview displays in the page.
   d. In the Text Color field, choose the color you want for the text fields.
      By default, the Header, Caption, and Text fields use different colors that are taken from your theme. If you select Dark, all text fields use the dark text color defined in your theme. If you select Light, all text fields use the light text color defined in your theme.
   e. In Column Alignment, select the positioning of the text content and the button.
      You can select either left aligned or center aligned.
   f. Select Open in New Window if you want the button link to open in a new tab or window.
   g. Use the Tags field to enter keywords that help you filter your content.
      See the help topic Content Tags and Filter Tools.

5. In the Column tabs:
   a. Select the image you want to display using the Image Manager.
      See Image Manager.
      If you do not select an image, only the text column is displayed.
   b. In the Alt Text field, enter a description of the image.
      This text is used to improve web accessibility for visually impaired users and for SEO purposes.
   c. In the Caption and Text fields, enter the text you want to display as a subtitle and in the column itself.
      In the Text field, you can use basic HTML formatting tags such as <strong> for bold text, <em> for italic, and <li> for bullet lists, for example. When entering your text, you should enclose any body text with <p> tags and use <h> tags to create headers.
   d. Enter the text you want to display on the button in the Button Text field.
      If you leave this field blank, the button does not display.
   e. In Button Link, enter the URL you want to open when the user clicks the button.

6. Repeat step 5 to include up to 3 columns. If you enter information on only one Column tab, only one column is displayed.

7. Click Save.

If you have not published your column content and you decided to remove it, you can discard it. If you have already published your column content, you can remove it directly from the page where it is located. For more information on the differences between discarding or expiring content, see the help topic Discard Content Vs Expiring Content.

To discard columns:
   1. Go to Unpublished Changes.
   2. Select the column content in the list.
3. Click Discard.
4. Click OK.

To remove columns:
1. Go to the page that contains the column content you want to remove.
2. Click the Columns box.
   This highlights it and displays the content controls.
3. Click Remove.
4. Click OK.

To change the button link or alternative text:
1. Go to the page that contains the columns.
2. Click the Columns box, and then click Settings.
   This displays the Columns settings in the side panel.
3. Enter the URL for the link in the Button Link field or enter the alternative text in the Alt Text field.
4. Click Save.

Blog

The Blog extension lets you create blog posts for your website using Site Management Tools. You can add images and rich text, include post previews, and determine the posts shown in the blog list by categories.

⚠️ Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

The Blog extension includes two content types for adding blog content to your site:

- **Blog Post**: Main content type where you write your blog article.
  You can include images, text, and add links to other pages. You can create a preview of your post that is used in the blog list.
- **Blog List**: List of all the blog posts published.
  It displays the preview of each post. You can filter the blog list to show blog posts by blog categories.

You use these content types in combination to create your blog. You add them to custom landing pages in your website using Site Management Tools. For more information on Site Management Tools, see the help topic SMT Overview.

1. Install and activate the SuiteCommerce Blog extension
2. Set up the basic configuration
3. Create a blog landing page
4. Create a blog post
5. Create a blog list

To set up the blog in your website and add content, you perform the following steps:
1. Install and activate the SuiteCommerce Blog extension
2. Set up the basic configuration
3. Create landing pages
4. Create a blog post
5. Create a blog list

Installation

SuiteCommerce Blog is an extension SuiteApp. It must be installed and activated.

To install the SC Blog SuiteApp:

1. In NetSuite, go to Customization > SuiteBundler > Search & Install Bundles.
2. In the Keywords field, enter the Bundle ID or “blog” and click Search.
3. Verify that the SC Blog SuiteApp is returned in the search and select it.
4. Review the SuiteApp details and then click Install.

To activate the extension for your website domain, see Manage Themes and Extensions.

Initial Setup

When you activate the SuiteCommerce Blog extension for the first time, you should perform the following tasks to set up the blog on your site:

- Add the blog to your web store navigation menu
- Create blog categories

If you want to access the blog landing page directly from your site navigation, you need to create a menu item in your web site configuration. This task is not required for your blog to work, but it makes it easier for users to access your blog content.

To add a menu item for the blog:

1. Go to Setup > SuiteCommerce Advanced > Configuration.
2. Select the website and domain where you want to set up the blog and click Configure.
3. Go to the Layout tab.
4. In the Navigation tab, enter the following fields:
   - Text: Enter the link text to be displayed for the menu item. For example, Blog.
   - HREF: Enter the internal URL to access with the menu item link. For example, /blog. Make a note of this path as it must be same as the blog landing page you create.
   - Level: Select the level at which you want the menu item to appear. For example, if you want the blog to appear at the top level, you select 1.
   - Data-TouchPoint: Select where you want the menu item to appear. For example, as part of the home menu.
5. Click Add and then Save.

Blog posts are organized by categories. Each blog post is assigned to a category. The blog list uses these categories to determine the posts displayed. When you install the SC Blog SuiteApp, the Blog
Category record is added to your account. This record determines the categories displayed in the Blog Post and Blog List content types in SMT. By default, all blog posts are assigned to the blog, category **Uncategorized**.

**To create a blog category:**

1. Go to Lists > Web Site > Blog Category.
2. Click **New Blog Category**.
3. In the **Name** field, enter the blog category you want to appear.
4. Click **Save**.

**Create Blog Landing Pages**

To organize the content on your blog, you need to create two types of landing page:

- **Blog landing page**
- **Blog post landing page**

**Blog List Landing Page**

You use the blog landing page to act as the point of entry to your blog and to display a list of the blog posts. You create this landing page in Site Management Tools. See the help topic **Landing Page**.

To link the new landing page to the **Blog** menu item, on the **General** tab, enter the path used in HREF during the **Initial Setup** in the **Path** field.

ℹ️ **Note:** The path entered in HREF field must be identical to the new landing page path. Otherwise, you are unable to view the page.

Since this landing page is used as a point of entry indefinitely, you should set the visibility as **Always Visible**.

In the **Metadata** tab, you can add a meta description and meta keywords to improve the blog's SEO rating in search engines.

When you have created the landing page, you then can add a blog list to this page. See **Create a Blog List**.

**Blog Post Landing Pages**

For each new blog post, you create a new landing page to host the blog post content using SMT. See the help topic **Landing Page**.

When creating landing pages for blog posts, bear in mind the following best practices:

- Use a URL path name that is similar (if not identical) to the post title for better SEO indexing.
- Add metadata description and keywords in the landing page.
- Use the **Tags** field to add additional keywords that can help you find the blog post landing page and content later in SMT.
- Ensure the landing page visibility is identical to the visibility settings for the **Blog** content. If your landing page has expired, your blog post is not shown.
Create a Blog Post

When you have created a landing page for the content, you add the blog post content to the blog post landing page. The Blog Post content type lets you create your blog post. You can add images, text, and links within the blog post body, add a header image to the top of the post, and indicate the author. You can also create a preview of the post, which summarizes the content and is displayed in the blog list.

To add a blog post:

1. Go the new landing page where you want to add the blog post.
   Ensure you are located on the page.
2. Click Add on the Site Management toolbar.
3. Drag the Blog Post content type to the page.
   
   **Note:** If you do not see this content type, check that the extension has been installed and has been activated. Click Settings on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

   Drag the Blog Post content type to the page.

   **Important:** Ensure that you drag it to the This Page area. If you add it to other areas, the post may be displayed on all pages.

4. In the General tab:
   a. Use the Name field to enter a description of your new content.
   b. Set the content visibility options.
      See the help topic Visibility Dates.
   c. In the Category field, select the category you want to assign to the blog post.
      To set up blog categories, see Initial Setup. If you have not set up any blog categories, all posts are automatically assigned to Uncategorized.
      
      **Note:** Blog posts can only be assigned to one category.
   d. Use the Tags field to enter keywords that help you filter your content.
      See the help topic Content Tags and Filter Tools.

5. In the Blog Post tab:
   a. In Header Image field, use the Image Manager to add an image that is displayed at the top of your blog post.
      
      **Note:** Images are displayed as full-width banners. The height should be approx. 250px. If the height is larger, the image is centered. On smaller screens, images are cropped.

   b. In the Header Image Alt Text field, enter a description of the image.
      This text is used to improve web accessibility for visually impaired users and for SEO purposes.
   c. In Post Title, enter the title of your blog post.
      This title is displayed in the blog list.
d. In **Author**, enter the name to be displayed as the author of the post. If you leave this field blank, your username defaults to the Author role.

e. Use **Post Body** to enter your blog post content.
   You can use the formatting tools offered by the SMT Text Editor, upload an image using the Image Manager, or enter HTML code by switching to the HTML View.
   For more information, see Text Editor.

6. In the **Blog Preview** tab:
   a. In **Preview Image**, select an image to be used in the preview of the blog post using the Image Manager.
      See Image Manager.
      
      **Note:** It is recommended that you upload a preview image. If you do not select an image, the header image for the blog post is used and may be cropped to fit.
   b. In the **Preview Image Alt Text** field, enter a description of the image.
      This text is used to improve web accessibility for visually impaired users and for SEO purposes.
   c. In the **Preview Text** fields, enter the text you want to display as a preview in the blog list.
      If you do not enter any text, only the post title, the author, and a link to the post is displayed in the blog list. See Create a Blog List.
   d. In the **Link Text** field, enter the text you want to use as a link to the blog post in the blog list.

7. Click **Save**.

If you have not published your blog post content and you decide to remove it, you can discard it. If you have already published your blog post, you can remove it directly from the page where it is located. You must also remove the landing page where the blog post was located. For more information on the differences between discarding or expiring content, see the help topic **Discard Content Vs Expiring Content**.

**To discard an unpublished blog post:**

1. Go to Unpublished Changes.
2. Select the blog post content in the list.
3. Click **Discard**.
4. Click **OK**.

**To remove a published blog post:**

1. Go to the page that contains the blog post content you want to remove.
2. Click the **Blog Post** box.
   This highlights it and displays the content controls.
3. Click **Remove**.
4. Click **OK**.
5. Go to the **Overview Mode** and select the **Pages** tab.
6. Select the landing page where the blog post was located.
7. Click **Remove**.
8. Go to **Review & Publish Changes** and click **Publish**.
Create a Blog List

The Blog List content type creates a summary of all the blog posts published. By default, all blog posts are assigned to the blog category Uncategorized.

For each post, the Blog List displays a preview image, the title, and a link to the post. If you enter text in the Preview Text field when you create the blog post, the text is displayed here.

Usually there is one blog list for the entire blog, however, you can use the Blog List content type to filter your blog content by categories. For example, you can set up landing pages for different categories and add a separate blog list for each category on each landing page.

**To add the blog list:**

1. Go the blog landing page where you want to add the blog list.
   Ensure you are located on the page.
2. Click Add on the Site Management toolbar.
3. Drag the Blog List content type to the page.
4. Use the Name field to enter a description of the blog list.
   See the help topic Content Tags and Filter Tools.
5. Set the content visibility options.
   See the help topic Visibility Dates.
6. In List Title, enter the header you want to display at the top of the blog list.
7. In the Category field, select the category of blog posts you want to display in the list.
   You can select multiple categories.
8. Use the Tags field to enter keywords that help you filter your content.
   See the help topic Content Tags and Filter Tools.
9. Click Save.

**To discard the blog list:**

1. Go to the Unpublished Changes list.
2. Select the blog list content in the list.
3. Click Discard.
4. Click OK.

**To remove a blog list:**

1. Go to the page that contains the blog list you want to remove.
2. Click the Blog List box.
   This highlights it and displays the content controls.
3. Click Remove.
4. Click OK.
5. Go to Overview Mode and select Pages.
6. Select the landing page where the blog list was located.
7. Click Remove.
8. Go to Unpublished Changes and click Publish.
Image Content

Applies to: Commerce Web Stores

Image content types enable you to place images and image related content on your site. See the following help topics for information on using the Image Manager and also on each of the image related content types.

- Image Manager
- SMT Image Content Type
- Image Text Overlay
- Photo Gallery
- Slideshow

Image Manager

Applies to: Commerce Web Stores | Site Management Tools

Watch a related video.

Images are an important part of your website. They add interest to the page and catch the visitor’s eye. They break up the visual monotony of text. They evoke thoughts, feelings, and emotions and can convey in an instant what might take a thousand words to describe. Where images on your site are concerned, you might want to add a banner image to the top of every page to advertise an upcoming sale or highlight a category of summer close-out items. You might want to include a picture of your staff on the About Us page. If you operate a pet supply, you might even want to post pictures of your employees’ pets.

Since images are so important, it is also important that you have an efficient way to manage them. It is important that you have an Image Manager.

The Image Manager is an SMT feature that lets you add images to your site. You can upload new images to the file cabinet or select from images that exist in the file cabinet. Images are stored in the SMT site image folder in the file cabinet. This folder is located in the file cabinet at Web Site Hosting Files > Live Hosting Files > SSP Applications > NetSuite Inc. - CMS > CMS > [Site Number] > files. You can also upload images directly to this folder from within NetSuite. Any images that you upload in this manner are also available for use with the Image Manager.

Note: The Image Manager lets you choose from only the images stored in this folder. You cannot select images that are stored elsewhere in the file cabinet.

Important features include:

- Drag and drop upload of one or more image files.
- Selection and upload of multiple files by browsing to the file location on your computer.
- Creation of subfolders within the site’s file folder.
- Multiple views, including thumbnail view and list view.
You can access the Image Manager by one of two methods.

- **Image Content Type** - The image content type utilizes the image manager when selecting files for the content.
- **Text Content Type** - The text editor toolbar button includes an option for the Image Manager.

**Legend:**

1. This panel displays the SMT files folder and any subfolders. This folder is located in the file cabinet at Web Site Hosting Files > Live Hosting Files > SSP Applications > NetSuite Inc. - CMS > CMS > [Site Number] > files.
2. Click this button to display thumbnails of the images in the selected folder.
3. Click **Menu** to display a list of images in the selected folder.
4. Enter text to limit the listed images to only those files that match your search term.
5. This pane lists all images in the currently selected folder. Click an image to select it.
6. Click **Create New Folder** to add a new subfolder.
7. Click this area to browse to an image file on your computer and upload it to the selected folder. You can also drag one or more files to this area to upload them to the selected folder.

**Note:** Supported file types include: JPG, GIF, PNG, PJGP, SVG, and TIFF.

8. Click **Cancel** to close the image manager without selecting a file.
9. Select is enabled only after you click an image to select it. Click **Select** to choose the image and insert it into your image content type or into the text editor.
SMT Image Content Type

Applies to: Commerce Web Stores | Site Management Tools

A graphics designer usually creates the images that are used on the site. These images might include:

- Banners to advertise current and upcoming sales or events
- Images that link to groups of items or categories
- Free shipping or other eye-catching notifications

Images are usually created with their intended locations in mind and are normally sized to fit into the space on the web page.

As with other content, you add image content to an area by dragging the image content from the side panel and placing it in one of the pre-defined areas on the page. When adding images, you select the image on your computer.

Note: You cannot choose images stored in the File Cabinet. If you have an image in the file cabinet that you want to use on the site, download it from the file cabinet to your computer and then use SMT to add it to the site.

You can place image content in any area on a page. If the area already contains content such as text or merchandising zone, you can position the image in any sequence for the content in that area. The scope of the area determines when the image is displayed.

- If the scope of the area is all pages, then the image content displays globally.
- If the scope of the area is page type, then the image displays on any page of that type.
- If the scope of the area is this page, then the image displays only on the page to which you add it.

Image Link

When you add an image to your site, you can set a link for the image. For example, you may add an image that you want to link to a listing of products. By setting the image link to the URL for the facet listing of your products, when a visitor clicks the image, he or she is taken to the product listing. Image links are specified in the Link field in the Image settings on the side panel. Image Settings are displayed in the side panel when you add a new image to an area on a page or when you click Edit on existing image content. The image link is optional.

Alternate Text

You can set alternate text for an image. This text is displayed on the page when an images does not load, for whatever the reason. The alternate text is also used by page readers and helps promote SEO of site content. You enter alternate text in the Alternate Text field in the Image Settings on the side panel.

Image Size and Format

Site Management Tools do not let you set image dimensions, so when you create an image to use for content, you should size the image to the size (or slightly larger than) the area where you will place it. If the image is larger than the area where you place it, the image is proportionally re-sized to fit within the area. If an image is smaller than the area where you place it, it is displayed at 100 percent and is not re-sized to fill the area.

Supported file types include: JPG, GIF, PNG, PJGP, SVG, and TIFF.
Note: Using excessively large image file sizes can impact page load times. For that reason, use the smallest image you can that does not effect the quality of image displayed on the site.

Image File Cabinet Locations

When you use SMT to add an image to your site, the image file is uploaded to the file cabinet:

Web Site Hosting Files > Live Hosting Files > SSP Applications > NetSuite Inc. - CMS > CMS > [site-number] > files

Image Template File

The image template file determines how an image you add to an area is displayed. This includes such things as the image alternate text and hyperlink. For more information on the image template file see Image Template.

Note: Any changes to images, including addition, edits, or deletions must be published before the changes are available on the site.

To add image content:

1. Go to the page where you want to add image content.
2. Click Add on the Site Management toolbar.
3. Drag the image content from the side panel to the area where you want to place it.
4. In the following screen shot, content is placed in the first position of an area that already includes text content and merchandising zone content.

When you drop the content, the system automatically displays an Open File dialog box and lets you browse your computer for the image file. Select the file and click Open. This places your image on the page.
5. Set the content visibility options. See the help topic Visibility Dates.
6. Add tags to the tag field. See the help topic Content Tags and Filter Tools.
7. If you want to link this image to another page on your site or to an external site, enter the URL for the page in the Link field on the Image Settings in the side panel. Leave the Link field empty if you do not want to link the image.
8. In the Alternate Text field, enter the text to use for this image.
9. Click Save.

To remove image content:
1. Go to the page that contains the image content you want to remove.
2. Point to the image content. This highlights it and displays the content controls.
3. Click Remove. This displays a warning that asks if you want to expire the content.
4. Click OK.

See the help topic Discard Content Vs Expiring Content.

To change an image link or alternate text:
1. Go to the page that contains the image.
2. Point to the image, and then click Settings. This displays the Image Settings in the side panel.
3. Enter the URL for the link in the Link field or enter the alternate text in the Alternate Text field.
4. Click Save.

Image Template

Any image you add to an area uses the standard SMT image template. This template determines how the HTML code for the image is written. When you use SMT to add an image to a page, the two settings for the image are the Link, which is the URL to which you want to link the image, and the Alternate Text. Both settings are optional.

If you specify a URL for an image, the default image template constructs the hypertext link for the image. When visitors click the image, they are taken to the location specified by the link. The resulting link for the image might appear similar to this:

```html
<a href="/shoppingcart"><img src="/shopflow/cms_assets/img/shoppingcart.jpg" alt="A photo of a shopping cart."/></a>
```

If you add an image to an area and do not specify a link for the image, the image template constructs only the image tag for the image. The resulting image tag might appear similar to this:

```html
<img src="/shopflow/cms_assets/img/shoppingcart.jpg" alt="A photo of a shopping cart."/>
```

You can use the default image template file as is or you can customize the template file to fit your needs.

Default Image Template

The default image template is located in the file cabinet at:

Web Site Hosting Files > Live Hosting Files > SSP Applications > NetSuite Inc. — CMS > CMS > [application name] > Published > Templates > image_default.txt
You can use this default template as a starting point for any custom image template you want to create.

**data-loader**

The `data-loader` attribute as displayed in the template file above lets you control **lazy loading** which means the image is downloaded and displayed only when needed. For example, if the image is off screen at the bottom of the page, it does not load in the browser until the visitor scrolls down to the area of the page that contains the image. This technique is often used on long web pages to make a page load faster. Setting the `data-loader` attribute to `false`, as in this template, disables lazy loading, and all images are loaded when the page loads. Setting the `data-loader` attribute to `true` enables lazy loading, and images are downloaded and displayed only as they are needed.

**Note:** NetSuite recommends setting the `data-loader` attribute to `false` to disable lazy loading so images always load when the page loads.

**Escaping Characters**

Notice in the template file that some of the inline code blocks are constructed as `"<%- ... %>%"`. This is a security measure designed to prevent cross-site scripting. The hyphen following the opening `<%` tag escapes certain characters, converting them to HTML character entities. These characters include: & < > " '/.

**Image Text Overlay**

**Applies to:** Commerce Web Stores | Site Management Tools

The Image Text Overlay extension lets you add an image and text that displays over the image using Site Management Tools. Images can be enhanced with dark and light overlays. You can choose the text color based on your Theme Settings, and select the position of your content. You can add a call-to-action button and select the button style. For example, with Image Text Overlay, you can create attractive images for home and landing pages that prominently feature your brands.

**Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see [Commerce Extensions](#).

**Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

You can add an image with text overlay information to multiple areas on your website using Site Management Tools. For more information on Site Management Tools, see the help topic [SMT Overview](#).
To add an image with text overlay:

1. Go to the page where you want to add an image with text overlay.
2. Click **Add** on the Site Management toolbar.
3. Drag the **Image Text Overlay** content type to the page.

   **Note:** If you do not see this content type, check that the extension has been installed and has been activated. Click **Settings** on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

   You can drag the Image Text Overlay content type to multiple areas on the page:
   - If you drag it to an area marked as **all pages**, then the content displays on any page that contains that area.
   - If you drag it to an area marked as **page type**, then the content displays on any page of that type.
   - If you drag it to an area marked as **this page**, then the content displays only on the page to which you add it.

4. In the **Settings** side panel, use the **Name** field to enter a description of your new content.
5. Set the content visibility options.
   See the help topic **Visibility Dates**.
6. Select the image you want to display using the Image Manager.
   See **Image Manager**.

   **Note:** Image Text Overlay allows a maximum image height of 750 px. If the image height is greater than 750 px, the image is resized to fit.

7. In the **Image Alignment** field, select the positioning of the image within the content box.
   You can choose the focus of your image. The options are top, center, or bottom.
8. In the **Image Overlay** field, select the opacity for your image.
   You can select dark, light, or no overlay.
9. In the **Alt Text** field, enter a description of the image.
   This text is used to improve web accessibility for visually impaired users and for SEO purposes.
10. Enter the text you want to display over the image in the **Text** field.
    You can use basic HTML formatting tags such as `<strong>` for bold text, `<em>` for italic, and `<li>` for bullet lists, for example. When entering your text, you should enclose any body text with `<p>` tags and use `<h>` tags to create headers.
11. In **Text Alignment**, select the positioning of the text content and button overlay.
    You can choose left, right, or center aligned.
12. In the **Text Color** field, choose the color you want for the text fields.
    By default, the colors are taken from your theme. If you select **Dark**, the text uses the dark text color as defined in your theme. If you select **Light**, the text uses the light text color as defined in your theme.
13. Enter the text you want to display on the button in the **Button Text** field.
    If you leave this field blank, the button does not display.
14. In the **Button Style** field, choose the appearance of the button that you want to display.
15. In **Button Link**, enter the URL you want to open when the user clicks the button.
16. Select **Open in New Window** if you want the button link to open in a new tab or window.
17. Use the **Tags** field to enter keywords that help you filter your content.
   See the help topic **Content Tags and Filter Tools**.
18. Click **Save**.

If you have not published your image with text overlay and you decided to remove it, you can discard it. If you have already published your image with text overlay, you can remove it directly from the page where it is located. For more information on the differences between discarding or expiring content, see the help topic **Discard Content Vs Expiring Content**.

**To discard an image with text overlay:**
1. Go to the **Review & Publish Changes** list.
2. Select the image with text overlay in the list.
3. Click **Discard**.
4. Click **OK**.

**To remove an image with text overlay:**
1. Go to the page that contains the image with text overlay.
2. Click the **Image Text Overlay** box.
   This highlights it and displays the content controls.
3. Click **Remove**.
4. Click **OK**.

**To change the button link or alternative text:**
1. Go to the page that contains the image with text overlay.
2. Click the **Image Text Overlay** box, and then click the **Settings** button.
   This displays the Image Text Overlay Settings in the side panel.
3. Enter the URL for the link in the **Button Link** field or enter the alternative text in the **Alt Text** field.
4. Click **Save**.

---

**Photo Gallery**

**Applies to:** Commerce Web Stores | Site Management Tools

The Photo Gallery extension lets you add a gallery of images to your web page using Site Management Tools (SMT).

With Photo Gallery, you can:

- Select the size and style of the gallery.
- Customize the display with animation effects.
- Add a heading and description to each image.
Choose text colors to match your look.
Add light or dark photo overlays.

For each image, you can link to an external or internal URL. For example, you can feature new product arrivals and link to the Product Details pages.

Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

This topic explains how to:
- Add a Photo Gallery
- Configure a Photo Gallery
- Remove a Photo Gallery

Use SMT to add, configure, or delete a photo gallery on multiple areas of your website. Adding this content type to enhanced or custom landing pages allows you to feature a gallery in the place and style you want. For more information on Site Management Tools, see the help topic SMT Overview.

Add a Photo Gallery

To add a photo gallery to your web store, add the Photo Gallery content type to a page of your site using SMT. You can add up to eight images.

To add a photo gallery:

1. In your website, navigate to the page where you want to add a photo gallery.
2. Log in to SMT.
   For more information, see the help topic Users and Roles.
3. In Edit mode, click Add on the Site Management toolbar.
4. Drag the Photo Gallery content type to the page.

Note: If you do not see this content type, check that the extension has been installed and is active. Click Settings on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

You can drag a Photo Gallery content type to multiple areas on the page.

For more information on the scopes of different SMT areas, see the help topic Site Management Tools Areas.

5. Configure the settings to best fit your needs.
   See Configure a Photo Gallery.

Configure a Photo Gallery

Configure properties to customize your photo gallery.

The following procedures explain how to customize:
- General settings — Configure gallery settings, such as gallery height and style, image animation effects, and visibility options.
- Image settings — Configure featured image settings, such as headings, descriptions, and image display options.

Using SMT, you can also customize the style and display settings of the photo gallery with the Photo Gallery fields in the Theme Customizer. You can choose the font, text colors, gallery size options, overlay colors, and more to make each display fit your needs. For more information, see the help topic Theme Customizer.

**To configure general settings:**

1. While logged in to SMT, navigate to the page that contains the photo gallery.
2. In the **Photo Gallery** box, click **Edit**.
   This displays the Photo Gallery Settings in the side panel.
3. In the **General** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sets the name for the photo gallery to appear in the Review Changes list in SMT.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Sets the visibility option that determines when you want to make the photo gallery visible. For more information on visibility options, see the help topic Visibility Dates.</td>
</tr>
<tr>
<td>Gallery Height</td>
<td>Determines the size of the photo gallery. You can customize these size options using the Theme Customizer. For more information, see the help topic Theme Customizer.</td>
</tr>
</tbody>
</table>
| Style           | Determines the display style of the photo gallery. You can choose from the following options:  
|                 | - **Carousel** - images appear in a carousel on a desktop and one at a time on a mobile device  
|                 | - **Grid** - images appear in a grid on a desktop and stacked on a mobile device  
| Hover Animation | Sets the hover animation behavior for the images. Hover animations only work if the Style field is set to Grid. Image scale options zoom in or out of the image, without affecting the container. Container drop shadow options display a shadow around the image container. |
| Carousel Animation | Sets the carousel animation behavior for the photo gallery, if the Style field is set to Carousel. |
| Open links in a new window | If checked, opens a link from the photo gallery in a new tab or window. |
| Image Size ID   | Links to the image resizing option you want the image to use. To use this option, you must enter an enabled Image Size ID found in the Image Resizing section of the Web Site Setup record (Setup > SuiteCommerce Advanced > Set Up Web Site > Images). For more information on Image Resizing, see Setting Up Image Resizing for SuiteCommerce. |
| Tags            | Sets keywords to help filter your content in the Review Changes list. For more information on content tags, see the help topic Content Tags and Filter Tools. |

4. Click **Save**.
To configure image settings:

1. While logged in to SMT, navigate to the page that contains the photo gallery.
2. In the **Photo Gallery** box, click **Edit**.
   This displays the Photo Gallery Settings in the side panel.
3. In the **Image** tab, set the following fields:
   Each image in the photo gallery has its own **Image** tab with associated fields, so you can change the settings for each photo individually.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Sets the image to display using the Image Manager. For more information, see Image Manager. For optimum performance, optimize images before uploading.</td>
</tr>
<tr>
<td>Alt Text</td>
<td>Sets a description of the image to be used to improve accessibility and SEO.</td>
</tr>
<tr>
<td>Image Alignment</td>
<td>Determines the positioning of the image within the content box.</td>
</tr>
<tr>
<td>Image Overlay</td>
<td>Determines the opacity of the image overlay.</td>
</tr>
<tr>
<td>Heading</td>
<td>Sets the main text to appear on the image.</td>
</tr>
<tr>
<td>Description</td>
<td>Sets the secondary text to appear on the image.</td>
</tr>
<tr>
<td>Text Alignment</td>
<td>Determines the positioning of the <strong>Heading</strong> and <strong>Description</strong> on the image.</td>
</tr>
<tr>
<td>Text Color</td>
<td>Sets the color for the <strong>Heading</strong> and <strong>Description</strong> texts. You can customize these color options using the Theme Customizer. For more information, see the help topic Theme Customizer.</td>
</tr>
<tr>
<td>Link</td>
<td>Determines the URL to which you want the image to link.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Remove a Photo Gallery

You delete the photo gallery from your site using SMT in one of two ways, depending on whether you have published the content to your website:

- **Discard** the photo gallery if you have not published the content.
- **Remove** the photo gallery if you have already published the content.

**To discard a photo gallery (Unpublished Content):**

1. While logged in to SMT on your website, select the **Review & Publish Changes** list from the Site Management toolbar.
2. Select the **Photo Gallery** content in the list.
3. Click **Discard**.
4. Click **OK**.

**To remove a photo gallery (Published Content):**

1. While logged in to SMT on your website, navigate to the page that contains the photo gallery content you want to remove.
2. In **Edit** mode, click the **Photo Gallery** box.
   This highlights the photo gallery and displays the content controls.
3. Click Remove.
4. Click OK.

Slideshow

Applies to: Commerce Web Stores | Site Management Tools

The Slideshow extension lets you add a carousel of images to your website using Site Management Tools. You can upload several images, select the focus of the image, and apply a dark or light overlay. Images slide automatically, and you can select the duration in seconds between each slide transition. You can link each image to an external or internal URL and add a call-to-action button. You can choose the text color based on your theme settings and select the position of your content. For example, with Slideshow, you can showcase featured products or highlight new collections.

Important: Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

Note: Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

You can add a slideshow to multiple areas on your website using Site Management Tools. For more information on Site Management Tools, see the help topic SMT Overview.

To add a slideshow:

1. Go to the page where you want to add a slideshow.
2. Click Add on the Site Management toolbar.
3. Drag the Slideshow content type to the page.

Note: If you do not see this content type, check that the extension has been installed and has been activated. Click Settings on the Site Management toolbar to access the Custom Content Type Settings. Drag the content type from the Inactive Content Types list to the Active Content Type list.

You can drag the Slideshow content type to multiple areas on the page:
- If you drag it to an area marked as all pages, then the content displays on any page that contains that area.
- If you drag it to an area marked as page type, then the content displays on any page of that type.
- If you drag it to an area marked as this page, then the content displays only on the page that you add it to.

4. In the General tab:
   a. Use the Name field to enter a description of your new content.
   b. Set the content visibility options.
      See the help topic Visibility Dates.
   c. If you do not want images to change automatically, clear the Automatic Slideshow box.
   d. In Transition Duration, select the delay in seconds between each image change.
   e. In Section Height, determine the size of your slideshow.
**Note:** On desktops, an image is resized to fit the container. On mobile devices, the section height is always small, and an image is cropped to fit the container.

f. Use the **Tags** field to enter keywords that help you filter your content. See the help topic **Content Tags and Filter Tools**.

5. In the **Image** tabs:
   a. Select the image you want to display using the Image Manager. See **Image Manager**. A preview displays in the page.

   **Note:** If you upload several images, all images should have the same resolution for optimum display.

   b. In the **Image Alignment** field, select the positioning of the image within the content box. You can choose the focus of your image. The options are top, center, or bottom.

   c. In the **Image Overlay** field, select the opacity for your image. You can select dark, light, or no overlay.

   d. In the **Alt Text** field, enter a description of the image. This text is used to improve web accessibility for visually impaired users and for SEO purposes.

   e. Enter the text you want to display in the slideshow in the **Text** field. You can use basic HTML formatting tags such as `<strong>` for bold text, `<em>` for italic, and `<li>` for bullet lists, for example. When entering your text, you should enclose any body text with `<p>` tags and use `<h>` tags to create headers.

   f. In **Text Alignment**, select the positioning of the text content and the button. You can choose left, right, or center aligned.

   g. In the **Text Color** field, choose the color you want for the text fields. By default, the colors are taken from your theme. If you select **Dark**, the text uses the dark text color as defined in your theme. If you select **Light**, the text uses the light text color as defined in your theme.

   h. Enter the text you want to display on the button in the **Button Text** field. If you leave this field blank, the button does not display.

   i. In the **Button Style** field, choose the appearance of the button that you want to display. The button definition is taken from the theme.

   j. In **Button Link**, enter the URL address you want to open when the user clicks the button.

   k. Select **Open in New Window** if you want the button link to open in a new tab or window.

6. Repeat step 5 to include additional images. You can add up to 8 images.

7. Click **Save**.

If you have not published your slideshow and you decided to remove it, you can discard it. If you have already published your slideshow, you can remove it directly from the page where it is located. For more information on the differences between discarding or expiring content, see the help topic **Discard Content Vs Expiring Content**.

**To discard a slideshow:**

1. Go to the **Review & Publish Changes** list.
2. Select the slideshow content in the list.
3. Click **Discard**.
4. Click **OK**.

**To remove a slideshow:**
1. Go to the page that contains the slideshow you want to remove.
2. Click the **Slideshow** box.
   This highlights it and displays the content controls.
3. Click **Remove**.
4. Click **OK**.

**To change the button link or alternative text:**
1. Go to the page that contains the slideshow.
2. Click the **Slideshow** box, and then click the **Settings** button.
   This displays the Slideshow Settings in the side panel.
3. Enter the URL for the link in the **Button Link** field or enter the alternative text in the **Alt Text** field.
4. Click **Save**.
HTML Content

⚠️ Applies to:  Commerce Web Stores

HTML content type lets you place HTML, JavaScript, or other code on the pages of your site. See the following help topics for information on using the HTML content type and HTML related content types.

- SMT HTML Content Type
- Map & Contact

SMT HTML Content Type

⚠️ Applies to:  Commerce Web Stores | Site Management Tools

The HTML content type lets you place HTML, JavaScript, or other code on the pages of your site. You can use this feature for any code that can reside between the `<body></body>` tags on the page. You cannot use HTML content type for any code that must be placed in the `<head></head>` tags of the page.

⚠️ Warning:  Do not use `document.write()` when creating scripts for your site. It creates conflicts for the page life cycle and breaks your site.

When you add HTML content to an area, the HTML settings are displayed in the side panel. The HTML settings give you two different views for adding and editing your HTML content. These are the basic view and the editor view. You can toggle between the two views by clicking expand/collapse, denoted by two opposing arrows, in the upper right corner of the editor. The basic view gives you a simple text area for entering your HTML code:

⚠️ Note:  If you use CSS from an external site in the HTML code, you may experience a brief page flicker while the site is loading.

The editor view gives you an expanded side panel and an HTML editor with syntax highlighting:
Examples of HTML content type include:

- Custom HTML
- Forms
- Social media widgets

**Note:** Any changes including additions, edits, or deletions, must be published before they are available on the site.

### Using the Hyperlink tag in HTML Code

A hyperlink lets you link to a file or document in another location by clicking on a highlighted word or image on the screen. This could include a link to a Word document, PDF, or image. When you use the hyperlink tag in the HTML Content area in SMT you must add an additional attribute to the CCT code. You must add target="_blank" inside the `<a>` tag.

Here is example HTML code:

```html
<a href="/site/images/Test.pdf" download="TEST PDF"><img src="/site/images/test_image.jpg" /></a>
```

For the link to work correctly, add target"_blank":

```html
<a href="/site/images/Test.pdf" download="TEST PDF" target="_blank"><img src="/site/images/test_image.jpg" /></a>
```

Whether the link is automatically downloaded, or opens in a new tab, depends on the users browser settings.

### To add HTML content:

1. Go to the page where you want to add HTML content.
2. Click **Add** on the site management toolbar.
3. Drag the HTML content from the side panel and place it in the desired area on the page. When you drop the content, the HTML Settings display in the side panel.
4. Set the content visibility options. See the help topic **Visibility Dates**.
5. You can enter your HTML code or JavaScript in the HTML code field in the side panel or click **expand** to expand the editor and enter your code.
   - The HTML content on the page updates in real time as you enter code.
6. Add tags to the tag field. See the help topic **Content Tags and Filter Tools**.
7. Click **Save**.
**To edit HTML content:**

1. Go to the page that contains the HTML content you want to edit.
2. Point to the HTML content and click **Edit**. This highlights the content and displays the HTML settings in the side panel.
3. Make your changes to the code.
4. Click **Save**.

**To remove HTML content:**

1. Go to the page that contains the HTML content you want to remove.
2. Point to the HTML content and click **Remove**. This displays a message box that asks if you want to expire the content.
3. Click **OK**.

See the help topic **Discard Content Vs Expiring Content**.

**Alternative to document.write()**

Do not use `document.write()` when creating scripts for your site, because it creates conflicts for the page life cycle and breaks your site. As an alternative, create an element and set its `innerHTML`.

The following depicts an example script:

```html
<span id='suiteElement'></span>
<script>
var suiteElement = document.getElementById('suiteElement');
if (suiteElement) {
    suiteElement.innerHTML = 'I Love HTML Content!';
}
</script>
```

**Map & Contact**

![i] **Applies to:** Commerce Web Stores | Site Management Tools

The SuiteCommerce Map & Contact extension lets you:

- Embed a third-party map
- Display contact details and store information, such as a phone number and operating hours
- Create a contact form for customers to get in touch
- Configure various Layout Settings, such as map position and section height

![important] **Important:** Commerce extensions are only available if provisioned, installed, and activated for a selected domain in your account. For more information, see Commerce Extensions.

![note] **Note:** Extensions require SuiteCommerce or the Aconcagua release of SCA or later.

Use Site Management Tools to add these content types to your website:

- Map & Contact Content Type
Contact Form Content Type

Adding these content types to enhanced or custom landing pages allows you to include a map, contact information, and a contact form to your web store. For more information on Site Management Tools, see the help topic SMT Overview.

Map & Contact Content Type

The Map & Contact content can be added to your web store to include a map with your store's location, in addition to store hours and contact information. The following procedures address how to:

- Add a Map and Contact Information
- Configure a Map and Contact Information
- Change Your Store Location on the Map
- Delete the Map and Contact Information

Add a Map and Contact Information

To include a map with your store's location, operating hours, and contact information on your website, add the Map & Contact content type to a page of your site using SMT.

To add a map and contact information:

1. In your website, navigate to the page where you want to add a map and contact information.
2. Log in to SMT.
   For more information on logging in to SMT, see the help topic Users and Roles.
3. In Edit mode, click Add on the Site Management toolbar.
4. Drag the Map & Contact content type to the page.
   Note: If you do not see this content type, check that the extension has been installed and is active. Click Settings on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.
   You can drag the Map & Contact content type to multiple areas on the page.
   For more information on the scopes of different SMT areas, see the help topic Site Management Tools Areas.
5. Click Save.

Configure a Map and Contact Information

Configure properties to customize your map and contact information. You can adjust the layout, add email and call buttons, and include store information. The following procedures explain how to:

- Configure general settings
- Configure map and contact details

To configure general settings:

1. While logged in to SMT on your website, navigate to the page that contains the Map & Contact content.
2. In the Map & Contact box, click Edit.
This displays the Map & Contact Settings in the side panel.

3. In the **General** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This sets a description of your new content.</td>
</tr>
<tr>
<td>Visibility</td>
<td>This sets the visibility option that determines when you would like to make the form visible. For more information on visibility options, see the help topic <a href="#">Visibility Dates</a>.</td>
</tr>
<tr>
<td>Map Position</td>
<td>This sets the layout of the map and the contact information. In mobile screens, the Map &amp; Contact information sections stack in order depending on whether you choose the left or right position.</td>
</tr>
<tr>
<td>Tags</td>
<td>This sets keywords to help filter your content in the Review Changes list. For more information on content tags, see the help topic <a href="#">Content Tags and Filter Tools</a>.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**To configure Map & Contact details:**

1. While logged in to SMT on your website, navigate to the page that contains the map and contact content.
2. In the **Map & Contact** box, click **Edit**. This displays the Map & Contact Settings in the side panel.
3. In the **Map & Contact** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>This sets the title to display at the top of the Map &amp; Contact box.</td>
</tr>
<tr>
<td>Map HTML Snippet</td>
<td>This is where you paste the HTML code of your map location. To use third-party map services, such as Google or OpenStreetMap, paste the HTML code obtained by the map provider here. To optimize display size, nest the embedded map HTML code within an iframe element.</td>
</tr>
<tr>
<td>Business Address &amp; Information</td>
<td>This specifies information about your business, such as your postal address, opening hours, or special instructions. This field supports basic HTML formatting tags.</td>
</tr>
<tr>
<td>Primary Phone Number</td>
<td>This sets the phone number to display for your business. Mobile users can tap a <strong>Call us</strong> button to call the primary phone number automatically.</td>
</tr>
<tr>
<td>Primary Email Address</td>
<td>This sets the email address to display for your business. Mobile users can tap a <strong>Contact us</strong> button to send an email to the primary email address automatically.</td>
</tr>
<tr>
<td>Hide Background Color</td>
<td>This determines if the background color is hidden.</td>
</tr>
<tr>
<td>Hide Icons</td>
<td>This determines if the <strong>Call us</strong> and <strong>Contact us</strong> icons are hidden.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Change Your Store Location on the Map**

You can change your store location on a preexisting map by gaining a new HTML code from a third-party provider and updating **Map & Contact** content on your website.
To change your store location on the map:
1. While logged in to SMT on your website, navigate to the page that contains the Map & Contact content.
2. In the Map & Contact box, click Edit.
   This displays the Map & Contact Settings in the side panel.
3. In the Map HTML Snippet field, enter the new HTML code for the new map location.
4. Click Save.

Delete the Map and Contact Information

You delete the map and contact information using SMT in one of two ways, depending on whether you have published the content to your website:
- **Discard** the map and contact information if you have not published the content.
- **Remove** the map and contact information if you have already published the content.

To discard the map and contact (Unpublished Content):
1. While logged in to SMT on your website, select the Review & Publish Changes list from the Site Management toolbar.
2. Select the Map & Contact content in the list.
3. Click Discard.
4. Click OK.

To remove the map and contact (Published Content):
1. While logged in to SMT on your website, navigate to the page that contains the map and contact content you want to remove.
2. In Edit mode, click the Map & Contact box.
   This highlights the map and contact content and displays the content controls.
3. Click Remove.
4. Click OK.

Contact Form Content Type

The Contact Form can be added to your webstore to include a form allowing users to reach out with questions or comments. The contact form creates Lead and Case records in NetSuite to document users’ names and emails addresses. The following sections address how to:
- Add a Contact Form
- Configure a Contact Form
- Delete a contact form

Add a Contact Form

To include a contact form with customizable fields on your website, add the Contact Form content type to a page of your site using SMT.
To add a contact form:

1. In your website, navigate to the page where you want to add a contact form.
2. Log in to SMT.
   For more information on logging in to SMT, see the help topic Users and Roles.
3. In Edit mode, click Add on the Site Management toolbar.
4. Drag the Contact Form content type to the page.

   **Note:** If you do not see this content type, check that the extension has been installed and is active. Click Settings on the Site Management toolbar to access the Content Manager. Drag the content type from the Inactive Content Types list to the Active Content Type list.

You can drag the Contact Form content type to multiple areas on the page.
For more information on the scopes of different SMT areas, see the help topic Site Management Tools Areas.
5. Click Save.

Configure a Contact Form

Configure properties to customize your contact form and make it ready for use. You can set the form fields and determine aspects such as field positioning, feedback messages, and additional fields. The following procedures explain how to:

- Configure Properties in NetSuite
- Configure General Settings
- Configure Contact Fields
- Configure Messaging Fields
- Configure an Additional Field
- Configure Feedback Messages
- Configure the Layout and Style

Configure Properties in NetSuite

To set up the Map & Contact extension, you must select your preferences in NetSuite.

To configure properties in NetSuite:

1. After activating the Map & Contact extension for a domain, go to Setup > SuiteCommerce Advanced > Configuration.
   For more information on activating an extension, see Manage Themes and Extensions.
2. Select the website and domain where you want to set up the extension and click Configure.
3. Navigate to the Extensions tab.
4. In the Map & Contact subtab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate Leads To</td>
<td>This determines the subsidiary with which you want the lead to be associated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default First Name</td>
<td>This sets the default text to display in the First Name field of the Lead record if a first name is not supplied by the user.</td>
</tr>
<tr>
<td>Default Last Name</td>
<td>This sets the default text to display in the Last Name field of the Lead record if a last name is not supplied by the user.</td>
</tr>
<tr>
<td>Default Company</td>
<td>This sets the default text to display in the Company field of the Lead record if a company is not supplied by the user.</td>
</tr>
<tr>
<td>Default Subject</td>
<td>This sets the default text to display in the Subject field of the Lead record if a subject is not supplied by the user.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

### Link Contact Form Leads to a Subsidiary

This section only applies if you are using SC Map & Contact version 1.1.1 or earlier and changing the Associate Leads To field from the default company. If you are using SC Map & Contact version 1.1.2 or later, or if you are using SC Map & Contact version 1.1.1 or earlier and want to associate the leads to the default company, no further action is necessary.

If you are using SC Map & Contact version 1.1.1 or earlier and set the Associate Leads To field to a subsidiary that is not the default company, you must edit the deployment record to change the associated role.

**To edit the deployment record:**

1. In NetSuite, go to Customization > Scripting > Scripts.
2. Click **View** next to the **NS SC SL Contact Us Form** script.
3. In the **Deployments** subtab, click the **NS SC SL Contact Us Form** deployment record.
4. Click **Edit**.
5. In the **Execute As Role** field, select the **Administrator** role.
6. Click **Save**.

### Configure General Settings

Set the general fields in SMT to set up your contact form.

**To configure general settings:**

1. While logged in to SMT on your website, navigate to the page that contains the contact form.
2. In the **Contact Form** box, click **Edit**.
   This displays the Contact Form Settings in the side panel.
3. In the **General** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This sets a description of your new content.</td>
</tr>
</tbody>
</table>
Configure Contact Fields

SMT lets you configure multiple properties for each Contact Form field to determine how the form looks to users on your site. For each contact field appearing on your Contact Form, you choose the label, placeholder, help text, whether the field is mandatory, and whether the field is visible.

To configure contact fields:

1. While logged in to SMT on your website, navigate to the page that contains the contact form.
2. In the Contact Form box, click Edit.
   This displays the Contact Form Settings in the side panel.
3. In the Contact Fields tab, set your preferences for each of the following Contact Form fields, using the table below as a reference:
   - First Name
   - Last Name
   - Email
   - Phone
   - Company

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>This sets the label for the Contact Form field.</td>
</tr>
<tr>
<td>Placeholder</td>
<td>This sets the placeholder text to display in the Contact Form field.</td>
</tr>
<tr>
<td>Help Text</td>
<td>This sets the help text for the Contact Form field.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>This determines if the Contact Form field is mandatory.</td>
</tr>
<tr>
<td>Hide</td>
<td>This determines if the Contact Form field is hidden.</td>
</tr>
</tbody>
</table>
4. Click **Save**.

**Configure Messaging Fields**

SMT lets you configure multiple properties for each Contact Form field to determine how the form looks to users on your site. For each messaging field appearing on the Contact Form of your site, you choose the label, placeholder, help text, whether the field is mandatory, and whether the field is visible.

**To configure messaging fields:**

1. While logged in to SMT on your website, navigate to the page that contains the contact form.
2. In the **Contact Form** box, click **Edit**.
   This displays the Contact Form Settings in the side panel.
3. In the **Messaging Fields** tab, set your preferences for each of the following **Contact Form** fields, using the table below as a reference:
   - Subject
   - Message

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>This sets the label for the Contact Form field.</td>
</tr>
<tr>
<td>Placeholder</td>
<td>This sets the placeholder text to display in the Contact Form field.</td>
</tr>
<tr>
<td>Help Text</td>
<td>This sets the help text for the Contact Form field.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>This determines if the Contact Form field is mandatory.</td>
</tr>
<tr>
<td>Hide</td>
<td>This determines if the Contact Form field is hidden.</td>
</tr>
</tbody>
</table>
4. Click **Save**.

**Configure an Additional Field**

SMT lets you configure multiple properties for each Contact Form field to determine how the form looks to users on your site. In addition to the established Contact Form fields, you can add an additional field to better fit your needs. You customize this field by choosing the field type, label, placeholder, help text, whether the field is mandatory, and whether the field is visible.

You first create the custom field in NetSuite, then use the Internal ID to connect the additional form field in SMT to the custom field record in NetSuite. For more information on creating a custom field in NetSuite, see the help topic **Creating a Custom Field**.

**To configure an additional field:**

1. While logged in to SMT on your website, navigate to the page that contains the contact form.
2. In the **Contact Form** box, click **Edit**.
   This displays the Contact Form Settings in the side panel.
3. In the **Additional Field** tab, set your preferences for the additional form field, using the table below as a reference:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Type — Additional Field</td>
<td>This determines the field type for a customized additional field. The field type correlates to the custom field type in NetSuite. Supported custom field types in NetSuite include Free-Form Text, Date, Checkbox, and Text Area.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Link to — Additional</td>
<td>This determines if the additional field is linked to the lead or case.</td>
</tr>
<tr>
<td>Field</td>
<td>If you select <strong>Lead</strong>, the additional field is linked to the Lead record created with form submission. If you select <strong>Support Case</strong>, the additional field is linked to the Support Case record. For Lead records, an additional field is an Entity field type that applies to a Customer. For Support Case records, an additional field is a CRM field type that applies to a Case.</td>
</tr>
<tr>
<td>Internal ID — Additional</td>
<td>This requires the Internal ID from the custom field record in NetSuite.</td>
</tr>
<tr>
<td>Field</td>
<td>This field is mandatory for the following field types: Text Input, Text Area, Date, and Checkbox. The Text field type is only for display and does not require an Internal ID.</td>
</tr>
<tr>
<td>Label — Additional</td>
<td>This sets the label for the additional field.</td>
</tr>
<tr>
<td>Field</td>
<td>This sets the placeholder text to display in the additional field.</td>
</tr>
<tr>
<td>Help Text — Additional</td>
<td>This sets the help text for the additional field.</td>
</tr>
<tr>
<td>Field</td>
<td>This determines if the additional field is mandatory.</td>
</tr>
<tr>
<td>Hide Additional Field</td>
<td>This determines if the additional field is hidden.</td>
</tr>
</tbody>
</table>

There is a different **Additional Field** tab in SMT for each customized field you add.

4. Click **Save**.

**Configure Feedback Messages**

You can determine the feedback messages shown to users by editing the feedback message fields in SMT.

**To configure feedback messages:**

1. While logged in to SMT on your website, navigate to the page that contains the contact form.
2. In the **Contact Form** box, click **Edit**. This displays the Contact Form Settings in the side panel.
3. In the **Feedback Messages** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success Message</td>
<td>This sets the message to display upon successful form submission.</td>
</tr>
<tr>
<td>Required Field Message</td>
<td>This sets the message to display when a mandatory field has been left blank.</td>
</tr>
<tr>
<td></td>
<td>The mandatory field’s label replaces the placeholder <code>[[field]]</code> automatically.</td>
</tr>
<tr>
<td>Invalid Email Field Message</td>
<td>This sets the message to display when an invalid email address has been entered.</td>
</tr>
<tr>
<td>Submit Error Message</td>
<td>This sets the message to display when there is an error during form submission.</td>
</tr>
</tbody>
</table>
4. Click **Save**.

Configure the Layout and Style

You can customize the look of the contact form by setting the layout and style fields in SMT.

**To configure the layout and style:**

1. While logged in to SMT on your website, navigate to the page that contains the contact form.
2. In the **Contact Form** box, click **Edit**.
   
   This displays the Contact Form Settings in the side panel.
3. In the **Layout & Style** tab, set the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button Text</td>
<td>This sets the text to display on the submit button. If you leave this field blank, the button will not appear.</td>
</tr>
<tr>
<td>Button Help Text</td>
<td>This sets the help text for the submit button.</td>
</tr>
<tr>
<td>Button Style</td>
<td>This sets the button style.</td>
</tr>
<tr>
<td>Hide Background Color</td>
<td>This determines if the background color is hidden. Background color and padding can be customized using the Theme Customizer in SMT.</td>
</tr>
<tr>
<td>Position</td>
<td>This determines the field for this position. If the same field is selected for multiple positions, the ranking is ignored and default settings are applied.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Delete a contact form

You delete a contact form using SMT in one of two ways, depending on whether you have published the content to your website:

- **Discard** the contact form if you have not published the content.
- **Remove** the contact form if you have already published the content.

**To discard a contact form (Unpublished Content):**

1. While logged in to SMT on your website, select the **Review & Publish Changes** list from the Site Management toolbar.
2. Select the **Contact Form** content in the list.
3. Click **Discard**.
4. Click **OK**.

**To remove the contact form (Published Content):**

1. While logged in to SMT on your website, navigate to the page that contains the contact form you want to remove.
2. In **Edit** mode, click the **Contact Form** box.

   This highlights the contact form content and displays the content controls.
3. Click Remove.
4. Click OK.